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Composer Pro User Guide

Introduction
Control4® Composer Professional Edition (Composer Pro) is software you can use to set up and configure a
Control4 home automation system. This document explains how to use Composer Pro. To learn about what’s
new in this release, and basic startup and configuration information, see the Composer Pro Getting Started
guide in the Composer Pro Help menu or on the Control4 website.

Scope
This Control4 Composer Pro User Guide, which was formerly separated into two parts, is now compiled into a
single manual. The User Guide covers these topics:

l Installing devices

l What's new in this release

l Configuring properties

l Configuring devices

l Customizing the Navigators

l Updating Composer and Director

l Example projects

l Troubleshooting the system

l Setting up the network configuration

l Creating device drivers

l Connecting and verifying devices

l Setting up the media

l Programming the system

If you've never used Composer Pro before, we suggest that you start by reading Composer Pro Getting
Started, available in the Composer Pro application's Help menu or on the Control4 website in PDF. If you're
already familiar with Composer Pro, you can skip through the Composer Pro Getting Started, and then
continue with this document.

For information about what’s new in this release, see What's new in this release.

15

http://www.control4.com/docs/product/composer-pro/dealer-getting-started/latest
http://www.control4.com/docs/product/composer-pro/dealer-getting-started/latest
http://www.control4.com/docs/product/composer-pro/dealer-getting-started/latest
http://www.control4.com/docs/product/composer-pro/dealer-getting-started/latest
What's new in this release.htm


Composer Pro User Guide

Related documents and resources

Document Title Location

Composer Pro Getting Started
(200-00168)

Composer Pro Getting Started

Composer Pro User Guide
(200-00005)

Composer Pro User Guide

Control4 System User Guide
(200-00001)

System User Guide

Control4 Operating System
Latest Release Notes

Latest release notes:
ctrl4.co/releasenotes

Composer Pro overview
This document is for new Control4 dealers or installers who want to learn how to use Composer Pro in the 
Control4 Smart Home OS 3.3.0 (OS 3.3.0) or later, or for those who want to keep up with the latest changes. If 
you are already familiar with Composer Pro, you may only want to know what has changed from the last 
release. If this is the case, see “What's new in this release” or “Where to go from here” for more advanced 
information about Composer Pro, and then search for your subjects in the Composer Pro User Guide.

The Control4 system is a combination of Control4 and third-party controllable devices, for example, HDTVs, 
DVDs, CD players, speakers, home theaters, lights (and so on) that communicate with one another via TCP/
IP, infrared (IR), serial, contact, or relay connections.

Composer Professional Edition (Composer Pro) is the software application that Control4 dealers and/or 
installers use to design and set up a Control4 system project for home automation in a consumer's home or 
business. The software runs on either a Windows 7, 8, 10, or Windows Vista computer, and provides a 
powerful graphical interface for object-based programming. When connected to a Control4 controller, the 
project's information is then communicated to Director on the controller. Director, in turn, uses the 
configuration information and device drivers to communicate to the devices in the home automation system.

Note: Composer Pro 3.0 is not compatible with Windows XP

The sections in this Getting Started document provide basic information and steps for Control4 dealers and
installers to become familiar with and start using the Composer Pro interface for initial design and setup of a
Control4 system.

Information beyond the basics described in this guide (for intermediate and advanced users of Composer Pro)
is provided in the Composer Pro User Guide.

Setting up the Control4 system—overview
Setting up a fully functional Control4 system includes the following major procedures.
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For best results, Control4 recommends that you follow the procedures in this order:

1. Install and connect the hardware—When deploying a Control4 system, install and connect the essential
devices:

l A Control4 controller (for example, an EA-3)

l A Windows-based computer to set up and configure the home automation system
using Composer Pro

l The device to be controlled (for example, touch screen, DVD player, speakers,
lights, Dock for iPod, etc.)

l A controller and PC connection to the home network

2. Purchase the required licenses—To use Composer Pro for your company or your employees, you’ll need to
purchase and assign licenses. See the document Managing Dealer Accounts on My.Control4.Com for
details.

3. Install the Composer Pro software—Use the Composer Pro installation software to install Composer on a PC
and activate it using your my.control4.com dealer user account.

4. Connect to a Director— Each time you start Composer on your PC, you either connect to Director running on
a local or remote controller (live connection) or a virtual Director running on your PC (virtual connection).
Director is the software on a controller that stores the Control4 system configuration and manages the control
of each subsystem and device in the Control4 system.

l Live connection: To make changes to a Control4 system in real time, connect to the Director through
either Local System (over the home network) or Remote System (over the Internet).

Note: Remote Access must be configured locally before using a remote connection
to the controller. See “Setting up Remote Access.”

l Virtual connection: Alternatively, to create or edit the system configuration offline
and save the project file, connect to Director through Virtual System. The saved .c4p
project file can be loaded later into a controller through a local connection to ensure
that Director has the updated system configuration.

5. Plan and design the system. To design a system in Composer Pro, you first create a project in the form of a
project tree that represents the hierarchy of locations for the devices to be automated in the home-
automation system (site > building > floors > rooms > devices) and the devices that reside in each room.

l Create a plan. Creating a plan before you start your project in Composer Pro will
help make your system design go much more smoothly.

l Design the system using System Design view: Use the System Design view where
you can view the project tree as you build the design.

6. Make and test the connections. In the Composer Pro project, you must define all of the physical connections
of the devices to the system: control (IR and serial)and AV (audio, video). You must also define other
connections: room control and network connections. You can use Composer Connections view to complete
the connections.

7. Register the system. Control4 recommends that you register each system you install at
customer.control4.com to maintain the system software through software updates and critical system
patches.
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Important: Only registered systems can use all of the media services available. System
registration is one of the essential steps that lets you access the system remotely (remote
access) for repairs, updates, and additions.

Composer Pro system requirements
Computer software and hardware

l Microsoft.NET 4 (the Composer install is launched automatically from the
Control4 website).

l Microsoft operating systems supported (Windows 10, 8, 7, or Vista). Mac
support when used with a Windows virtual machine such as Parallels or
VMWare Fusion for Mac.

l 500 MHz or higher processor

l 256 MB RAM

l 90 MB available hard disk space

l Video card and monitor supporting a resolution of 1024x768 or higher

l Keyboard

l Mouse

l 1 to 2 Ethernet (CAT5 or CAT6) cables

Home computer network
l Wireless access point (WAP) or wireless router that supports 802.11 b/g/n
(optional)

l TCP/IP-based (Ethernet) home network. This usually includes a network
gateway, router or switch.

l 1–2 Ethernet (CAT5 or CAT6) cables

l A broadband Internet connection. During initial setup, a broadband Internet
connection is required to update the Control4 system and retrieve the
media's cover art. Also, a broadband Internet connection is required to
support remote access to the system.

Control4 home automation network
l A Control4 controller (for example, an EA-3).

l Control4 Composer Professional Edition (Composer Pro) software, version
3.0.0.

l Note: A Control4 controller is set by default as a DHCP client. If the home
network has a DHCP server in place (for example, a router that provides
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DHCP services), then the controller automatically receives a valid IP address.

Note: Control4 recommends that you update to the latest software release.

l A wireless access point (WAP) that supports 802.11b/g/n (required to use a
Control4 wireless touch screen).

l A valid electronic license to run Composer Pro. Control4 now requires
activation using a my.control4.com account with a license to run Composer
Pro. Re-activation is required every 30 days. See Managing Dealer Accounts
on My.Control4.com on the Control4 dealer website or Knowledgebase to
learn how to add and manage licenses frommy.control4.com.
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Installing the hardware and software
This section provides guidelines to install the devices and Composer Pro.

Installing and connecting the hardware
Before you can set up a Control4 home automation system in Composer Pro, all
of the devices to be used in the system need to be installed and connected to the
home network. Additional devices can be added and identified to the Composer
Pro project if you install or replace devices in the future.

Follow these guidelines to get started:

1. Create a system specification, and refer to it so you can answer these questions.
1. What does the home have?

l Any there any outer buildings, for example a detached garage, that will be
automated? All buildings to be automated must be included in the project.

l How many floors are there in each building? For example, the house has three
floors and a basement; the garage has one floor.

l What rooms are on each floor? For example, the third floor of the house has one
Master Bedroom and two other bedrooms. The third floor also has one Master Bath
and one Main Bath.

2. Which Control4 devices are or will be installed in each room (include manufacturers and model numbers)?

3. Which third-party devices are or will be installed in each room (include manufacturers and model numbers)?

4. If any of these devices has a choice of power sources, indicate how the device will be powered: AC, DC, or
batteries.

5. If any of these devices has communication options, indicate how each device will communicate with the
controller (how the device will be controlled): Ethernet, Power Over Ethernet (POE), Wi-Fi, Zigbee® Pro, IR,
serial, contact, or relay.

2. Install and connect the Control4 devices as described in the installation or setup guide that ships with each
device.

Tip: See also “Related documents and resources” in this guide for document locations.

3. Install and connect all third-party devices, for example, audio-video devices, door contacts, and security
panels, as described in the installation guide that ships with each device.

4. Connect the Control4 controller and your PC to the home network. Initial setup of the controller requires a
hard-wired (Ethernet) connection to the network, and an Ethernet connection is always recommended. A
simple Control4 system and home network are shown below.
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l Use the RJ-45 jack labeled ‘Ethernet’ on the back of the controller to connect it to
the home network. If successful, the amber LED turns on and the green LED blinks.
Read the controller’s installation guide to learn how the LEDs work.

l Use either a wireless access point (WAP) or Ethernet cable to connect the PC to the
home network. 

5. Confirm that the Control4 devices are getting network addresses from the gateway, router, or switch. See the
Composer Pro User Guide for details.

Installing Composer HE software
Follow these steps to install your Control4 Composer HE software for the first time. If you are upgrading from a
version earlier than OS 2.9.1, you must first upgrade to OS 2.9.1 to continue. Please refer to the specific
version of this document for further information.

Note: An Internet connection is required to perform this installation.

Follow these general steps for existing systems:

l Your dealer should purchase, install and activate the Home Edition license.
The computer running Composer HE must be connected to the Internet,
andyou must have a customer.control4.com account with a license to run
Composer HE.

l Install Composer HE 3.2.4.
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To install the Composer Pro software:

1. Obtain the Composer HE Installation software (available as web download from customer.control4.com).

Note: Windows 7 or later and an Internet connection are required to perform this
installation.

2. Start the Composer HE installation, and follow the on-screen instructions.

3. Select to update to the latest version of Composer.

Tip: As new features and drivers become available, the Composer HE software and
associated drivers can be updated.

4. During the installation process, click Continue Anyway to allow the installation to proceed.

5. The next screen asks for your account login and password. This assumes that you already have an account
on customer.control4.com with a Composer HE license. If you don't have an account, contact your Control4
dealer.
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Exploring Composer Pro features
The Control4 Composer Pro interface (views) and wizards are designed to help
you simplify the process of designing the system, identifying and configuring the
devices, making the connections, and then customizing the system through
programming. How you set up the devices in Composer Pro determines how they
function in the system.

First page
When you start Composer Pro and connect to a Director, a similar screen like the
following System Design view appears: 

The Composer Pro interface contains menus, panes, a project tree, tabs, and objects. These components are
explained in this document.

Composer Pro startup options
Start Composer Pro
You can start the Control4 Composer Pro application two ways:

l Double-click the Composer icon on your desktop (easiest way).
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l Click Start > All Programs > Control4 > Composer 3.0.0 > Composer 3.0.0.

Tip: For your convenience, in Composer 2.5 and later the Start menu also
displays your projects, logs, and drivers.

When you start Composer Pro, the Composer startup screen displays: 

This screen presents the following Director-connection options. Click one of the options to access the
Composer Pro project and project tree (System Design view).

l Virtual System—Click this option to work on the project when you are
disconnected from the network. If you do not have access to the
controller, you can still set up a system using a “virtual” Director on your
PC, and later upload your changes to the controller. Using a virtual
connection, you can complete most design tasks, including making
software connections and performing some programming tasks. You
cannot identify network connections, test device control, or set up media
virtually in this mode, however.

Note: Use this option, for example, if you are installing Centralized Lighting
products. Also, check Install the Report Viewer to add the Centralized
Lighting reports. Your electrician will need these reports to install the
panels and modules when they become available. See the documentation,
plans, and videos on the Control4 website.

l Local System—Click this option if you have a direct connection to the
home network (inside the firewall). This option gives you all the
capabilities of the application: set up and design a project, connect the
devices to the network, configure the media, and program the system.

l Remote System—Click this option to work from a remote location by
establishing an Internet connection to the home network (outside the
firewall). You can perform the same tasks as if you were connected using
the Local System option.
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l System Manager—Click this option to launch System Manager. System
Manager can also be launched from Tools > System Manager, or from the
Composer folder in the Windows Start menu.

This Directors dialog appears when you click Local System. In this case,
you select the network address associated with the controller, and then
click Connect.

l Connect—Lets you connect to the Director that resides on the controller
attached to the local network.

l Cancel—Cancels and closes the Directors dialog box.

l Add...—Lets you add the Director’s address of the controller to which you
are trying to connect.

l Remove—Lets you remove the selected Director from the list.

l Refresh—Lets you update the Directors list to display recently-added
Directors.

Exit Composer Pro
You can exit Composer two ways:

l Startup window (where you start Director):click Exit Composer.

l File menu (in the Composer project): select Exit.

As you exit, Composer Pro prompts you to back up your project and media information to your local computer.
This is not required except when using a Virtual System connection, but Control4 highly recommends that you
back up your project every time you close Composer Pro.
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Composer Pro views
Available views
The Control4 Composer Pro application has five main views (buttons are located in the bottom left pane).
When you select a view (see the figures below) the appearance, functionality, and configuration change for
that view.

Also note the status bar at the bottom of the screen, which indicates the Director’s network IP address and
Director status.

Tip: Collapse the views by clicking the dotted bar just above the views so you
have more room to view the project tree.

Main menu:

Composer view buttons:

Click one of these buttons for the desired view.

l System Design—Build the project tree by adding locations and devices and
define device properties.

l Connections—Make connections in the project between devices (Room,
Control, AV, Network) and identify devices.

l Media—Add and scan stored or broadcast media.
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l Agents—Set up an agent for use in the system and in programming. Agent
types: Lighting Scenes, Wakeup, Scheduler, Variables, etc.

l Programming—Program events and actions to automate the system. Using
predefined events and user-defined agents.

System Design view

Use the Control4 Composer Pro System Design view (the default view when you
start Composer Pro) to define the Control4 system project for a customer. 

This view lets you set up the project tree by defining
l The location of the devices to set up in the project (building).

l The device you want to include in the project (device objects).

l The location of each device by room (room). 

To access the System Design view:

1. Start Composer. 

Take note of the three large panes in the screen below (System Design, Properties, and
Items):

l System Design (left pane)—Contains the project tree where you build or update
the project configuration with locations and device drivers. Select the room where
you want the device driver to go, and then double-click a device driver in the Items
pane (right side) to add it to the project tree.

l Properties (center pane)—Contains the Properties of the object you select from
the project tree when you want to check or modify a device, project, and room.
Refer to the sections below to view more information about the Properties pane.

l “Project Properties”

l “Room Properties”

27



Composer Pro User Guide

l “Device Properties”

l Items (right pane)—Contains the items (or objects, device drivers) you use to build
your project, such as locations (sites, buildings, floors, rooms) and devices
(controller hardware, DVDs, TVs, receivers, lights, contacts, relays, etc.). If a
device is not available in the My Drivers tab in this pane, use the Search tab to
search for that device (see the Composer Pro User Guide for information about how
to search for drivers). If you've created a new driver using the Driver Wizard or
DriverWorks, you will find your new driver in the Search tab.

System Design pane

The System Design pane in the System Design view displays the project tree. You
build the project by adding floors, rooms, and devices from the Items pane to the
tree.

To access the System Design pane:

1. Start Composer.

Note: The example project tree below shows the project name (Main), site (Home),
building (House), floors (Main), rooms (Family, etc.), and the devices already added to
the project. If your project is new, the pane will show only the New Project icon and
item. Rename your project by right-clicking the name and selecting Rename.
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Use the project tree to:

l Add Locations—Lets you add locations (sites, buildings, and floors) to the project
tree. Double-click to select an item from the Items pane > Locations tab to move
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location items to the project tree. If you do not manually add the locations,
Composer automatically adds generic locations.

l Add Devices—Lets you add devices (lights, VCRs, TVs, controllers, etc.) and their
device driver to the project tree below the selected room. To add devices, click the
location (where the device is installed) in the project tree, and then double-click a
device in the Items pane >My Drivers or Search tabs (right pane) to move device
to the project tree.

l For more information about how to create a project, see “Introduction.”

Right-click on a device, room, or other item in the project tree to bring up additional options for that item.

Tip: You can use Ctrl+R to collapse rooms, Ctrl+D to collapse
devices, or Ctrl+E to expand all even without right-clicking.

Project tree search, sync, and filter

To make it easier to find and manage devices in large projects, the project tree has search, sync, and filter
controls.

l Search—Type the device name to search for here. Click the Find Next button
to jump to the next device of that name. Click the down arrow on the right
side of the search box to select from previously used search terms.

l Sync—Use Sync to keep the same project device selected while switching
between System Design, Connections, and Programming views. Click the
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Sync button and select the checkbox for the views you want to keep
synchronized with the System Design view, then click Done. To clear them,
click the checkboxes or click Clear All.

l Filters—Use filters to hide or show only certain types of items in the project
tree. Click the Filters button, then set filters by Device Type or Category. The
Device Type list contains only device types already included in your project.
Setting a filter under Device Type will clear any filters already set in Category,
and vice versa. To clear all filters, click Clear All Filters.

Device Control window

The Device Control window in System Design lets you test and control a physical
device (after identifying the device and making its connection) in Composer Pro
to make sure it works in the system.

Note: You must define the connections before you test or control the devices.
See “Testing the device connections” for information about how to make the
connections. 

Example: To use the Device Control for a dimmer, you click a button in the
Device Control window to turn the dimmer on or off and change the light
level. If the physical light changes also, you know the dimmer driver is added
and the basic connections are made correctly.
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To access the Device Control window:

1. Start Composer. The System Design view appears.

Double-click the device in the project tree to access the Device Control window (see below) for that device.

This window lets you change the configuration parameters (temporarily) and control a device. Later, you can
set the parameters permanently in the Properties pane or Programming view.

Example: You can adjust and test the ramp rate of a dimmer to determine the
desired ramp rate to set during programming.

Properties pane

In the System Design view, click the project name in the project tree to view the
Properties pane (center pane).

The project Properties appear when you first start Composer Pro, or any time you
select the project name (or root node) in the project tree. Different properties
appear depending on the item you select.
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This option lets you enter project-specific information; for example, the project name, location, and ZIP Code.
Composer Pro automatically enters the latitude/longitude and date/time information after you provide the
location and ZIP Code.
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Properties Pane

Project Settings tab
Category Boxes or Buttons
Project Name—Lets you enter/edit
the name of the project.

N/A

Location—Lets you look up a
location’s latitude and longitude
based on city, state, country, etc.

Latitude/Longitude—Lets the system calculate
from the entered ZIP Code, the local latitude and
longitude coordinate information. Knowing
location information lets the system calculate
local sunrise and sunset times. This is useful for
programming lights to turn on at dusk and off at
dawn. Using a ZIP Code to find the coordinates
only provides a close estimate of latitude and
longitude. If you want to enter exact coordinates,
the fields can be edited. Also used for outside
temperature on the touch screens.
Country—Lets you select the country in which
the project is located.
Lookup Button—Lets you enter/edit the ZIP
Code which identifies to the system the local
cable, satellite, and broadcast channel
programming. It also automatically provides
latitude and longitude coordinate location.

Date and Time—Lets you set a date,
time, and time zone for the Control4
system. By changing the time here
and refreshing Navigators (File >
Refresh Navigators), you reset the
time on the entire system. However,
Control4 systems with access to the
Internet automatically synchronize
the system clock using Network Time
Protocol (NTP).

Timezone—Lets you set the appropriate time
zone by clicking Edit. Changing the time zone
causes the controller to reboot.
Display time using a 24-hour clock—If
checked, lets you use the 24-hour clock (0 to
2400 hours) rather than 12 am to 12 pm.

Project Settings Control—Lets you
set a device in Composer that does
not allow the setting to be overridden
at the device.

Push Settings From Project—Check the box for
devices to receive settings from the Composer
project only. New settings in the Composer
project override any settings at the device.

System Security—If set, all
Navigators (Release 2.0 or later)
must connect through a secure

Properties Pane: Information tab
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Properties Pane

connection.
Localization—Lets you set the locale
and character set for countries outside
the United States.

Locale—Use the down arrow to change the
locale.

Scale—Lets you select the
temperature type.

Fahrenheit or Celsius.

Information tab
Category Boxes or Buttons
System Owner Name, Address, Phone, and Email—Enter

homeowner information into these fields.
Dealer Information Name, Address, Phone, Email, Primary

Contact, Lead Installer, Original Install Date,
and Date of Last Update—Enter dealer
information and project update dates into these
fields.

Project Notes Any notes the dealer wants to add can be stored
here.
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Lighting Defaults tab
Category Boxes or Buttons
Status LEDs—Lets you set
default LED colors for switches,
dimmers, and keypads.

Top/Scene—Set the default On and Off color for Top
buttons and lighting scenes in the project.
Bottom—Set the default On and Off color for Bottom
buttons on devices in the project.
Toggle—Set the default On and Off color for buttons
configured to toggle lights or scenes in the project.
Backlight—Set the default backlight color for devices
with backlights in the project.

Style—Lets you set default
engraving style settings for each
device in the project.

Button Style—Set the default Button Style for devices
in the project, Traditional or Contemporary.
Engraving Alignment—Set the default alignment for
engravings: Left, Center, or Right.
Engraving Size—Select the default engraving text
size: Large or Standard.
Finish—Select the default button finish for devices in
the project. Finish styles include:White, Light
Almond, Ivory, Brown, Black, Aluminum, Snow
White, Biscuit, andMidnight Black. Available finish
styles may vary.

Apply To...—Click Apply To... to apply the current
lighting styles to desired devices in the project. Click
next to a device, room, or the whole project to select
the desired devices to change, and then click Apply.

Centralized—Lets you set
default settings for Centralized
Lighting devices in the project.

Nominal Voltage—Set the default voltage for all
Centralized Lighting devices in the project.
Centralized Modules In Control4 Panel—Set the
default setting if your Centralized Lighting modules
are in a Control4 panel or not.
Centralized Modules use Arc Fault Breaker—Set
the default setting if your Centralized Lighting
modules use an arc fault breaker.

Allowed Networks tab
Category Boxes or Buttons
Subnets By default, it is not possible to identify a device that

resides on a different network (e.g., subnet) because
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Lighting Defaults tab
Director actively excludes identification broadcasts
received from devices on a different network.

You can expand the list of allowed networks by
adding one, or more, CIDR network specifications to
the following list.

For example:
192.168.2.0/24

For more examples see:
https://en.wikipedia.org/wiki/Classless_Inter-Domain_
Routing

Zigbee Configuration tab
Category Boxes or Buttons
Edit Zigbee Configuration Click on this link to define, edit, and move Zigbee

mesh configurations.
Refresh Click on this link to refresh the Zigbee status view

below.
Zigbee Network Status Use this view to see the status of the Zigbee mesh(es)

in your project.
Name—Name of the device configured in the Zigbee
mesh.
Controller Status—The colored icon shows an at-a-
glance status of the Zigbee network. Green for online,
Yellow for offline, Red for error.
Zigbee Server—The controller defined as the Zigbee
Server will say “Enabled”.
Zigbee Status—Shows the status of the Zigbee
Server. “Running” means the Zigbee Server is
configured and running.
Channel—The current channel of the Zigbee mesh.
ZAP Status—A controller configured as a ZAP will
show as “Coordinator” or “Enabled”.

Z-Wave Configuration tab
Category Boxes or Buttons
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Lighting Defaults tab
Advanced Use the Learn, Network Update, Reset Defaults, and

Send Node Info buttons to manage your Z-Wave
network. See the Z-Wave Setup Guide for more
information (ctrl4.co/z-wave-sg)

Room Properties

The room Properties (System Design > Room > Properties) appear when you
select a room in the System Design project tree.

The room Properties pane lets you view room-specific device and media information (for example, the iPod
located in the Office is an available audio source in the Family room), and helps you troubleshoot any
incorrect room connections.

The Audio/Video Devices tablets you view the devices configured for each end point device and the devices
that are available in the room.

Example: If you can’t play movies from a Disc Changer in a particular room,
you can view the room’s Properties to see if the disc changer shows up in the
List view. If it does not, you are probably missing AV bindings in the path to
the device. Detailed information about connections is available in the
Composer Pro User Guide, or see “Connections view.”
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Properties Pane—Room Properties
Category Box or Button
Audio Video Devices tab—Provides
information that lets you view all audio
and video devices and control
connections in a selected room.

Audio Endpoint—The device that is
configured to play audio in the room.
Tip: Which device needs to turn on and off to
listen to any source of audio in the room?

Audio Volume—The device that is configured
to control the audio volume in the room.
Tip: Which device do you need to send volume
commands to in order to control the audio
volume in the room?

Video Endpoint—The device in the room that
is configured to display the video in the room.
Tip:Which video display device is in the room,
or where does the video end up?

Navigator tab—Lets you hide and re-
order device visibility for all Navigators
(in Watch, Listen, etc.).

Modify—Lets you move the order of devices
up or down, and hide or show them. Select the
device in the Menu list.

Miscellaneous view—Lets you set the
default audio and video volume for the
room, for example, what the room will
revert to after a power cycle. This is
also where you set the IR Mask for the
room.

Enable Default Volume—Select and use the
up or down arrows to change the audio and
video volume.

Mute When Paused—Select this option to
send a mute command when media is the room
is paused.

Multi-Room Shared IR Settings—Use the
down arrow to select the IR.

Room Summary

The room Summary (System Design > Room > Properties) appear when you
select a room in the System Design project tree and click on the Summary tab..
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This screen gives useful summary information for the room including room
location in the project, Room ID (which can be helpful when reviewing project
logs), and Device Programming that pertains to the room.

Device Properties

The device Properties (System Design > device > Properties) are visible when you
select a device in the project tree. This option lets you modify the available (if any)
user options for the selected device.
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Properties Pane: Device Properties
Category
Properties—Lets you modify options (if available) that are common to all devices of
that type.

Advanced Properties—Lets you modify advanced options (if available) on some
devices.

List View pane

Use the Control4 Composer Pro List View pane in System Design to view all of the
devices in a room.

When you select a room or any device in a room in the project tree, and then click
List View, all of the devices installed in that room display; for example, notice all of
the devices installed in the Family room (shown below).

Note: The List View shows all the devices in a given area and the current state
of contact inputs or other devices. When selecting the site, building, floor, or
room, all of the devices associated in that area are visible. If a single device is
selected in the project tree, List View shows all devices that are in the same
room.
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To access the List View pane:

1. Start Composer.

2. In the project tree, click any object.

3. In the Properties pane, click the List View tab.

4. You can double-click a device in the List View pane to display its Device Control window.

Items pane

The Control4 Composer Pro Items pane lets you build the project tree either by:

l Dragging and dropping items from the Items pane to the project tree, or by

l Double-clicking the item in the Items pane (which adds it to the project tree).

Note: In OS 2.3.0 or later, specific devices can be added and identified in the
project tree automatically using the Discovered tab (via SDDP). See the figure
below and the Composer Pro User Guide for details.

To access the Items pane:

1. Start Composer Pro. The System Design view appears by default.

2. View the Items pane on the right side.

3. Click the Locations tab. 

The Locations tab displays the list of available objects by their physical location in the home (site,
building, floor, or room) that you can add to a project. Use the items in the Locations tab to organize the
project tree by area. 
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Example: The Sites object shows which sites (Home, Work, Corporate, etc.) you can add
to your project tree as you begin to build your design. 

4. Click the Discovered tab.

The Discovered tab (supported for devices added in OS 2.3 and later) lists the devices that can be
automatically discovered by the system. You simply click where in the project (room) you want the device
to go (left pane), and then double-click the device in the list; it will be added and identified automatically.
See “Configuring devices” in the Composer Pro User Guide for details. This feature is ideal for smaller
systems.

5. Click theMy Drivers tab.
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The My Drivers tab displays a list of device drivers you can add to the project tree. This is a list of common
Control4 and third-party device drivers. If you can't find the driver you want, go to Step 6.

6. To locate a driver that is not in the common list, click the Search tab. If you can't find the driver you want here,
you may need to create your own driver. See “Search tab” for details about how to use the Search function.
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The Search tab lets you search for drivers that don't appear in the My Drivers tab.

My Drivers tab

Use theMy Drivers tab to add Control4 and popular third-party device drivers to
the project tree. 
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To access the My Drivers tab:

1. Start Composer Pro and connect to a Director.

2. In the project tree, click the room to add the driver to.

In the Items pane (right side), click the My Drivers tab. A list of devices appears.

3. Click to expand a category, and type in the search box to search for a device name.

4. Double-click a device driver in the list to add it to the project tree. For information about configuring devices
after adding them to the project tree, see "Configuring devices" in the Composer Pro User Guide.

5. The My Drivers list is only a set of common devices. If you do not see the device driver you need, you can find
and add device drivers to the My Drivers list using the Search tab.

If you select a generic device, a dialog box with a list of devices appears. Select a specific model to add it to
the project tree. If you can't find the device driver you need, you can either modify an existing one or create a
new one. See the Composer Pro User Guide for details.

My Drivers options

If you right-click any device driver in theMy Drivers list, the following options
display:
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l New Folder—Create a new folder in theMy Drivers list.

l Rename Folder—Rename an existing folder.

l Collapse Folders—Close all folders.

l Expand Folders—Open all folders to expose the items.

l Add Driver—Add a driver to theMy Drivers list..

l Delete—Remove an existing driver from theMy Drivers list.

l Move Up—Move the item up the list.

l Move Down—Move the item down the list.

l Save List—Save theMy Drivers list.

l Load List—Load a saved list.

l Add from Defaults—Add a driver from the default list.

l Restore Default List—Restore the device list to the default contents.

Search tab

Use the Search tab to search for and add device drivers to the project tree that do not appear in the My Drivers
list.

To find a device driver using Search:

1. Start Composer Pro and connect to a Director.

2. In the project tree, click the room to add the driver to.
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3. In the Items pane, click the Search tab.

To find a device driver:

1. From the project tree, select the room where the device resides.

2. In the Search tab, type the text to search for in the search box. As you type, matching options are displayed.

3. To narrow down the search, select the device type and the manufacturer from the respective filters.

4. Drag the driver to the project tree, or double-click the device driver to add it the project tree.

l [search text field]—Type the text to search for here. You can use the drop-
down menu to select terms that were previously typed.

l Local (default)—The Local checkbox lets you view device drivers stored on
your local computer.

l Online—The Online checkbox lets you view and download drivers from the
online database.

l Certified Only—This checkbox specifies that only Control4-Certified drivers
will appear in the search results.

l Device Types—Lets you select the device type (proxy), for example, AV
Switch (includes audio switches), Blinds, CD, Disc Changer (includes DVD and
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CD Changers), DVD, Light, Receiver, Satellite (includes DVRs), Cable TV,
Television, Thermostat, Tuner, VCR and more.

l Manufacturers—Lets you select the manufacturer.

l Sort by—Lets you select the order that search results are displayed.

l Results—Detailed search results appear, including the manufacturer, model,
and driver location.

Locations tab

Use the Locations tab to add the list of available locations (site, building, floor, room, etc.) to a project.

To access the Locations tab:

1. In the project tree, click the site, building, or floor where you want to add the location.

2. In the Items pane (right side), click the Locations tab.

3. Double-click a location in the Locations tab to add it to the project tree.

Click Sites, Buildings, Floors or Rooms to expand the category.
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l Sites—Define the project site type. Defines the main location, and identifies
the type of system you are designing, for example, a residence, commercial,
or corporate site.

l Buildings—Place the buildings on the site (House, Building, Office, etc.).
Defines the buildings located on the site. For example, a residence might
have a separate Garage, Workshop, Shed, or Pool house. A Campus might
have a building for each college.

l Floors—Add the floors in each building (Main, Second, etc.). Lets you describe
the various floors in each building, for example, Main and Basement or First,
Second, and Third floors.

l Rooms—Add the rooms on each floor (Bedroom, Bathroom, etc.). Lets you
describe the various rooms on a floor, for example, Kitchen, Living Room,
Great Room, Master Bedroom, Laundry Room, etc.
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Info pane

Use the Info pane in System Design to view information about the system owner and Control4 dealer. 

Tip: Some of the information you enter here is added to the touch screens,
Control4 apps, or on-screen navigators (More > Settings > About) in Release
2.0 or later. For example, the longitude and latitude display the outside
temperature on a touch screen, Control4 app, or on-screen Navigator.

To access the Info pane:

1. In System Design, click the Info tab.

2. View, add or change existing information about the system owner or dealer in each box.

3. Check and change the data periodically as needed.

The Info pane lists:

l System Owner information

l Name

l Address

l Phone

l Email address

l Dealer information

l Name

l Address

l Phone

l Email address
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l Primary Contact

l Lead Installer

l Original Install Date

l Date of Last Update

l Installation Notes—Use the Notes box to add any relevant details about a
particular installation.

Connections view

Use the Connections view to define to the Control4 system the physical connections and addresses of each
device added to the Control4 system. The connections are added automatically when you add the device, but
you need to connect each device to other devices in the system. See the Composer Pro User Guide for
details.

To access the Connections view:

1. Click Connections at the bottom of the left pane (see orange highlight).

The Connections pane (left side) has two tabs:

l Control/AV—Lets you define control and audio or video connections.

l Network—Lets you identify devices with their IP address or network name.

The Control & Audio Video Connections pane has three categories and several columns:

l Categories:

l Audio/Video Inputs

l Control Inputs

l Room Control
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l Columns:

l Name—The name of the connection

l Type—The connection category, for example, Audio or RoomControl

l Connection—The connection type, for example, HDMI or Component.

l Input/Output—Shows whether the connection is for input or output.

l Connected To—Shows which device this connection is connected to.

The bottom pane has several columns:

l Device—The name of the device.

l Name—The name of the connection on the device.

l Location—The room where the device is located in the project tree.

l Connections—Lists the devices connected to this connection.

Control/AV tab

Use the Control/AV tab in the Connections view to define the physical connections between the Control4
controller and other devices you add to the Control4 system, including AV signals, IRs, relays, contacts,
and/or serial connections.

To access the Control/AV tab:

1. Click Connections at the bottom of the left pane.

2. In the Connections pane, click the Control/AV tab.
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The Control/AV tab contains two panes:
l The left pane displays the project tree.

l The right pane lists the actual device connections.

3. If you click an object in the project tree of the Control/AV tab, you are selecting either a room or a device to
display the following types of connections in the Control & Audio Video Connections pane:

l Room Connections—Lets you define the connections specific to the room which
can include, for example, a thermostat that you can control from a touch screen,
Control4 app, or on-screen Navigator. Room connections help you customize and
design the devices to perform specific functions in the room. 

If you select a room (for example, Family) on the Control/AV tab, the available room
connections appear in the pane under Family (the bar just below Control & Audio Video
Connections). The Video, Audio, or Video’s Audio End-Points and the Audio or Video
Volume are all defined for the room. 
l Control & Audio Video Connections—If you select a device in the Connections >
Control/AV tab, the available Control & Audio Video Connections pane displays the
following panes: 

l Available inputs and outputs—The top pane identifies the available inputs and
outputs of a device to make its connections.

l Connected items—When you select an item in the top pane, the bottom pane
displays the available connections for that input or output.

4. To make the actual connection, select the item in the top pane, and drag it to the associated item in the
bottom pane.

Note: If you select a device on the project tree and nothing appears, the device doesn’t
have any control or AV connections; maybe it uses the network connection to
communicate to the controller. In these cases, use the Network tab to identify this
device’s network address to the system. See “Network Tab” below. 

The available input and output categories for the selected device display in this order:

l Audio/Video Inputs—Shows the available audio and video inputs. In this category,
the video connections are listed first, and then the audio connections.

l Audio/Video Outputs—Shows the available audio and video outputs. In this
category, the video connections are listed first, and then the audio connections.

l Control Inputs—Shows the available input control connection.

l Control Outputs—Shows the available output control connection.

l Room Control—Lists the available room control connections.
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If the connections you need do not appear, you can edit the driver to create the needed connections.
From the Driver menu (in the Composer menu bar), select Edit Existing Driver to open the Driver Wizard. 

Note: Editing drivers is an advanced task and is out of the scope of this document.
Details about the Driver Wizard are discussed in the Composer Pro User Guide or
you can use the Driver Editor. Talk to your Control4 Sales Representative to find
out how to order this tool.

Network tab

Use the Network tab in the Connections view to display a list of all devices in the
system that have a network connection and use a network address. Click the
Identify button (for releases older than OS 2.2 or to re-identify a device) to
establish the network connection for any device that communicates to the
controller using TCP/IP, Wi-Fi, Zigbee, or any other device that uses a network
address.

To access the Network tab:

1. Click Connections at the bottom of the System Design pane.

2. In the Connections pane, click the Network tab. The Network tab displays the network type, for example, IP
Network, along with the

l IP Network Connections pane, and the

l Available Devices pane.

The IP Network Connections pane lists all devices for the selected network type. After identifying the
network connection, the device’s address appears in the IP Network Connections pane under Address.

l Buttons

l Identify—Select a device from the IP Network Connections pane and click
Identify to have Composer identify the device. This causes Director to listen
on the network for the device to broadcast its network address, Zigbee
address, or network name. Once Director is waiting for the device to identify
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itself, you must cause the device to broadcast its address on the network. The
Identify window gives a description on how to make a device identify itself.

l Disconnect—Select the device, and then click Disconnect to remove the
connection.

l Disconnect All—Click Disconnect All to remove all of the connections.

l Columns

l Device—The name of the device.

l Room—The room in which the device resides.

l Type—The device type recognized by the system.

l Address Type—The type of address used, for example, Zigbee.

l Address—The deviceaddress.

After identifying the network connection, the device address appears. If a device does not have an address
next to it, it needs to be identified to the system.

The Available Devices pane shows the list of devices that the network has discovered. Each device shows up
under the service type. It also displays the total number of devices found and the number of connected or
unconnected devices of each type. 

Tip: Throughout the Control4 system, devices are identified using various
types of addresses, for example, Zigbee, Zigbee Pro, IP, UDP, etc. These types
of addresses are known as “network addresses.”

Media view

Use the Media view to select the stored or broadcast media on touch screens, Control4 apps, and on-screen
Navigators. The Media view lets you add media selections to the Control4 system: stored music and media
collections from a network-attached storage device (NAS) or other devices, for example, a Dock for iPod, DVD
player or disc changer, broadcasts, channels, and stations. 

To view and select the media from the Navigators, you first need to add and scan the media to the Control4
controller (for example, an EA-3 controller). With MP3, WMA, FLAC, or AAC files that you add and scan, you
can create playlists saved to the controller (if it has a hard drive) in the media database. See the Composer
Pro User Guide for details. 

Other Media Managers: You can use other media managers, for example, iTunes, Windows Media Player,
and Media Monkey to stream MP3s, WMAs, or MP4s. And your customers can use Composer Media Edition
(Composer ME) or Composer Home Edition (Composer HE) to add media files to Control4. 
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To access the Media view:

1. Click Media at the bottom of the System Design pane.

2. In the Media pane, view the media devices. In the Media view, the left-side selections change the right-side
views.

The system can access and use several types of media and supports various Media Scanning options:

l Stored media (e.g., DVDs) includes the possible media types that store media:

l Controller—Lets you store MP3s, WMAs, or MP4s in the digital audio database of
the controller (if you have a controller with a hard drive).

l CD—Lets you store CD cover art, albums, artist ratings, and genre (Rock, Jazz,
Country, etc.).

l DVD Player or Disc Changer—Lets you store DVD and CD (when DVD supports
CD) selections by viewing cover art, title, info, results, media, and disc list.

l MP3s on Digital Audio Player—Lets you store MP3 — HDD music cover art,
album, artist rating, and genre (Rock, Jazz, Country, etc.).

l External or Network File Storage Devices—Lets you store MP3, WMA, MP4,
FLAC, or AAC formats on an external hard drive, USB drive, or server.

l Screen Saver—Lets you store the custom images to be used as screen savers on the
Navigators.

l Internet radio—Lets you assign a particular Internet radio station with cover art.
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l Broadcast media (for example, Cable/Satellite) includes the possible media types:

l Direct TV—Lets you view DIRECTV channel options, including station ID, genre,
rating and music channel.

l Dish Network—Lets you view Dish Network channel options, including station ID,
genre, rating, and music channel.

l Cable TV—Lets you view Cable channel options, including station ID, genre,
rating, and music channel.

l UHF/VHF—Lets you view the UHF channel options, including station ID, genre,
rating, and HDTV.

l AM/FM/XM—Lets you scan AM, FM, and XM radio stations.

l Playlists includes the possible media types:

l MP3 on Digital Audio Player—Lets you play and view MP3 or MP4 — HDD
music cover art, album, artist rating, and genre (Rock, Jazz, Country, etc.).

l CD—Lets you play and view CD cover art, albums, the artist ratings, and genre
(Rock, Jazz, Country, etc.).

l Controller—Lets you play MP3, WMA, MP4, FLAC, or AAC formats from the
controller (if supported).

l External or Network File Storage Devices—Lets you play MP3, WMA, MP4,
FLAC, or AAC formats from an external hard drive, USB drive, or server.

l DVD Player or Disc Changer—Lets you play DVD and CD (when DVD supports
CD) selections and view cover art, title, info, results, media, and disc list. 

Possible buttons

One or more of these buttons may appear in the center pane depending on
which category you select:

l Edit—Lets you edit the information for an existing album or movie.

l New—A dialog box opens. You can add information for a new album or
movie, etc.

l Delete—Lets you remove an existing item from the list.

l Add—Lets you add media to your system, for example, MP3, WMA, MP4,
FLAC, or AAC files.

l Scan—Lets you scan the selected media type or storage location for music or
media information

l Configure—Lets you select the storage device on which the media you're
configuring resides.
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Right-click options

Right-click on a device in Storedmedia or Broadcastmedia to bring up various
options:

l Clear Media List—Use Clear Media List with caution because it clears all
media from the device—and for a controller, you will have to start over by
adding each album again.

l Export Media List and Export Playlists—Lets you save an XML file of your
lists; if you ever clear your project you won't have to rebuild the lists.

l Import Media List and Import Playlists—Lets you recover your media lists
after you've cleared your project.

l Import DVD List from File—Lets you import an Excel list of DVD titles for a
Disc Changer.

l New Playlist—Lets you create a playlist which appears in the Playlists type.

l Delete Playlist—Lets you delete an existing playlist.

l Rename Playlist—Lets you rename an existing playlist.

Right-click on Playlists to display New Playlist.

Right-click on a playlist name to display these options:

l Export Playlists

l Import Playlists

l New Playlist

l Delete Playlist

l Rename Playlist

Right-click on the individual songs in the window below the albums to edit song
information or delete individual songs.

Agents view

Use the Agents view to performmore complex programming by module. 

Note: See Programming with agents for help configuring and using these
agents.
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To access the Agents view:

1. Click Agents at the bottom of the System Design pane.

2. In the Agents pane, view the list of agents and their variables. 

Available agents include:

l Access

l Advanced Lighting Scenes

l Announcements

l Backup

l Communication

l Custom Buttons

l Email Notification

l Guest Services

l History

l Identity

l Light Properties

l Lighting Scenes

l Macros
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l Media Scenes

l Media Sessions

l Navigator

l Push Notification

l Scheduler

l Screen Saver

l Timer

l Variables

l UI Configuration

l Wakeup/Goodnight

Example: The Scheduler agent lets you program using dates and times. See Using
the Scheduler agent for examples. 

Common buttons available on some agents in the Agents view:

l Add—Lets you add agents to your system.

l Remove—Lets you remove agents from your system.

l New—Lets you create a new instance for customizing the selected agent in
the Agents pane. For each specific instance of the agent, you provide a
unique name and customize it according to your needs.

l Delete—Lets you remove an existing instance of the selected agent in the
Agents pane.

l Save—Lets you save the agent-specific information. Not all agents require a
manual save option. In most cases, the agent information saves
automatically.

Programming view

Use the Programming view to have the Control4 system control devices by identifying to the system any
device behavior or configuration options that you want to occur automatically. The Programming view lets you
create a program script using the drag-and-drop method. 

Note: Programming is an advanced feature in Composer Pro. Detailed
information about programming is explained in the Composer Pro User
Guide. This section discusses some basics. 

All programming is based on events in the Control4 system. For example, a door that opens is an event. When
an event occurs in the system, it can trigger other programmed actions to run.
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Example: When the Bathroom door opens (event occurs), program the
Bathroom light to turn on (action taken).

Another example is shown in the figure below. Note the text in the Script pane (center pane). The event is
“When the Family > Left Dimmer top button is pushed,” and the action is “Open the Garage > Garage Door
(Sensor).” The event came from the Events pane, and the action came from the Actions pane. 

To access the Programming view:

1. Click Programming at the bottom of the System Design pane.

2. In the Programming pane, view the list of Device Events (see below) and events for the object selected.

The Programming view consists of several panes:

l Programming:

l Device Events (left pane)—Displays all devices that have associated events in the
project tree.

l <Device> or <Room> Events (left pane)—Displays the available events for the
currently selected device or room in the Device Events project tree. If there are no
events for that device or room, none are displayed.

l Script (center pane)—Displays the script associated with the currently-selected
event from the Device Events pane. You drag-and-drop an action from the <Project
Title> Actions pane to arrange the order of actions and nest them in the Script pane.

l Actions:
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l Device Actions (right pane)—Displays all available device options with associated
actions you can use to write your script.

l <Project Title> Actions (right pane)—Displays the Command, Conditionals, and
Loops tabs. You move commands, conditionals, and loops into the Script pane from
this pane.

To add an action to the script:

1. Select the device in the Device Action project tree (right pane).

2. Select the type of action you want in the Actions pane.

3. Click the green arrow.

4. Drag and drop the action to the Script pane.

l Commands tab—Use this tab to select commands (delete, add, etc.) to use for your
script.

l Conditionals tab—Use this tab to select conditionals ('if' statements) to use for
your script.

l Loops tab—Use this tab to select loops ('while' statements, etc.) to use for your
script.

Composer Pro menu options

When you start Composer Pro and connect to Director, the menu bar appears at the top of the Composer
screen. 

The menu bar provides the following menu items:

l File—Lets you perform typical file management tasks, clear or load projects,
connect or disconnect to the local Director, update both the Composer and
Navigator software, and exit Composer.

l Media—(only appears when the Media view is selected)—Lets you perform
tasks regarding music and media lists.

l Driver—Lets you create, copy, edit, add, or manage drivers to enable devices
to work on the system.

l Go—Lets you access the various Composer Pro views, including System
Design (Ctrl+1), Connections (Ctrl+2), Media (Ctrl+3), Agents (Ctrl+4), and
Programming (Ctrl+5).

l Tools—Lets you view Network Tools, System Manager, Zigbee Health, Device
Logs, Detective Suite, Reports (if installed), System Diagnostics, Account
Services, and Update Manager.

l Feedback—Leave feedback for Composer or Driver Suggestions.
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l Help—Lets you view this document in help form plus version information.

File menu

Access the Filemenu from the menu bar on any Composer screen. 

From the Filemenu, you can perform project file management tasks: 
l Manage the project (clear, load, back up, etc.).

l Manage cloud backups.

l Connect to Director.

l Refresh Composer Pro.

l Refresh the Navigators: touch screens, Control4 apps, or on-screen Navigator. 

l Validate Project

The file management options apply to the files you back up on your computer called project files (project name
plus a .c4p extension). Project files are saved by default to the My Documents directory under
Control4/Projects.

When you set up a Control4 system, you create project configuration information. This information is created
live on the controller hardware, or backed up to a project file on a computer that lets you save specific
information about each system, including devices, connections, configuration, programming information, and
media. The project configuration is automatically stored on the controller hardware to which you are
connected from your computer.

Backing up the project lets you save a copy of the project on your computer which is always recommended
whenever you make changes in Composer Pro or update the system. 

The following options are available:

l Clear Project—Removes any project configuration from the hard drive on the
controller. Composer Pro prompts you for a backup before erasing the
project configuration information to present a blank project. Use this option
with caution.
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l Load Project—Loads a selected project into the currently-connected
controller. Composer Pro prompts you for a backup before it clears the
project configuration information, and replaces it with a selected project you
can browse to and load.

l Cloud Management—Manage online backups saved from the registered
system. You can load a cloud project to the controller, delete a cloud project,
add a project to the cloud, show a history of cloud backups for this project,
and save a cloud project to your local computer.

l Backup to Cloud—Creates a backup of the project and saves it to Control4
online services. Requires a valid 4Sight subscription.

l Connect to Director—Connects you to a Director residing on the controller.
When you connect, project configuration information from the controller is
presented to the screen in Composer Pro.

l Disconnect from Director—Disconnects you from a Director. Composer
prompts you to back up your project before disconnecting you from the
currently-connected Director. This option is available when connected to a
Director.

l Back up—Backs up the current project to your computer. The first time you
back up your project, Composer prompts you for a filename. It also prompts
you to back up any media information. If you select this option, the current
project becomes an option in the File > Load Project list.

l Back up As—Backs up the current project, and prompts you to enter the
name of the file. It also prompts you to back up any media information. If you
select this option, the current project becomes an option in the File > Load
Project list.

l Refresh—Refreshes the current Composer Pro project.

l Refresh Navigators—Refreshes the Navigators connected to the system.
Note: Control4 for PCs and tablets must be updated in that app. Control4 for
iPhone, iPod touch, iPads, and Androids will update if online.

l Validate Project—Performs a check for project file integrity.

Media menu

Access theMediamenu from the menu bar in theMedia view.

Note: The Media menu becomes available when the Media tab is selected (on the
left menu).
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From the Media menu, you can create, delete, and rename playlists. You can also clear, export, and import
media lists. A Media List is the list of media information associated with the selected device, for example, all
DVDs with associated cover art, title, notes, etc., for each DVD in a disc changer. 

The media has been scanned or manually added to the media database. After you add an item to the media
database, the cover art and information about the media can be viewed and selected from any of the
Navigators (touch screens, Control4 apps, and on-screen navigators, etc.). 

The following options are available:
l Clear Media List—Clears the media list of the selected device from the media
database.

l Export Media List—Exports a media list for the selected device from the
controller to a PC.

l Import Media List—Imports a media list from the PC to the controller.

l Export Playlists—Exports a playlist from a controller to a PC.

l Import Playlists—Imports a playlist from the PC to a controller.

l Import DVD List from File—Imports an Excel list of DVD titles for a Disc
Changer.

l New Playlist—Creates a new playlist from a controller to a PC.

l Delete Playlist—Removes a playlist.

l Rename Playlist—Renames a playlist.

l Tag media files—Used for OS 2.0 or later conversion of media files so all
media players can see the same tags.

Driver menu

Access the Drivermenu from the menu bar on any Composer Pro screen.

Note: You may prefer to use the new Driver Editor tool released in 2012. Check
with your Control4 Sales Representative for details. 
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From the Driver menu, you can create, copy, or edit drivers. You can also manage the local database of
drivers and add other drivers from the online database as needed. 

Note: Creating a new device driver is an advanced procedure. See "Creating
device drivers" in the Composer Pro User Guide for details.

The following options are available:

l Create New Driver—Launches the Driver Wizard and lets you create a new
driver based on the typical features of a particular device type, such as DVD
players, and TVs. See “Create, copy, and edit drivers with Driver Wizard.”

l Copy Existing Driver—Launches the Driver Wizard and lets you copy an
existing driver model. For example, if a driver exists for a device from a
particular manufacturer, but it isn’t the same model, you can modify the
driver for the model you need. See “Create, copy, and edit drivers with Driver
Wizard.”

l Edit Existing Driver—Launches the Driver Wizard and lets you modify an
existing driver. This is mostly for testing purposes. After you create a driver,
you can test the driver by adding it to the Control4 system to see if it
functions correctly. The Edit feature allows you to make modifications when
necessary. See “Create, copy, and edit drivers with Driver Wizard.”

l Add Driver—Lets you search the local database to add a .c4i driver if it
doesn't exist in the project. Director will load the new driver, but you will have
to add the driver to the project. You can use Update Driver to replace an
existing one. This option is used mostly with DriverWorks. See Composer Pro
User Guide for details.

l Manage Drivers—Lets you manage drivers in your local database and the
drivers on the My Drivers tab. See “Manage Drivers dialog.”

Tip: You can also right-click the driver in the project tree to: Rename, Edit
Driver, Export Driver, Update Driver, or Delete a driver. For OS 2.0 or later, use
the same procedure for Update Driver as with Add Driver (see above).
However, Update Driver updates your driver if it IS in your project. Note: If the
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driver connection IDs change, the driver will need to be connected again.
Double-check your connections after you update your driver.

Manage Drivers dialog

Access theManage Drivers dialog from the Driver >Manage Driversmenu item
on any Composer Pro screen.

From the Manage Drivers dialog, you can organize the device drivers (or drivers) in your local database. You
can sort by Device Type, Name, Manufacturer, Model, Driver Status, Creator, Created Date, and Modified
Date. 

Buttons
l Add—Lets you add drivers from the Control4 online database to the local
driver database (Local Database). When the dialog appears, from the pull-
down menus, select the Device Type andManufacturer of the device you
want to download, and then click Search. Check the driver you want to add
to the local driver database, and click OK. This adds the device driver to your
local database.

l Delete—Lets you delete a driver from the local driver database.

l My Drivers—Lets you add the selected driver to theMy Drivers list. In the
Manage Drivers dialog, you select a device or use the Shift (to add multiple
drivers) or Ctrl keys (to add multiple drivers all in a row).

l Notes—Lets you add notes about your drivers.

l Exit—Lets you exit the Manage Drivers dialog. 

Other options
l Sort—Lets you sort and find drivers by column and by Device Type, Name,
Manufacturer, Model, Creator, Created Date, andModified Date. Click the
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top of each column to sort accordingly. Click on the column head to sort the
column.

Create, copy, and edit drivers with Driver Wizard

To enhance device support in Composer Pro and in the Control4 system, a device
needs a corresponding driver, known as a device driver. 

If you want to add a device to the Control4 system, and it does not have a
supporting driver (or one that you can find in the online database), you can use
the built-in Driver Wizard in Composer Pro to create a driver prior to setting up
the device.

You can access the wizard from the Drivermenu > Create New Driver.

The Driver Wizard lets you add device support to the system for infrared (IR) or serial drivers. 

For more information and example implementations, see “Overview of creating device drivers” and “Using the
Driver Wizard” in the Composer Pro User Guide.

Go menu

Access the Gomenu from the menu bar on any Composer Pro screen.
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From the Go menu, you can access the various Composer Pro views: System Design (Ctrl+1), Connections
(Ctrl+2), Media (Ctrl+3), Agents (Ctrl+4), and Programming (Ctrl+5). This is an alternative to using the buttons
(left side at the bottom).

The following options are available:

l System Design—Lets you build the project tree and identify the devices in
the Control4 system. Access this view with the keyboard shortcut Ctrl+1.

l Connections—Lets you identify all connections (Room, Control, AV, Network).
Access this view with the keyboard shortcut Ctrl+2.

l Media—Lets you add and scan stored or broadcast media. Access this view
with the keyboard shortcut Ctrl+3.

l Agents—Lets you set up agents for use on the system and programming.
Agents include: Lighting Scenes, Wakeup, Scheduler, Variables, etc. Access
this view with the keyboard shortcut Ctrl+4.

l Programming—Lets you program devices and agents on the system. Access
this view with the keyboard shortcut Ctrl+5.

Tools menu

Access the Tools menu from the menu bar on any Composer Pro screen.

From the Tools menu, you can access tools for checking the device connection status.

The following options are available:

l System Manager—Launches a tool to connect to and configure Control4
Controller hardware and devices. See “ System Manager.”

l Zigbee Health—Open the Zigbee Health diagnostic view. See"Zigbee Health."
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l Detective Suite—Launches a suite of diagnostic tools: Bindings, Discovery,
Performance, Programming, and Zigbee.

l Network Tools—Launches the Connections > Network view. Composer
shows the status of all network devices on the IP Network and Zigbee
Network. The Network view shows you which devices in your project are
identified and communicating to the network.

l Reports—Lets you select one of the Centralized Lighting reports to run: Panel
Report, Module Report, or Load Schedule Report. See “Reports” in the
Composer Pro User Guide for details.

l Device Logs—Download a snapshot of device logs from controllers,
touchscreens, or Triad One streaming amplifiers.

l System Diagnostics—Assists you in gathering system information to help
you determine if any issues encountered are configuration problems,
performance issues, or potential defects. The System Diagnostics tool is
valuable also for logging information and sending email to Control4
Technical Support. See “System Diagnostics.”

l Account Services—Facilitates system registration which is required for
software updates and to use the media services throughout the Control4
system. It is also required in conjunction with a customer account to enable
Remote Access, which allows secure access to your system via the Internet.
See “Account Services.”

Network Tools

The Network Toolsmenu option shows the Connections > Network view which
offers network information on IP and Zigbee devices.

From the Tools menu, select Network Tools. 

The Network tabs describe the following:
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l IP Network—Lists the devices on the IP network.

l Zigbee Network—Lists information about the Zigbee devices.
l Z-Wave Network—Lists information about the Z-Wave devices

The icons denote the following:
l Green—Indicates that an address is identified and the device is online. For
example, a dimmer is identified and communicating to the Control4 system.

l Yellow—Indicates that an address is identified and the device is offline. For
example, if the System Remote Control goes to sleep, the status turns yellow.
This indicates that the System Remote Control has been identified, but it is
offline.

l Red—Indicates that a device is not identified or has been offline for a long
period of time. In this case, go to the Connections view > Network tab and
identify the device to the system.

The Network Tools tabs are shown below.

IP Network tab

This shows the IP devices on the network, network addresses, and status.

Zigbee Network tab

This tab displays Zigbee devices, addresses, online states, and signal strengths

You can view the Zigbee network items two ways using these radio buttons:
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l Tree—Takes the devices that are in the project and lists them in a room tree
view.

l List—Takes the devices that are in the project and lists them in one list.

Detective Suite

Use the Detective Suite in Composer Pro to perform diagnostic tests on the
system.

From the Toolsmenu, select Detective Suite. The following window appears with
tabs for Connections and Programming.

Tab descriptions:
l Connections—Lists all the connections in the project. Lets you search by
keywords, and expand by room or the whole house. In the Connections tab, if
you right-click on an item, more menu options are available.

l Go To Device—Goes to the selected connection in the Connections view of
Composer.

l Expand All—Expands all the items and rooms in the list.
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l Collapse All—Collapses all the items and rooms in the list.
l Refresh—Refreshes the connections and rooms in the list.
l Disconnect—Disconnects the selected connection.

l Programming—Shows programming that has been created. Lets you search
by keywords, and expand by room or the whole house. Can expand the
events to include actions. In the Programming tab, if you right-click on an
item, more menu options are available.

l Go To Device—Goes to the selected event in the Programming view of
Composer.

l Expand All—Expands all the items and rooms in the list.
l Collapse All—Collapses all the items and rooms in the list.
l Collapse to Events—Collapses all the items and rooms in the list to only
show events with programming defined.

l Refresh—Refreshes the connections and rooms in the list.
l Remove—Removes the programming script items from the selected event.

System Diagnostics

From the Toolsmenu, click System Diagnostics. Use these screens to help you
diagnose system problems and activity.

l Controller Performance tab—Lets you view controller performance
information, including CPU and memory usage. Process data is listed in the
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bottom pane.

l History button—Lets you view the history of CPU and memory performance. 

l Controller Networking tab—Lets you view controller networking
information, including network type, connection status, MAC address, IP
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address, Subnet mask, Gateway, DHCP status, and DNS server information.

l Test Internet Connection button—Lets you test the current Internet
connection. After viewing, click Close to exit the dialog box.

l System Info tab—Lets you view system information in a tree view. Click Save
To File to save this information.
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l Logging tab—Lets you log system problems.

This logging feature lets you:

l Change the logging level of any of the program loggers on the operating
system. Select from fatal, error,warning, info, debug, trace, and default.
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l View the selected log in real time (“Tail”). To start the tail, select the log, then
click Start Tail. To stop the tail, click Stop Tail.

l Open the current log file of the selected program logger. To open the log,
select the logger, then click Open Log.

l View all the logs available on the device at that location.

l Click Auto Scroll Output to scroll through the log entries, or click Clear
Output to clear all entries.

Account Services

From the Toolsmenu, select Account Services to set up a customer.control4.com
account and register a controller, remove a controller from registration, or check
in for a service connection. To register the controller, see Registering the Control4
system.

You can also check the current account status and service level. Select the Status
tab. You can view:

l Account Status

l Customer Account

l Customer Email

l Service Level

l VPN Status

Update Manager

To continue to improve our products, periodically the Control4 team needs to develop updated versions of
Composer Pro and Director and provide those updates to you. Use Update Manager to update your
Composer software and the system.
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To update Director:

1. From the Tools menu, select Update Manager.

2. Click Update.

3. Click Begin Update. 

To update the system software:

1. Click Update to update the system. After you begin the updates, you cannot modify your project. Do not
remove any power cords or Ethernet cables until the updates are completed. You can have an email
message sent to you when the update completes to notify you when you can modify the project again. See
“Programming with agents” in the Composer Pro User Guide to set up notifications.

2. To view the project, you can close the Update Manager dialog without interrupting the update, but you
cannot make any changes.

3. Click View Logs in the Update Manager dialog to view the update messages.

4. Click Cancel Pending to cancel the device downloads. This action cancels a download from the device.

Note: You cannot cancel an update after the device download has finished and the
firmware update on the device has begun.

Feedback menu

From the Feedbackmenu, you can leave feedback, vote on feedback from others,
or view Top, Trending, or New feedback. Feedback is organized by Composer
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(suggestions related to features in Composer) and Drivers (suggestions related to
drivers and their documentation).

To use the Feedback menu:

1. Click on the Feedback menu and click on Composer or Driver Suggestions.

2. In the feedback window, you can create a post by adding a TITLE, DETAILS, and clicking on
CREATE POST. When a post is created, the feedback menu automatically searches for feedback that is
already posted, and rather than create a new post, recommends you add a vote to an existing post and add
comments.

3. You can show existing Feedback by Trending posts, posts with the most votes, or newest posts.

4. You can search for feedback by using the search window. Votes can be added to existing feedback by click
on the up arrow.

5. You can view the feedback detail by clicking on the feedback post. You can upvote the feedback on this page
and leave a comment..
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Help menu

From the Helpmenu, you can:
l Access the online Help topics, Index, and Search function for this Composer
Pro Getting Started.

l Access a PDF of the Composer Pro User Guide. Note: Use the links in the
Composer Pro Getting Started help topics to access the PDF for the
Composer Pro User Guide.

l Check the Composer Pro and Director versions.

l Contact Control4 Technical Support.

The following options are available:
l What's New—Opens a link to the What's New section in this document.

l Chat with Support—Opens a link to contact Chat Support.
l Getting Started Guide—Displays this Getting Started Guide.

l User Guide—Opens a link to the Composer Pro User Guide.

l Documentation Library—Opens a link to the documentation library on the
Dealer Portal.

l Knowledgebase—Displays the Control4 Knowledgebase login. The
Knowledgebase contains documents, articles, and other sources for
reference.

l Change Logging—Displays the Composer Logging windows to change
Composer logging options.

l Reset Composer Layout—Resets saved Composer layout options. This can
be useful if a window or section of Composer is not displaying correctly.

l Check for Updates—Checks for available updates to Composer Pro. Select
the Check for version of Composer at startup option to have Composer
automatically check for updates.

l About Composer—Displays the Composer and Director versions.

Composer Pro Properties

Access the Properties panes from the System Design view.

There are three categories of properties in a Control4 system: Project, Room, and Device properties.
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l Project Properties

l Room Properties

l Device Properties

Accessing properties from the project tree

You can use the Control4 Composer Pro Properties pane to view:

l Devices

l Connections

l Status information

l Project or customer information

l Configuration information for devices and rooms

To access the Properties pane:

1. After adding the device and making the connections, select the device from the project
tree in the System Design view.

2. Click the Properties tab. The properties for the device appear in the Properties pane.

Properties pane

In the  System Design view, click the project name (top level name) in the project
tree to view the project Properties.
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The project Properties appear when you first start Composer Pro, or any time the
project name (or root node) is selected in the project tree and the System Design
view.

This option lets you enter project-specific information; for example, the project name, location, and ZIP Code.
Composer Pro automatically enters the latitude/longitude and date/time information when you provide the
location and ZIP Code.

Basic Composer Pro tasks

You can perform simple but important tasks in Control4 Composer Pro (see below), or you can take a deeper
dive into intermediate or more advanced tasks (the Composer Pro User Guide will show you how).

Accessing the List view from the project tree

Use the List View tab to view the devices in your project (by room). Ensure that
the devices are added and identified to the project.

To view the list:

1. Click System Design.
2. Select a room in the project tree.
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3. Click the List View tab; the status of each device associated with that room displays in
the List View pane.

Removing items from the project tree

Use the project tree in System Design to remove devices, rooms, buildings, etc.

To remove items from the project tree or other lists in a Composer project:

1. Right-click the item to remove in the project tree, and then select Delete.

2. Click Yes to confirm.

Clearing a project

To erase all project configuration information, use the Clear Projectmenu option.

Note: Control4 recommends that you create a backup file of your project first
before you use this function. To back up the project, go to the File menu, and
then select Back Up. Give the project a filename; the file saves to the My
Documents folder by default.

To clear out a project:

1. From the File menu, select Clear Project to erase the project configuration information.

Exiting Composer Pro

Use the Exit command to close Composer Pro.

To exit Composer:

1. From the File menu, select Exit.
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2. Composer asks you if you want to back up your configuration information.

Note: Control4 recommends that you always save a backup copy of your
configuration.

Getting project configuration information from a controller

Use the Connect to Director link to view configuration information.

To get existing project configuration data from a controller:

1. Verify that your PC and the controller are connected to the same network.
2. From the Composer Startup screen, click Local System or from menu bar, click File >

Connect to Director (see below). The project configuration appears unless it is a new
project.

Loading a project’s configuration from a computer to a controller

Use Connect to Director to load configuration information.

To load the project configuration from a computer to the controller hardware:

1. Verify that your PC and the controller are connected to the same network.
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2. From the startup screen, click Local System, or from menu bar, click File > Connect to Director (see below).

3. From the File menu, select Load Project.

4. Click Yes when prompted to back up the project. Browse and select the project file.

Example: SmithProject.c4p
5. When you see the new project displayed in the System Design view, the project is loaded to the controller,

and you are connected.

Backing up a Composer Pro project

Use the Filemenu to back up your project. Control4 recommends that you do this
whenever you change anything in a project or if you update the software.

The File menu in the Composer screens provides the following options for backups:
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l Back Up—Backs up the current project to your PC. The first time you back
up, it prompts you for a filename. It also prompts you to back up any media
information. If you select this option, the current project becomes an option
in the File > Load Project list.

l Back Up As—Backs up the current project, and prompts you to enter the
name of the file. It also prompts you to back up any media information. If you
select this option, the current project becomes an option in the File > Load
Project list.

Any time you exit Composer by clicking File > Exit, Composer Pro asks you if you want to back up your
project. If you've made changes, it's a good idea to do so.

Automatic Project Backups

The Backup Agent allows you to schedule backups on specific days and times. The last time a backup
occurred is displayed at the bottom of the window.

To configure the Backup Agent:

1. Open the Agents view and select Backup from the Agents pane.

2. Verify Schedule Backups is checked.

3. Select the data to be backed up.

4. Select the day(s) you want to have an automatic backup.

5. Set the time you want the backup to occur, then click Save.

Backing up and loading from a virtual to a local or remote Director

Use the Connect to Director option to back up a Director.

To back up and load configuration information from a virtual Director to a local Director:

1. From the Composer File menu, select Connect to Director.
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2. When prompted, click Yes or No if you want to back up the media information.

3. A Directors dialog box appears listing the available Director IP addresses. Select the address of the controller
to which you are connecting.

4. Click Connect. You are now connected to a local Director.

Backing up a project's configuration and media

Use Composer Pro to back up project information. When connected to the
controller, changes are immediate.

To save a project configuration to your computer, and then use the Back Up and Back Up As options:

1. From the File menu, select Back Up.

2. Type a filename to back up the project, or use the same name, if you prefer.

3. When prompted, click to select the options to back up media information and personal information, then click
Save.

Validating the project

Use Composer Pro to validate the integrity of the project file. You can validate a project while connected to a
Director or Virtual Director.

To check project integrity after connecting to Director (or Virtual Director):

1. From the File menu, click Validate Project. Composer displays any errors.
If no errors are found, nothing else will be displayed.
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Composer Pro Version Independence
With the release of Composer Pro 3.1, Composer Pro now connects to Director
running on the primary controller through a set of versioned APIs. The change
allows Composer Pro to connect to any controller running OS 3 or newer. But
most importantly, Composer Pro can now be released independently from
Control4 OS releases which clears the path to accelerated enhancements,
features, and fixes to Composer software.

Prior to this release, Composer Pro, Control4 OS updates, and Drivers and Agents
were all released at the same time. When a revision to one of these components
was published, they were all updated together. This was necessary because these
components communicated with each another through conventional Application
Programming Interfaces, or APIs. When any API was added, changed, removed,
or in some cases just used differently, all other components had to be revised to
match.  Here’s a simplified view of the prior relationships among these
components:

With the release of Composer Pro 3.1, communication between Composer Pro
and Drivers and Agents were made part of a versioned API. Now, new features
can be added to Composer software while still allowing Composer to
communicate to Drivers and Agents through a versioned API. 

Here’s what things look like now:

For systems running Control4 OS 3 or higher, versioned APIs between Composer
Pro and Drivers and Agents allow the two components to be version-
mismatched. In other words, Composer Pro is now version-independent of
Drivers and Agents, which in turn makes it version-independent of Director.

Note: While Composer Pro and Drivers and Agents communicate through a
versioned API, the OS’s built-in Drivers and Agents communicate with Director
through conventional APIs. This means that for the time being, Drivers and
Agents must continue to be version-matched with Director. APIs for Control4 and
3rd-party drivers that are based on the Driver Wizard or the DriverWorks SDK are
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independent of the OS version. Developers of drivers which use the DriverWorks
SDK APIs may designate a minimum-OS version.
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Connecting Composer Pro to a Virtual,
Local, or Remote System
Composer Pro gives users three connection options at startup.  The same three
options are presented after disconnecting:

Virtual System
Virtual System, also known as Virtual Director, is a software emulation of the
software that runs on the primary Control4 controller (Director). Selecting Virtual
System will connect Composer to a Virtual Director running on the same PC.
There’s no need to be connected to the local network (LAN) or to the internet to
establish this connection.

Local System
Selecting Local System allows Composer to connect to a Control4 controller
running Director on the same LAN as the host PC. Neither the PC running
Composer or the controller have to be connected to the internet to establish this
connection.

Remote System
Selecting Remote System allows Composer to connect to a Control4 controller
running Director—that is also registered to Control4 account—located on a
different LAN than the host PC. The PC running Composer and the controller
both need to be connected to the internet.
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Composer Pro makes new decisions
when connecting
When connecting Composer Pro to a Virtual, Local, or Remote System, Composer
Pro now connects through a set of versioned APIs, if applicable, and allows you to
manage those APIs when you connect.

Connecting to a Virtual System with versioned APIs
Each release of Composer Pro comes with the latest set of Drivers and Agents
and Virtual Director. Connecting to Virtual System is straightforward for any
version of Composer Pro, and as long as the user has not uninstalled its Drivers
and Agents, the matched set of components will always be available.

Connecting to a Local or Remote System with versioned
APIs
When connecting to a Local System or Remote System, the user must select the
controller on the LAN or WAN to connect to. The Connect to Project (formerly, the
Directors) screen presents a list of controllers to choose from, along with their IP
addresses and OS version numbers. 

In prior releases, if the user selected a controller with an incompatible version,
Composer would alert the user and then open the project in a read-only
“compatibility mode.” 

With Composer Pro 3.1, the following changes have been made to the way the
Connect To Project selection screen works:

1. If the major component of the OS version number (for example, the ‘3’ in
version number ‘3.1.0’) of the controller matches that of Composer Pro:

l If the minor and revision components of the version number also
match that of the Drivers and Agents installed on the PC,
Composer Pro will display “Ready to connect” in the Status column
for the controller, and a single action button labeled “Connect”: 
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l If the minor and revision components of the version number DO
NOT match that of the Drivers and Agents installed on the PC,
Composer Pro displays “Requires OS management package
[version#]” in the Status column, and a single action button labeled
“Install and Connect”.  If the PC is connected to the internet,
Composer Pro will download and install the correct drivers before
connecting to this instance of Director. If the PC is not connected
to the internet, Composer Pro will use the OS management
package that matches itself and connect to the project in
compatibility mode.

2. If the major component of the version number (for example, the ‘2’ in the OS
version number ‘2.10.0’) of the controller DOES NOT MATCH that of
Composer Pro (for example, ‘3.1.0’), Composer Pro displays “Ready to connect
to view or update” in the Status column. Composer Pro displays an action button
labeled “Connect”, which when clicked, connects to the project in compatibility
mode. In addition,
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l If version 2.10.0 of Composer Pro is already installed on the PC,
Composer Pro displays an additional action button, “Launch and
Connect Composer 2.10.0”, which launches Composer 2.10.0 and
connects to the project in full access mode.

l If version 2.10.0 of Composer Pro is NOT installed on the PC,
Composer Pro displays an additional action button, “Install and
Connect Composer 2.10.0”, which downloads and installs Composer
2.10.0 before launching it and connecting to the project in full
access mode.
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Connecting to a Director
Each Control4 controller (for example, an EA-3) ships with pre-installed Director
software. The Director communicates with Control4 and third-party products to
enable home automation so devices can communicate with each other and
Director.
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Connecting Composer Pro to a Virtual,
Local, or Remote System
Composer Pro gives users three connection options at startup.  The same three
options are presented after disconnecting:

Virtual System
Virtual System, also known as Virtual Director, is a software emulation of the
software that runs on the primary Control4 controller (Director). Selecting Virtual
System will connect Composer to a Virtual Director running on the same PC.
There’s no need to be connected to the local network (LAN) or to the internet to
establish this connection.

Local System
Selecting Local System allows Composer to connect to a Control4 controller
running Director on the same LAN as the host PC. Neither the PC running
Composer or the controller have to be connected to the internet to establish this
connection.

Remote System
Selecting Remote System allows Composer to connect to a Control4 controller
running Director—that is also registered to Control4 account—located on a
different LAN than the host PC. The PC running Composer and the controller
both need to be connected to the internet.
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Connecting to a virtual system
If you connect to a virtual Director, you are working in Virtual Director mode. This
means you are not connected to the Control4 controller and the home network,
and changes are not automatically saved in real time to the Control4 controller.

Saving changes when working virtually
The only way your changes are saved is to manually use the Back Up As or Back Up option from the File
menu to save the project file. The project file saves by default with a .c4p extension to your My Documents
directory on your computer.

Using Virtual mode
After you have designed and set up a system in Virtual Director mode, you can load the project to the
controller.

The Load Project option is available from the File menu. This mode is useful, for example, if you are using a
laptop PC, and you can't connect to the network.

l If you change the project, you can connect to the network and synchronize
your changes to the controller when you're ready.

l If you design and set up a system in Virtual Director mode, you can later load
the project to the controller. In the Filemenu, the Load Project option is
available for synchronization.

To connect to a virtual Director:

1. Start Composer and connect to a Director.

2. At the Composer Startup screen, click Virtual System. Virtual Director lets you work in Composer while
disconnected from a Director. Composer opens to the main Composer view in Virtual Mode.
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The System Design view appears by default.

Connecting to a Director on a local network
When you connect to a Local Director, you are making 'live' changes on the controller. Every time you connect
to the Director on that controller, your project opens.

Tip: You also have the option to make a backup of the project on your
computer by using the Back Up As or Back Up option from the File menu to
save the project file. When you back up a project file, it is backed up by default
to the My Documents directory on your computer.

To connect to a Director locally:

1. From the desktop, double-click the Composer 3.0 icon.

2. At the Composer startup screen, click Local System. Local Director connects you to the home network while
working in Composer Pro.

3. From the Director dialog box, select the Director’s network address for the controller you are setting up, and
then click Connect.
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4. Make a note of the network’s IP address. Composer Pro opens to the Composer System Design view.

Setting up Remote Access
Use a Control4 Navigator to enable or disable Remote Access. This feature lets
you access your Control4 system for updates using the Internet from a remote
location. Note: You can also set up Remote Access when you create an account at
customer.control4.com.

Prerequisites
l Register the system at customer.control4.com. This process can be
completed by the installer or homeowner as long as the system a Navigator,
touch screen or on-screen configured in the system.

To set up Remote Access for OS 2.6 or later:

1. At one of the touch screens or on-screen Navigators, select Settings > Service Connection.

2. Select Yes under Remote Service.

Notes:

After you enable remote access, if the user has a 4Sight subscription for this
system, then the user can enter their email address and password and
securely log in to their Control4 home network from any Internet connection
in the world.

When the user logs in, the homeowner can use the Web Navigator to monitor
and control their lights, change their temperature (warm or cool the home
remotely), or check whether any doors or windows were left open. You or the
user can refer to this Internet information in the Control4 System User Guide.

If this system and controller are registered on customer.control4.com, the
system is accessible for remote access (without a 4Sight subscription) after a
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request by the Control4 Installer or Control4 Technical Support representative
has been made to access the system. After OS 2.4.0, this check-in is no longer
required to initiate a remote service connection.

Connecting to a Director using Remote Access
If you connect to a Remote System, you are making “live” changes to a remote
system controller, where changes are communicated over an Internet connection
rather than a local network connection. This type of connection is not available,
however, until the initial configuration and registration are completed. 

Note: The customer may revoke access rights through my.control.com at any
time, but this is not recommended as it interferes with routine Control4
updates.

Requirements
l The customer must be registered at customer.control4.com and remote
access must be enabled. (See “Registering the Control4 system” or “ Register
the controller from a Navigator.”)

l A PC with Composer initially installed must be in the same local network as
the controller when remote access is set up.

Before you can use the Remote System option, you must configure the system to support remote access (see
“Registering the Control4 system”).

Connecting using Remote Access

To connect to a Remote Director:

1. Using a PC with Composer Pro installed, verify that the PC has an Internet connection.

2. From the desktop, start Composer.

3. At the Composer startup screen, click Remote System. Remote Director connects you to the home network
while working in Composer from a remote location. 

4. Enter your Email Address and Password in the Account Name dialog box. This should be the login
information from your account on your dealer my.control4.com account.

5. When the Select Remote Account dialog box appears, select the account you want to access, and click
Connect.
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If the account name doesn't appear under Name, click Add to add the account name, and Username
(Email address) and Password if they are different from your dealer account login credentials, and click
OK in the dialog box that appears. This is the Account Name you created during registration at
customer.control4.com. After you do this, select the account from the Select remote account dialog box,
and click Connect.

The next screen shows that your account, the User Email Address, and the Password are being verified.
This may take several minutes to complete as it is accesses a remote connection.

When authenticated and connected through the Remote Access service, a list of Directors available for
connection appears.

6. Select the Director you want to connect to, and then click Connect.

When connected, Composer opens and the main Composer view connects to the controller remotely.
Composer functions normally as if you were connected to Local Director, allowing you to configure, program,
and troubleshoot the Control4 system.
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Ensuring that Director and Composer are
compatible
Verify that the Control4 controller software (Director) and the Composer software are on the same version
before beginning to design a project, or any time you use Composer to ensure the best communication
between the two.

To check compatibility:

1. In the Composer menu bar, click Help > About Composer. 

2. From the dialog that appears, compare the Composer and Director version numbers. For the Control4
system to run properly, these numbers must match. If they don't match, update Composer and/or Director to
get to the same version. See the Composer Pro User Guide for information about updating your system, or
see “Update Manager.”

Example:
Composer version: 3.0.0.562742

Director version: 3.0.0.562742

Note that the two versions in the screen below are the same.

System Compatibility Check
When connecting to a system, Composer Pro performs a capability check to ensure that the Composer
version and OS version are compatible. Use the System Compatibility Check to review which version of
Composer must be used to modify your system.

System Compatibility Check
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Designing the Control4 system
Become familiar with the Control4 Composer Pro design options before you start to build your first project and
project tree. The project tree represents the hierarchy of locations (sites, buildings, floors, and rooms) AND
devices in each room. You will add all types of controllable devices to the Control4 system, including
audio/video, multi-room audio, lighting, motorization, sensors, relays, and more.

Here are some sections that might interest you as you prepare to design a
system:

l “Introduction to Designing a Control4 System”

l “Ways to Create a Project in Composer”

l “Purpose of Device Drivers”

l “Adding Items to the Project Tree”

l “Using Composer Views to Build a Project”

In most cases, it’s good to make a list of the actual devices to be used in the project, the manufacturer and the
model number. You will need this information as you build the project. Also, before you start, create a plan for
your project.

Tip: It might be worth your while to check out some cool project management
programs called "Smart Office" and "Control Integration" by Simply Reliable.
These products help you manage your projects, from creating home
automation proposals to integration of devices, into a Composer project.
There's also a service called Blackwire Designs (blackwiredesigns.com) that
can help with design and networking infrastructure.

Introduction
Designing a Control4 system in Composer Pro is similar to designing a house. You
start with the plan; then you build the foundation; you build the framework; and
then you add the electrical, plumbing, walls, carpets, paint, etc. to finish the home.

To give you a 'bird's eye view' about how to design and implement a Control4
system:

l Create a plan. This includes the devices to be used, where they will reside in
the home, and how the network will be set up. For example, to plan a
Centralized Lighting project, you’ll need to obtain the blueprint plan and
where all of the lighting devices and panels will be located in the home,
ensure that all of the lighting legs are clearly identified, determine what types
of loads will be controlled by the centralized system, and where the panels
will be located (see Control4 University on control4.com for more
information).

l Physically install and connect the Control4 and third-party devices that need
to communicate to the network. Note: Many Control4 or third-party devices
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may be installed already.

l Physically connect these devices to each other and to the controller(s) used in
the project so they all communicate with the controller and the home
network.

l In the Composer Pro software, build the project tree using the System Design
view. This includes adding objects to the project tree that represent the
physical buildings, rooms, and devices. Note: You can connect a physical
device, and then add it to Composer one at a time if you prefer.

l In Composer Pro, identify and virtually connect all of the devices. In addition
to the hardware connections, you have to connect your devices the same way
in the Composer software also.

l Customize the behavior of the devices in Composer and on the Navigators. To
customize the devices for specific functions, you program events and actions,
Lighting Scenes, agents, and so on for your customers' needs. Many custom
functions can be performed on the touch screens and on-screen Navigators.
See the Control4 System User Guide and Control4 Quick Start Guide for more
information.

Designing a fully functioning Control4 system includes these major steps:

l Use Existing or Custom Device Drivers. Every device in the Control4 system
needs a corresponding device driver so that controlling the device is possible.
When designing and implementing a Control4 system, each time you add a
device to a room, a corresponding device driver must be added to the
Composer project in the project tree. Device drivers for Control4 products
come pre-installed in Composer. In addition, device drivers for hundreds of
third-party devices are available through an online database, and easily can
be added to the project when the driver is available. If a driver for the model
you need does not exist, you can use the Driver Creation Wizard (available
through a menu option) or DriverWorks (a free add-on utility) to create a
custom driver. See the Composer Pro User Guide for details.

Tip: If you can't find the device driver you need, you can start with an existing
device driver, and modify it for your device using the Driver Creation Wizard or
Driver Editor. 

l Make the connections. In the Composer project, you identify all physical
device connections to the Control4 system, including control, AV (audio,
video), network, and other connections (there are several types of
connections). Identifying a device to the systemmeans the controller
acknowledges that the device exists on the home network and can
communicate with it and the other devices in the network. Use the
Connections view in Composer for this.
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l Register the system at customer.control4.com. Control4 strongly
recommends that you register each system you install at my.control4.com to
maintain the system software easily through online downloads. Only
registered systems can use all of the media services available. In addition,
system registration is one of the essential steps in enabling remote access to
the system.

l Set up the media. You identify existing media on the system using the Media
view in Composer. The Media view helps you search or scan for movies, videos
or music in stored media and auto-generate a list of local broadcast channels,
stations, playlists, etc. After you have searched for or scanned in the existing
media, you can test Media access through the navigation devices (also known
as Navigators).

l Configure the properties. You will want to set individual device properties
according to your customers' wishes, because most devices have some
settings that can be configured (for example, dimmers that ramp up and
down).

l Program events and actions. You define interactions between system events
and the actions of other devices. For example, when a projector turns on, it
can trigger other devices (lights, etc.) in the Home Theater to dim down or
turn off.

l Create the variables and agents for use in programming. Advanced
programming setup options are available to you, including string, Boolean,
device properties, variables, delays, and agents. Using these options, you can
configure, for example, a 3-way switch, turn equipment on and off with
proper delay times, create Lighting Scenes, and perform other desired
programming between devices. Advanced programming is discussed in the
Composer Pro User Guide.

l Customize the Navigators. You complete the registration process and enable
Remote Access. You can work with your customers also to set up screen
savers and other custom functions on their Navigators.

l Centralized Lighting design. Designing for a Centralized Lighting system is a
bit more complicated than designing a typical control system. For details
about Centralized Lighting, see the Centralized Lighting Products section on
the Control4 website, and take available training classes.

Purpose of device drivers
Every device in the Control4 system needs a corresponding device driver so the device can be controlled by
the Control4 system. When you design a system in Composer, the corresponding device driver is added to the
project each time you add a new device to a room. 

106

http://www.control4.com/docs/product/composer-pro/dealer-user-guide/english/latest


Composer Pro User Guide

Device drivers for Control4 products come pre-installed in Composer. Device drivers for hundreds of third-
party devices are available through an online database and can be added easily to the project. If a driver for
the model you need does not exist, you can use the Driver Wizard to create a custom driver. 

Note: Creating a device driver is an advanced skill in Composer. For detailed
information about how to create a driver, see “Creating device drivers” in the
Composer Pro User Guide.

Adding items to the project tree
To add items to the project tree or other lists in a Composer project, use one of
these methods:

l Double-click—After selecting a location in the project tree, double-click an
item in the Items pane to add it to a selected location in the project tree.

l Drag and drop—Drag and drop items (such as building, floors, rooms,
devices, etc.) from the Items pane to the desired location in the project tree.
When dragging-and-dropping items, drag the item directly on top of the
room or location (such as site, building, floor) in the project tree (left pane)
where you want the item to reside. 

l Hover—After you’ve added an item to the project tree, you can hover over it
for a pop-up of important identifying information.

Example: Drag a device (for example, a television) directly on top of the
Theater room to ensure it resides in that room.

Building a project in System Design
Using the System Design view, you create the foundation of the Control4 system by building a project tree in
System Design.

Tip: Before you begin to build the system, you may want to assign all of the
devices that will be used in the Control4 system unique and meaningful titles
if you used a planning worksheet. That way, they will be easy to identify when
you connect them to the home network.

To build a new project tree in System Design:

1. Start Composer Pro and connect to a Director. A new project opens in the System Design view by default.
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2. In System Design, click the Properties tab, and enter the following information:

l Name—Enter homeowner’s name or other project name.

l ZIP Code/Postal Code—In Lookup, enter the homeowner’s ZIP Code.

l Latitude and Longitude—Populated automatically when you enter a ZIP
Code or postal code.

l Date—Update as needed.

l Time—Update as needed.

l Click to select the project tree.

3. Add the locations to the project tree, including sites, buildings, floors, and rooms.

Composer Pro requires this location hierarchy: Site > Building > Floor > Room. The devices will be added
to the rooms later.

Tip: You do not have to add every level in the hierarchy manually. If you begin building
your project tree by adding a room, Composer Pro automatically adds a Building and
Floor object for you. You can easily rename these objects in the tree later.

1. In the project tree, select a location (site, building, or floor) where a room exists.

Example: The Master Bedroom is on the Second floor, so you would click Second to
select it. Go to the Items pane and double-click or drag-and-dropMaster Bedroom to
copy it to the project tree.

2. In the Items pane > Locations tab, double-click the room you want to add. The room displays in the selected
location in the project tree. The room is given a default name, but you can rename it any time by right-clicking
on the object in the project tree, and choosing Rename.

3. Repeat these steps until you have included all of the floors and rooms on each floor in the home to complete
your project.

Example: Add three rooms to the Main floor which already has a few rooms and the
Garage. 

4. Click Theater in the Items pane > Locations tab to add a Home > House > Main > Theater to the project tree.

5. Select Main in the project tree, and then click Bedroom to add it to the Main floor.
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6. With Main still highlighted in the project tree, click the Front room to add it to the Main floor.

4. Click the room and add the devices. For example, add the controller in a room of the project tree. 

Important: Ensure that the devices you select have exact and meaningful titles; for
example, “Wireless Dimmer” could be renamed to East Wall Wireless Dimmer for
easy recognition later. If you have several devices, such as wireless dimmers, in the
same room give them a unique name. 
Tip: You can right-click the driver in the project tree to: Rename, Edit Driver, Export
Driver, Update Driver, or Delete a driver. Use the same procedure to Update Driver as
for Add Driver (see “Driver menu”). 
Note: If you installed this version of Composer on a computer that has an older version
of Composer, right-click in the white space below the My Driver tab and select Restore
Default List. This action updates the My Drivers list. 

1. Click the room in the project tree.

2. From Items pane > My Drivers tab, double-click a controller to move it to the selected room (all devices to be
added must be selected from the My Drivers tab). 

Example: Select the Theater room, and then double-click the controller. The controller
and associated Digital Audio objects appear in the project tree. Digital Audio is a
component that resides on the controller, but shows up as a separate object in the project
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tree. Digital Audio provides the functionality to play media.

5. Add the Control4 lighting devices and Navigators to the selected room if they reside there. 

Example: Add the following devices to the Theater room. 

1. Double-click Wireless Dimmer, and then rename it to Dimmer.

2. Double-click Wireless Switch, and then rename it to Light Switch.

3. Double-click Wireless Outlet Switch, and then rename it to TV Outlet Switch. (This will be used to control
the power on a TV that uses an On/Off toggle switch.)

4. Double-click System Remote Control SR-250.

5. Double-click 6 Button Keypad. 

Note: If you have a wireless touch screen, add it now to your project.

6. Add all applicable audio and video devices to the selected room. 

Here are three examples to follow.

Example 1: Add a receiver to the Theater room 

1. Select the Theater room in the project tree.

2. Double-click Receiver in the Audio/Video section of the My Drivers tab. A dialog box displays with Local
Database selected and the receiver drivers that are currently available in the local database.

3. Select the receiver’s manufacturer and model. In the dialog box, select Online Database, select the
manufacturer Harmon Kardon, and then double-click AVR230[IR].
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Note: The Receiver object is added to the tree, along with a Tuner. The next time you add a receiver to
this project, the AVR230[IR] will appear in local database driver list. 

Example 2: Add a TV to the Theater room 
1. Select the Theater room in the project tree.

2. Double-click Television in the Audio/Video section of the My Drivers tab. A dialog box displays with local
database selected, and the TV drivers currently available in the local database.

3. In the dialog box, select Online Database, select the manufacturer Samsung, and then double-click TX-
P1430[IR].
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Notes:

The UHF/VHF object is added automatically to enable you to scan for UHF/VHF
broadcast channels.
The next time you add a TV to this project, the TX-P1430[IR] appears in the local
database driver list.
Example 3: Add the DVD player to the Theater room 

1. Select the Theater room in the project tree.

2. Double-click DVD in the Audio/Video section of My Drivers tab.

3. In the dialog box that appears, select Online Database, select the manufacturer Apple, and then double-
click DVD Apple TV [IR].
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7. Add Motorized devices or Sensors, if applicable, to the selected room. 

Example: From the My Drivers tab, add aMotorized Screen and a Door Contact
Sensor to the Theater room from the online database.

1. Select Theater in the project tree.

2. In the My Drivers tab under Motorization (scroll down), double-click Motorized Screen.

3. In the My Drivers tab under Sensors (scroll down), double-click Door Contact Sensor. 
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8. Add an HVAC, if available, to the selected room. 

l Add a Security Panel, if available, to the selected room.

l Add an IP Camera, if available, to the selected room.

l Add a pool and spa controller, if available, to the selected room.

l Add Network File Storage, if available, to the selected room.

l Repeat Steps 6–8 as needed for each room. 

9. Identify and the test the connections. See the Composer Pro User Guide for configuration and connection
information.

Composer Pro design methods
Planning a Composer Pro project: Create a plan
Before you start to work on a new Control Composer project (especially if you're new at it) it's best to create a
plan. 

Tip: Some of our dealers use a variety of design tools, for example, AVSnap,
Microsoft Visio, AutoCAD, and conceptdraw. AVSnap seems to be the
cheapest and the most popular tool.

Here are some suggestions: 

l If you haven't done so yet, we strongly recommend that everyone who
installs and configures Control4 products take the 'Tech 1 Training' class
provided by Control4. Send an email message to training@control4.com or
go to http://dealer.control4.com/dealer/training (dealer login required) to find
out how to enroll.

l Sign up for the Control4 Online Training sessions.

l Check out the Control4 Troubleshooting Guides, Best Practices, and other
materials on the Training site in the dealer portal.

l Check the Control4 Knowledgebase and dealer forums.

l Review the documentation on the Control4 dealer website.

l Check out the Training  web page on the dealer website.

Home automation design methods
Prerequisites to creating a design

Before you begin to create a design for a Control4 system, it’s a good idea to create a plan so you know all of
the devices in each room, how many rooms there are, how many floors, buildings, the home network
structure, and so on.
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Guidelines of system design

Consider the following items before you start to design a project for a Control4
automated home.

l Use existing or custom device drivers—Every device in the system needs a
corresponding device driver so the Control4 system can control the device.
When designing the system, each time you add a physical device to a room,
for example, a DVD player, the corresponding device driver must be added to
the project in the project tree. Device drivers for Control4 products are
installed in Composer Pro. Device drivers for hundreds of third-party devices
are available through an online database, and can be added easily to the
project when the driver is available. If a driver for the model of a device does
not exist, you can use the Driver Creation Wizard (available through a menu
option) or DriverWorks (a free add-on utility) to create a custom driver.

l Connect and identify the devices to the network—In the Composer project,
you identify all physical connections to the system, including control, AV
(audio, video), network, and other connections. Use to the Connections view
in Composer to complete this task.

l Register the system at my.control4.com—Control4 recommends that you
register each system you install at customer.control4.com so you can
maintain the system software using the online downloads.

Important: Only registered systems can use all of the media services that are
available to Control4 customers. System registration is one of the essential
steps in enabling remote access to the system.

l Set up the media—Identify any existing media on the system using the
Media view in Composer. The Media view helps you search or scan stored
media and auto-generate a list of local broadcast channels and stations. After
you’ve searched or scanned in the existing media, you can test the Media
access through the navigation devices (also known as Navigators), and you
can create playlists also.

l Configure properties—Manage a device’s settings in the Properties pane.

l Program events and actions—Define interactions between system events
and the actions of other devices in the Programming view. For example,
when a projector turns on, it can trigger other devices in the Home Theater to
turn on or off causing an event to occur.

l Create variables and agents for use in programming—Advanced setup
options are available in Composer: string, Boolean, device properties,
variables, delays, and agents. Using these options, you can configure, for
example, a 3-way switch, turn equipment on and off with proper delay times,
create lighting scenes, and other customized programming between devices.
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l Customize the Navigators—Complete the registration process and enable
remote access. Work with your customers to set up screen savers and other
custom functions.

Using Composer views to build a project
Composer Pro lets you set up a Control4 system using different Composer views
for different tasks. In Composer views, you can add devices, make connections,
set up media, and program the system using devices and agents.

In Composer views, you have the flexibility to follow any setup path you choose as
long as a controller is the first device you add to the project.

Note: Before you start to create a project, you will need to understand how to
use the views.

To use Composer views:

1. Start Composer Pro and connect to a Director.

2. The System Design view appears by default. Notice that the System Design, Properties and Items panes
appear in the screen. Each view has its own set of panes.

116



Composer Pro User Guide

Making and testing the connections

Connecting the hardware
Before you can design and build a project in Composer Pro, first start by installing the devices and connecting
the cables on every device that will be a part of the Control4 system. Otherwise, the devices will not be
acknowledged by Composer and Director.

If you purchased equipment from Control4, ensure that you’ve carefully read the installation or setup
instructions and/or user guides included in the box. These instructions will show you how to attach the cables,
and in some cases, how to set up and use the device in Composer Pro.

Testing the device connections
When you test a Control4 device connection, you are ensuring that the connection is successful so you don’t
encounter any problems with devices not functioning later on. You must perform this action for customer
satisfaction. For information about identifying devices and device connections, see the Composer Pro User
Guide.

The following types of connections may need to be tested on the Control4 system:

l Network connections—Defines the devices that use a network address.
Network connections include IP and Zigbee or Zigbee Pro devices.

l Control connections—Defines the control connection between a device and
the controller. Control connections include contacts, relays, serial, and IR-
controlled (infrared) devices.

l Audio and video connections—Defines the devices that have audio and/or
video signals.

l Room connections—Defines the video, audio, or video/audio end points and
the video/audio or audio volume for the selected room.

Testing network connections
In the Connections view, click the Network tab > IP Network. The list of devices appears.

Make sure there is a network address for every item in the list. If there is not, see “Cannot identify the device to
the network” in the Composer Pro User Guide.

Testing control and AV connections
In the Connections view, click the Control/AV tab. This list of devices appears.

Testing room connections
In the Connections view, click the Control/AV tab. This list of devices appears in the Room Connections pane.
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Registering the Control4 system
Every system must be registered at customer.control4.com to maintain the system software through online
downloads, and to use all of the media features in the system (for example, the Control4 online media
database for scanning music). System registration is also one of the essential first steps in enabling remote
access to the system.

After you complete the initial Control4 system setup (adding devices to a project, identifying them
automatically for devices released with OS 2.3.0 or later, and making software connections for each device),
you are ready to register the system and set up the media. “Setting Up the Media” is discussed in the
Composer Pro User Guide.

You can register the system either from Composer or by using a Navigator. See the sections below.

Register the system at customer.control4.com
Control4 recommends that you register each Control4 system you install at customer.control4.com to maintain
the system software easily through online downloads. Only registered systems can use all of the media
services available.

System registration, which includes setting up a customer.control4.com account, is required to use most of the
media services that are available in the Control4 system, for example, scanning media into the system (so that
you don’t need to manually add individual music files). 

You can register the system now through Composer, or later through a Navigator if you customize the
Navigator. You may have already registered the system in Composer to set up media. If not, you can register
the system using any Internet connection and one of the Navigators that is connected and identified.

Register the controller from Composer Pro
Composer Pro lets you register the controller to a customer account without having to log in to the customer’s
account. You can now create a new account and register the controller in one step, register to an existing
account found under your dealer of record, or manually register the controller using the 10-digit code from the
customer’s account page under Controller registration.

To set up a new customer.control4.com account and register this Control4 system:

1. In Composer Pro, go to Tools > Account Services.
2. Click the Add New Account tab to create a customer.control4.com account and start

the registration process for the user.

118

http://customer.control4.com/
http://www.control4.com/docs/product/composer-pro/dealer-user-guide/english/latest
http://customer.control4.com/


Composer Pro User Guide

3. Complete the Account Information form for the user, and then record the Account
Name and Email Address for the user’s future reference.

4. Click Add Account to create an account for this Control4 system and register the controller to the new
account.

To register the system to an existing customer account:

1. In Composer Pro, go to Tools > Account Services.
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2. Click Select Account and select the existing account you wish to register to in the list of Customer Accounts.

Note: If the existing customer account does not show up in the Customer Accounts
list, have the customer log in to their account and verify their dealer of record is
pointing to your dealer account.

To manually register the system to an existing customer account:

1. In Composer Pro, go to Tools > Account Services.
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2. Click Manual Registration.

3. From the customer.control4.com account page, copy the 10-digit registration code found under My Devices >
Controller Registration > Register New Controller. This code is time sensitive and must be used within 10
minutes. It provides a temporary code used to exchange the security parameters and create a secure
connection between customer.control4.com and the controller.

4. On the Account Services page, click the text box and paste the 10-digit registration code in the box.

5. Click the Register button on the Account Services page in Composer (now enabled) to complete the
registration. The Current Status changes to 'Registered.'

Setting up a 4Sight subscription
Use the Internet to set up a 4Sight subscription. This feature enables a Control4 system user to log in to the
Internet and manage their Control4 system on the web. Consumers will need 4Sight to use Anywhere Access
also.

Note: 4Sight subscriptions are sold separately.

Prerequisites
1. Design and set up the project.

2. Register the Control4 controller and the system owner.

When a 4Sight subscription has been obtained for the Control4 system, this setup can be done by the
homeowner or installer. The installer or a Control4 representative should be able to provide information about
how the homeowner can set up a customer account. The Control4 System User Guide or Account Setup
provides that information for the homeowner. 
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To set up a 4Sight subscription at customer.control4.com:

1. Obtain a 4Sight subscription code for the system (sold separately).

2. Log in to customer.control4.com using the homeowner/user email address and password.

3. From the My Account tab, select the Subscriptions view.

4. Enter the 4Sight subscription code provided by your Control4 representative, and then click Activate.

Tip: Scroll down and view Account Subscriptions to see which subscriptions you
already have.

Managing and assigning Composer Pro licenses
Use my.control4.com to set up additional Composer Pro Licenses for dealers and their employees who use
Composer Pro. You must do this before you run Composer Pro.

Notes
l Controller registration is separate from a Composer Pro License.

l You cannot assign Composer Pro Licenses to consumer accounts; these are
for dealers and their employees only.

l Thirty days after the license is activated, you will be notified to renew the
license. You can choose not to, or you can extend the period another 30 days.

Prerequisites
l Composer Pro must be installed or updated to the current release.

l A valid dealer account must be set up.

l A valid dealer sub-account that the dealer account manages can also be
used.

l Access to my.control4.com.

You can find comprehensive information about this subject in Managing Dealer Accounts in my.control4.com.
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Where to go from here
This Control4 Composer Pro Getting Started guide gave you:

l An overview of Composer: how to install and start it, how to access a Director,
and includes a preview of the Composer interface (views, menus, properties,
panes, etc.).

l An overview of how to start designing your project with suggested tools.

l An overview about connections and how to test devices.

l How to register the Control4 system.

l How to set up a 4Sight subscription.

l How to set up Remote Access.

l Examples about how to build a system in System Design. 

More detailed and advanced sections (Composer Pro User Guide) are outside the scope of this document but
you can find them on the Dealer Portal.

The advanced sections give you specific details about:

l Setting Up Media

l Creating Device Drivers

l Making Connections

l Verifying Connections

l Configuring Devices

l Configuring Properties

l Basic Programming

l Advanced Programming

l Customizing Navigators

l Installing Devices

l Troubleshooting the System

Contacting Control4 technical support
Should you encounter any problems while using Composer Pro, please contact Control4 Technical Support
for assistance.

l Phone: 1-888-400-4072

l E-mail: support@control4.com
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Other resources
Also check out the Control4 Forums or Knowledgebase.
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Project build example using system
design
The following sample project steps you through the creation of a Control4 project using Composer Pro. This
example assumes that you’ve already saved the project as a backup, and covers basic device additions to the
project, but not connecting or identifying the components. This example project:

l Includes a theater room

l Adds keypad and electrical interfaces

l Adds AV components

l Adds a touch screen

Adding a controller
When setting up a system, first add the controller to the list. You must attach a controller to each television you
add to the Control4 system.

To add a controller:

1. Start Composer and connect to a director.

2. In the System Design pane’s project tree, select the Theater room.

3. In the Items pane, click the My Drivers tab.

4. In the Controller category, double-click EA-5. The controller is added to the project’s Theater room.

Note: If you installed this version of Composer Pro on a computer that already had an
older version of Composer Pro, right-click anywhere in theMy Driver tab, then click
Restore Default List. The My Driver list updates.
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Adding keypad and electrical interfaces
After adding a controller, you can add dimmers, switches, keypads, outlets, and a remote control.

To add keypad interfaces:

1. In the System Design pane’s project tree, select the Theater room.

2. In the My Drivers tab, do the following:

1. Under Lighting > Light (v2), double-click Adaptive Phase Dimmer to add it to the project, and then rename it
to Dimmer in the project.

2. Under Lighting > Light (v2), double-click Switch, and then rename it to Light Switch.

3. Under Lighting > Light (v2), double-click Wireless Outlet Switch, and then rename it to Television Outlet
Switch.

4. Under User Interface, double-click System Remote Control.

5. Under User Interface, double-click Configurable Keypad.

Tip: Use a descriptive name for items added to a project. You can right-click and select
Rename, or you can begin typing right after the item is added. For example, if you have
two dimmers in a room, you could name one “Wall Dimmer” and the other “Ceiling
Dimmer.” This helps you clearly identify items later when making connections.

Adding AV components
After adding interfaces, you can add the main components of the home theater.

To add AV components: 

1. In the System Design pane’s project tree, select the Theater room.

2. Add a receiver to the room:

1. In the My Drivers tab, under Audio/Video, double-click Receiver.

2. In the dialog box that opens, select Online, select the manufacturer Harmon Kardon, then double-click
AVR230[IR]. The receiver is added to the project. 
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3. Add a retracting movie screen to the room:

1. In the My Drivers tab, under Motorization, double-click Motorized Screen.

2. Under Sensors, double-click Door Contact Sensor.

4. Add a TV to the room:

1. Under Audio/Video, double-click Television.

2. In the dialog box that opens, select Online Database, select the manufacturer Samsung, then double-click
TX-P1430[IR]. The TV is added to the project. 
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The Cable TV and UHF/VHF objects are also added to the project, to enable you to scan for cable and
broadcast channels.

5. Add a DVD player to the room:

1. Under Audio/Video, double-click DVD.

2. In the dialog box that opens, select Online Database, select the manufacturer Samsung, and then double-
click DVD HD841[IR]. The DVD is added to the project.
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6. Add online TV to the room:

1. Under Audio/Video, double-click DVD.

2. In the dialog box that opens, select Online Database, select the manufacturer Apple, and then double-click
AppleTV [IR]. Apple TV is added to the project.

129



Composer Pro User Guide

Adding a touch screen
After adding AV components, add a touch screen.

To add a touch screen:

1. Under User Interface, double-click a Touch Screen. The touch screen is added to the
project.

Finishing the project
After adding devices to your project, you will still need to identify, connect, and test the devices. For more
information, see Connecting and verifying devices in the Composer Pro User Guide.
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Basics
Composer Pro basics

Use this chapter to learn how to:

l Install and configure devices

l Configure Composer Pro properties
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Installing devices
Use the Dealer Portal at dealer.control4.com, Products > Additional Resources or Support > Documentation
pages to access PDFs or web help for all current and past product installation and setup guides, and then
install and set up your Control4 system devices according to these guides. OS 2.3.0 or later supports the auto
discovery of many current devices. See “ How to add devices to a project” and “ Configuring third-party
devices” in this document for details.

If you're installing devices that are not owned by Control4, you may need to edit an existing driver or create a
new one. See “ Creating device drivers.”

To access the installation, setup, and user documents in PDF format:

1. Go to the dealer Documentation page.

2. Log in using your dealer username and password.
3. If the list of documents doesn’t appear, click the Products link, and then select Support > Documentation.

4. View the list and then click the link for the document you want to view or print.
Configuring device properties
Use the Composer Pro Properties pane in System Design to change device
properties. The Properties pane lets you make configuration changes to a project,
room, or device. 

In the Control4 system, you have a choice of configuration options using these
property types:

l Project Properties—Lets you set project-specific configuration options.
l Room Properties—Lets you set room-specific configuration options.

l List View Properties—Lets you set device properties listed by location, for example, room, floor, house,
etc.

l Device Properties—Lets you set device-specific configuration options.

To configure properties:

1. Start Composer and connect to a Director.

2. Click System Design.

3. Select one of the following property types:

l Project—Select the root node in the project tree, for example the project
name (such as Franklin Smith Home) to access the project properties and
modify the:

l Project name

l ZIP Code

l Latitude/longitude

l Date

l Time (12-hour and 24-hour clocks)
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l Time zone

l Lighting Defaults

l Project Settings Control

l System Security

l Localization

l Scale (Temperature)

For more information, see “Composer Pro properties".

l Room—Select the room in the project tree, for example, Theater; the
Properties tab is visible (default).

Room properties let you:
l View room-specific devices

l View media information

l Help you troubleshoot any incorrect room connections

For more information, see “Room Properties”.

l List View—Select a room, and then select the List View tab. View and/or
modify the devices in the room. For more information, see “Device
Properties”.

l Device—Select the device to modify the available user options. For more
information, see “Device Properties”.

Help for device properties
Device properties vary by type of device. Changes made to the properties of most
devices are immediately applied to the system. Changes made to Navigators may
not be noticeable until you refresh the Navigators using Composer Pro’s File >
Refresh Navigators command (Shift+F5).

For the most up-to-date device properties information, click the Documentation
tab in the Properties window (available only on select devices) or the Help button
on the proxy.
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Configuring devices
Use this chapter to learn how to configure Control4® devices. “Configuration” can mean anything from
identifying the device to the network to configuring the device’s properties within Composer Pro.

Note: The device listings in this chapter have been reorganized to better
match the order in Composer Pro’s My Drivers tab.
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How to add devices to a project
There are two options to add a device to a project and identify it in the Control4 system:

l Auto Discovery—In OS 2.3.0 or later, current Control4 devices support auto
discovery via the Simple Device Discovery Protocol (SDDP) using the
Discovered tab in the Items pane. This is the easiest way to add and identify
new devices attached to a Control4 system because it works automatically. If
the device you want to add to a project and identify in the system appears in
the Discovered tab, all you do is double-click to add the device to the selected
room and Director does the rest. See “Auto Discovery (SDDP)” below for more
details.

l Composer Views—You can add a Control4-supported device driver or a
third-party driver to an existing project any time using the System Design
and Connections views. See “Composer Views” or “Example Projects” in this
guide or "Using Composer Views to Build a Project" in Composer Pro Getting
Started.

Auto Discovery (SDDP)
Auto discovery uses SDDP to automatically discover IP devices and ensure that
the correct device drivers are added to a project and installed into the Control4
system. When a device uses SDDP, it can advertise on the network what it is,
what driver it uses, and what its network address is.

Note: As a best practice, Control4 recommends that you add and identify the
Panelized Lighting products manually rather than using Auto Discovery.

The Auto Discovery function through SDDP does these things:

l Enables devices to use DHCP (Dynamic Host Configuration Protocol) while
still being able to identify them uniquely

l Enables Director to discover and identify Control4 and some third-party
devices in the Control4 system

l Enables automatic installation of drivers for discovered devices

Note: Auto Discovery does not make the room connections. You must do that
manually. See “Connecting and verifying devices” in this guide.

Benefits:

l It discovers devices that are not yet in the project

l It adds the manufacturer’s driver without having to search for it

l It identifies the device using a unique identifier when adding it to the project
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l You don’t need to type in TCP/IP addresses or restrict devices to static IP
addresses

To use Auto Discovery:

1. Start Composer Pro and connect to a Director.

2. Click System Design (default view).

3. In the Items pane, click the Discovered tab. View the devices in the list.

4. In the project, click the room to add the device to.

5. In the Discovered list (Items pane), double-click the device to add it to the project. If the device you want to
add does not appear in the list, it may be already added to the project or it does not support Auto Discovery. If
you need to add a device that doesn’t support Auto Discovery, you can use the Composer views to add and
identify your device.

Add/Identify Options. Both options will add and identify a device in one step.

l Devices listed in the Discovered tab

l ‘Auto add identified devices’ box in the Discovered tab

To add discovered devices to the project:

1. Double-click the device to add it to the current room in the project which will add and identify it in one step.

To use the ‘auto add identified’ box:

1. Check the auto add identified devices box at the bottom of the Discovered Items pane. This allows you to go
directly to the device and use the Identify button to add and identify it. This box is useful if you want to be very
specific about the device you’re adding. Without the box checked, the add/identify process will not be
executed with a button press.

2. Press the Identify button or button-press sequence on the device.

3. The device will automatically be added to the current room in the project.

Note: If the Identify button is pressed when ‘auto add identified devices’ is not selected,
that device will be highlighted in yellow in the Discovered tab. It will not be
automatically added to the project.
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Example: If you have third-party devices, for example, three different TVs in three
different rooms in the home, you can check ‘auto add identified devices,’ select the
room where the TV is located, and then have someone identify at the TV. The device
will be added automatically to the project.

To view all devices on the network (including those already in the project) that use SDDP:

1. In Composer, click the Connections view.

2. Click the Network tab.

3. Notice in the right pane the list of devices. SDDP-recognized devices will have an SDDP text highlight.

To use the Info button:

1. Click the Info button in the Discovered tab, or right-click the device.

2. Select the device. An Info box opens which will give you identification and other information about that device
(based on what the driver developer has provided).

Composer views
Using the My Drivers tab
In the System Design view, click the My Drivers tab to find device drivers and add them to the project tree (if
you are not using Auto Discovery).

Read “Purpose of device drivers” and “Adding items to the Project Tree” in Composer Pro Getting Started first
to understand how to create and populate the project tree for a project.

To use the My Drivers tab:

1. Install and connect the physical devices that need to be added to the Composer Pro project.

2. In the project tree, click the room to add the driver to.

3. In the System Design view, click the My Drivers tab in the Items pane.

4. Locate the device and double-click or drag the device to the System Design pane's project tree.
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Tip: To ensure that you’ve got the correct device driver (SKU) in your project tree, after
you’ve added it to the tree, hover over it. The SKU and other device information
appears.

5. Click the Connections view, and then click the Network tab.

6. Locate the added driver in the IP Network Connections pane.

7. Select the device and then click Identify.

8. Follow the on-screen prompts in the popup. In most cases, you’ll need to go to the physical device and press
a button several times to identify it to the system.

9. Make the necessary control, network or AV connections. See “Connecting a Device to the Network,”
“Connecting and Verifying Devices,” or “Connecting Devices” and “Testing the Device Connections” in
Composer Pro Getting Started for information.

10. Set any necessary device properties by selecting the device (see “Properties Pane” in Composer Pro Getting
Started). If any properties are available for a device, they will display in the Properties pane. The following
“Configuring…” sections describe the various properties for devices.

11. If you are adding Wi-Fi devices, refer to the Control4 training courses on the Dealer Portal to learn how to
install and configure Wi-Fi.

Using the Search tab
Thousands of third-party device drivers are supported in the device driver database. Drivers that are not in the
local database can be found in the online database, if they are available. Use the Search tab to search for and
add device drivers to the project tree that do not appear in the My Drivers list.

Certified and non-certified drivers are available. Look for the certification icon to the right of the driver in the
list. Certified drivers appear at the top of the list if you search under manufacturer > all certified.

Note: Due to the large quantity of drivers in the database, Control4 has not
validated every device driver provided. If you experience limited functionality
using any device driver provided by Control4, please report the limitations to
Control4 Technical Support. To report defects or enhancements, please
contact Control4 (phone: 1-888-400-4072 or email: support@control4.com).

Read “Purpose of device drivers” and “Adding items to the Project Tree” in Composer Pro Getting Started first
to understand how to create and populate the project tree for a project.

To find a device driver using Search:

1. Install and connect the physical devices that need to be added to the Composer Pro project.

2. In the project tree, click the room to add the driver to.
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3. In the System Design view, click the Search tab in the Items pane.

4. From the project tree, select the room where the device resides.

5. In the Search tab, select the device type from the Device Types filter.

6. Select the manufacturer from the Manufacturers filter.

7. Drag the driver to the project tree, or double-click the device driver to add it the project tree.

l [search text field]—Type the text to search for here. You can use the drop-
down menu to select terms that were previously typed.

l Local (default)—The Local checkbox lets you view device drivers stored on
your local database.

l Online—The Online checkbox lets you view and download drivers from the
online database.

l Certified Only—This checkbox specifies that only Control4-Certified drivers
will appear in the search results.

l Device Types—Lets you select the device type (proxy), for example, AV
Switch (includes audio switches), Blinds, CD, Disc Changer (includes DVD and
CD Changers), DVD, Light, Receiver, Satellite (includes DVRs), Cable TV,
Television, Thermostat, Tuner, VCR and more.

l Manufacturers—Lets you select the manufacturer.
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l Sort by—Lets you select the order that search results are displayed.

l Results—Detailed search results appear, including the manufacturer, model,
and driver location.

8. Configure the device by setting up the connections (Network and/or Control/AV tabs). See “Connecting and
verifying devices” for details.

Adding drivers manually
If you need to use a driver that is not included in a Composer Pro version, you can download it (from Control4
or a third-party source) and add it to your local database manually.

To add a driver manually:

1. In Composer Pro’s menu bar, click Driver, then click Add or Update Driver.

2. In the Select c4i file to add dialog box, navigate to the folder containing the driver, then select it and click
Open. The driver is added to your driver database.

3. To add a device using the new driver, follow the instructions in “Using the Search tab” above.

Adding Z-Wave devices
After configuring your Z-Wave controller, add drivers corresponding to the Z-Wave devices to your project.
Many Z-Wave device drivers will also need a motorization, sensor, or light driver, like a door or window driver,
added into your Control4 project to represent the Z-Wave device in a Control4 Navigator.

Z-Wave device drivers
To add a Z-Wave device driver into your project:

1. In System Design, enter the name of driver in the Search tab.

2. Double-click on the driver to add it into the project. You can also right-click on the driver and select Add to
Project to add the driver.
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3. If you have more than a couple Z-Wave devices, it is recommended that you rename this driver to help with
troubleshooting multiple devices. Right-click on the driver and select Rename. Enter a descriptive name and
press Enter.

Most Z-Wave device drivers will also need a motorization, sensor, or light driver. For example, a window
contact sensor device driver also needs the Window Contact Sensor driver and an outlet module device driver
needs the Z-Wave Dimmable Light (Outlet) driver.

Motorization, sensor, and light drivers
To add a motorization, sensor or light driver into your project:

1. In System Design, enter the name of the driver in the search field in the Search tab.

2. Double-click on the driver to add it into the project. You can also right-click on the driver and select Add to
Project to add the driver.

3. This is the driver that will show up in the UI, rename the driver to represent the device it is controlling. Right-
click on the driver and select Rename. Enter the name to be shown in the UI and press Enter.

141



Composer Pro User Guide

Configuring third-party devices
Use the System Design and Connections views to configure third-party devices using third-party device
drivers. The same basic steps apply to third-party drivers as with Control4 devices. Many of these drivers are
‘certified’ and are available in the drivers online database. Some of them will use Auto Discovery in the future.

Notes: (1) If the device you want to add and identify doesn’t support Auto
Discovery, you can follow the steps in “Composer views” or “Example projects”
later in this guide. (2) New drivers for Sony STR-DA2800ES and DA5800ES
receivers (ZSO-STR-DA2800ES or ZSO-STR-DA5800ES) are available in the
Search > Online Database list (‘Receiver’ if the device is used as a receiver only
in the Control4 system). The Sony receivers cannot be used as a controller in
OS 2.6.0 or higher, see “Configuring a home controller” in this document.

Although third-party drivers are supported, they are not documented in this guide. For information about the
devices and drivers, see the product’s own website.
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Configuring controllers
Use the System Design view to add and identify a controller to the network connection. Refer to the sections
below for the controller type you want to configure. This section also covers other controller-related tasks. 

Note: Home Theater Controller, Home Controller HC-500, HC-200, HC-300, HC-
1000, and Media Controller are no longer sold by Control4.

Configuring a home controller
Use the System Design view to add and configure controllers (CA-10, CORE 5, CORE 3, CORE 1, EA-1, EA-
3, EA-5, and CA-1). The steps below are basically the same for all of these controllers; however, some
properties may vary.

Note: Emphasis is placed on the most recently released controllers.

Prerequisites

Ensure that the controller is installed as directed in the controller’s installation guide, which is available on the
Dealer Portal.

To add and configure a controller:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the correct driver
is added to the project tree. The Digital Media object is added automatically also.

2. Change the Properties for each controller as shown below.

Note: If a controller is not listed in My Drivers, right-click in My Drivers and select
Restore Default List. This action updates the list. See “Using My Drivers or Search
Tabs.”

3. To establish a Wi-Fi network connection to older controllers, configure a USBWi-Fi Adapter for home
controllers (sold separately). See “Configuring a Wi-Fi connection” for details. Wi-Fi is built-in to EA, CA-1,
and HC-800 controllers, but you still have to configure them for Wi-Fi.

Note: EA-3 V2 and EA-5 V2 controllers require an external Wi-Fi adapter. The EA-1
V2 PoE controller does not support Wi-Fi.

4. (Optional) For additional controller setup, configure the properties.

1. In the System Design view project tree, select the Home Controller object.
2. Modify the properties in the Properties pane:

l Controller Status—Shows whether the controller is Online or Offline.

l Zigbee Server Configuration—Lets you view, enable and disable the Zserver.
Edit Zigbee Configuration opens the Zigbee Network Settings dialog.

Note: The Zigbee Network Settings box shows which ZAPs are configured,
identified, or enabled. See also Tools > Network Tools and select the Zigbee
Network tab.
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l IP Address—Shows the IP address for the controller, if the controller is
identified and communicating on the network.

l Zigbee Server Status—Shows whether the controller as Zigbee Server is
Running or Not Running. Older controllers show ‘Not Supported.’

l ZAP Configuration Type—Shows whether the controller is the Coordinator or
ZAP. Older controllers show ‘Not Supported.’

l ZAP Status—Shows whether the controller as ZAP is Running or Not
Running. Older controllers show ‘Not Supported.’

l For Video Connection (HC-250 and HC-800 only)—Select component or
HDMI, change the Video Resolution, and then click Set Resolution. This will
cause the controller to set the configuration and restart. Note: This does not
reflect what is set in the Connections view for video output.

l Video Resolution (HC-250 and HC-800 only)—If your video doesn’t display
properly, use the drop-down to select your correct video resolution.

l Current Resolution (HC-250 and HC-800 only)—Displays what hardware
resolution is currently configured.

l I/O Firmware Version (EA, HC-250, and HC-800 controllers)—Lists the
current IO server firmware version of this controller.

Configuring a CA-10 Automation Controller
Use the System Design view to add and configure the CA-10 controllers.

Prerequisites

Ensure that the controller is installed as directed in the controller’s installation guide (ctrl4.co/ca10-ig)

To add and configure a controller:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the correct driver
is added to the project tree. The Digital Media object is added automatically also.

Note: If the CA-10 controller is not listed in My Drivers, right-click in My Drivers and
select Restore Default List. This action updates the list. See “Using My Drivers or
Search Tabs.”

2. Use Composer Pro to monitor the controller status and view any needed service actions.

1. Controller Status—This field gives an overall controller status. The individual
hardware components, their service state, and any action needed is listed below.
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2. Logs—Use the Logs field to viewcontroller logs, clear logs, and copy log text to the
clipboard to export the log data.
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Configuring a Zigbee mesh controller
You can use System Design to check the project properties, enable a Zigbee
mesh controller, and view the status of the Zigbee mesh controller running in a
Control4 project.

Note: A Zigbee network requires an HC-800, CORE, EA, or CA-1 controller.

To configure a Z-Wave controller:
1. In the Project Tree, select the Project Name (top line of the project tree) object for the project properties to

appear.

2. Click on the Zigbee Configuration tab.

3. Click Edit Zigbee Configuration.

4. In the Zigbee Server selection menu, choose the controller to run the Zigbee mesh.

5. Select the channel in Zigbee Channel.

6. Click OK to save the configuration and wait a few minutes for the Zigbee server to come online.

Note:For more information, see the Zigbee Best Practices at ctrl4.co/zigbee-
bp.

Configuring high-resolution audio with an EA Controller
Options for configuring high-resolution audio quality in a project running OS 2.9.0 or later can be found on the
Properties page of the Digital Media driver. Click on Digital Media in the Project Tree.

Advanced Audio—Provides superior audio quality, lowered audio latencies, and support for future features.
This field shows if Advanced Audio is enabled in the project.

Note: For Advanced Audio to be enabled, no audio inputs or outputs from HC-
200, HC-300, HC-500 Controllers or Speaker Points can be bound in the
project
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Audio Latency—This parameter adjusts the delay when playing audio. For a project where all networked audio
devices are wired and no EA HDMI connections are used, a latency below 1500 ms can be used. For projects
where networked audio devices are wireless and include EA HDMI connections, a minimum latency setting of
1500 is recommended. Further adjustments may need to be made depending on the networking environment.

Max Quality—This setting specifies the best audio output in systems that support high-resolution audio
beyond CD (44.1 kHz / 16 bit). Large values will consume more network bandwidth, but will ensure high-
quality source media fidelity is preserved. The Max Quality feature requires the use of Advanced Audio and
EA controllers. Older controllers added to a zone with high-quality audio will receive CD quality audio.

Active Quality—Indicates the current audio quality setting of the project. Active Quality can be different from
the Max Quality setting depending on the number of bound audio outputs in a project.

Note: Active Quality is limited to 96 kHz/24 bit when MQA audio is enabled.
See "Configuring MQA audio".

Maximum number of bound audio outputs/simultaneous audio streams per project

l 192 kHz / 24-bit audio is limited to two bound audio outputs

l 96 kHz / 24-bit audio is limited to four bound audio outputs

l 48 kHz / 24-bit audio is not limited, but it is recommended to have no more
than 12 simultaneous digital media streams at this quality.

Replacing an existing controller using the Controller
Migration Wizard
Use the Controller Migration Wizard in Composer Pro to easily replace an existing controller in a project.

Note: You should be connected to the same network as the controller when
using the Migration Wizard.

Supported uses:

l Primary Controller — Replace a functioning primary controller with a new (or
different) controller; migrate project & controller registration to
customer.control4.com web services.

l Secondary Controller—

1. Replace a functioning secondary controller with a new (or different) controller.

2. Replace a non-functioning secondary controller with a new (or RMA replacement)
controller.

Limitations:

l Please note that third-party drivers that are authorized, activated, or
registered with the MAC address of the primary controller will need to be re-
authorized by the installer after the primary controller is changed. The wizard
will report the new primary controller’s MAC address. You will need to contact
the third-party suppliers and request an updated license(s) or activation keys..
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l Some Control4-produced and third-party drivers also use MAC-based pairing
or activation solutions to enable communications with the target device or
system. Examples of these include: Pandora, AppleTV, and Apple iTunes.
These drivers will also need to be reactivated after the migration.

l It is not possible to migrate a non-functional primary controller. If the primary
controller needs to be RMA’d, you have to manually load the project onto the
new controller.

Before you begin:

1. Add the replacement controller to the project.
2. Identify the replacement controller.
3. Update the OS on the project and controllers to the same version.

To start the Controller Migration Wizard:

1. Click Tools > Controller Migration Wizard to open the Wizards windows.

2. Read the pre-requistes, then click the Start button.

3. In the Controller Selection window, select the Source Controller then the Target Controller from the list of
controllers in the project.
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4. Click Project Migration, Zigbee Mesh Controller Migration to move this function to the Target Controller and
click Next.

Note:Migration Options auto-populate based on the functions that the
Source Controller is running.

5. Verify the connections you wish to transfer to the Target Controller. Click Accept to select all the connections,
or de-select connections if you're keeping the old controller for inputs and outputs. Click Next, when you're
finished.
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Note: Since controllers can support a different number of connections, all
connections are moved in sequential order starting at the first available
option. For example, if a single IR connection on an EA-3 is connected to IR
Output 3, the connection will be mapped to a CORE-3 IR Output 1.

6. Verify the location to save a pre and post project backup and Migration Wizard Report to your computer. Click
the folder icon to change the location. Click Next.
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7. The Migration Wizards moves the project configuration and connections to the Target Controller. When the
migration is finished, it drops the connection to Director.
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8. Connect to the new controller and verify the migration was successful.

Ensure that Zigbee Server is running
Use the System Design view to check the controller's properties and ensure that
Zigbee Server is running on a controller.

To ensure the controller properties are set correctly:

1. In the project tree, select the project name object for the Zigbee Configuration tab to appear.

2. Ensure that the Zigbee Server is running. If not, see “Example: Verify the network connections” in this
document.

Tip: Be patient. In cases where the Zigbee mesh is moved, it can take up to five

152



Composer Pro User Guide

minutes for all connections to get re-established.
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Configuring a Z-Wave controller
You can use System Design to check the project properties, enable a Z-Wave controller,
and view the status of the Z-Wave controller running in a Control4 project.

Note: Z-Wave requires a Z-Wave module connected to an EA or CA controller.
See the Z-Wave Module Installation Guide for more help.

To configure a Z-Wave controller:
1. In the Project Tree, select the Project Name (top line of the project tree) object for the project properties to

appear.

2. Click on the Z-Wave Configuration tab.

3. Check the box under Z-Wave Enabled for the controller you want to be your Z-Wave controller.

Note: Only one Z-Wave controller can be configured in a Control4 project.

The configuration should show a status of “Secure” when it is configured properly. If the Status field is empty,
make sure the Z-Wave module is connected and installed properly, and that the EA or CA controller is online
and identified in the project.

Advanced configuration
Several options are available for advanced Z-Wave configurations in the Z-Wave Configuration tab in the
project properties window. These are not required in most cases when operating Z-Wave devices with a Z-
Wave module in a Control4 system. They can be used for extending operation with external devices and third-
party Z-Wave controllers.
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l Learn—This option joins the selected controller to another open Z-Wave mesh. This action will change
the Home ID of the controller, and any devices on the previous Home ID will no longer be available. If the
controller is joined to a mesh that contains a Node ID controller (SUC/SIS), the controller will be an
Inclusion controller with the Home ID of the mesh it joined.

l Network Update—When acting as an Inclusion controller, Network Update requests network topology
updates from the Node ID controller (SUC/SIS).

l Reset Defaults—Reset Defaults clears the Home ID on the Z-Wave controller and abandons any nodes
on the existing network. Any Z-Wave devices previously joined to the network must be removed before
they can join the new network. See “Removing Z-Wave devices.” Use this procedure only in the event
that the network primary controller is missing or otherwise inoperable.

Note: If this controller is the primary controller for your network, resetting it
will result in the nodes in your network being orphaned and it will be
necessary, after the reset to defaults, to reset and re-add all of the nodes in the
network. If this controller is being used as a secondary controller in the
network, use this procedure to reset this controller only if the network primary
controller is missing or otherwise inoperable.

l Send Node Info—When connected to another mesh, Send Node Info sends information about the
controller to all other devices on the mesh.
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Advanced Z-wave concepts
Replication—Control4 controllers do not implement controller replication. The controller will respond
appropriately to replicate requests.

Basic Command Class—Control4 controllers allow controlling unknown devices with the Basic Command
Class (see Non-Preferred devices below). Control4 controllers “Do Nothing” when receiving Z-Wave Basic
Command Class commands.

Non-Preferred Devices—Control4 controllers allow adding unknown Z-Wave devices through a “Generic Z-
Wave” driver. When a device is connected to this driver, it can be controlled through the Basic Command
Class using the properties page for the device. Information reported from the device is also be available on
this properties page. Non-preferred devices can also be added to a Z-Wave mesh using the Available Devices
Add button. This allows devices to be added and then associated using manufacturer specific methods for
doing so. See manufacturer specific documentation on how to create associations on specific devices.

Association Command Class—Control4 controllers implement associations on the Lifeline association group
(group 1). This association is used to provide device reset information to an associated device. A single
associated device is supported.

Repeater Functionality—This product can be operated in any Z-Wave network with other Z-Wave certified
devices from other manufacturers. All non-battery operated nodes within the network will act as repeaters
regardless of vendor to increase reliability of the network.
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Troubleshooting Z-Wave
When joined to a network, a Z-Wave device will not join a different network. Z-
Wave devices can be removed from any network at any time by using the
Remove button found in Available Devices. This is true even if they are not part of
the network performing the remove operation. If there appears to be trouble
joining a device to a network, it is a good idea to either perform a reset defaults
on the device, or explicitly perform a removal procedure, prior to attempting to
add the device to the existing network. This ensures the device is not currently
configured for another network prior to adding the device to the desired network.

Ensure that Video Mode is set correctly
Use the System Design view to check the controller's properties and ensure that
video mode is set correctly on a controller. Video Mode lets you set the video
format that the controller outputs when configured to display video.

To ensure the controller properties are set correctly:

1. In the project tree, select the Controller object for the properties to appear.
2. Ensure that the video format is set correctly. NTSC mode is used in the U.S. and PAL

mode is generally used in Europe.

Configure multiple controllers
Use the System Design view and Connections > Network tab to configure multiple controllers. If you have
more than one controller in your Control4 system, you must designate one of them as the primary controller
(Director). The others will be secondary controllers.

To add and configure multiple controllers:

1. Start Composer Pro and connect to a Director on Local Network.

2. From the Directors dialog that appears, select the Director’s network address of the primary controller
hardware you are setting up, and click Connect.
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When you have multiple controllers in the system, connecting to a controller defines where the project
configuration will be saved (Director). When you identify the controllers to the project, any other
controllers will be configured as a slave or secondary controller and Director will be turned off
automatically. The next time you launch Composer Pro, only the network address of the Director of the
primary controller appears on this screen. If the correct address is not listed, click Add to add the address
manually.

3. In the project tree, select the room where the controller resides, and add it to the system. Do the same for all
the controllers you plan to add to the system. See “ How to add devices to a project” for details.

4. Click the Connections view.

5. In the Connections view, select the Network tab.

6. Select the first controller listed, and click Identify.

7. On the dialog that appears, follow the on-screen instructions, and click Next to continue to identify the other
controllers you have added to the system.

8. When you finish identifying all of the controllers and any other devices in your project, click Close to return to
the Network tab in the Connections view.

9. In the IP Network Connections pane under Address make sure that all the devices in your project have an
address on the list.

Configure an IO Extender
The IO Extender opens up a whole world of options in the Control4 system to
control home theaters, distributed audio systems, video devices, motion sensors,
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and other devices that use infrared (IR), serial, contact, and relay connections. This
device is a great companion to the EA controllers to expand output capability.

Ensure that the IO Extender is installed and set up as directed in the IO Extender Installation Guide available
on the Dealer Portal.

To add and configure an IO Extender:

1. Follow the steps in “ How to add devices to a project” to add and identify the device. Ensure that the IO
Extender driver is added to the project tree.

2. Add device drivers, for devices to be controlled by IR or serial, or Motorization drivers, for devices connected
by relay or contact sensor (see “Configuring Motorization” in this document) and make the appropriate
connections between those drivers and the IO extender on the Connections > Control/AV window (see
“ Connect and verify devices” in this document).
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Configuring lighting
Use the System Design and Connections views to configure dimmers, switches
and keypads.

Tip: Double- and triple-tap events apply to the Control4 dimmers, switches,
and keypads. When you tap a button consecutively two or three times for
about one-half of one second the events fire.You can use these events for
programming without requiring the more complex programming logic tied to
timers and button 'Press/Release' events. 

Note: When programming using double and triple-tap events, be aware that
Press and Release events also occur when double and triple-tap events occur.
Plan your programming using these events so that they don't conflict with the
intended outcome. In most cases, when using double and triple-tap
programming events, don't program on the Press and Release events. 

Tip: These sections are organized by how devices are listed in the My Drivers
tab.

Wireless Lighting
Device settings for Configurable Keypads

Properties
l Button Settings

l Name—The name of the button (used for defining its connections to other
devices or events within Composer HE).

l Engraving—Text that you want printed onto the buttons. For more
information, see “Ignore device when it comes online—When selected, this
checkbox tells the system to ignore the older device when it comes back
online.

l ” below.

l Icons—Icons that you want printed onto the buttons. To add an icon to the
Engraving text box, click Icons, then double-click the icon to add.

l LED Behavior

l Follow Bound Device—LED behavior reflects the state of the device the
button is bound to.

l Push/Release—LED behavior reflects the button state (pressed or released).

l Push Color—Sets the LED color while the button is pressed.

l Release Color— Sets the LED color while the button is released.
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l Finish—Color of the buttons.

Advanced Properties
l Ambient Light Profiles

l Select a preset brightness profile for the keypad backlight and LEDs that
changes their brightness according to the room’s ambient light. You can also
select Fully Customized and manually set each brightness level according to
ambient lighting.

l Backlight Color—Sets the keypad’s backlight color. If you don’t want a
keypad backlight, keep the default setting (black).

l Sensing—The ambient sensing mode and follow source are displayed in the
Sensing window.

l Mode—The ambient light sensing modes are: Independent (using the light's
own sensor), Source (another light is using this light's sensor) or Follower
(using the sensor from another light). If Mode is Follower, the source device is
listed.

l In Connections, select the lighting devices to be the Source device. Connect
the Ambient Light Level (Source) connection in Control Outputs to each
Follower light or keypad.

l Network—(wireless keypads only) Displays the MAC address and firmware
version of the selected device. These fields are not editable.

l Replace Legacy Control4 Device

l Replace Keypad—Replaces a legacy device in your project with this new
device. After you configure this new device, click this button, select the older
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device in the mini project tree that opens, then click OK.

l Ignore device when it comes online—When selected, this checkbox tells
the system to ignore the older device when it comes back online.
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Device settings for dimmers

Properties (applies to: Keypad Dimmer, Forward Phase Dimmer, Adaptive Phase Dimmer, 0-10V Dimmer)

l Click rates

l Preset Level—The percentage of light output is used for On.

l Ramp Up—The time it takes to reach the preset On level.

l Ramp Down—The time it takes to reach 0% (Off).
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l Hold Ramp Rates

l Up—The rate in seconds for reaching the Max On level from an Off state
when the top button is held down.

l Down—The rate in seconds for reaching the Off state from an On state when
the bottom button is held down.

l Range Levels

l Min On—The percentage of light for the minimum “On” power level. The
default is 0. The functional minimum level can vary, depending on the light
type (such as incandescent, fluorescent, compact fluorescent, and LED).

This is especially important in compact fluorescent (CLF) and LED lighting
that sometimes have a minimum threshold for producing visible light that
could be anywhere from the 10-40% range. Some loads will flicker or pulse
right at their minimum threshold.

Example: A bulb doesn’t produce visible light until it reaches 20%. The
minimum On to 25% will ensure a clean On transition.

l Max On—This setting enables capping the light level for a given load below
100%, either to enhance bulb life or match the light level in a given living
space better. This is an absolute maximum level rather than the Preset On
level, which can be bypassed.

l Cold Start Values—These settings are mainly applicable to compact
fluorescent (CFL) loads. Switching from an Off state to On sometimes exhibits
a higher visible light threshold than after the CFLs have been on and have
warmed up. If a Cold Start % is set (above the Minimum On %), the dimmer
cleanly jumps to that level from Off to On. However, when the dimmer has
been on for the time period designated by the Cold Start timer, the dimmer
can ramp below the Cold Start On % to the minimum On%. 

Example: Fluorescent lights go on, warm up, and then will dim down to the
Minimum On Level % setting. Tapping the keypad on a 2-button dimmer sets
the light to its preset level. If you press and hold the button, the light checks
the Minimum On Level % setting. 

l Time— The time a light takes to warm up before it dims (ramps) down to the
Cold Start Level setting.

l Level— The light level that the bulb returns to after bulb warmup. This value
must be higher than the Min On level defined under Range Levels.

l LED Information

l Top—The On and Off LED colors for the top LED.

l Bottom—The On and Off LED colors for the bottom LED.
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l Toggle—The LED colors of the LEDs while being held down(?).

Advanced Properties
l Fault Detection

l Status—Displays the device’s current fault status. Green is normal, but red
indicates a fault.

l Reset—Resets the fault status indicator. If the fault repeats, make sure that
the load type is compatible, that the device is wired correctly, and that the
device is not damaged.

l Dimming Mode (Adaptive Phase Dimmer only)

l Ambient Light Profiles

l Select a preset brightness profile for the keypad backlight and LEDs that
changes their brightness according to the room’s ambient light. You can also
select Fully Customized and manually set each brightness level according to
ambient lighting.

l Backlight Color—Sets the keypad’s backlight color. If you don’t want a
keypad backlight, keep the default setting (black).

l Sensing—The ambient sensing mode and follow source are displayed in the
Sensing window.

l Mode—The ambient light sensing modes are: Independent (using the light's
own sensor), Source (another light is using this light's sensor) or Follower
(using the sensor from another light). If Mode is Follower, the source device is
listed.

l In Connections, select the lighting devices to be the Source device. Connect
the Ambient Light Level (Source) connection in Control Outputs to each
Follower light or keypad.

Button Settings
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l Engraving—Text that you want printed onto the buttons. See “” in this
document. Note: When the custom engraved keycaps are installed, make
sure that the device properties in Composer HE match the device’s actual
configuration..

l Finish—Color of the buttons.

l Icons—Icons that you want printed onto the buttons. To add an icon to the
Engraving text box, click Icons, then double-click the icon to add.

l Buttons Control Load—When selected, this checkbox tells the system that
the device directly controls an electrical load, such as a light fixture.

l LEDs Follow Load—When selected, this checkbox tells the dimmer’s LEDs to
indicate the electrical load status.

l Use as 2 Button Keypad—When selected, this checkbox allows you to
configure and program the device as a 2-button keypad, and a new section “2
Button Keypad Settings” appears.

l Hide From Nav—When selected, this hides the keypad from any Navigator.
Navigators must be refreshed for this setting to take effect.

2 Button Keypad Settings (visible only when “Use as 2 Button Keypad” option is selected)

l Button—Select the button to configure.

l LED Behavior

l Follow Bound Device—LED behavior reflects the state of the device the
button is bound to.

l Follow Load—LED behavior reflects the state of the lighting load (on or off).

l On Color—Sets the LED color when the controlled load is on.

l Off Color— Sets the LED color when the controlled load is off.

l Push/Release—LED behavior reflects the button state (pressed or released).

l Push Color—Sets the LED color while the button is pressed.

l Release Color— Sets the LED color while the button is released.

Energy Information (view only)

l Minutes Off—Elapsed minutes since device was turned off.

l Minutes On—Elapsed minutes since device was turned on.

l Minutes On Today—Total minutes device has been on for the current day.

l Current Power—Power being consumed by the device at the present time.

l Energy Used—Total watt hours consumed by the device over its lifetime.
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l Energy Used Today—Watt hours consumed by the device for the current
day.

Network—The current MAC address and firmware version of the selected device. These fields are not
editable.

Replace Legacy Control4 Device
l Replace Light—Replaces a legacy device in your project with this new device.
After you configure this new device, click this button, select the older device
in the mini project tree that opens, then click OK.

l Ignore device when it comes online—When selected, this checkbox tells
the system to ignore the older device when it comes back online.

Configuring the Keypad Dimmer’s buttons

When you add a new lighting Keypad Dimmer, a “Keypad” proxy is added
underneath the Keypad Dimmer in the project tree.

To configure the Keypad Dimmer’s buttons:

1. Add the keypad to your project tree, then identify it. For instructions, see “ How to add
devices to a project.”

167



Composer Pro User Guide

2. In the System Design view, select the device. The device’s Properties tab opens.

3. In the Button Settings area, click and drag the appropriate Keypad Parts items to the Assembled Keypad
example until the example matches the desired keypad configuration.

Tips:
l The Down/Up buttons can be placed only in the bottom slot and cannot have
custom engraving.

l Drag the desired button to the top slot of the range where you want the button
positioned.

4. Configure the settings described below.
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5. Click Apply to… to apply the changes to other lighting devices.

l If you entered text for custom engraving, go to “Ignore device when it comes
online—When selected, this checkbox tells the system to ignore the older
device when it comes back online.”—When selected, this checkbox tells the
system to ignore the older device when it comes back online.

Device settings for switches

Properties (applies to new lighting Switch C4-SW120277)

l LED Information

l Top—The On and Off LED colors for the top LED.

l Bottom—The On and Off LED colors for the bottom LED.

l Toggle—The LED colors of the LEDs while being held down.

Advanced Properties
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l Fault Detection

l Status—Displays the device’s current fault status. Green is normal, but red
indicates a fault.

l Reset—Resets the fault status indicator. If the fault repeats, make sure that
the load type is compatible, that the device is wired correctly, and that the
device is not damaged.

l Ambient Light Profiles

l Select a preset brightness profile for the switch backlight and LEDs that
changes their brightness according to the room’s ambient light. You can also
select Fully Customized and manually set each brightness level according to
ambient lighting.

l Backlight Color—Sets the switch’s backlight color. If you don’t want a switch
backlight, keep the default setting (black).

l Button Settings

l Engraving—Text that you want printed onto the switch. See “Ordering
keycap engraving” in this document. Note:When the custom engraved
keycaps are installed, make sure that the device properties in Composer Pro
match the device’s actual configuration.

l Finish—Color of the switch.

l Icons—Icons that you want printed onto the buttons. To add an icon to the
Engraving text box, click Icons, then double-click the icon to add.

l Buttons Control Load—When selected, this checkbox tells the system that
the device directly controls an electrical load, such as a light fixture.

l LEDs Follow Load—When selected, this checkbox tells the dimmer’s LEDs to
indicate the electrical load status.

l Use as 2 Button Keypad—When selected, this checkbox allows you to
configure and program the device as a 2-button keypad, and a new section “2
Button Keypad Settings” appears.

l Hide From Nav—When selected, this hides the switch from any Navigator.
Navigators must be refreshed for this setting to take effect.

l 2 Button Keypad Settings (visible only when “Use as 2 Button Keypad”
option is selected)

l Button—Select the button to configure.

l LED Behavior

l Follow Bound Device—LED behavior reflects the state of the device the
button is bound to.
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l Follow Load—LED behavior reflects the state of the lighting load (on or off).

l On Color—Sets the LED color when the controlled load is on.

l Off Color— Sets the LED color when the controlled load is off.

l Push/Release—LED behavior reflects the button state (pressed or released).

l Push Color—Sets the LED color while the button is pressed.

l Release Color— Sets the LED color while the button is released.

l Energy Information (view only)

l Minutes Off—Elapsed minutes since device was turned off.

l Minutes On—Elapsed minutes since device was turned on.

l Minutes On Today—Total minutes device has been on for the current day.

l Current Power—Power being consumed by the device at the present time.

l Energy Used—Total watt hours consumed by the device over its lifetime.

l Energy Used Today—Watt hours consumed by the device for the current
day.

l Network—The current MAC address and firmware version of the selected
device. These fields are not editable.

l Replace Legacy Control4 Device

l Replace Light—Replaces a legacy device in your project with this new device.
After you configure this new device, click this button, select the older device
in the mini project tree that opens, then click OK.

l Ignore device when it comes online—When selected, this checkbox tells
the system to ignore the older device when it comes back online.
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Changing LED colors on a switch or dimmer
After you verify that your connections are correct in Composer Pro, you can set
the properties and configure the system to meet the home control needs.

To change the LED colors on a switch or dimmer:

1. In the project tree, select the Switch or Dimmer object for the properties to appear. 

2. For each LED light, click the color box to set a different color for the On and Off states. To control the Bottom
LED color, use the drop-down menu.

l Top Color On—The LED color for the Top LED when the LED state is On.

l Top Color Off—The LED color for the Top LED when the LED state is Off.

l Bottom Color On—The LED color for the Bottom LED when the LED state is
On.

l Bottom Color Off—The LED color for the Bottom LED when the LED state is
Off.

Tip: You can change the LED lights based on programming. See the
Programming view > Switch or Dimmer objects for the events available. Also,
see the actions available for both switch and dimmer.

Outlet Lighting
Outlet lighting lets you add home automation to light fixtures that plug into power outlets.
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Configure a Wireless Outlet Switch V2
Use the Composer Pro System Design and Connections views to configure a
Wireless Outlet Switch.

Configure and use the Wireless Outlet Switch and its plugged-in device to:
l Control a plugged-in audio/video component (such as a DVD player or VCR)
or other electrical equipment controlled by IR.

l Control power to a plugged-in relay device (such as a pump) or other
household appliances.

l Switch a plugged-in lamp to On or Off. 

Each Wireless Outlet Switch has two outlets: Outlet 1 and Outlet 2. When the
Wireless Outlet Switch is plugged into an outlet oriented as shown below, Outlet 1
is on the left and Outlet 2 is on the right.

Prerequisites
l Ensure that the Wireless Outlet Switch is installed as directed in the Control4
Wireless Outlet Switch Installation Guide available on the Dealer Portal.

l Ensure that your project has a controller added and identified in the Control4
system.

To add and configure a Wireless Outlet Switch:

IMPORTANT TIP: When configuring the Wireless Outlet Switch, add two drivers:
one for the Wireless Outlet Switch and one for the plugged-in device. In addition,
define the connection between these two devices In the Connections view >
Control/AV tab. 

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure
that theWireless Outlet Switch V2 driver is added to the project tree.
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2. Select the Wireless Outlet Switch that has been added to your project, then configure these settings in the
Properties tab:

LEDs—Allows you to enable/disable the outlet indicators on top of the Wireless Outlet Switch.

Settling Time—Sets the interval following on and off commands before the system performs a status
check on the device.

Network—These are read-only fields for the switch’s network settings.

3. Add a driver for the device you want to plug into the Wireless Outlet Switch as appropriate for your use
(power sensing, power controlling, or switching lamps on and off).

Power Sensing (Contact)—Using the Wireless Outlet Switch, the system can sense the power state of the
plugged-in device, and the controller can send the appropriate control commands based on the power
state. 

For a plugged-in device: 
1. Add the appropriate driver.

2. (For an AV device only, such as a DVD Player) Edit the driver to change the power management option in the
driver for the correct connection to appear in the Connections view. To do this, see the "Change Power
Management Options." For other devices, it is not necessary to edit the driver.

3. Before you can use power sensing for the plugged-in device, perform Power Learning on the Wireless Outlet
Switch for the plugged-in device on the appropriate outlet. For information about Power Learning when using
the Wireless Outlet Switch power sensing, see “Perform Power Learning” later in this section.

Power Control (Relay)—For a plugged-in device, add the appropriate driver. 

Example: Add a relay device by selecting a Pump to the project. Go to the System
Design view in the Items pane, select theMy Drivers tab >Motorization, and double-
click the Pump object.

Lighting—For a lamp, add a Non-Dimmable Light (Outlet) to the project. Go to the System Design view
in the Items pane. Select the My Drivers tab > Lighting > Outlet Lighting, and double-click the Non-
Dimmable Light (Outlet) object. 

174



Composer Pro User Guide

Note: This is the Non-Dimmable Light (Outlet) object, and not the regular Wireless
Outlet Switch V2 object.
Configure the following fields:

LED Information—Sets the colors of the keypad buttons that are bound to the light. Select Top, Bottom,
or Toggle LED colors, based on the type of keypad button binding used.

Energy Information

l Minutes Off—Minutes light has been off since going online.

l Minutes On—Minutes light has been on since going online.

l Minutes On Today—Minutes light has been on since midnight.

l Current Power—N/A.

l Energy Used—N/A.

l Energy Used Today—N/A.

4. Define the connection between the Wireless Outlet Switch and the plugged-in device.

1. Click the Control/AV tab.

2. Make a connection between the Wireless Outlet Switch V2 and the device that is plugged into the Wireless
Outlet Switch. Make this connection for any of these three possible uses: power sensing (contact), power
control (relay), and switching a lamp On or Off.

3. In the Connections view, select the device that is plugged into the Wireless Outlet Switch.

4. From the top screen, drag the appropriate connection to the Wireless Outlet Switch
connection on the bottom screen. 
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Example: Connection between the Wireless Outlet Switch and the light outlet.

Perform power learning
To enable use of the power-sensing features, configure your Wireless Outlet Switch to read the power state of
the devices that you plug into it.

To perform power learning:

1. Follow the steps in the previous section.

2. Turn Off the device plugged into the Wireless Outlet Switch.

3. Push and hold the button on the Top panel of the Wireless Outlet Switch until the two LEDs toggle orange
On/Off, alternating back and forth.

4. Select an outlet to configure (Outlet 1 or 2) by releasing the button when the LED that corresponds to that
outlet number lights up. 

Example: If a device is plugged into Outlet 1, release the button when LED 1 lights up.
Upon doing so, the LED you chose flashes orange, indicating that the Wireless Outlet
Switch is learning a steady state of the device (such as On or Off). When the LED turns
solid orange, the Wireless Outlet Switch has learned the steady state, but has not yet
determined whether the state is On or Off. 

5. With the LED now solid orange, turn the device plugged into the Wireless Outlet Switch to an On state. The
LED again flashes orange while the Wireless Outlet Switch is learning the On state of the device. When
learning completes, the LED glows solid orange again to indicate the Wireless Outlet Switch has learned the
steady state.

6. With the LED now solid orange again, turn the device Off. The LED flashes orange to indicate the Wireless
Outlet Switch is waiting for a steady state. When the device reaches a steady state, the LED glows red to
indicate the Wireless Outlet Switch has learned the Off state.

7. With the LED now solid red, turn the device On again. The LED flashes orange to indicate it is waiting for a
steady state. When the device reaches a steady state, the LED glows green to indicate the Wireless Outlet
Switch has learned the On state.

8. With the LED now solid green, press the button on the Wireless Outlet Switch one time to save and exit the
Power Learning mode. 

IMPORTANT TIP: You can use a quick button press during any step of this process
prior to the LEDs turning solid red or green to exit the Learning mode without saving. 
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9. Repeat the steps to configure the other outlet (Outlet 1or 2) as needed for any additional plugged-in device. 

Note: To unlearn a device, press the button nine times, but use with care; this will reset
both outlets.
Configure a Wireless Outlet Switch for power-sensing AV devices
Use the Wireless Outlet switch and its plugged-in device to:

l Control a plugged-in audio/video component (such as a DVD player or VCR)
or other electrical equipment controlled by IR.

l Control power to a plugged-in relay device (such as a pump) or other
household appliances.

l Switch a plugged-in lamp On or Off.

The instructions below describe how to configure an Outlet Switch in Composer Pro for a Samsung television.
For instructions about how to configure the other actions, see “ Configure a Wireless Outlet Switch V2.” 

Each Wireless Outlet Switch has two outlets: Outlet 1 and Outlet 2. When the Wireless Outlet Switch is
plugged in to the wall, Outlet 1 is on the left and Outlet 2 is on the right.

IMPORTANT! When configuring the Wireless Outlet Switch, you need to add
two drivers:

l One for the Wireless Outlet Switch

l One for the plugged-in device

In addition, define the connection between these two devices in the Connections view > Control/AV tab.

Prerequisites
1. Ensure that your project has a Control4 controller added and identified on the Control4 system.

2. Ensure that the Wireless Outlet Switch object is added to the project tree, and is identified on the Control4
system.

3. Ensure that the AV device, for example, the Samsung Television object, is added and configured for the
device.
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To configure a Wireless Outlet Switch to use an AV device:

Select the Power Codes
1. In the project tree, right-click, for example, Samsung Television and select Edit Driver. The Driver Wizard

opens.

2. In the Driver Wizard, check Has power feedback.

3. Change the Power Management option to Contact sensor; ensure that the Send toggle code is selected.

4. Click Codes.

1. In Codes under Default Commands, make sure Power On and Power Off, or Power Toggle items are not
checked. If they are, any programming you do in conjunction with power using the Wireless Outlet Switch and
the television is invalid.

2. Click Finish.

3. Click next to close the window.

IMPORTANT! Don’t click back to check if the selection was saved because it refreshes
the screen; in that case, you will need to redefine what you just defined.

Define the connection

5. Define the connection between the Wireless Outlet Switch and the plugged-in device (Samsung Television).

6. To do this, in the Connection > Control & Audio Video Connections pane select the Samsung Television
that is plugged into the Wireless Outlet Switch.

7. From the top screen drag the Contact Sensor connection to the correct sensor on the Wireless Outlet Switch
in the bottom screen.

8. Before you can use power sensing for the plugged-in device, perform Power Learning on the Wireless Outlet
Switch for that plugged-in device on the appropriate outlet.

1. Turn off the device plugged into the Wireless Outlet Switch.

2. Push and hold the button on the top panel of the Wireless Outlet Switch until the two LEDs toggle orange
On/Off, alternating back and forth.
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3. Select an outlet to configure (Outlet 1 or 2) by releasing the button when the LED that corresponds to that
outlet number lights up.

Example: If a device is plugged into Outlet 1, release the button when LED 1 lights up.
The LED you chose flashes orange, indicating that the Wireless Outlet Switch is
learning a steady state of the device (such as On or Off). When the LED turns solid
orange, the Wireless Outlet Switch has learned the steady state, but has not yet
determined whether the state is On or Off.

4. With the LED now solid orange, turn the device plugged into the Wireless Outlet Switch On. The LED
again flashes orange while the Wireless Outlet Switch is learning the On state. When the learning completes,
the LED glows solid orange again to indicate the Wireless Outlet Switch has learned the steady state.

5. With the LED now solid orange again, turn the device Off. The LED flashes orange to indicate the Wireless
Outlet Switch is waiting for a steady state. When the device reaches a steady state, the LED glows red to
indicate that the Wireless Outlet Switch has learned the Off state.

6. With the LED now solid red, turn the device On again. The LED flashes orange to indicate it is waiting for a
steady state. When the device reaches a steady state, the LED glows green to indicate the Wireless Outlet
Switch has learned the On state.

7. With the LED now solid green, press the button on the Wireless Outlet Switch one time to save and exit the
Power Learning mode.

Tip: Use a quick-button press during any step prior to the LEDs turning solid red or
green to exit the Power Learning mode without saving.

9. Repeat the steps to configure the other outlet (Outlet 1or 2) as needed for any additional plugged-in device.

10. To unlearn a device, press the button nine times, but use with care; as this will reset both outlets.

Configure a Wireless Outlet Dimmer V2
Use the System Design and Connections views to configure a Wireless Outlet Dimmer V2. Configure the
Wireless Outlet Dimmer to control and dim lamps.

Prerequisites
l Ensure that the Wireless Outlet Dimmer is installed and set up as directed in
the Control4 Wireless Outlet Dimmer Installation Guide available on the
Dealer Portal.

l Ensure that your project has a Control4 controller added and identified on
the Control4 system.

To add and configure a Wireless Outlet Dimmer:

Note: Each Wireless Outlet Dimmer has two outlets: Outlet 1 and Outlet 2. When
the Wireless Outlet Dimmer is plugged into an outlet and oriented as shown
below, Outlet 1 is on the left and Outlet 2 is on the right.
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1. In the Items pane > My Drivers tab > Lighting > Outlet Lighting double-click the Wireless Outlet Dimmer V2
object driver to add it to the project.

2. Double-click the Dimmable Light (Outlet) object to add a light to the outlet. Repeat if you want to add
another.

3. Ensure that at least two objects are added to the project tree:

l One for the Wireless Outlet Dimmer

l One other object representing Outlet 1 (plus another, if you want to use
Outlet 2).

4. To configure the properties, click System Design. In the project tree, select the
Wireless Outlet Dimmer V2 object to view the device properties.

l LEDs—Allows you to enable/disable the outlet indicators on top of the
Wireless Outlet Dimmer.

l Network—These are read-only fields for the switch’s network settings.

5. Add a driver for the device you want to plug into the Wireless Outlet Dimmer as appropriate for your use. 

To add a lamp, add a Dimmable Light (Outlet) to the project. Go to the System Design view in the Items
pane. Select the My Drivers tab > Lighting > Outlet Lighting, and double-click the Dimmable Light
(Outlet) object. 
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Note: This is the Dimmable Light (Outlet) object, and not the regular Wireless Outlet
Dimmer V2 object.
Configure the following fields:

Dimmer Information
l Click Rates

l Preset Level—The percentage of the load to which the dimmer ramps when turned
on.

l Ramp Up—The rate the light ramps from off to on when the button is clicked.

l Ramp Down—The rate the light ramps from on to off when the button is clicked.

l Hold Ramp Rates

l Up—The time, in seconds, it takes the light to ramp to 100% when a button
controlling the light is pressed and held.

l Down—The time, in seconds, it takes the light to fade to 0% when a button
controlling the light is pressed and held.

LED Information—Sets the colors of the keypad buttons that are bound to the light. Select Top, Bottom,
or Toggle LED colors, based on the type of keypad button binding used.
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Energy Information
l Minutes Off—Minutes light has been off since going online.

l Minutes On—Minutes light has been on since going online.

l Minutes On Today—Minutes light has been on since midnight.

l Current Power—N/A.

l Energy Used—N/A.

l Energy Used Today—N/A.

6. Define the connection between the Wireless Outlet Dimmer and the plugged-in device.

1. Click the Control/AV tab.

2. Make a connection between the Wireless Outlet Dimmer V2 and the device that is plugged into the Wireless
Outlet Dimmer.

3. In the Connections view, select the device that is plugged into the Wireless Outlet Dimmer.

4. From the top screen, drag the appropriate connection to the Wireless Outlet Dimmer
connection on the bottom screen. 

Example: Connection between the Wireless Outlet Dimmer and the light outlet.

Centralized Lighting
Centralized Lighting lets you install a lighting control central panel in a
mechanical room for new construction. Along with terminal blocks, the 8-
Channel Dimmers, 8-Port Ethernet switches, 8-Channel 0-10V Dimmers, and 8-
Channel Relay modules can be installed in these panels and connected to
dimmers and switches in all rooms of the house. With any Navigator, you can
control lights in any room or in the entire house, while eliminating wall clutter.

The products in the Centralized Lighting family include:
l 5-Slot Panel (C4-DIN-5PAN)

l 2-Slot Panel (C4-DIN-2PAN)

l 8-Channel Dimmer (C4-DIN-8DIM-E)

l 8-Port Ethernet Switch (C4-DIN-8ESW-E)
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l 8-Channel Relay (C4-DIN-8REL-E)

l 8-Channel 0-10V Dimmer (C4-DIN-8TV-E)

l Bus Power Supply (C4-DIN-BPS)

l Bus Ethernet Gateway, DIN Rail (C4-DIN-BEG)

l 4-Channel Bus Dry Contact Input (C4-BDCI4)

Each device you install needs to be:

1. Added to the project.

2. Identified (except for the panels and 8-Port Ethernet Switch).

3. Configured.

See the following sections for details. Configure the light properties first (next section), and then configure
each of the modules after that.

To learn how to design, plan, set up, and install the Centralized Lighting products, see the Centralized Lighting
information under Lighting on the Dealer Portal.

Tip: Use the Advanced Lighting Scenes and Light Properties agents with
Centralized Lighting.

Tip: Also refer to “Configuring user interfaces” for Centralized Lighting keypad
configurations.

Adding Centralized Lighting to your project
Use the System Design view to add dimmable, non-dimmable, and 0-10V lights.

l Dimmable light—Use for any line-voltage dimmable light. Connect only to an
8-Channel Dimmer.

l Non-dimmable light—Use for non-dimmable lights including non-dimmable
CFLs and fluorescents. Connect to an 8-Channel Relay or 8-Channel Dimmer
if the wattage is low enough.

l 0-10V light—Use for 0-10V lights (fluorescent lights and LEDs). Connect to an
8-Channel 0-10V Dimmer and an 8-Channel Relay at the same time).

Ensure that a project has been created using Virtual Director and rooms have been added. Refer to the
Control4 training or the Centralized Lighting Quick Start Guide on the dealer portal for details.

To add a Centralized Lighting device:

1. To add the drivers, see “ How to add devices to a project”. Ensure that the Light drivers are added to the
project tree (see the next step).

2. Start Composer Pro and connect to a Director.

3. Click System Design.
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4. In the Items pane, click the MyDrivers tab > Light V2 > Dimmable Light (Panelized), Non-Dimmable Light
(Panelized), or 0-10V Light (Panelized) to add the lights to the project tree.

5. (Optional) Rename the lights to something meaningful in the room, for example, “Overhead Lights.”

Next, you need to configure the light’s properties.

Configure light properties for Centralized Lighting
Use the System Design view to configure dimmable, non-dimmable, and 0-10V
lights.

To add and configure a CentralizedLighting device:

1. In the project tree, select the light, then make changes to the device in the Properties pane.

Tip: Before you do anything else, set the values for the Load # and Watts. For your
convenience, we recommend that you add all of the lights to the project first, and then
go to Agents and add the Light Properties agent. This will bring up a table with all of
your lights. You can then add all of the Load #s and Watts to that page, eliminating the
need to go into the properties for each light and configure these two values individually.

2. To save your changes, click Set.
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Set Dimmable Light properties

Properties: Dimmer Information
l Click Rates

l Preset Level—The percentage of the load to which the dimmer module
ramps when turned on.

l Ramp Up—The rate the light ramps from off to on when the button is clicked.

l Ramp Down—The rate the light ramps from on to off when the button is
clicked.

l Hold Ramp Rates

l Up—The time, in seconds, it takes the load to ramp to 100% when a button
controlling the load is pressed and held.
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l Down—The time, in seconds, it takes the load to fade to 0% when a button
controlling the load is pressed and held.

l Range Levels. Setting the Range Levels smooths out the dimming curve
between the minimum and maximum values. This provides a much better
dimming experience, particularly with LED lights.

l Min On—The minimum dimmed level, for example, 10%.

l Max On—The maximum dimmed level where the light will not get any
brighter, for example, at 80%, the light will never get brighter than that.

l Cold Start Values. Many dimmable fluorescents and some LEDs require an
initial burst of energy to get them to turn on. In this case, you could set the
Time to 500 milliseconds and the Level to 50%.

l Time—Use the arrows selection box to select the time in milliseconds. The
default is 0. This is the length of time a light takes to warm up before it dims
down to the Cold Start Level setting.

l Level—Use the arrows selection box to select the minimum cold start % light
level in 1% increments.

l LED Information—The virtual LED colors used when a keypad button is
bound to the load. Select Top, Bottom, or Toggle LED Colors.

Advanced Properties
l Options

l Load #—The Load number or circuit number may be specified in the lighting
plan. Adding that information here will provide the link from the lighting plan
to the project and then to the reports that must be generated later (see
"Reports " in this document for details). If the lighting plan doesn't include
load numbers it's a good idea to create a unique load number for each load
leg. To do this, assign a number for each floor (e.g., Basement = 1, Main = 2).
Assign a number for each room on the floor (e.g., Kitchen=01, Master
Bedroom = 02), and add a number for each light in the room (e.g., 01, 02, 03,
etc.), so the load number would look something like this: '02-01-03.’ The load
number must be unique for each Panelized Lighting light.

l Watts—The wattage value of the light (or collection of lights in the load leg).
You must enter this value prior to connecting the light to a module to ensure
that the wattage calculations are correct and that the module does not
overload. Example: the light leg controls six can lights in the Kitchen; each
can is 100 watts. In this case, enter 600 watts (6 x 100).

l Override Level (%)—Defines the level or on/off state that the dimmer load
will be set to when the module override button is pressed or when the
auxiliary override is engaged.
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l Dimming Mode (8-Channel Dimmer only)—Defaults to Autodetect until the
dimmer detects the load type and sets the forward or reverse-phase
dimming mode appropriately. LEDs usually auto detect as reverse-phase.
Some LEDs work better in forward-phase. Experiment with forward and
reverse phase after installation to see which option works the best.

l Detected—(8-Channel Dimmer only). Indicates whether forward-phase or
reverse-phasedimming is detected when the dimming mode is set to
Autodetect.

l Use Power Booster—(8-Channel Dimmer only). Select this option as a power
booster that will be used to control the light. Power boosters allow loads
greater than the maximum wattage for individual channels on the 8-Channel
Dimmer to be properly dimmed. Selecting the Power Booster option
automatically changes the wattage to 25W for the load calculations, and
indicates in the reports that a power booster should be used.

l Energy Information

l Minutes Off—The number of minutes that the load has been off since the
dimmer module was last reset.

l Minutes On—The number of minutes that the load has been on since the
dimmer module was last reset.

l Minutes On Today—The number of minutes that the load has been on today.

l Current Power—The current power being used by the load (in watts).

l Energy Used—The total number of watt hours used by the load since the
device was last reset.

l Energy Used Today—The total number of watt hours used by the load from
12:00 AM until 11:59 PM today.

Non-Dimmable properties
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Properties: LED Information

l The virtual LED colors used when a keypad button is bound to the load.
Select Top, Bottom, or Toggle LED Colors.

Advanced Properties
l Options

l Load #—The Load number and circuit number may be specified in the
lighting plan. Adding that information here will provide the link from the
lighting plan to the project and then to the reports that must be generated
later (see "Creating Reports" in this document for details). If the lighting plan
doesn't include load numbers, it's a good idea to create a unique load
number for each load leg. To do this, assign a number for each floor (e.g.,
Basement = 1, Main = 2). Assign a number for each room on the floor (e.g.,
Kitchen=01, Master Bedroom = 02), and add a number for each light in the
room (e.g., 01, 02, 03, etc.). So the load number would look something like this:
'02-01-03.’ The load number must be unique for each Panelized Lighting
device.

l Watts—The wattage value of the light (or collection of lights in the load leg).
You must enter this value prior to connecting the light to a module to ensure
that the wattage calculations are correct and that the module does not
overload.

Example: The light leg controls six can lights in the Kitchen; each can is
100 watts. In this case, enter 600 watts (6 x 100).

l Override Level (%)—Defines the level or on/off state that the dimmer load
will be set to when the module override button is pressed or when the
auxiliary override is engaged.

l Energy Information

l Minutes Off—The number of minutes that the load has been off since the
dimmer module was last reset.

l Minutes On—The number of minutes that the load has been on since the
dimmer module was last reset.

l Minutes On Today—The number of minutes that the load has been on today.

l Current Power—The current power being used by the load (in watts).

l Energy Used—The total number of watt hours used by the load since the
device was last reset.

l Energy Used Today—The total number of watt hours used by the load from
12:00 AM until 11:59 PM today.
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0-10V properties

Properties
l Dimmer Information

l Click Rates

l Preset Level—The percentage of the load to which the dimmer module
ramps when turned on.

l Ramp Up—The rate the light ramps from off to on when the button is clicked.

l Ramp Down—The rate the light ramps from on to off when the button is
clicked.

l Hold Ramp Rates

l Up—The time, in seconds, it takes the load to ramp to 100% when a button
controlling the load is pressed and held.
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l Down—The time, in seconds, it takes the load to fade to 0% when a button
controlling the load is pressed and held.

l Range Levels

l Min On—The minimum dimmed level, for example, 10%.

l Max On—The maximum dimmed level where the light will not get any
brighter, for example, at 80%, the light will never get brighter than that.

l Cold Start Values

l Time—Use the arrows selection box to select the time in milliseconds. The
default is 0. This is the length of time a light takes to warm up before it dims
down to the Cold Start Level setting.

l Level—Use the arrows selection box to select the minimum cold start % light
level in 1% increments.

l LED Information—The virtual LED colors used when a keypad button is
bound to the load. Select Top, Bottom, or Toggle LED Colors.

Advanced Properties
l Options

l Load #—The load number and circuit number may be specified in the
lighting plan. Adding that information here will provide the link from the
lighting plan to the project and then to the reports that must be generated
later (see "Reports " in this document for details). If the lighting plan doesn't
include load numbers, it's a good idea to create a unique load number for
each load leg. To do this, assign a number for each floor (e.g., Basement = 1,
Main = 2). Assign a number for each room on the floor (e.g., Kitchen=01,
Master Bedroom = 02), and add a number for each light in the room (e.g., 01,
02, 03, etc.). So the load number would look something like this: '02-01-03.’
The load number must be unique for each Panelized Lighting device.

l Watts—The wattage value of the light (or collection of lights in the load leg).
You must enter this value prior to connecting the light to a module to ensure
that the wattage calculations are correct and that the module does not
overload. Example: The light leg controls six can lights in the Kitchen; each
can is 100 watts. In this case, enter 600 watts (6 x 100).

l Override Level(%)—Defines the level or on/off state that the dimmer load will
be set to when the module override button is pressed or when the auxiliary
override is engaged.

l Load Type—Select an option based on the specific type of 0-10V light being
used:

l 0-10V Regular—Used when 0V = minimum dimmed level and 10V =
maximum level. Note that most “0-10V” lights do not actually use 0-10V, they
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use 1-10V. Only select this option if you know that the light actually requires
true 0-10V control.

l 1-10V Regular—Used when 1V = minimum dimmed level and 10V = maximum
level. This is the default selection as it is the actual standard for 0-10V lights.

l 0-10V Inverted—Used when 10V = minimum dimmed level and 0V =
maximum level. (Rarely used.)

l 1-10V Inverted—Used when 10V = minimum dimmed level and 1V =
maximumlevel. (Rarely used.)

l Use External Relay—Check the box if an external relay such as a Leviton
Power Pack Relay will be used for on/off control of the 0-10V light. Uncheck if
on/off control will be provided by a Control4 Relay Module or if the 0-10V light
does not require separate on/off control. If the Use External Relay box is
checked, the 0-10V light will not be able to be connected to a Control4 Relay
Module and the reports will indicate that an external relay should be used.

Energy Information
l Note—Energy information is only provided when the 0-10V light is connected
to a Control4 Relay Module.

l Minutes Off—The number of minutes that the load has been off since the
relay module was last reset.

l Minutes On—The number of minutes that the load has been on since the
relay module was last reset.

l Minutes On Today—The number of minutes that the load has been on today.

l Current Power—The current power being used by the load (in watts).

l Energy Used—The total number of watt hours used by the load since the
device was last reset.

l Energy Used Today—The total number of watt hours used by the load from
12:00 AM until 11:59 PM today.

Configure an 8-Channel Dimmer
Use the System Design and Connections views to configure an 8-Channel Dimmer module for Centralized
Lighting.

Ensure that the 8-Channel Dimmer module (C4-DIN-8-DIM-E) is installed as directed in the Control4 8-
Channel Dimmer Installation Guide, 8-Channel Dimmer Operation and Configuration Guide, and the 8-
Channel Dimmer Wiring Guide on the Dealer Portal.

To add and configure an 8-Channel Dimmer module:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the 8-Channel
Dimmer driver is added to the project tree (see the next step). Add as many 8-Channel Dimmer drivers as
needed (eight loads per module).
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2. In the Items pane > My Drivers tab > Lighting > Panelized Lighting select the 8-Channel Dimmer to add the
driver to the project tree.

Notes: (1) Auto Discovery is available, but we recommend that you add the drivers
manually for best results. (2) It’s best to add all of the modules at the same time before
making all of the connections.

3. (Optional) Rename the module drivers to something meaningful in the room, for example, 8-Channel Dimmer
1 in the Mechanical Room.

4. (Optional) To configure the dimmer’s properties, in the project tree select the 8-Channel Dimmer object and
view the items in the Properties pane.

Dimmer Properties:

Module Information
l Nominal Voltage—(110V – 277V) The voltage of the circuit to which the
module will be connected. Measured voltage may differ slightly from nominal
voltage depending on the electrical supply. This is used for wattage
calculations when connecting loads to the module.

l Measured Voltage—Indicates the electrical voltage that the module is
measuring. Not editable.

l Frequency—Indicates the electrical frequency that the module is measuring.
Not editable.

l Temperature—View the module’s temperature.

l Overtemp Fault—View the module’s temperature fault, if displayed.

l In Control4 Panel—Check if this module will be installed in a Control4 2-slot
or 5-slot panel. Do not check if the module will be installed in a third-party
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DIN rail panel. This is used in maximum wattage calculations. Dimmers in
third-party panels must be derated with lower wattage limits.

l Auxiliary Override Switch Location—Indicates where the override switch
should be installed and wired, e.g., the Master Bedroom Closet. Type the
room’s name. This information will be included in the Module Report that can
be provided to the electrician.

l Circuits (2 maximum)—Set to 1 or 2. It’s usually best to set this value to 2 and
then reduce it to 1 if the connections made later are under the maximum
wattage for a single circuit.

l Circuit 1, 2—The breaker size for each circuit. This can be set from 10A to 20A.
Used for maximum wattage calculations.

l Arc Fault—Check with the local electrician to determine the local
requirements for arc-fault breakers. In the U.S., NEC requires arc-fault
breakers (AFCIs) for circuits serving most living areas. Some municipalities
using an older version of the code may require them only on lights in
bedrooms or not require them on lighting circuits. AFCIs are prone to
interpret dimming as a fault and nuisance trip. They are limited to only 8.3A
of dimming on the circuit. This setting is used for maximum wattage
calculations.

Channel Information
l Channel#—The channel number indicated on the module’s hardware.

l Load Name—The name of the load that is connected to the indicated
channel.

l Fault Status—Refer to the 8-Channel Dimmer Installation Guide for fault
details.

Network
l Firmware Version—Indicates the firmware driver version for this module.

l Modules Config Page—Click to open the network configuration page for the
module in your internet browser.

Configure an 8-Channel Relay
Use the System Design and Connections views to configure an 8-Channel Relay module for Centralized
Lighting devices.

Ensure that the 8-Channel Relay module (C4-DIN-8REL-E) is installed as directed in the Control4 8-Channel
Relay Installation Guide on the Dealer Portal.

To add and configure an 8-Channel Relay module:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the 8-Channel
Relay driver is added to the project tree (see the next step). Add as many 8-Channel Relay drivers as needed
(eight relays per module).
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2. In the Items pane > My Drivers tab > Lighting > Panelized Lighting select the 8-Channel Relay to add the
driver to the project tree.

Notes: (1) Auto Discovery is available for this product, but we recommend that you add
the drivers manually for best results. (2) It’s best to add all of the modules at the same
time before making all of the connections.

3. (Optional) Rename the module drivers to something meaningful in the room, for example, 8-Channel Relay 1
in the Mechanical Room.

4. (Optional) To configure the relay’s properties, in the project tree select the 8-Channel Relay object and view
the items in the Properties pane.

Relay Properties:

Module Information
l Nominal Voltage (110V – 277V)—The voltage of the circuit to which the
module will be connected. Measured voltage may differ slightly from nominal
voltage depending on the electrical supply. This is used for maximum
wattage calculations.

l Measured Voltage—Not editable.

l Frequency—Not editable.

l Temperature—View the module’s temperature.

l Overtemp Fault—View the module’s temperature fault, if displayed.

l In Control4 Panel—Check if this module is installed in a 2-slot or 5-slot panel.
Do not check if the module will be installed in a third-party DIN rail panel.
This is used in maximum wattage calculations. Relays in third-party panels
must be derated with lower wattage limits.
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l Auxiliary Override Switch Location—Indicates where the override switch
should be installed and wired, e.g., the Master Bedroom Closet. Type the
room’s name in the box.

l Circuit 1, 2, 3, 4—The breaker size for each circuit. This can be set from 10A to
20A. Used for maximum wattage calculations.

Channel Information
l Channel#—The channel number indicated on the module’s hardware.

l Load Name— The name of the load that is connected to the indicated
channel.

Network
l Firmware Version—Indicates the firmware version for this driver.

l Modules Config Page—Click to open the network configuration page for the
module in your Internet browser.

Configure an 8-Port Ethernet Switch
There are no properties to define for the 8-Port Ethernet Switch (C4-DIN-8ESW-E) driver in Composer Pro.

Configure an 8-Channel 0-10V Dimmer
Use the System Design and Connections views to configure an 8-Channel 0-10V Dimmer module.

Ensure that the 8-Channel 0-10V Dimmer module (C4-DIN-8TV-E) is installed as directed in the Control4 8-
Channel 0-10V Dimmer Installation Guide and 8-Channel 0-10V Dimmer Wiring Guide available on the Dealer
Portal.

To add and configure an 8-Channel 0-10V Dimmer module:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the 8-Channel 0-
10V Dimmer module driver is added to the project tree (see the next step). Add as many 8-Channel 0-10V
Module drivers as needed (eight dimmers per module).

2. In the Items pane > My Drivers tab > Lighting select the 8-Channel 0-10V Module to add the driver to the
project tree.

Notes: (1) Auto Discovery is available, but we recommend that you add the drivers
manually for best results. (2) It’s best to add all of the modules at the same time before
making all of the connections.

3. (Optional) Rename the module drivers to something meaningful in the room, for example, 8-Channel 0-10V
Module 1 in the Mechanical Room.

4. (Optional) To configure the dimmer’s properties, in the project tree select the 8-Channel 0-10V Module
object and view the items in the Properties pane.

0-10V Dimmer Properties:
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Module Information
l Temperature—View the module’s temperature.

l Overtemp Fault—View the module’s temperature fault, if displayed.

l Auxiliary Override Switch Location—Indicates where the override switch
should be installed and wired, e.g., the Master Bedroom Closet. Type the
room’s name in the box.

Channel Information
l Channel#—The channel number indicated on the module’s hardware.

l Load Name—The load name used.

Network
l Firmware Version—Indicates the firmware driver version for this module.

l Modules Config Page—Click to open the network configuration page for the
module in your internet browser.

Configure a Bus Ethernet Gateway
Use the System Design and Connections views to configure a Bus Ethernet
Gateway.

To add and configure a Bus Ethernet Gateway:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the Bus Ethernet
Gateway driver is added to the project tree (see the next step).
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2. In the Items pane > My Drivers tab > Lighting select the Bus Ethernet Gateway to add the driver to the
project tree.

3. Click each button to define its name and behavior.

Bus Ethernet Gateway Properties:

Unidentified Devices
l Add Keypad—Allows you to indicate which keypads are to be bound to this
keypad. This is a convent way of doing mass bindings, instead of having to
use the Connection page. Only keypads bound to the gateway will appear in
the two project trees.

l Identify Keypad—Identifies the currently selected keypad. A window will
appear with further instructions.

Identified Devices
l Unidentify Keypad—Un-identifies the currently selected keypad. Un-
identifying resets it to its default state.

Network Settings
l MAC Address—Read-only field displaying the network’s MAC address of the
device.
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l Firmware Version—Indicates the firmware version for the device.

l Use DHCP—Select this option to use DHCP, then click Apply Settings. The
Client ID appears in the read-only field.

l Use Static IP—Select this and enter values for the IP Address and the Router
Address to use Static IP, then click Apply Settings.

l Volts—(read-only) Displays the voltage rating coming from the device. Green
background=ok, yellow=caution, red=warning.

l Upgrading—(read-only, normally blank) If updating, displays a progress bar
and ID of the upgrading device.

l Blink Keypads—For debugging. Set the number of seconds you want the
keypads to blink, then click Blink Keypads.

l Show Traffic—Displays network traffic crossing the gateway. Clear Traffic
clears the log, and Save Traffic allows you to save the log.
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Configuring user interfaces
Use the System Design and Connections views to configure Navigators for the Control4 system.

These subsections provide information about configuring system remote controls and touch screens:

l “Configure System Remote Control SR-150B”

l “Configure System Remote Control Version 3, SR-250”

l “Configure a 7” Portable Touch Screen with Camera”

l “Configure a 7” Portable Touch Screen”

l “Configure a 7” Tabletop or Wall-Mounted Touch Screen”

l “Configure a 7” In-Wall Touch Screen with Camera”

l “Configure a 5” or 7” In-Wall Touch Screen”

l “Configure Mobile Devices or PCs/Tablets as Navigators”

l “Configure a Door Station”

Change the order and visibility of devices
You can modify the order that your customer's devices will show up in Navigators and hide or display devices
by sorting the devices in the major Experience Menus: Comfort, Lights, Listen, Security, Shades, and Watch
and in the Submenu FIlters: Cameras, Channels, Lighting Scenes, Locks & Sensors, Movies, Music, Pools,
and Stations.

To change the order or visibility of your customer's devices:

1. In the project tree, click the room to control.

2. Click Apply To....

3. From the Menu (left side), select the function to change; for example, Watch or Listen.

4. Select the item in Device Visibility and Display Order, and then click Modify.

5. Change to the desired order, and then click OK.
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You can also apply these settings to all rooms or to chosen rooms in the project.

To change the order or visibility of your customer's devices and apply to multiple rooms:

1. Follow the steps above to set the desired order in each menu and submenu.

2. Check the box next to each category in the Categories list (for example Watch and Listen) to apply the
settings for those categories to multiple rooms.

3. Check the box next to each room, floor, building, location, or the project to apply the settings for the chosen
categories to those rooms.

4. Click on Apply these settings to apply the visibility and display order settings from the chosen categories to
the chosen rooms..

Enable Equalizer Settings
You can modify the order that your customer's devices will show up in Navigators and hide or display devices
by sorting the devices in the major Experience Menus: Comfort, Lights, Listen, Security, Shades, and Watch
and in the Submenu FIlters: Cameras, Channels, Lighting Scenes, Locks & Sensors, Movies, Music, Pools,
and Stations.
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To show Equalizer Settings in your customer's devices:

1. In the project tree, click the room you want to show Equalizer settings.

2. Click on the Navigator tab.

3. Under Equalizer Settings, click the box next to Show EQ in Navigator.

4. To enable the Equalizer settings in more than one room, click Apply To..., select the rooms, and click OK.

Important! Equalizer settings require a supported device connected to the
audio end-point for the room. Supported devices include analog audio out of
an EA controller, Triad One, and Triad audio matrix switches.

Configuring remote controls
Configure System Remote Control SR-150B
Use the System Design and Connections views to add and identify this device.

Ensure that the SR-150B is installed as directed in the Control4 System Remote
Control SR-150B Setup Guide.

To add and configure an SR-150B:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the System
Remote Control SR-150 driver is added to the project tree. 

2. (Optional) To configure the properties, click System Design.

3. In the project tree, select the System Remote Control object.

4. View and change the properties in the Properties pane. 

Note: Press any button on the system remote control to display the configurable property
values in the Properties pane. Because the SR-150B has no window, some of the options
below are not supported in the SR-150B. 

Modifiable properties include:
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l Screen Backlight—Not used.

l Keypad Backlight—Lets you set the light level of the backlight. The default is
0%. Click Set Level.

l Sleep Mode—Lets you configure sleep mode settings. The default is five
seconds, but can be extended to 60 seconds. SelectWake on Movement if
you want the remote control to wake up when moved.

l Batteries—Lets you view the battery level on your remote control.

l Enable Recharge Station—Check this box if you received a Remote
Recharging Station with a remote. This feature updates your existing remote
to recognize the new rechargeable battery.

l Network—Lets you view the remote control’s Zigbee channel, gateway, MAC
address and firmware version.

l MAC—Displays the remote’s own MAC address.

l Firmware Version—Displays the current firmware version of the remote
control.

l Watch/Listen Button Behavior—If you select one of the options below, the
following action occurs when you press theWatch button.

l No Action—When you press theWatch button, nothing happens. This option
can be tied to programming a button (see the section below).

l Select Most Recently Used Device—Lists the last three devices (for example,
DVD player, media player, television).

5. Change the system remote control settings as needed at the physical system remote control SR-150B using
the applicable button-press sequence:

l Check Zigbee Channel—To determine the current Zigbee channel, press
Room Off, 0, 0, 3 (or Room Off, 7, 4, 7) (in that order), and then count the
blinks of Room Off. The number of blinks corresponds with the channel
number.

l Reset to Factory Defaults—To reset all settings to the factory defaults
(including Zigbee channel), press Room Off, 9, 9, 9.

Program the System Remote Control SR-150B programmable buttons

On the System Remote Control SR-150, you can program six buttons (red, green, yellow, blue, *, and #) to
perform programmed activities. The buttons can be programmed to execute any of the AV device’s macros or
IR codes or be programmed by room.

To program the buttons:

1. Ensure that you have the following devices in your project:

l Controller

l System remote control SR-150B
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l An AV device to be controlled

2. In Composer Pro, click Connections.

3. Click the Network tab. Ensure that the controller and the remote are both network identified.

4. Program the programmable buttons (Red, Green, Yellow, Blue, *, or #) either based on the selected AV
device or the selected room.

Based on AV device:
1. Click System Design.

2. Select an AV device to display the device’s Properties page. 

3. On the device’s Properties page, select Code or Macro for the button you want to program, and then select a
code or macro from the drop-down list.

4. Edit the Help text as needed, and then select Set. 

Note: Help text describes custom programming to users in the House option in any of
the Navigators. 
Example: (1) In System Design, select Disc Changer. (2) In the Red button, select
Code. (3) From the drop-down list, select Subtitle. (4) Select the Set button to create a
Subtitle button. 

Based on room:

1. Click Programming.

2. Select a room in the Device Events pane.

3. Select the Commands radio button in the <Room> Events pane.

4. Use the drop-down menu to select a command or button (example, Blue Button).
5. In the Actions pane, build the script using the items to program the actions in the selected room when the

selected command or button is used.

Configure System Remote Control SR-250
Use the System Design and Connections views to add and identify this device.

Ensure that the system remote control SR-250 is installed as directed in the Control4 System Remote Control
SR-250 Setup Guide available on the Dealer Portal.
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To add and configure an SR-250:
1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the System

Remote Control SR-250 driver is added to the project tree.

2. (Optional) To configure the properties, click System Design.

3. In the project tree, select the System Remote Control object.

4. View and change the properties in the Properties pane. 

Note: Press any button on the SR-250 to display the configurable property values in the
Properties pane.
Tip: You can also change most of these settings on the SR-250 using Info > Config. 

Modifiable properties include:

l Screen Backlight—Lets you set the light level of the screen's backlight. Select a
percentage from 0 (Off) to 100 (full brightness). The default is 100%. Click Set
Level.

l Keypad Backlight—Lets you set the light level of the keypad's backlight. Select a
percentage from 0 (Off) to 100 (full brightness). The default is 100%. Click Set
Level.

l Sleep Mode—Lets you set how long the remote control stays awake after no
activity. The default setting is five seconds, but can be extended to 60 seconds.
Select Wake on movement to wake the SR-250 up when moved.

l Batteries—Lets you view the battery level (strength in %) of your remote.

l Enable Recharge Station—Check this box if you received a Remote Recharging
Station with a remote. This feature updates your existing remote to recognize the
new rechargeable battery.

l Network—Lets you view the remote’s Zigbee channel, gateway, MAC address and
firmware version.

l Channel—Displays your Zigbee channel (1-15), which should match the Zigbee
channel set for the controller.

l Gateway—Displays the MAC address of the Zigbee server (usually your controller
unless you specify otherwise).

l MAC—Displays the remote's own MAC address.

l Firmware Version—Displays the current firmware version of the remote.

l Watch/Listen Button Behavior—If you select one of the options below, the
following action occurs when you press theWatch button.

l No Action—If you select this option and you press the Watch button, nothing
happens. This option can be tied to programming a button (see the section below).
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l Select Most Recently Used Device—Lists the last three devices (for example, DVD
player, media player, TV).

l Show Device List—Lists the source device of the selection.

5. (Conditional) Change Zigbee Channel: If you need to change the Zigbee channel to match the controller’s
channel or to improve reception, do the following on the system remote control SR-250.

If the system remote control is NOT identified, follow these steps:
1. Press buttons 2, 4, 8, 6, #, *, and then press the List button (in that order) to get into Edit mode.

2. Use the up or down arrows to pick the Zigbee channel.

3. Press Select to change the Zigbee channel.

4. Press CNCL to exit Edit mode. 

If the system remote control IS identified, follow these steps:
1. Press the List button once or twice to display the menu options.

2. Press buttons 2, 4, 8, 6, #, * and then press the List button (in that order) to get into Edit mode.

3. Use the up or down arrows to pick a Zigbee channel.

4. Press Select to change the Zigbee channel.

5. Press CNCL to exit Edit mode.

Program the SR-250 programmable buttons

On the system remote control SR-250, you can program six buttons (Red, Green,
Yellow, Blue, *, and #) to perform programmed activities. You can program these
buttons to execute any of the AV device’s macros or IR codes or they can be
programmed by room.

To program the SR-250 programmable buttons:

1. Ensure that you have the following devices in your project:
l Controller

l System remote control SR-250

l An AV device to be controlled

2. In Composer Pro click Connections.

3. Click the Network tab. Ensure that the controller and the remote are both network identified.

4. Program the programmable buttons (Red, Green, Yellow, Blue, *, or #) either based on
the selected AV device or the selected room.

Based on AV device:
1. Click System Design.
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2. Select an AV device to display the device’s Properties page.

3. On the device’s Properties page, select Code or Macro for the button you want to program, and then select a
code or macro from the drop-down list.

4. Edit the Help text as needed, and then select Set.

Note: Help text describes custom programming to users in the House option in any of
the Navigators.
Example: (1) In System Design view, select Disc Changer. (2) In the Red button, select
Code. (3) From the drop-down list, select Subtitle. (4) Select the Set button to create a
Subtitle button.
Based on room:

1. Click Programming.
2. Select a room in the Device Events pane.

3. Select the Commands radio button in the <Room> Events pane.

4. Use the drop-down menu to select a command or button (example, Blue Button).

5. In the Actions pane, build the script using the items to program the actions in the
selected room when the selected command or button is used.
Program the SR-250 Paging feature

Configure the Beep paging feature for this remote version through
programming. Use this feature to page a lost remote. You can program a keypad
or a custom button to cause the remote to beep when pressed.

To program the paging feature for this system remote control:
1. In Composer Pro, click Programming.

2. Select the event that you want to use to start the page. Example: To select a keypad button press, first select
the Keypad in the Device Event pane, and then select the button in Events.

3. In the Actions list, select System Remote Control SR-250.

4. In the Commands list, select an action below for the remote, and then drag the green
arrow to the Script pane.
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l Beep until button press—The remote beeps until you press one of its buttons.

l Beep for X seconds (<254)—The remote beeps until X seconds have elapsed
or you press one of its buttons.

l Stop Beep—The remote stops beeping.

5. Click Execute.

Configure System Remote Control SR-260
Use the System Design and Connections views to add and identify this device.

Ensure that the System Remote Control SR-260 is installed as directed in the Control4 System Remote
Control SR-260 Setup Guide available on the Dealer Portal.

To add and configure an SR-260:
1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the System

Remote Control SR-260 driver is added to the project tree.

2. (Optional) To configure the properties, click System Design.
3. In the project tree, select the System Remote Control object.

4. View and change the properties in the Properties pane.

Note: Press any button on the SR-260 to display the configurable property values in the
Properties pane.
Tip: You can also change most of these settings on the SR-260 using Info > Config.

Modifiable properties include:

l Screen Backlight—Lets you set the light level of the screen's backlight. Select
a percentage from 0 (Off) to 100 (full brightness). The default is 100%. Click Set
Level.

l Keypad Backlight—Lets you set the light level of the keypad's backlight.
Select a percentage from 0 (Off) to 100 (full brightness). The default is 100%.
Click Set Level.

l Check Light Sensor Enabled to allow the ambient light sensor to control the
backlight.

l Awake Duration—Lets you set how long the remote control stays awake after
no activity. The default setting is five seconds, but can be extended to 60
seconds.
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l Wake on Motion—Lets you set the SR-260 to wake up when moved. Choose
the desired option and click Set Level.

l Check In Interval—Lets you set how often the remote control will check in
with the Control4 system on the Zigbee network. The default is 10 seconds,
but decreasing the interval may decrease battery life. Click Set Timeout.

l Battery—Lets you view the battery level (strength in %) of your remote.

l Enable Recharge Station—Check this box if you received a Remote
Recharging Station with a remote. This feature updates your existing remote
to recognize the new rechargeable battery.

l Network—Lets you view the remote’s MAC address and firmware version.

l MAC—Displays the remote's own MAC address.

l Firmware Version—Displays the current firmware version of the remote.

l Watch/Listen Button Behavior—If you select one of the options below, the
following action occurs when you press theWatch button.

l No Action—If you select this option and you press the Watch button, nothing
happens. This option can be tied to programming a button (see the section
below).

l Select Most Recently Used Device—Lists the last three devices (for example,
DVD player, media player, TV).

l Show Device List—Lists the source device of the selection. When Show
Device List is selected, Watch and Listen items will not show in the List
Navigator menu.

l Text Color—Choose the text color to display on the SR-260. The text color will
preview in the Text Preview field. Click Set Color.

Program the SR-260 programmable buttons

On the system remote control SR-260, you can program six buttons (Red, Green,
Yellow, Blue, *, and #) to perform programmed activities. You can program these
buttons to execute any of the AV device’s macros or IR codes or they can be
programmed by room.

To program the SR-260 programmable buttons:

1. Ensure that you have the following devices in your project:
l Controller

l System remote control SR-260

l An AV device to be controlled

2. In Composer Pro click Connections.

3. Click the Network tab. Ensure that the controller and the remote are both network identified.
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4. Program the programmable buttons (Red, Green, Yellow, Blue, *, # or Custom 1/2/3) either based on the
selected AV device or the selected room.

Based on AV device:

1. Click System Design.
2. Select an AV device to display the device’s Properties page.

3. On the device’s Properties page, select Code or Macro for the button you want to program, and then select a
code or macro from the drop-down list.

4. Edit the Help text as needed, and then select Set. 

Note: Help text describes custom programming to users in the House option in any of
the Navigators. 
Example: (1) In System Design view, select Disc Changer. (2) In the Red button, select
Code. (3) From the drop-down list, select Subtitle. (4) Select the Set button to create a
Subtitle button. 
Based on room:

1. Click Programming.
2. Select a room in the Device Events pane.

3. Select the Commands radio button in the <Room> Events pane.

4. Use the drop-down menu to select a command or button (example, Blue Button or Custom 1/2/3).

5. In the Actions pane, build the script using the items to program the actions in the
selected room when the selected command or button is used.
Program the SR-260 Paging feature

Configure the Beep paging feature for this remote version through
programming. Use this feature to page a lost remote. You can program a keypad
or a custom button to cause the remote to beep when pressed.

To program the paging feature for this system remote control:
1. In Composer Pro, click Programming.
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2. Select the event that you want to use to start the page. Example: To select a keypad button press, first select
the Keypad in the Device Event pane, and then select the button in Events.

3. In the Actions list, select System Remote Control SR-260.

4. In the Commands list, select an action below for the remote, and then drag the green
arrow to the Script pane. 

l Beep until button press—The remote beeps until you press one of its buttons.

l Beep for X seconds (<254)—The remote beeps until X seconds have elapsed
or you press one of its buttons.

l Stop Beep—The remote stops beeping.

5. Click Execute.

Configuring touch screens
Configure the Intercom Proxy Properties for touch screen drivers
compatible with the Communication agent
To be compatible with the Communication agent and Intercom Proxy in OS 2.7, touch screen drivers labeled
(Communication) with an Intercom Proxy sub-driver are available in My Drivers in Composer. Drivers for the
T3 touch screens also have the Intercom Proxy sub-driver. Intercom Properties for each touch screen are
configured in this Intercom proxy portion of the driver.

Note: Existing touch screen drivers not marked “(Communication)” must be
replaced to be compatible with the Communication agent. If the Intercom
agent was previously added to the project, it must also be removed and the
Communication agent replaces it. The Communication Agent Wizard
automates this process for you. See “Communication Agent Wizard and
Migration Process” on the Knowledgebase .

To configure the Intercom properties for a touch screen:

1. In System Design, expand the driver to display the Intercom proxy portion of the driver. If the driver does not
have the Intercom proxy portion, replace the driver with one marked “(Communication).”
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2. Select the Intercom portion of the driver, and the Properties pane appears.

3. Configure the Intercom properties for the touch screen:

Appearance:

l Check the box next to Exclude from Navigator if you do not want this device to
show in the list of Intercom devices in Navigator.

Behavior:

l Play Door Chime—Check the box to enable this touchscreen to play the door chime
when a call from a Door Station is received

l Do Not Disturb—When checked, this touch screen will not receive any Intercom
calls

l Auto Answer—Check to cause the touch screen to automatically answer incoming
calls.

l Send Video—Check to automatically send video in Intercom calls.

l Monitor Mode—Enables Monitor Mode which mutes the microphone and sets Auto
Answer. This allows the screen to be used as a baby monitor, for example.

Audio Control:

l Set Ringer, Speaker, and Microphone (if available) levels.

Sip Information:

l Displays SIP information for the touch screen. The Display Name is the same as the
name of the touch screen or door station driver.

Custom Buttons:

l Check to enable a Custom Button on the Intercom display. Define the name of the
button in the Button Label field.

Alternate Camera:
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l Use Alternate Camera—Check to enable an alternate camera view during Video
Intercom calls. After you check the box, select the IP camera driver in your project
to use from the Choose System Items window that opens. Click OK to exit.

Configure a 7” or 10” T3 Series In-Wall Touch Screen
Use the System Design and Connections views to add and configure this device.

To add and configure a T3 in-wall touch screen to a project:

1. Add the C4-WALL7 or C4-WALL10 In-Wall Touch Screen driver to your project.

2. To configure the properties, click System Design.

3. In the project tree, select the T3 7" or T3 10" In-Wall Touch Screen.

4. View and change the properties in the Properties pane as needed.

Properties include:
l Network Connection—Reports the touch screen’s current network connection type.

l Back Light—Use the arrows or type numbers to set the light level, then click Set.

Advanced properties include:
l Enable Camera—Allows you to enable or disable the camera.

Configure a 7” T3 Series Tabletop Touch Screen
Use the System Design and Connections views to add and configure this device.

To add and configure a T3 tabletop touch screen to a project:

1. Add the C4-TT7 Tabletop Touch Screen driver to your project.

2. To configure the properties, click System Design.

3. In the project tree, select the T3 7" Tabletop Touch Screen.

4. View and change the properties in the Properties pane as needed.

Properties include:
l Network Connection—Reports the touch screen’s current network connection type.

l Back Light—Use the arrows or type numbers to set the light level, then click Set.

Advanced properties include:
l Enable Camera—Allows you to enable or disable the camera.

Configure a 7" In-Wall Touch Screen with Camera (C4-TW7CO)
Use the System Design and Connections views to add and configure the 7″ In-Wall Touch Screen (C4-
TW7CO) with a camera.

Note: This particular touch screen includes full duplex point-to-point Intercom
sessions, broadcast support to multiple touch screens, monitoring from the
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interface, and comes with a camera for video conferences to another device
that supports cameras. An Intercom driver and agent must be added and
configured in the Composer project before the customer can use the
Intercom functions on their touch screen. See this section, the Control4
System User Guide, and “Example: Using the Intercom agent” for details.

As of June 1, 2013, the HC-800 (C4-HC800-BL-1) and HC-250 (C4-HC250-BL-1)
ship with included support for Intercom and the Control4 app. For controllers
shipped before that time, you must purchase an Intercom and Control4 app
license for consumers who want this feature. In either case, the license must
be assigned and active on the consumer's account for the Intercom and
Control4 app to function. See Managing Dealer Accounts on MyControl4 on
the Knowledgebase for information about how to purchase and assign an
Intercom license.

Scenarios

1. The user wants to have full-duplex, room-to-room calling. In this case, the Control4
system must have at least two 7" In-Wall Touch Screens installed.

2. The user wants to broadcast a message without a response. In this case, the
Control4 system must have at least one 7" In-Wall Touch Screen installed.

3. The user wants to broadcast a message with a response. In this case, the Control4
system must have at least two 7" In-Wall Touch Screens installed.

4. The user wants to monitor the sounds in another room. In this case, the Control4 system must have at least
two 7" In-Wall Touch Screens installed.

5. The user wants to have a video conference with others. In this case, the Control4 system must have at
least two devices that support Video Intercom (7” In-Wall Touch Screen with Camera, 7” Portable Touch
Screen with Camera, or Door Station – Exterior).

Prerequisites
1. Ensure that the 7" In-Wall Touch Screen (C4-TW7CO-XX) is installed as directed in the Control4 7" In-Wall

Touch Screen Installation Guide available on the Dealer Portal.

2. Ensure that your project has a Control4 controller added and identified in the Control4
system.

To add and configure a 7" In-Wall Touch Screen with Camera:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the In-Wall 7"
Touch Screen V2 driver is added to the project tree.

Note: If this touch screen will be providing audio output, the touch screen needs to be
connected as an Audio end point for the room.

2. (Optional) To configure the properties, click System Design.

3. In the project tree, select the 7" Touch Screen object.
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4. View and change the properties in the Properties pane as needed.

Modifiable properties include:
Backlight Level—Use the up or down arrows to set the light level of the backlight. You can change the
brightness of the backlight with this option by percentage, so 100% is On at full brightness and 0% is Off.
Click Set to save your changes.

Backlight Preset Level—Lets you set the default backlight level. If you ever restart or power the touch
screen again, this is the backlight level it would go to. Click Set to save your changes.

WiFi Signal Strength (%)—If Wi-Fi is used this shows the strength of the signal. Ensure that the signal is
strong and robust if you use the Door Station for Wi-Fi. We recommend using Ethernet rather than Wi-Fi
for best results.

Notes: (1) Video Intercom usage. Although this device supports b/g/n, 802.11 b is not
recommended for Video Intercom. (2) Wireless-n is recommended for Video Intercom.
See “Wireless Network Limitations” below.

Refresh—Click to refresh the signal strength values.

Enable Camera— Checked by default. When checked, this allows the device to use the camera for Video
Intercom in addition to audio.

Wireless Network Limitations—Many Wi-Fi Access Points handle Multicasts (Wi-Fi
simultaneously sent to multiple devices, for example, when the 7” In-Wall Touch Screen
with Camera broadcasts video to all stations) by slowing down transmission speed to the
1 Mb basic rate. This can cause overall Wi-Fi congestion in the Wi-Fi network during
the broadcast. Video Intercom response times and images may degrade at each device.

If a home requires a large number of Wi-Fi Video Intercom devices, ensure that you have a robust Wi-Fi
network (possibly consisting of multiple access points).

Configure a 7" Portable Touch Screen with Camera (C4-TSMC7-EN)
Use the System Design and Connections views to add and configure this device.

Prerequisites

1. Ensure that the 7" Portable Touch Screen with Camera (C4-TSMC7-EN) is installed as
directed in the Control4 7" Portable Touch Screen with Camera Setup Guide available
on the Dealer Portal.

Note: If you want to install the new 7" Portable Touch Screen with Camera, ensure that
the part number says "C4-TSMC7-EN" when you add the driver.

2. Ensure that your project has a Control4 controller added and identified in the Control4 system.

To add and configure a 7" Portable Touch Screen with Camera:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that you add the
driver Portable 7" Touch Screen V2 to the project tree. 

Note: If this touch screen will be providing audio output, the touch screen needs to be
connected as an audio end point for the room.

2. (Optional) To configure the properties, click System Design.

3. In the project tree, select the Portable 7" Touch Screen V2 object.
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4. View and change the properties in the Properties pane.

Modifiable properties include:
Backlight Level—Use the up or down arrows to set the light level of the backlight. You can change the
brightness of the backlight with this option by percentage, so 100% is On at full brightness and 0% is Off.
Click Set to save.

WiFi Signal Strength—If using Wi-Fi, shows you the strength of your wireless signal.

Notes: (1) Video Intercom. Although this device supports b/g/n, 802.11b is not
supported for Video Intercom use. (2) Wireless-n is recommended for Video Intercom.
See “Wireless Network Limitations” below.

Enable Camera—Check to use the camera with this device for video intercom.

Conservative AEC (Acoustic Echo Cancellation)—When selected, this can reduce excessive feedback,
squealing, or other audio interference during intercom use. This setting does not reduce feedback noise
caused by two touch screens being too close to each other. Use this option if other measures (such as
increasing intercom distances and reducing volume) have not sufficiently reduced feedback.

Wireless Network Limitations
Many Wi-Fi Access Points handle Multicasts (Wi-Fi simultaneously sent to multiple devices, for example,
when the T3 touch screenbroadcasts video to all stations) by slowing down transmission speed to the 1
Mb basic rate. This can cause overall Wi-Fi congestion in the Wi-Fi network during the broadcast. Video
Intercom response times and images may degrade at each device.

If a home requires a large number of Wi-Fi Video Intercom devices, ensure that you have a robust Wi-Fi
network (possibly consisting of multiple access points).

Configure a 5" or 7" In-Wall Touch Screen (C4-TSWMC5 or C4-
TSWMC7)
Use the System Design and Connections views to add and configure this device.

Note: This touch screen includes full duplex point-to-point Intercom sessions,
broadcast support to multiple touch screens, and monitoring from the
interface.

As of June 1, 2013, the HC-800 (C4-HC800-BL-1) and HC-250 (C4-HC250-BL-1) ship with included support
for Intercom and the Control4 app. For controllers shipped before that time, you must purchase an Intercom
and Control4 app license for consumers who want this feature. In either case, the license must be assigned
and active on the consumer's account for the Intercom and the Control4 app to function. See this section, the
Control4 System User Guide, and “Example: Using the Intercom agent” for details. See Managing Dealer
Accounts on MyControl4 on the Knowledgebase for information about how to purchase and assign an
Intercom license.

Scenarios

1. User wants to have full-duplex, room-to-room calling. In this case, the Control4
system must have at least two 5" or 7" In-Wall Touch Screens installed.

2. User wants to broadcast a message without a response. In this case, the Control4 system must have at
least one 5" or 7" In-Wall Touch Screen installed.

3. User wants to broadcast a message with a response. In this case, the Control4 system must have at least
two 5" or 7" In-Wall Touch Screens installed.
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4. User wants to monitor the sounds in another room. In this case, the Control4 system must have at least two
5" or 7" In-Wall Touch Screens installed.

Prerequisites
l Ensure that the 5" In-Wall Touch Screen (C4-TSWMC5) or 7" In-Wall Touch
Screen (C4-TSWMC7) is installed as directed in the Control4 5" and 7" In-Wall
Touch Screen Installation Guide available on the Dealer Portal.

l Ensure that your project has a Control4 controller added and identified in the
Control4 system.

To add and configure a 5" or 7" In-Wall Touch Screen:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure
that the IE 5" Touch Screen or IE 7" Touch Screen driver is added to the project tree.

Note: If this touch screen will be providing audio output, the touch screen needs to be
connected as an Audio End Point for the room.

2. (Optional) To configure the properties, click System Design.

3. In the project tree, select the IE 5" Touch Screen or IE 7" Touch Screen object.

4. View and change the properties in the Properties pane as needed.

Modifiable properties include:

l Backlight Level—Use the up or down arrows to set the light level of the backlight.
You can change the brightness of the backlight with this option by percentage, so
100% is On at full brightness and 0% is Off.

l Backlight Preset Level—Lets you set the default backlight level. If you ever restart
or power the touch screen again, this is the backlight level it would go to. Click Set
to save your changes.

l Button Animation Enabled—Lets you enable animated buttons for a 3D effect.

l Volume Control Follows Selected—Lets you select other rooms aside from the
one that contains the touch screen, and change its volume when leaving the room.

l Conservative AEC (Acoustic Echo Cancellation)—When selected, this can reduce
excessive feedback, squealing, or other audio interference during intercom use. This
setting does not reduce feedback noise caused by two touch screens being too close
to each other. Use this option if other measures (such as increasing intercom
distances and reducing volume) have not sufficiently reduced feedback.

Keypads
Configure a Configurable Keypad
This applies to next generation lighting (compatible with OS 2.5 and later).
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To configure a Configurable Keypad:

1. Add the keypad to your project tree, then identify it. For instructions, see “ How to add
devices to a project.”

2. In the System Design view, select the device. The device’s Properties tab opens.

3. In the Button Settings area, click and drag the appropriate Keypad Parts items to the
Assembled Keypad example until the example matches the desired keypad
configuration.

Tips:

217



Composer Pro User Guide

l The Down/Up buttons can be placed only in the bottom slot and cannot have
custom engraving.

l Drag the desired button to the top slot of the range where you want the
button positioned.

4. Configure the settings described below.

5. Click Apply to… to apply the changes to other lighting devices.

l If you entered text for custom engraving, go to “Ordering keycap engraving”
in this document.

Device settings for Configurable Keypads

Properties
l Button Settings

l Name—The name of the button (used for defining its connections to other
devices or events within Composer Pro).

l Engraving—Text that you want printed onto the buttons. For more
information, see “Ignore device when it comes online—When selected, this
checkbox tells the system to ignore the older device when it comes back
online.

l ” below.

l Icons—Icons that you want printed onto the buttons. To add an icon to the
Engraving text box, click Icons, then double-click the icon to add.

l LED Behavior

l Follow Bound Device—LED behavior reflects the state of the device the
button is bound to.

l Push/Release—LED behavior reflects the button state (pressed or released).

l Push Color—Sets the LED color while the button is pressed.

l Release Color— Sets the LED color while the button is released.

l Finish—Color of the buttons.

Advanced Properties
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l Ambient Light Profiles

l Select a preset brightness profile for the keypad backlight and LEDs that
changes their brightness according to the room’s ambient light. You can also
select Fully Customized and manually set each brightness level according to
ambient lighting.

l Backlight Color—Sets the keypad’s backlight color. If you don’t want a
keypad backlight, keep the default setting (black).

l Network—(wireless keypads only) Displays the MAC address and firmware
version of the selected device. These fields are not editable.

l Replace Legacy Control4 Device

l Replace Keypad—Replaces a legacy device in your project with this new
device. After you configure this new device, click this button, select the older
device in the mini project tree that opens, then click OK.

l Ignore device when it comes online—When selected, this checkbox tells
the system to ignore the older device when it comes back online.

Ordering keycap engraving
If you entered text to be engraved onto keycaps, you need to special order the custom engraving. You can
order in three ways:

United States and Canada:
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l Upload the engraving order file on the Dealer Portal (easiest for most orders).

l Enter the information on the Dealer Portal (good for small orders of individual
keycaps).

All other regions:
l Send the engraving order file to your ISA.

When your custom engraved keycaps arrive, install the keycaps according to the Keypad Buttons Installation
Guide, then make sure that the keypad configuration matches the device properties in Composer Pro.

To create an engraving order file:

1. In Composer Pro, make sure that the text and icons for each keycap have been entered on the device
Properties pages exactly as you want them to appear. Pay special attention to spelling.

Tip: In a keypad’s Button Settings properties, the button Name is used only for defining
connections within Composer Pro. For engraving, make sure that you enter text in the
Engraving fields.

2. Click Tools, then Reports.

3. Click Keypad Engraving, then click Display Report.

4. Print the report and review with your customer to make sure that all engraving meets the customer’s
expectations.

5. Click Export Engraving Order, then click Export Order File.

6. Specify a location to store the file, then click Save.

To upload the engraving report file on the Dealer Portal:

1. Access the Dealer Portal at dealer.control4.com.

2. Go to Products > Lighting > Engraving.

3. Click Upload Composer File. The file upload page opens.
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4. Select the file you created above, then click OK.

5. Complete the order process.

To enter engraving information on the Dealer Portal:

1. While building the system, take note of the text and icons you want to be engraved on each keycap. Pay
special attention to spelling.

2. Access the Dealer Portal at dealer.control4.com.

3. Go to Products > Lighting > Engraving.

4. Click Single Keycap Engraving. The configuration page opens.

5. Select the type of keycap, then type the text for the engraving.

6. Complete the order process.

To send the engraving report file to your ISA (international customers only):

1. Create an email message to send to your ISA.

2. Attach the engraving report file you created above, then send the message.

3. Follow up with your ISA regarding order status and schedule.

Configuring lights for 3-way
Rather than creating programming to tie lighting variables and Control4 3-way lights together, you can use a
simplified lighting configuration to set up lighting control. In the Connections view, you can configure global
changes in Composer Pro Properties, and configure 3-way lights by dragging the lighting and control
connections. 

The Push and Release features available on the keypads let you dim lights like a dimmer. 

Tip: To find out how to configure global changes for lights and other devices,
see "Accessing properties from the project treeAccessing properties from the
project tree" in Composer Pro Getting Started.

Configuring a 2-Button Keypad as a 3-way light

Use the Connections view to configure a 3-way light using a 2-button keypad. 

Example: Configure a 2-Button Keypad to turn On (Top button) and turn Off
(Bottom button) a dimmer, and to use the Push/Release function available on
the 2-Button Keypad to dim a light.

Prerequisites
1. Ensure that your controller hardware is added and identified to the Control4 system.

2. Ensure that you have a 2-Button Keypad and dimmer (or switch) added and identified to the project.

To configure a 2-button keypad as a 3-way light:

1. In the project tree, select the 2-Button Keypad.

2. In the Control & Audio Video Connections pane under Control Inputs, click the Button 1 Link connection, and
drag it to the dimmer’s Top Button Link in the bottom pane.
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3. Click the Button 2 Link connection, and drag it to the dimmer’s Bottom Button Link
in the bottom pane. 

4. Test to ensure that the 2-Button Keypad turns the light on and off, and that the Push/Release functions dim
the light.

Configuring a 3-Button Keypad to control a 3-way light

Use the Composer Pro Connections view to configure a 3-Button Keypad to use a toggle for a 3-way light. 

Example: Configure a 3-Button Keypad to toggle the light On and Off. Use
Push and Release to dim and brighten the light as desired.

Prerequisites
1. Ensure that your controller hardware is configured properly, and that the 3-Button Keypad and dimmer (or

switch) are added to the project and identified.

2. Ensure that you have a 3-Button Keypad added and identified to the project.

To configure a button on a 3-Button Keypad to control a 3-way light:

1. In the project tree, select the 3-Button Keypad.
2. In the Control & Audio Video Connections pane, drag the Button 1 Link connection

from the top list over the light’s Toggle Button Link in the bottom list.

222



Composer Pro User Guide

3. Test to ensure that the 3-Button Keypad turns the light On and Off, and that the Push/Release functions dim
the light.

Configure a Dry Contact Input Module
The Dry Contact Input Module (C4-DCIM4) appears in the User Interface and the
Sensors sections of theMy Drivers list.

To configure a Dry Contact Input Module:

1. Add the Dry Contact Input Module to your project tree, then identify it. When you first
add it to the project tree, its default label is “Keypad.”
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2. In the System Design view, select the device. The device’s Properties tab opens.

Device settings for Dry Contact Input Module

Properties
l Button Settings

l Name—The name of the selected button (used for defining its connections to
other devices or events within Composer Pro). After clicking the appropriate
button on the right, you can change this name.

l Button Behavior—The type of connection that the physical button or
mechanism provides.

l Momentary—Closure is maintained only while the button is being pressed.

l Latch—Closure is maintained indefinitely until reopened.

l Contact Sensor—Contact is made by a secondary device that triggers a
closure (like the contact sensor on a home controller).

Advanced Properties
l 12v Power Output—Enables 12V (up to 30mA) power to the connected device
(for example, a motion sensor).

l Network Settings

l 485 Address

l MAC Address

l Firmware Version
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Configure mobile devices or PCs/tablets as Navigators
Use the Control4 apps to configure an iPod Touch, iPad, iPhone, Android, or PC device for use as a touch
screen in a Control4 system.

Ensure that the license and correct apps are installed.

Follow the instructions in the documents mentioned previously to set up the apps for these devices. You don't
need to do anything in Composer Pro.

Configure a Door Station
Use the System Design and Connections views to add and configure a Door
Station.

Prerequisites
l Ensure that the Door Station is installed as directed in the Control4 Door
Station – Exterior Setup Guide or Door Station-Interior Setup Guide available
on the Dealer Portal.

l Ensure that your project has a Control4 controller added and identified in the
Control4 system.

To add and configure a Door Station:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the Door Station
driver is added to the project tree.

2. (Optional) To configure the properties, click System Design.

3. In the project tree, select the Door Station object. Both Door Station models use the same driver.

4. View and change the properties in the Properties pane as needed.

Modifiable properties include:

l Reboot—Click Reboot to reboot the Door Station.

l WiFi Signal Strength (%)—If Wi-Fi is used this shows the strength of the
signal. Ensure that the signal is strong and robust if you use the Door Station
for Wi-Fi. We recommend using Ethernet rather than Wi-Fi for best results.

Notes: (1) Video Intercom. Although this device supports b/g/n, 802.11 b is not
supported for video intercom use. (2) Wireless-n is recommended for video
intercom.

l Refresh—Click to refresh the signal strength values.

l Select Intercom Group—If a group has been created, use the drop-down list
to select the group. The default is All.

Door Station Options:
l Enable Camera—Checked by default. When checked, this allows the device
to use the camera for video intercom in addition to audio.
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l Door Bell Ring—Checked by default. When checked, this allows the device to
be used with the doorbell. This can be disabled if programming is used; for
example, if you want a different sound or lights to come on.

l Door Bell Button:

l Forking Call—Configures the Door Bell Button on the Door Station to
perform a forking call. Use this option with T3 series touch screens in the
project.

l Broadcast Call—Configures the Door Bell Button on the Door Station to
perform a broadcast call. Use this option with legacy touchscreens in the
project.

l Programming Only— Configures the Door Bell Button on the Door Station to
not automatically make an intercom call. You can program an
announcement or other types of calls in the Programming view when the
button is pressed.

l Enable Button Backlight—Checked by default. When checked, this turns on
the button's backlight. If you don't want to use the backlight, uncheck this
option. Tip: This option can be used in programming to turn on the backlight
at night.

Note: The Door Station driver includes an Intercom Proxy sub-driver with OS 2.7. See “Configure the
Intercom Proxy Properties for touch screen drivers compatible with the Communication agent.”

Wireless Network Limitations

Many Wi-Fi Access Points handle Multicasts (Wi-Fi simultaneously sent to multiple devices, for example,
when the Door Station broadcasts video to all stations) by slowing down transmission speed to the 1 Mb
basic rate. This can cause overall Wi-Fi congestion in the Wi-Fi network during the broadcast. Video
intercom response times and images may degrade at each device.

If a home requires a large number of Wi-Fi Video Intercom devices, ensure that you have a robust Wi-Fi
network (possibly consisting of multiple access points).
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Configuring AV devices
Configuring audio-video (AV) devices means that you want to 'identify' or make the device connection to the
Control4 system so the devices communicate with the controller and other devices in the system. See “ How
to add devices to a project” to add and identify the device. Also see “ Overview of media management”.

Configure a Triad Audio Matrix Switch
Use the System Design and Connections views to identify a Triad 8x8 or 24x24 Audio Matrix Switch (TS-
AMS8 or TS-AMS24) to the Control4 system. These matrix switches switch up to 8/24 input sources and up to
8/24 outputs.

Ensure that the matrix switch is installed as directed in the Triad Audio Matrix Switch Installation Guide.

To add the driver and identify a Triad Audio Matrix Switch:

1. Configure the IP settings with System Manager, if required. By default, the audio matrix switch will be
configured to DHCP.

2. In the System Design view, click on the Discovered tab.

3. Double-click on the matrix switch in the list to add it to the system and identify it.

Note: You can set this device to either DHCP Client (default) or a client that uses
Static IP.

To configure the Triad Audio Matrix Switch driver:

1. Install and set up the audio matrix switch and any associated hardware according to
each device’s installation guide.
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2. Modify the properties in the Properties pane:

l Device Firmware—The firmware version of the switch. Not editable.

l Logging—Select the logging behavior and level for the matrix switch driver.
Print sends log events to the LUA tab. Log sends log events to a log file on the
controller.

l All Channels

l Reset Settings—Resets all channel input and output settings to factory
defaults.

l Disable Audio Sense—Disables audio sensing on the matrix switch inputs.

l Input Gain

l Select an input and adjust the gain or select the gain and click Apply To All.

l Output Controls—Select one of the outputs to adjust settings for and then
adjust settings for that zone or click Apply To All.
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l Audio Output—Choose Bypass, Tone Control, or Equalizer to adjust settings
for the chosen Audio Output.

l Bypass—No equalizer settings are applied to the output by the matrix switch.

l Tone Control—Enables Bass and Treble settings for the output.

Move the slider to adjust the Bass and Treble settings.

l Equalizer—Enables five-band parametric EQ settings for the output.

Choose a preset or define your own EQ settings. Save your EQ settings using the
Save As… button to be able to recall and apply them to another output.

Tip: Customized EQ settings for many Triad speakers are already built in and
saved as presets into the Triad Audio Matrix Switch driver.

l Volume—Sets the volume for the selected output.

l Mute—Sets the mute for the selected output.

l Output Loudness— Turns on the Loudness setting for the selected output.

l Balance—Sets the L/R speaker balance for the selected output.

l Assignable Trigger—Assigns the assignable trigger to activate when the
selected output is active.

l Audio Properties—Assign a maximum volume to the selected output and
click Set. The output can also function as a mono sum of the source. This
setting combines the L + R signals and outputs the mono-summed signal on
both outputs.

l 2.1 Audio Zone—Assigns two outputs to act as a single zone and mono-sums
the source and sends the signal on the output selected in Pair Sub Output.
Choose the output to pair with the output selected (at the top of the Output
Controls section) and click Set.
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Configure a Triad Power Amplifier
Use the System Design and Connections views to add a Triad Power Amplifier (TS-PAMP8-100) to the
Control4 system.

Ensure that the amplifier is installed as directed in the Triad 8-Zone Power Amplifier Installation Guide.

To add the driver for a Triad Power Amplfiier:

1. In the System Design view, click on the My Drivers tab.

2. Double-click on the Triad 8-Zone Power Amplifier in the list Audio/Video folder to add the driver to the
system. This driver does not need to be identified

To configure the amplifier driver:

1. Install and set up the audio matrix switch and any associated hardware according to
each device’s installation guide.

2. Modify the properties in the Properties pane:

l Zone Inputs (1-8)

l Select Zone Input or Global Input to configure the input settings. To link an
input to the Global Input, the Link to Global Input dip switch must be
enabled on the back of the amplifier.

Configure a Triad One Streaming Amplifier
Use the System Design and Connections views to identify a Triad One Streaming Amplifier (TS-SAMP1-100)
to the Control4 system. The Triad One can power a single analog zone and act as a streaming audio output for
Control4 digital media.
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Ensure that the Triad One is installed as directed in the Triad One Installation Guide.

To add the driver and identify a Triad One:

1. Configure the IP settings (or Wi-Fi settings) with System Manager, if required. By default, the Triad One will
be configured to DHCP

2. In the System Design view, click on the Discovered tab.

3. Double-click on the Triad One in the list to add it to the system and identify it.

Note: You can set this device to either DHCP Client (default) or a client that uses
Static IP.

To configure the Triad One driver:

1. Install and set up the Triad One and any associated hardware according to each device’s
installation guide.

2. Modify the properties in the Properties pane:

l I/O Firmware Version—The firmware version of the switch. Not editable.

l Advanced Audio: Custom Delay—This field provides the option to adjust
streaming audio output timing to better match other zones.

l Disable Front Status LED—Check this box to turn off the status LED on the
front of the Triad One.
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l Source Leveling - Input Gain

l Select an input and adjust the gain, click Set to save.
l Change the Input Mode to Direct, Stream, or Direct+Stream. See Input Mode
section below for additional details.

l Output Controls—Select one of the outputs to adjust settings for and then
adjust settings for that zone or click Apply To All.

l Audio Output—Choose Bypass (DSP Off), Tone Control, Equalizer, or Test
Tone to adjust settings for the Audio Output.

l Bypass—No equalizer settings are applied to the output by the matrix switch.

l Tone Control—Enables Bass and Treble settings for the output.

Move the slider to adjust the Bass and Treble settings.
l Equalizer—Enables ten-band EQ settings for the output.

Choose a preset or define your own EQ settings. Save your
EQ settings using the Save As… button to be able to
recall and apply them to another output.

Tip: Customized EQ settings for many Triad speakers are
already built in and saved as presets into the Triad One
driver.
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l Amp Properties—Assign a maximum volume to the selected output and
click Set. The output can also function as a mono sum of the source. This
settings combines the L + R signals and outputs the mono-summed signal
on both outputs.

l Cross Over—Sets a low-pass filter on the subwoofer out of the Triad One to
80, 90, 100, 110, 125, or 140.

Input Mode
This field determines how each source input is routed, either locally to the Triad One and/or over the IP
network. Select an input from the drop down field above before adjusting this setting. Depending on the
installation use case, there are three options.

Direct

Select this option if the source will only be played back locally. The local input is routed directly to the local
output(s) of the Triad One with no delay. This setting is best for video sources, where audio must be in sync
with video.

Stream

Select this option if the source should be played back locally AND in other rooms. The input is encoded and
streamed, with delay, to the local output(s) of the Triad One AND to other Triad One units or EA controller
audio outputs on the IP network. Selecting this option ensures audio synchronization across all devices, local
or remote. This setting is not recommended for video sources.

Direct + Stream

Select this option if the audio must be played back locally with no delay (i.e. video source), but also needs to
be available as a source in other rooms. The local input is routed to the local output of the Triad One, with no
delay AND is streamed to other Triad One or EA Controller audio outputs on the IP network. Note: This option
will cause audio to be out of sync between the local room and other rooms. Direct + Stream mode should only
be used when the Triad One is out of earshot of other rooms that are playing the same source.

Note: When the Triad One's analog or digital input is encoded (streamed)
there will be a 2-4 second input-to-output audio delay.

Configure Triad One for Wi-Fi

To configure a Triad One for Wi-Fi use:

1. Start Composer Pro and connect to Director on Local Network.
2. In the Tools menu, select System Manager.

3. In the Devices pane, select the network address of the device you want to configure,
and click Connect.
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Tip: If the device’s network address is not on this list, click Refresh. If it still does not
appear, click Add to enter it manually. If you don’t know the network address, look in
the Tools menu > Network Tools. 

4. Click the Network tab, and click Configure. 

5. Click Next when a Network Configuration wizard dialog appears.

6. If desired, enter a new name for the device, and click Next.

IMPORTANT TIP! If the device has already been identified on the Control4
system, and you change the name (on this wizard screen), identify the device again.
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Until it is identified again, the controller cannot recognize the name and will not be
able to communicate with the device.

7. Select the type of network you want the device to be a part of, and click Next. 

Example: Wireless network. 

8. Select the method to obtain an IP address, such as DHCP (first option) or Static IP (second option) , and
click Next. 

Example: Obtain an IP address automatically using DHCP. 

9. Select the method to obtain the DNS server address automatically, and click Next. 

Example: Obtain the DNS server address automatically. 

10. Enter the Network Name (SSID) of your wireless access point.

11. Use the pull-down menu to indicate your Data encryption preference (64 or 128 bit).

12. Select the Key type (hex or ASCII).

13. Enter your Network Key (WEP Key), and click Test.

l Hex—64 bit (10 digits) or 128 bit (26 digits)—acceptable values 0 - 9, A- F

l ASCII—64 bit (5 digits) or 128 bit (13 digits)—acceptable values ASCII
characters 

Example:

l Network Name (SSID)—<name of wireless access point>
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l Data encryption—wep64

l Key Type—hex

l Network Key (in hex)—ABCDE12345.

Note: If the hex Network Key you insert is not valid, a screen with a red
exclamation point comes up. In this case, enter your key again.

14. Click Test to test your network connection. If it fails, follow the on-screen instructions.

15. Click Finish when you come to the “Congratulations! You have successfully changed your network
configuration” screen.

16. At this time, the system reboots. Do not disconnect any temporary Ethernet cables until the device has
successfully rebooted and is powered on.

17. If you are using the Wi-Fi to communicate to your controller, disconnect the Ethernet cable.

Configure an Audio Matrix Switch
Use the System Design and Connections views to identify an Audio Matrix Switch V3 (C4-16ZAMS-V3-B) to
the Control4 system. This device switches up to 16 input sources and up to 16 outputs.

Ensure that the matrix switch is installed as directed in the Audio Matrix Switch Installation and Setup Guide.

To add the driver and identify a

Note: You can set this device to either DHCP Client (default) or a client that
uses Static IP.

To add and configure an Audio Matrix Switch:

1. Install and set up the audio matrix switch and any associated hardware according to
each device’s installation guide.

2. To add the driver to your project and identify the device, see “ How to add devices to a project.”

3. Modify the properties in the Properties pane:
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l Device Firmware—The firmware version of the switch. Not editable.

l Output Controls

l Audio Output—Select one of the 16 outputs to adjust settings for.

l Volume—Sets the volume for the selected output.

l Bass—Sets the Bass level for the selected output.

l Treble—Sets the Treble level for the selected output.

l Balance—Sets the L/R speaker balance for the selected output.

l Source Leveling

l Audio Input—Select one of the 16 inputs to adjust the setting for, move the
slider to the desired setting, then click Set.

l Network Settings

l Use DHCP—Select this option to use DHCP, then click Apply Settings.
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l Use Static IP—Select this and enter values for the IP Address, Subnet Mask,
and Gateway, then click Apply Settings.

l All Channels

l Reset Settings—Resets all channel input and output settings to factory
defaults.

l Set Unity Gain—Resets the Source Leveling for all inputs to 0dB.

Configure a Control4 4k Ultra HD 10x10 HDMI Matrix
Switch
Use the System Design and Connections views to identify a LU1082 HDMI Matrix
Switch (C4-LU1082) to the Control4 system. This device switches up to 10 HDMI
input sources and uses an HDBaseT Receiver (C4-LU1E) to connect to AV output
devices.

IMPORTANT! The hardware setup for the switch can be complex. Refer to the
and the Setup Installation Guide for guidelines, warnings, and cautions to help
ensure a smooth setup.

To add and configure an HDMI Matrix Switch:

1. Install and set up the video switch and any associated hardware according to each
device’s installation guide.

2. To add the driver to your project and identify the device, see “ How to add devices to a project.”

3. Make any necessary network or control/AV connections as necessary for your
configuration. For information on setting each Properties field’s parameters, click the
Documentation tab in the driver’s Properties window.

Configure an audio or AV switch
Use the System Design and Connections view to set up an audio or audio/video
switch.

You can access the AV switch drivers from the System Design view in the Items pane by clicking the Search
tab > Device Type: A/V Switch or Audio Switch > Manufacturer: All Manufacturers. Use the Driver Wizard
for additional support for your audio or AV switch.

Install the audio or AV switch according to the manufacturer’s instructions.

To add and configure an audio or audio/video switch:

1. Install and set up the audio or audio/video switch and any associated hardware.
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2. In the System Design view, locate the driver. Click the Search tab > Device Type: Audio Switch or A/V
Switch > Manufacturer: All manufacturers.

3. Select the Audio Video or AV Switch object in the project tree to view the device properties for that object
and make configuration changes if applicable.

Example: The Knox AV Switch has no properties to modify, but other switches have
properties, for example, the Control4 Audio Switch. 

4. Make any necessary network or control/AV connections as necessary for your configuration. See “ Connect
and verify devices” for details.

5. Modify any room connections as needed for your configuration.

Configure a 4-Zone Amplifier
Use the System Design and Connections views to add and configure a 4-Zone Amplifier (C4-8AMP1-B). This
device lets you enjoy up to four zones (rooms) of music in the home.

Ensure that the 4-Zone Amplifier is installed as directed in the Control4 4-Zone Amplifier Installation Guide
available on the Dealer Portal.

To add and configure a 4-zone Amplifier:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the Multi
Channel Amplifier 4 Zone driver (under Audio/Video > Amplifier) is added to the project tree.

IMPORTANT! The amplifier can be identified by IP only. The amplifier can
communicate with the Control4 system using the TCP/IP network.
Note: If you are using a TCP/IP network and the latest shipping version of this device,
you can set this device to either DHCP Client (default) or a client that uses Static IP. To
change this setting, see the LCD screen menu on the device.

2. Make the necessary connections. See “ Connect and verify devices” for details.

3. (Optional) Change the 4-Zone Amplifier properties.
1. In the System Design view on the project tree, select the Amplifier object.
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2. Modify the properties in the Properties pane: 

Modifiable properties include:
l Advanced Properties

l Inputs Locked—This locks Audio Inputs to set Audio Outputs. You can have
one Audio Input with several Audio Outputs, but an Audio Output may only
have one Audio Input.

l Power Save Enabled—Check to save power.

l Device Firmware—This displays the firmware version.

l Power Save Status—This displays when power save is enabled.

l Volume Curve—Shows how the output volume of the amplifier reacts (the
device compensates) to an increase in volume as heard by the human ear.

l Output Settings

l Output Zones—Select zones 1 through 8.

l Maximum Volume—Use the drop-down menu to select the volume up to
100. Click Set.

l Parametric EQ Settings

l Frequency—Center frequency to be adjusted.

l Gain—Set from -24dB (cut) to +6dB (boost) for the center frequency.

l Quality Factor (Q)—Width of the EQ boost/cut can be set from 0.5 to 1.0 in 0.1
steps and 1.0 to 10.0 in 1 step (there are no units for Q).
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l Shelving EQ Settings

l Frequency—Center frequency to be adjusted.

l Gain—Set from -24dB (cut) to +6dB (boost) for the center frequency

Notes on EQ settings: The Q setting on the EQ setting determines the bandwidth
of the boosted frequency (or cut frequency).

The Quality Factor is the center frequency divided by the bandwidth (Q=Center
Frequency/Bandwidth), where bandwidth is determined by the frequency points;
either side of the center frequency are -3dB from the center frequency. A setting
of 1kHz with a Q of 1 means that the boosted frequencies affected are from 500Hz
to 1.5kHz (1kHz wide to the -3dB points centered at 1kHz).

Example: If the Q is increased to 10 with the same 1kHz center frequency, then the
bandwidth must decrease by the same ratio. Mathematically:

Q = Freq/BW10 = 1kHz/BWBW = 100HzAffected frequencies are Center Frequency
+/- ½ (BW)1kHz +/- ½ (100Hz)1kHz +/- 50Hz = 950Hz to 1,050Hz

The higher the Q setting the narrower the frequency range affected by the gain
setting, while a lower Q setting increases the frequency range affected by the
gain setting at each EQ frequency.

The frequency response can be visualized as a tall, skinny building with a high Q
value or a tall, wide (or pyramid shaped) building with a low Q value. The peak (or
height of the building) at the center frequency is set by the Gain setting.

Configure a Multi-Channel Amplifier
Use the System Design and Connections views to add and configure a Multi-
Channel amplifier (C4-16AMP3-B). This device provides eight stereo inputs and
outputs with full audio switching.

Note: In Release 1.8 and later, the Multi-Channel amplifier does not work with
Zigbee Pro. Configure this device with Ethernet.

Ensure that the Multi-Channel amplifier is installed as directed in the Control4 Multi Channel Amplifier
Installation Guide available on the Dealer Portal.

To add and configure a Multi-Channel amplifier:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the Multi
Channel Amplifier v3 - 16 driver is in the project tree. 

Note: You can set this device to either DHCP Client (default) or a client that uses Static
IP. To change this setting, see the LCD screen menu on the device.

2. Make the necessary connections. See “ Connect and verify devices” for details.

3. (Optional) Change the properties as needed.
1. In the System Design view on the project tree, select the Amplifier object.
2. Modify the properties in the Properties pane:
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Modifiable properties include:
l Inputs Locked—This locks Audio Inputs to set Audio Outputs. You can have
one Audio Input with several Audio Outputs, but an Audio Output may only
have one Audio Input.

l Device Firmware—This displays the version of firmware.

l Zigbee Firmware—This displays the version of firmware.

l Volume Curve—Shows how the output volume of the amplifier reacts to an
increase in volume; the soft-to-loud response of the volume control.

l Output Settings:

l Output Zones—Select zones 1 through 8.

l Maximum Volume—Use the drop-down menu to select the volume up to
100. Click Set.

l Parametric EQ Settings:

l Frequency—Center frequency to be adjusted.

l Gain—Set from -24dB (cut) to +6dB (boost) for the center frequency.

l Quality Factor (Q)—Width of the EQ boost/cut settable from 0.5 to 1.0 in 0.1
steps and 1.0 to 10.0 in 1 step (there are no units for Q).

l Shelving EQ Settings

l Frequency—Center frequency to be adjusted.

l Gain—Set from -24dB (cut) to +6dB (boost) for the center frequency.

Notes on EQ settings: The Q setting on the EQ setting determines the bandwidth
of the boosted frequency (or cut frequency).
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The Quality Factor is the center frequency divided by the bandwidth (Q=Center
Frequency/Bandwidth), where bandwidth is determined by the frequency points
are either side of the center frequency are -3dB from the center frequency. A
setting of 1kHz with a Q of 1 means that the boosted frequencies affected are from
500Hz to 1.5kHz (1kHz wide to the -3dB points centered at 1kHz).

Example: If the Q is increased to 10 with the same 1kHz center frequency, then the
bandwidth must decrease by the same ratio. Mathematically:

Q = Freq/BW10 = 1kHz/BWBW = 100HzAffected frequencies are Center Frequency
+/- ½ (BW)1kHz +/- ½ (100Hz)1kHz +/- 50Hz = 950Hz to 1,050Hz

The higher the Q setting the narrower the frequency range affected by the gain
setting, while a lower Q setting increases the frequency range affected by the
gain setting at each EQ frequency.

The frequency response can be visualized as a tall, skinny building with a high Q
value or a tall, wide (or pyramid shaped) building with a low Q value. The peak (or
height of the building) at the center frequency is set by the Gain setting.

Configure a media player
Use the System Design and Connections views to add and configure a media
player. The device automatically scans videos. A media player (such as Netgear
EVA8000) lets you play media that is stored on a network drive or available
through the Internet to a TV.

The media player driver lets the Control4 system interact with the media player hardware through one of the
Control4 system remote controls. The driver also supports the video playback functionality of the hardware,
allowing the Control4 Navigators to be used to select a video title.

Ensure that your media player is installed according to the instructions in its documentation.

To configure a media player in your system:

1. To add the driver and identify the device see “ How to add devices to a project.” Make
sure that the media player is added to the project tree.

2. Add a Network File Storage driver to your Composer Pro project (available on the My Drivers tab), then
configure the properties including browsing to the network location. For information on adding and
configuring network file storage, see “ Using external storage devices.” The network location must be an
open share location (no password required). The Network File Storage driver supports both audio and video
content.

3. Make the necessary audio and video connections. See “ Connect and verify devices” for details.

4. To use the features of the media player, do one of the following:
l Scan the videos. In the Media view, scan the videos that are in video_ts format:

l Select Video Media under the network file share where you want to add the videos.

l Click Scan. The scan operation identifies the video_ts format video files, adds them
to the media database, and automatically associates the video metadata including
cover art. When the scan completes, the videos in video_ts format are available for
playback from the Navigators.
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l Manually add the videos. In the Media view, manually add videos that are in
formats other than video_ts. Video formats other than video_ts that are supported by
your media player can be added to the media database in Composer Pro manually.

l Select Video Media under the network file share where you want to add the videos.

l Click New, and then select the Browse option next to the Location text box in the
pop-up window. A new pop-up window will appear.

l In the pop-up window, select the drop-down menu for Files of type, and then select
the *.* option.

l Select the file format you want to add to the database.

When the videos in alternative video formats are added to the system manually, those videos become
available for playback from the Navigators.

Note: When using a system remote control Version 2, the Cancel button is mapped to
the EVA8000 Back button and the DVR button toggles between aspect ratios.

5. Check the properties. In the System Design view, select the media player, then click the Documentation tab
for more information about this device.

6. To view logging output, in the Properties pane, click the Lua tab.

Configure a Wireless Music Bridge
Use the System Design view to identify a Wireless Music Bridge (C4-WMB-B) to a Control4 system. This
bridge lets you play music, Internet radio, podcasts, and more through your smartphone and tablet devices to
the whole house (supported in OS 2.5 and later).

Prerequisites
l Ensure that the Wireless Music Bridge is physically installed as directed in the
Control4 Wireless Music Bridge Installation Guide.

This audio output device uses SDDP (Auto Discovery) to identify the device automatically. See “Auto
Discovery (SDDP)” in this documentfor details about Auto Discovery. If you ever need to identify the device
again, use the standard method. If you want to play different streams for each zone in the home, you need a
separate bridge for each stream. This device will play one stream in all supported zones, however.

To add and configure the Wireless Music Bridge:

1. In the System Design view's Discovered tab (Items pane), locate the Wireless Music Bridge (also listed in My
Drivers > Audio/Video).

2. Make the necessary connections. See " Connect and verify devices" for details.

3. In the Properties pane, change the properties as needed.
4. Click the driver’s Documentation tab for explanations of the Properties fields and additional information

about the driver and device.

5. Click the Lua tab to view logged output.
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Configure TuneIn
Use the System Design view to access and change TuneIn properties for a Control4 system. The TuneIn app
lets you play music, Internet radio, podcasts, news, sports, and more through your Navigators and
smartphone devices to the whole house (supported in OS 2.4 and later).

Prerequisites
l The TuneIn app, driver, and license are included in OS 2.4 and later, but your
customers will need to set a TuneIn account to pair TuneIn with their system
and they must have an EA, HC-250, or HC-800 Controller as their primary
controller. The TuneIn driver appears below the controller in the Composer
Pro project when these conditions are met.

l For the best audio experience, have your customers create a TuneIn account
and add Favorites. They can then pair their TuneIn account to the Control4
system so they can play their favorite stations on their Navigators. See the
TuneIn Setup Guide or TuneIn User Guide in the Residential or dealer
Documentation page for details.

This TuneIn driver is added automatically (see "Prerequisites" above). If you need to add the driver again, use
the standard method. The driver is located in My Drivers > Audio/Video > Media Service.

To configure the TuneIn properties:

1. In Composer Pro > System Design, locate the TuneIn driver.

2. Select TuneIn, then change the properties as needed.

3. Click the Actions tab to sync Favorite stations, update the TuneIn pairing status, drop a TuneIn account, or
join a TuneIn account.

4. Click the Documentation tab for explanations of the Properties and Actions fields and additional information
about the driver and device.

5. Click the Lua tab to view logged output.
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Adding a media service
Use the System Design view to add a music service to a Control4 system. In this example, Pandora is used,
but the Media Service proxy will support additional services as drivers for them become available.

Prerequisites
l Ensure that a supported music service account has already been set up by the user.

l Ensure that the devices you want to use for Rhapsody output are added and identified to the system.

To add a media service:

1. In the Items pane > My Drivers tab > Audio/Video, double-click Media Service.

The Select the Driver dialog box opens.

2. Double-click the music service to add. The service is added to your project tree.

3. The customer should log into their music service account in any Navigator under Settings. You can also have
them log in to the service on your computer under the service device control’s Navigator tab.
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4. Click the driver’s Documentation tab for explanations of the Properties fields and additional information
about the driver and device.
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Configuring Motorization
Use the System Design and Connections views to add and configure contacts and
relays.

Configuring a Zigbee IO and Zigbee Contact
Ensure the Zigbee IO or Zigbee Contact is installed as described in their respective Installation Guide.

l Zigbee IO Installation Guide (ctrl4.co/z2io-ig)

l Zigbee Contact Installation Guide (ctrl4.co/z2c-ig)

To add and configure a Zigbee IO or Zigbee Contact:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the Zigbee IO or
Zigbee Contact driver is added to the project tree. 

2. (Optional) To configure the properties, click System Design.

3. In the project tree, select the Zigbee IO or Zigbee Contact object.

4. View and change the properties in the Properties pane. 

A full description of the device properties can be found in the Documentation tab.

Configure a contact
Use the System Design view to check and change properties for contacts.

When using a contact in your project, the physical change of the contact’s state might not always result in a
single open-to-close or close-to-open state change, but rather bounce between states multiple times before
the final state is reached.

To eliminate false notification of the contact state to the Control4 system, you can configure a 'Debounce
Timer' to allow the system to see only a single state change.

In the System Design view, you can set this option in the Properties pane when you select a contact.
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To set this option:

1. Select the contact object from the project tree. View its properties in the Properties pane.

Modifiable properties include:

Invert Sensor—Depending on the sensor type, the controller sends a small amount of voltage through the
sensor to close it, if for example when a door is closed with feedback indicating such. You use Invert
Sensor if you want to feedback to be the opposite.

Enable Debounce Timer—Sets an amount of time that lapses before the sensor triggers to on.

Debounce Time(ms)—The amount of time in milliseconds before the sensor state changes to on.

2. Check the Enable Debounce Timer box.

3. In the Debounce Time(ms) (in milliseconds) drop-down menu, select to delay notification of the contact state
(the default is 100 milliseconds). 

Configure a Fan Speed Controller
This applies to next generation lighting (compatible with OS 2.5 and later).

When adding a Fan Speed Controller to your project, a keypad is also added
underneath it. Both devices need to be configured.

To configure a Fan Speed Controller:

1. Add the Fan Speed Controller to your project tree, then identify it. For instructions, see
“ How to add devices to a project.”

2. In the System Design view, select Fan Speed Controller. The device’s Properties tab
opens.

3. Configure the settings for the device as described in the following Properties sections.

If you entered text for custom engraving, go to “ Ordering keycap engraving” Fan properties
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Properties
l Preset Level— Select a fan speed from the drop-down list. This is the speed
that will be used when the fan is toggled on.

Advanced Properties
l Fault Detection

l Status—Displays the device’s current fault status. Green is normal, but red
indicates a fault.

l Reset—Resets the fault status indicator. If the fault repeats, make sure that
the load type is compatible, that the device is wired correctly, and that the
device is not damaged.

l Fan Speed Colors

l Name—Select the fan speed using the Name drop-down menu, then click
the True or False color bars to change them. True is the keypad color when
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that speed is active.

l Ambient Light Profiles

l Select a preset brightness profile for the keypad backlight and LEDs that
changes their brightness according to the room’s ambient light. You can also
select Fully Customized and manually set each brightness level according to
ambient lighting.

l Backlight Color—Sets the keypad’s backlight color. If you don’t want a
keypad backlight, keep the default setting (black).

Energy Information (view only)

l Minutes Off—Elapsed minutes since device was turned off.

l Minutes On—Elapsed minutes since device was turned on.

l Minutes On Today—Total minutes device has been on for the current day.

l Current Power—Power being consumed by the device at the present time.

l Energy Used—Total watt hours consumed by the device over its lifetime.

l Energy Used Today—Watt hours consumed by the device for the current
day.

Network—(read only) The current MAC address and firmware version of the selected device. These fields are
not editable.

Keypad properties

Properties
l Button Settings

l Name—The name of the button (used for defining its connections to other
devices or events within Composer Pro).
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l Engraving—Text that you want printed onto the buttons. For more
information, see “Ignore device when it comes online—When selected, this
checkbox tells the system to ignore the older device when it comes back
online."—When selected, this checkbox tells the system to ignore the older
device when it comes back online.

l Icons—Icons that you want printed onto the buttons. To add an icon to the
Engraving text box, click Icons, then double-click the icon to add.

l Button Behavior—The fan speed that the selected button activates. You can
also select Keypad for the button to act like a standard keypad button that
doesn’t directly control the fan speed.

l LED Behavior

l Follow Bound Device—LED behavior reflects the state of the device the
button is bound to.

l Follow Fan Speed—LED behavior reflects the fan speed.

l Push/Release—LED behavior reflects the button state (pressed or released).

l Push Color—Sets the LED color while the button is pressed.

l Release Color— Sets the LED color while the button is released.

l Programmed—LED behavior follows programming commands.

l Finish—Color of the buttons.
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Configuring HVAC systems
Use the System Design and Connections views to configure a Control4 Wireless Thermostat. Control4 also
supports multiple third-party thermostat models.

Note: Previous releases of Composer Pro documentation included instructions
about how to configure third-party products and older versions of the Wireless
Thermostat. Starting with OS 2.0, third-party device configurations are no
longer included in the Control4 documentation, although they are still
supported in the drivers list (for example, EnviraZone and Aprilaire RS232).
Refer to previous releases of the Composer Pro User Guide for information
about these third-party drivers and examples of older thermostat models.

Setting up a Wireless Thermostat
Use the System Design and Connections views to set up a Control4 Wireless Thermostat.

Prerequisites
l Ensure that your project has a Control4 controller added to the project tree
and is identified on the Control4 system.

l Ensure that the thermostat is installed at the wall as directed in the Control4
Wireless Thermostat Installation Guide available on the Dealer Portal.

l Ensure that the Control4 Wireless Thermostat is added to the project tree.

To configure a Wireless Thermostat for the Control4 system:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the Residential
Thermostat driver is added to the project tree (unless you’re using a third-party thermostat).

l To program the schedule, see “ Programming the Control4 Thermostat
schedule.”

l To set up advanced properties, see “ Using the Wireless Thermostat advanced
properties.”

Programming the Control4 Thermostat schedule
Use the System Design view to set a heating and cooling schedule for your Control4 Wireless Thermostat
(model number: Control4-CCZ-T1-x for OS 2.0 and later). The Control4 Wireless Thermostat works with your
heating and cooling system to maintain a consistent temperature called a ‘set point.’ Using the Control4
Wireless Thermostat, you can specify separate heating and cooling set points. 

Tip: New in OS 2.0 and later, you can set the heating and cooling schedule
from a touch screen or on-screen Navigator. See the Control4 System User
Guide for details. 

The Control4 Wireless Thermostat automatically engages the appropriate heating or cooling system until the
room reaches the desired temperature. In Composer Pro, you can set up a Heat Point and a Cool point for six
possible Program Events in a day time period. 
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Program Events include:

l Awake—Sets the wakeup time and related Heat/Cool Points.

l Leave—Sets the away time and related Heat/Cool Points.

l Return—Sets for return time and related Heat/Cool Points.

l Sleep—Sets for sleep time and related Heat/Cool Points.

l Custom 1—Sets a specified time and related Heat/Cool Points.

l Custom 2—Sets a specified time and related Heat/Cool Points. 

You can enable these Program Events for weekdays, weekends, or individual days to match activity in the
home.

Prerequisite

Ensure that the thermostat is installed as directed in the Control4 Wireless Thermostat Installation Guide
available on the Dealer Portal.

To program the Wireless Thermostat schedule:

1. In the System Design view, select the Control4 Wireless Thermostat object.

2. The Properties appear in the center pane. Fahrenheit is selected by default; select Celsius as needed.

3. In the Properties tab, select View/Edit Schedule. The Schedule dialog appears with the
currently programmed schedule for Monday through Sunday. 

Note: You can schedule the thermostat either in Composer Pro or in the Control4 touch
screens, Control4 apps, or on-screen Navigators. See the Control4 Wireless Thermostat
User Guide or the Control4 System User Guide for information about scheduling a
Wireless Thermostat from a Navigator.

Tip: To return to the original settings, click the Restore Default button.
4. For each line item: Awake, Leave, Return, Sleep, Custom 1, and Custom 2, use the up

and down arrows to set the day and temperature Heat and Cool set points.
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Notes: (1) You can view the schedule by selecting the 12 Hour Display or the 24 Hour
Display. (2) The Cool and Heat Points stay two degrees apart. Example: If you set the
Heat Point to 72 degrees, the lowest you can set the Cool Set Point is 74 degrees. This
keeps your furnace and your air conditioner from competing with each other.

5. When you are finished, click Ok. Your updated schedule displays. You may then set the modifiable
properties. See “ Using the Wireless Thermostat advanced properties.”

Using the Wireless Thermostat advanced properties
Use the System Design view to view and change the Wireless Thermostat properties. Set the Properties to
create a schedule and the Advanced Properties to modify the thermostat’s configuration.

Ensure that the Control4 Wireless Thermostat (model number: Control4-CCZ-T1-x for OS 2.0 and later) is
installed as directed in the Control4 Wireless Thermostat Installation Guide available on the Dealer Portal.

To use the thermostat advanced properties:

1. In the project tree select the Control4 Wireless Thermostat.

2. Click the Properties tab to view the list below. 

Note: Different properties may appear, depending on the thermostat model. The
properties below apply to the Control4 Wireless Thermostat for OS 2.3.0 or later.

Modifiable Advanced Properties include: 

Properties
l Fahrenheit or Celsius—Sets the temperature display in Fahrenheit or Celsius.

l View/Edit Schedule—Brings up the schedule page to set heat and cool set points
for auto mode (see below). In the mode (Awake, Leave, Return, etc.), set the day
and temperature set points. Click OK to close the window. Note: You can view the
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schedule by selecting the 12 Hour Display or the 24 Hour Display.

l Vacation—Lets you set the Heat Set Point and Cool Set Point when the
homeowner is on vacation. Use the up or down arrows to set the heat and cool set
points, and then click OK.

l Use Remote Temperature Sensor—Sets the thermostat to use either the on-board
Local temperature sensor (default) or an optional Remote temperature sensor to
control the HVAC system by selecting the Use Remote Temperature Sensor radio
button.

l Buttons—Locks local buttons to prevent unwanted changes to thermostat settings.
Select the Locked and Unlocked radio buttons. Note: If buttons are disabled, they
will be re-enabled when the thermostat power cycles. This is a safety mechanism to
prevent a thermostat from becoming completely inoperable if it were removed from
a project while the buttons were disabled. 

Advanced Properties
l General Setup

l Backlight Mode—Lets you select your preferences for the backlight. Select On
Button Press to light the backlight for ten seconds when any button is pressed.
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Select Always On to keep the backlight on constantly. When using batteries for
power with power stealing enabled, the Always On option is not recommended.

l Battery—Shows the power source or battery level (for example, "Externally
Powered").

l Time Format (Date and Time)—Lets you set preferences regarding Date Format
(MM/DD/YYYY or DD/MM/YYY) and Time Format (12 h or 24 h). Click the
Sync Time button under Time Format to update the time on your thermostat
manually to the controller. (The thermostat also updates automatically at 3:00 AM
each morning.)

l Network—Displays informational boxes that provide Zigbee networking
information (MAC and Firmware Version).

l Advanced Device Configuration—Click this button to fine-tune your thermostat
(see below).

3. Select Apply to to apply the current properties to the selected Wireless Thermostats.

Advanced Device Configuration
Control4 has enhanced the available thermostat settings to allow users and installers to modify engage
and cutoff temperature deltas—as well as maximum and minimum run time, off, and delay times—so that
the thermostat can be configured to run optimally with any HVAC system.

Note: Allowing such fine tuning of all settings can result in setting improper
values and combination of values to cause the HVAC system to run less than
optimal. To prevent thrashing the cool and heating engage (constant heat, then
cool, engagement), cutoff and set points are enforced to have at least a one
degree difference for engage temperatures.

The formula for the dependency of these values is:

Heat/cool engage delta—Opposite stage (if heat engage, then cool cutoff and visa versa) cutoff delta +
set points delta (cool set point – heat set point) >=1

The screen below shows the Advanced Device Configuration properties. 
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l Temperature Calibration—Use the up or down arrows to set x degree(s), and
then click Set Calibration. This lets you fine tune the current temperature
reported by the thermostat by +/- 5 degrees. Example: If your thermostat
reads 72 degrees Fahrenheit, and you determine that the current
temperature should be 70 degrees Fahrenheit, press the down button two
times to lower the thermostat’s reading to 70 degrees Fahrenheit. Click Set
Calibration.

Note: No changes to calibration should be made within 20 minutes of
powering on the thermostat. The thermostat generates a small amount of
heat which affects the calibration. After 20 minutes of continuous operation,
this will stabilize allowing proper calibration.

l Heating Cutoff Point—Use the up or down arrows to set x degree(s) from
the set point, and then click Set Heat Cutoff. This sets how far over the
setpoint you want the heating system to remain engaged before shutting off.
Example: If the heat set point is set to 68 degrees Fahrenheit and the cutoff
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point is set to 2 degrees Fahrenheit, the heating system will engage until
reaching 70 degrees.

l Cooling Cutoff Point—Use the up or down arrows to set x degree(s) from the
set point, and then click Set Cool Cutoff. This sets how far under the setpoint
you want the cooling system to remain engaged before shutting off.
Example: If the cool setpoint is set to 68 degrees Fahrenheit and the cutoff
point is set to 2 degrees Fahrenheit, the cooling system will engage until
reaching 66 degrees.

l Stage Minimum Off Time (Minutes)—Use the up or down arrows to set the
minimum off time in minutes. Note: This setting takes effect as soon as the
Advanced Device Configuration box is closed.

This is the minimum amount of time that the heating or cooling will remain off before initiating again.
Example: If while cooling, the temperature does not reach the designated cutoff point before the
maximum run time is reached, the cooling system will shut off and not initiate cooling again until the
Minimum Off Time is reached. Note: Some HVAC systems automatically enforce a Minimum Off
Time. In this case, the heating or cooling will remain off for the higher of the two settings (thermostat
or HVAC system).

Stage Configuration (Heat Stage 1, 2; Cool Stage 1, 2; Auxiliary; Emergency)

The stage configuration boxes allows for setting the engage delta, minimum run time and maximum
run time for each stage.

Note: These settings take effect as soon as the Advanced Device Configuration
box is closed.

l Delta (degrees)—Use the up or down arrows to set the stage engage
temperature delta. This sets howmany degrees the current temperature will
reach beyond the setpoint before the stage engages.

Example:

For heat, if the heat setpoint is 70 degrees Fahrenheit and the engage delta is 2 degrees Fahrenheit,
the heat stage will engage when temperature reaches 68 degrees.

Note: For multi-stage systems, the deltas for the first and second stages are
cumulative. If the first stage delta is set at 2 degrees Fahrenheit and the
second stage delta is set at 2 degrees Fahrenheit, the second stage will not
engage until the current temperature has passed the stage setpoint by 4
degrees Fahrenheit. However, the Auxiliary Heat and Emergency Heat deltas
are NOT cumulative.

l Minimum Run Time—Use the up or down arrows to set the stage x
minimum run time in minutes. The minimum run time is one minute. This
sets the minimum time the heating and cooling will run before shutting off.
Example: If while cooling or heating, the temperature reaches the designated
Cutoff Point before the Minimum Run Time is reached, the system will not
shut off until the Minimum Run Time is reached. Also, if heat or cool is
engaged and shut off manually, the system will not shut off until the
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Minimum Run Time is reached. Note: Some HVAC systems have built-in
Minimum Run Times that may be greater than that set on the thermostat.

l Maximum Run Time—Use the up or down arrows to set the Heat Stage x
maximum run time in minutes. The maximum run time is 255 minutes. This
sets the maximum time the heating or cooling will run before turning off.
Example: If heating or cooling is engaged, but does not reach the Cutoff
Point before the Maximum Run Time is reached, the cooling system will turn
off. Note: The Maximum and Minimum Run Times are not per stage, but for
cooling and heating run times regardless of first or second stage transitions.

Auxiliary Stage

The Auxiliary and Emergency Heat stages are specifically for heat pump systems.
The switches on the back of the thermostat allow the thermostat to operate a
heat pump system.

Note: These settings take effect as soon as the Advanced Device Configuration
box is closed.

l Stage Delay (Minutes)—Use the up or down arrows to set the stage delay for
xminutes. This sets the allotted time the main heat pump system will run
without reaching the desired heat setpoint goal before the Auxiliary stage
engages. Note: If set to the maximum time allowed, the auxiliary system will
be disabled and never engage.

l Stage Cutoff Delay (seconds)—Use the up or down arrows to set the stage
cutoff delay in seconds. This sets howmuch of a delay before the main heat
pump cuts off, leaving the Auxiliary heating stage to run on its own. Note: If
set to the maximum time allowed, the main heat pump stage and the
Auxiliary heat stage will run together indefinitely.
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Configuring a camera
Use the System Design and Connections views to configure this device. Security
cameras, including on-screen controls in Navigators such as pan, tilt, zoom, and
preset settings, are supported, along with HTTP control and JPEG or MJPEG
images.

Drivers for cameras (also referred to as IP cameras, web cameras, or security cameras) now have greater
configurability within Composer Pro. A camera diagnostics page has also been added to the basic properties.
In addition, the video feed quality is greatly improved for mobile viewing.

Prerequisites
l Ensure that your project has a Control4 controller added to the project tree
and is identified on the Control4 system.

l Ensure that the camera is installed as directed in the manufacturer's
installation guide.

To add and configure a camera:

1. In the camera's Properties pane, click Help. A help topic opens explaining how to configure and test the
camera driver.
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Configuring Black & Decker locks
Use the System Design view to add and configure Black & Decker KwikSet®

SmartCode® with Home ConnectTM Technology Zigbee Deadbolt locks, Baldwin,
or other supported locks for exterior doors. In general, these instructions can be
used to add and configure lock drivers for other lock products compatible with
Control4 systems.

Ensure that the Black & Decker locks are installed as directed in the Black & Decker Installation instructions
shipped with the product.

To add and configure Black & Decker locks:

1. To add the driver and identify the device see “ How to add devices to a project.” Ensure that the Black and
Decker SmartLock RF Zigbee driver is added to the project tree.

Tip: If you are adding several locks in a home, it might be useful to give each lock a
unique name.

2. For each lock you add to the project, add a Relay to the project tree also. See “Configuring Motorization.”

3. Click the Connections view.

4. In the Connections view, use the Control & Audio Video Connections tab to make the necessary control
connection.

5. Under Control Outputs, select the Lock State and drag it down to the Relay in the RELAY Input Devices
pane.

6. (Optional) For additional Black and Decker Zigbee Lock setup, configure the
Properties.

1. In the System Design view project tree, select the Black and Decker Zigbee Lock
object.

2. Modify the properties in the Properties pane, and then click Set (if applicable).
l Debug Mode—Use the drop-down menu to select logging and printing.

l Lock Sleep Timer—Use the drop-down menu to select how long the lock is
in sleep mode (in seconds).

l # of Log Items—Use the up or down arrows to set the number of items to
log.

l Last Status—Last change made in Debug Mode.

l Firmware Version—Indicates the Zigbee firmware version for the lock.

l Instructions—See the Documentation tab.

l Name, Code x—Enter the lock name and code here. You can enter up to 30
code entries. Set up the user codes here. Type the user's name, then a
comma (,), and then add the numeric code (4 to 8 characters allowed).
Example: Bob, 12345. Up to 30 codes can be entered.
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Tip: The codes can be entered also on the touch screen or on-screen Navigator
if you download the Black & Decker application from 4Store.

3. Click the Documentation tab for additional information about setting the properties, user codes, and actions
for the locks.

4. Click the Actions tab.

l Get Battery Status—Click to show the status of the battery on the lock.

l Show User Codes—Click to show all of the user codes assigned to this lock.
The user codes appear in the Properties tab.

l Hide User Codes—Click to hide all user codes assigned to this lock. The user
codes appear as x's in the Properties tab.

l Delete All Codes—Click to delete all user codes assigned to this lock. 

Note: You can set the user codes either from Composer Pro, or from the touch
screen or on-screen Navigator in My Apps (downloaded from 4Store). The
priority for setting user codes and Actions is whoever set the codes or actions
last, whether it was in Composer Pro or on a touch screen or on-screen
Navigator, will be the valid codes or actions used. See the Black & Decker
KwikSet SmartCode with HomeConnect™ Locks User Guide on the Control4
Products page for details.

5. Click the Lua tab. This is used for the DriverWorks SDK (developers only).
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Connecting devices
After you plan and create the project in Composer Pro's System Design for a Control4 system (adding the
buildings, rooms, devices, etc.), you are ready to make the necessary connections in the system. Just like you
connect cables and wires between your physical devices so they work together, those same connections need
to be added virtually in Composer Pro using the Connections view.

Use this chapter to learn how to:

l Connect devices virtually

l Verify the connections by testing them
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Why you need connections
The software connections represent either connections between the controller and its attached devices or
connections among AV devices.

When you match the connections together in Composer Pro, the software connections mirror the hardware
connections in the system where appropriate. The system can then control the connected devices and
identifies where to route the media where it’s available. 

These types of connections are used in the Control4 system:

l Network Connections—Defines the devices that use a network address. Network connections include IP
and Zigbee or Zigbee Pro devices.

l Control Connections—Defines the control connection between a device and the controller. Control
connections include contacts, relays, serial, and IR -controlled devices.

l Audio and Video Connections—Defines the devices that have audio and/or video signals.

l Room Connections—Defines the video, audio, or video/audio end points and the video/audio or audio
volume for the selected room.

Connection design tips for CentralizedLighting
Because there could be potentially many devices in a Centralized Lighting solution, making the proper
connections between the modules and loads is key to efficient Centralized Lighting design. It will require some
practice and trial and error on each project to get the system designed the way you want it.

Keep these things in mind:

l Each module ideally should use all channels and be close to the maximum wattage allowed. This must
be traded off, however, against certain realities; for example, arc-fault breakers, numerous small loads,
and very large loads.

l Whenever possible, put the loads in the same room on the same module. This allows each module
override scene to control loads that would be grouped together logically.

l When using multiple panel/module installation locations, connect loads to modules in a nearby location
to minimize long wiring runs.
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Connect and verify devices
In Composer Pro Connections, you can:

l Identify Control4 devices to establish a network connection

l Check all network connections

l Define AV connections

l Define control connections

When only one connection is available in a room for a given connection type, Composer Pro assumes that
connection.

Tip: To remove any inappropriate connection, right-click the connection, and
select Disconnect.

Example: If a TV is the only Audio Output device in a room, the system
assumes that the Audio Output connection is routed to the TV. This feature
adds value to Composer Pro, but increases the need to verify every
connection.

To connect devices:

1. Start Composer Pro and connect to a Director.

2. Click Connections.

3. Identify the devices to add their network addresses to the project.

1. In Connections, click the Network tab > IP Network (default). 

Notice the devices that do not have an address listed in the Address column of the IP
Network Connections pane. These devices need to be identified and connected.

Tip: Devices that appear with a highlighted SDDP in the Available Devices pane
can be added and identified using Auto Discovery. See “Auto Discovery (SDDP)”
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in this document for details.

2. Select an unidentified device in the address list, then right-click and select Identify (or click the Identify
button in the list header). A device-specific instruction screen with a graphic of the device displays (for
example, 8 Channel Dimmer).

3. At the physical device, press the Identification button or dial, as indicated on the screen. The button to be
pushed on the device flashes on the screen.
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4. When the device’s network address displays in the box, click Next to continue, or click Close if you’ve
identified the IP network device. Follow these steps for each device.

When you are finished, notice that the Address column is populated with an address for the network
device.

Define the control and AV connections

4. For each device, define the following when applicable:

l Video connections (path of video signals)
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l Audio connections (path of audio signals)

l Control connections (how the controller communicates with the device)

To define the connections:
1. In Connections, click the Control/AV tab.

2. Select a device in the Control/AV tab. The Control & Audio Video Connections for the selected device display
in the top pane.

3. Select one of the device’s connections in the top pane. The available connections for the selected connection
display in the bottom pane.

4. To make a connection, drag a device’s input (or output) in the top pane to the output (or input) in the bottom
pane.

Example 1: Make Receiver Connections 
In the top pane under Audio Video Inputs:

5. Click INPUT DVD (Video-COMPOSITE), and drag it to DVD (Output—Theater) in the bottom pane.

6. Click INPUT VIDEO 1 (Video-COMPOSITE), and drag it to Home Controller HC-800 (Video Out 1-
Theater) in the bottom pane. This connects the Receiver Video 1 input to the controller Video 1 output.

7. Click INPUT DVD (Audio-STEREO), and drag it to DVD (Output-Theater) in the bottom pane.

8. Click INPUT VIDEO 1 (Audio-STEREO), and drag to Controller (Stereo 1-Theater) in the bottom pane.

9. In the top pane under the Control Inputs pane (scroll down), click IR Sensor (Control-IR_OUT), and drag it to
Controller (IR Output 2-Theater) in the bottom pane. 
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Example 2: Make Television Connections 

In the top pane under the Audio Video Inputs pane:

10. Click AV (Video-COMPOSITE), and drag it to Receiver (Output-Theater) in the bottom pane.

11. Click AV (Audio-STEREO), and drag it to Receiver (Output -Theater) in the bottom pane.

12. Under Control Inputs, click IR Sensor (Control-IR_OUT), and drag to Controller (IR Output 1-Theater) in
the bottom pane.

Example 3: Make module and load connections for Centralized Lighting

In the Control/AV tab:
13. Select the room where the module is located, Mechanical Room, and then select the module, for example,

8-Channel Dimmer 1.
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14. In Control & Audio Video Connections, locate the first entry Channel 1 under Circuit 1.

15. Click Channel 1 and drag it to Overhead Lights in the bottom pane.

16. Click Channel 2 and drag it to Fan Light in the bottom pane.

17. Click Channel 3 and drag it to Alcove Lights in the bottom pane.

18. Note ‘Connected To’ in the top pane and ‘Connections’ in the bottom pane. You should see that the module
and load are now connected.

19. Filter the loads by Unbound, Bound, Dimmable lights, and Non-Dimmable lights:

20. The following example shows bound, non-dimmable lights. This is an easy way to
make sure all of your connections are correct.
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21. View the wattage: max, used, and available wattage for each circuit as you make the connections.

Watt types:

l Circuit watts—The total number of watts allowed on each circuit.

l Dimming watts—The dimming number of watts allowed when using Arc-Fault
breakers.

l Module watts—The total number of watts allowed for the module.

22. If you get an overloaded circuit error message, connect the load to a different module.

23. Connect the modules to the panels.

l It’s easier to connect from the panel to the module.

l Ethernet switches are installed in Slot 5 (bottom slot).

l If 8-channel dimmers are mixed with other module types, the dimmers
should be installed toward the top of the panel for the best heat ventilation.
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Connection Filters
In Composer Pro Connections view, you can use filters to narrow the output connections to more easily find
connections. This can save you time in small and large projects.

To use Connection Filters:

1. In Composer Pro, click Connections.

2. Select a connection to make, for example, click on a room and Video End-Point.

3. In the bottom-right pane, VIDEO_SELECTION Output Devices, the available filters are listed above the
output devices.

1. Select a room to filter output devices by a specific room.

2. Select All Connections, Not Connected, or Connected to filter output devices by connection status.

3. Enter text to filter output devices by name, location, or connection.

4. Click Clear Filters to remove any applied filters.

Tip: When filters are active, the background around the filters is blue.
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Connecting rooms
Use the Room Connections to set configuration connection options to customize and optimize audio and AV
paths to control devices in a room.

Get room connections
To get to room connections:

1. Start Composer Pro and connect to a Director.

2. Click Connections.

3. Select the room in the project tree.

4. Click the Control/AV tab. The Control & Audio Video Connections pane displays.

If you use System Design views, room connections use the default settings according to the devices you
add.

Example: For a basic system with a television, DVD player, VCR, and satellite,
Composer Pro by default makes the television the video end point which is the end
of the AV path for viewing video. The video audio end point is the end of the AV
path for listening and managing volume for sound when viewing a DVD, VCR or
satellite.

Example: Video End-Point—The Plasma Television displays video for DVD, VCR,
and satellite.
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Note: For the Control4 system to work properly, verify that the default settings
match your physical environment. Define each room connection according to your
Control4 system. If the default settings do not match your system setup exactly,
change the settings to match the physical environment, and define each room
connection according to that system setup.

An End Point defines the software path that an audio or video signal must follow to reach the desired
destination. 

Example: When a device is selected as a Video End Point, start at the device and
work backward to figure out the source-selection and input-switching that must take
place to display video. 

Note: Speakers are not included in the Control4 project configuration. 

A room provides two priority levels for end points of audio (Audio End Point 1 and 2) and two for audio playing
for video (Video Audio End Point 1 and 2). The system automatically connects the first end point in the room to
End Point 1 as the first priority. If that device is part of AV path selected, it manages the volume in the room
automatically.

Room connection types
The general types of room connections are:

l Video End Point—On the Control4 system, this is the end of the path in the selected room that defines
video. The default is the Television.

l Audio End Point 1 and 2—On the Control4 system, this is the end of the path in the selected room that
defines audio. The default is the first applicable devices added to the system, for example, a Speaker
Point. However, when a television is added, it overrides the initial setting. When a receiver is added, it
overrides the television.

l Video Audio End Point—On the Control4 system, this is the end of the path in the selected room that
defines audio when watching video on the Control4 system. The default is the first applicable device
added to the system. However, when a television is added, it overrides the first device. When a receiver
is added, it overrides the television.

l Video Volume 1 and 2—Options that let you set the volume management to a device that is not an audio
end point or a video audio end point.
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Example: If you added an AV switch to your system, the television is probably
the video audio end point, but you want to use the AV switch for volume
control to utilize added features of the switch. 

l Audio Volume 1 and 2—Options that let you set the volume management to a device that is not an audio
end point or an audio video end point. 

Example: If you added an audio switch to your system, another device is
probably the audio end point, but you should use the audio switch for volume
control. 

l On-Screen Device—Defines the device (television) that displays the on-screen Navigator.

l Temperature and Temperature Control—Defines the device that manages the temperature in the room,
such as a thermostat.

l Security System—Defines the device that manages the security system in the room, such as a security
system.

Examples of system configurations
The following examples show possible system configurations. 

Example 1: Video Audio End Point 1 and 2—The Plasma Television is Video
Audio End Point 1 and the receiver is Video Audio End Point 2The Plasma
Television manages the volume when the homeowner watches cable, and the
receiver manages the volume when the homeowner watches the DVD or VCR.

Example 2: Video Audio End-Point 1—The receiver is Video Audio End Point 1 and
manages the volume in the room when the homeowner watches video using the
DVD, VCR, or cable.

277



Composer Pro User Guide

Example 3: Video End-Point—The Plasma Television switches video for DVD,
VCR, and satellite.

Example 4: Video Audio End-Point (combined)—The receiver switches both
audio and video for DVD, VCR, and satellite.

Example 5: Audio End-Point—The receiver switches audio for DVD, VCR, and
satellite.
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Tip: Understand the physical room connections on your system. The system
uses default settings. It cannot auto-detect how your system is set up.

Verify default room connections
To verify default room connections including prioritized AV audio end point providers:

1. Add devices to the project using Composer Pro System Design view. See Composer Pro Getting Started for
details.

While you set up the project, room connections are set for you according to the default settings. The
defaults are set by rules in the system, and they might not match your physical environment. Manually
ensure that the settings match your desired outcome.

2. Verify that the initial room connections are set up correctly for each room.

1. From Connections, click the Control/AV tab (default).

2. Click the room in the project tree.

3. Verify each connection by ensuring that it mirrors your exact hardware setup.

4. To change a connection, select a device in the project tree, and then select the device to change in the
Control & Audio Video Connections pane.

5. In the Room Control list, select an item in the upper list, and then drag it to an item in the lower list to connect
the two items. When successful, both lists update to reflect the connection.

Example: To show how to change a connection from the top center pane, click Video
Audio End Point (RoomControl-AUDIO_SELECTION), and drag it to the bottom
pane to connect it to Television (Room Selection - Output-Theater).
Example Project: Using the sample project, ensure that the following room connections
exist as outlined in the table.
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Room End Point or Volume Device (End Point or
Volume Management)

Theater Video End Point 1 Television (default setting)

Audio End Point 2 Receiver (default setting)

Video Audio End Point 1 Receiver (default setting)

Video Volume Not set

Audio Volume Not set

Bedroom Audio End Point Mini Touch screen

Audio Volume Touch screen

Front There are no video or audio End Points or any devices
that can manage volume in the Front room, so you don’t
need to identify the video or audio source or volume
control device in that room, or modify the room for
room connections.

3. Create a connection to define the other devices in the room where you want volume.

1. Select a room in the project tree.

2. In the Room Control list, select an item in the Control & Audio Video Connections, and then drag it to an item
in the lower list to connect the two items. When successful, both lists are updated to reflect the connection.

Example: From the top center pane, click Video Volume 2 (RoomControl-AUDIO_
VOLUME), and drag to the bottom center pane to connect it to Television (Room
Selection - Output-Theater).

280



Composer Pro User Guide

Connecting devices to the network
After you complete your planning and design of a Control4 system (adding the buildings, rooms, devices, etc.,
see the Composer Pro Getting Started guide for details), you are ready to make the necessary connections in
the system.

Connecting a device to the network
The Network tab lists all devices in the systems with a network connection and lists network addresses.

Verify the network address for any device that communicates to the controller using TCP/IP, Wi-Fi, Zigbee,
Zigbee Pro or any other device that uses a network address.

To connect network devices:

1. Start Composer Pro and connect to a Director.

2. Click Connections > Network tab.

3. Select the device, and then click Identify for the wizard to open.

4. Follow the on-screen instructions to identify each device as indicated. After identifying the network
connection, the device’s address appears.

5. Use the Network tab to identify devices to the Control4 system that use a network address.

There are two places to verify network connections: the Network tab and the Tools menu.

Configuring a Wi-Fi connection
Use the System Manager tool to connect to Wi-Fi. 

Some devices can be connected directly to Ethernet, and then can be configured on a Navigator. See your
device's installation instructions for details about how to configure wireless on a Navigator page (More >
Settings > Network).

Prerequisites

To establish a Wi-Fi network connection to a controller or other wireless device in the Control4 system, first
establish an Ethernet connection, and then configure the Wi-Fi.

To connect to Wi-Fi, complete the following steps:

1. Establish an initial temporary Ethernet connection from the device to the Ethernet
network using a Category 5 (CAT5) cable.

2. Start Composer Pro and connect to a Local Director.

3. From the Tools menu, select System Manager.

4. From the Devices pane, select the network address for the device you want to set up,
and click Connect.
l If the device’s network address is not on this list, click Refresh.

l If it still does not appear, click Add to enter it manually.

l If you do not know the network address, you can find it at the Connections >
Network tab.
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5. Click the Network tab, and then click Configure.

6. Click Next when the Network Configuration Wizard dialog appears. Continue through the wizard screens and
provide the following information appropriate for your system. Much of this information has to match that of
your Wireless Access Point (WAP).

7. Enter the new device name. Do not include spaces in the new name.

8. Indicate the network type: Wireless (WiFi) network.

9. Indicate the method for obtaining DNS server address: DHCP or Static IP. Control4 recommends DHCP
(automatically selected).

10. Enter the SSID number.

11. Enter the WEP key (if any).

12. Enter the encryption type (64 or 128).

13. Click on a key type (hex or ascii).

14. Click Finish to complete the wizard; reboot the adapter to apply the network configuration changes.

15. Disconnect the Ethernet cable from the controller.

Verifying the network connections
Use the Network tab or Network Tools to verify the Control4 system network
connections.

Prerequisites

Ensure that the devices to be connected have been added to the project.

Network Tab

To ensure that all network connections are identified on the Network tab:

1. Click Connections > Network tab > IP Network.

2. In the Address column, check whether there is an address for every line item.

Network Tools Option

To ensure that all Network connections are connected and active at the Network Tools:

1. From the Tools menu, select Network Tools.

2. Check both the IP Network and ZigBee Network tabs for Green, Yellow, and Red connection icons.

The colors indicate the following:
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l Green—An address is identified and the device is online. For example, the dimmer
is identified and communicating to the system.

l Yellow—An address is identified and the device is offline. For example, if the
System Remote Control goes to sleep, the status turns yellow. This indicates that
the System Remote Control has been identified, but is offline. Make this device
active so it can communicate to the system.

l Red—A device is not identified. Go to the Connections view > Network tab and
identify the device to the system.

Tip: Be patient. In cases where the Zigbee mesh is moved, it can take up to five
minutes for all connections to get re-established.

3. If you find yellow or red icons, do the following:
l Yellow icons—Go to the device and activate it according to its documentation.

l Red icons—Go to the Connections view > Network tab and identify the device to
the system.

Example: At this point in your project, the System Remote Control should be
yellow (or the only device not green). The System Remote Control turns green as
soon as you wake it. To wake the System Remote Control press the red Control4 4
button.
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Tip: You can also review a device’s Zigbee signal strength by checking the strength
meter icons in the Signal column. The strength meters show the strength of the
signal as detected by the next nearest Zigbee device.
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Connecting Zigbee devices
After you have added all the necessary device drivers into your project and configured a Zigbee mesh
controller, you are ready to make the necessary connections for these drivers.

Connecting Zigbee device drivers to the Zigbee network
To connect a Zigbee device driver to the Zigbee controller:

1. In Connections in the Network tab, select Zigbee Network.

A list of Zigbee device drivers will show in the Zigbee Network Connections window.

2. Double-click on the Zigbee device driver to open the identify window or highlight the device and click on the
Identify button.
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3. Identify (add) the Zigbee device according to the instructions, usually by pressing a Zigbee button on the
device.

Note: You have 60 seconds to identify (add) the Zigbee device to the network
and a timer will show the time remaining. If you run out of time, close the
window and try to identify the Zigbee device again.

4. If the device is added, configured, and identified successfully, the address will show in the address field.

Note: If the Zigbee device will not identify (add), you should try to remove the
device and then try to identify the device again.

Zigbee Mesh Routing Tree
When the device is identified and added to the Zigbee network, the Zigbee Mesh Routing Tree window will
show the device online with a green icon.
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Connecting Z-Wave devices
After you have added all the necessary device drivers and motorization, sensor or light drivers into your
project, you are ready to make the necessary connections for these drivers.

There are two types of connections that need to be made:

l Connect Z-Wave device drivers to the Z-Wave controller and identify them into the project

l Connect Z-Wave device drivers virtually in the Control4 project to motorization, sensor, or light drivers

Connecting Z-Wave device drivers to the Z-Wave network
To connect a Z-Wave device driver to the Z-Wave controller:

1. In Connections in the Network tab, select Z-Wave Network.

A list of Z-Wave device drivers will show in the Z-Wave Network Connections
window.

2. Double-click on the Z-Wave device driver to open the identify window or highlight the device and click on the
Identify button.
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3. Identify (add) the Z-Wave device according to the manufacturer’s instructions, usually by pressing a Z-Wave
button on the device. See the documentation for the Z-Wave device for more information.

Note: You have 60 seconds to identify (add) the Z-Wave device to the network
and a timer will show the time remaining. If you run out of time, close the
window and try to identify the Z-Wave device again.

4. After adding the Z-Wave device to the Z-Wave network, the driver will do some additional configuration.

Important: Do not skip this step by closing the window or clicking next!
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5. If the device is added, configured, and identified successfully, the address will show in the address field and
the timer instructions will change to say “Identification Successful”.

Note: If the Z-Wave device will not identify (add), you should try to remove the
device and then try to identify the device again. See “Removing Z-Wave
devices”.

Connecting Z-Wave device drivers to motorization, sensor
or light drivers
To connect a Z-Wave device driver to a motorization, sensor or light driver:

1. In Connections under the Control/AV tab, select the Z-Wave device driver. The Control & Audio Video
Connections window will show the available connections.

2. Click on the Control Output connection Door/Window Sensor and the available devices to connect appear
below in the CONTACT_SENSOR Input Devices window.
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3. Click and drag the contact sensor output in the upper window to the contact sensor input in the lower
window. When a valid connection is available, the cursor changes and has a + symbol. Release the mouse
button to make the connection.

When the Z-Wave devices are connected to the appropriate motorization, sensor or light drivers, the UI will
now show appropriate drivers to represent the Z-Wave devices. Now the Z-Wave device drivers must be
connected to the Z-Wave controller and identified in the project.

Available Devices
When the device is identified and added to the Z-Wave network, the Available Devices window will show the
device online with a green icon. A Z-Wave device that is added to the Z-Wave network and also identified to a
device driver will show the device driver name and location next to the Node ID.

Z-Wave devices that are added to the Z-Wave network, but not identified to a device driver will show up with
just the Node ID.
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Removing Z-Wave devices
Z-Wave devices can be removed from any network at any time by using the Remove button found in Available
Devices. This is true even if they are not part of the network performing the remove operation.

Removing Z-Wave devices from a previously installed network requires an available Z-Wave controller and
interaction with the Z-Wave device-usually by pressing the Z-Wave button on the device. There is no “Remove
from mesh” button press sequence similar to ZigBee Pro devices.

Removing Z-Wave devices from the network
To remove a Z-Wave device from the network:

1. In Connections in the Z-Wave Network, click Remove in the Available Devices window.

The Removing Z-Wave Device window appears and a 60 second timer starts.

2. Remove the Z-Wave device from the network according to the manufacturer’s instructions, usually by
pressing a Z-Wave button on the device. See the documentation for the Z-Wave device for more information.

Note: If the device is not removed from the network before the timer ends,
close the window and click the Remove button to try again.

3. If the device was removed successfully, the timer will stop and the window will say the devices was removed
from the network.
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4. If the device is not removed from the network before the timer ends, close the window and click the Remove
button to try again.

Removing failed Z-Wave devices
If a Z-Wave device has become lost or inoperable so that a physical button press cannot be performed to
remove it from the network, the Remove Failed option is provided. Remove Failed is used to force a Z-Wave
device off of the network.

Important! Do not use this option if the device is operational. See “Removing
Z-Wave devices from the network”. Use this option only if a device has
physically failed and is inoperable!

To remove a failed Z-Wave device:

1. In Connections under Z-Wave Network, right-click on the Node ID of the failed Z-Wave device, and select
Remove Failed.

2. The controller will make one last attempt to communicate with the Z-Wave device. If the device successfully
communicates, the Remove Failed will not proceed and the device must be removed using the Remove
button instead. Remove the device according to the manufacturer’s instructions, usually by pressing the Z-
Wave button.

3. If the communication attempt fails, the device will be removed from the network and will not be tracked as a
Z-Wave node by the Z-Wave controller. Be aware that this device must now be reset to defaults before using
the device again within the system. See the manufacturer’s instructions for more information.

Replacing failed Z-Wave devices
If a Z-Wave device has become lost or inoperable so that a physical button press cannot be performed to
remove it from the network, the Replaced Failed option is provided. Replace Failed is used to force a Z-Wave
device off of the network and prompt the user for a replacement. The new device can be either the same type
or different.
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This option allows you to replace a Z-Wave device and preserve the same Node ID. This can be useful if you
have some direct device associations done between Z-Wave devices. It is not needed for most Control4
systems.

Important! Do not use this option if the device is operational. See “Removing
Z-Wave devices from the network”. Use this option only if a device has
physically failed and is inoperable!

To replace a failed Z-Wave device:

1. In Connections under Z-Wave Network, right-click on the Node ID of the failed Z-Wave device, and select
Replace Failed.

2. Click Yes to continue only if you are replacing a failed device.

The controller will make one last attempt to communicate with the Z-Wave device. If the device
successfully communicates, the Replace Failed will not proceed and the device must be removed using
the Remove button instead. Remove the device according to the manufacturer’s instructions, usually by
pressing the Z-Wave button.

If the communication attempt fails, the device will be removed from the mesh and will not be tracked as a
Z-Wave node by the Z-Wave controller. Be aware that this device must now be reset to defaults before
using the device again within the system. See the manufacturer’s instructions for more information.

3. Add the replacement Z-Wave device to the mesh according to the manufacturer’s instructions (usually by
pressing the Z-Wave button) before the timer expires.
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4. When the device is added successfully, the timer will show complete and a message will say the replacement
was successful.

Connecting and managing control and AV devices
Control/AV connections are visible when you select the Control/AV tab in the Connections view. The
Control/AV tab lets you define the physical connections between the controller or other devices, including AV
signals, IRs, relays, contacts, and/or serial connections.

Tip: If connections do not appear as needed, edit the driver to create the
needed connections as described in “Editing a Driver Using the Driver Wizard.”

Verifying control and AV connections
Use the Control & Audio Video Connections pane to verify connections, and use
the System Design view to verify room connections.
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To verify all Control and AV connections by checking the connection list:

1. Click Connections, and select the project from the project tree. The Control & Audio Video Connections pane
displays.

2. Carefully go through all your Control and AV connections by verifying each connection in the pane.

To verify all Control and AV connections by checking room properties:

1. Start Composer Pro and connect to a Director.

2. Click System Design.

3. Select a room in the project tree.

4. Click the List View tab. On the List View tab check whether your AV devices are accessible in the room. If an
AV device is in a room and in your project; but if it is not in the view, see “Connect and verify devices.”

Disconnecting or removing control/AV connections
Use the Connections view to remove and disconnect a connection.

To disconnect or remove a Control/AV connection:

1. Start Composer Pro and connect to a Director.

2. Click Connections.

3. Click the Control/AV tab.

4. In the Control/AV project tree, select a device for the device’s control and AV connections to appear.

5. In the Control and AV Connections pane, right-click an input (or output) connection and select Disconnect.

Re-assigning control/AV connections
Use the Connections view to reassign connections.

To re-assign Control/AV connections:

1. Start Composer Pro and connect to a Director.
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2. Click Connections > Control/AV tab.

3. In the project tree, select a device. The device’s control and AV connections appear.

4. In the Control and AV Connections pane, drag an input from the top pane to a different
output on the bottom pane. The connection is moved to the specified output. 

Updating connections when a location changes
If you use the same project but you change locations, update all of the Control4
system connection information in Composer Pro.

To update the connection information in an existing project:

1. Start Composer Pro and connect to a Director.
2. Click Connections.

3. Click the Control/AV tab, and review your connections to ensure they are updated in the current control and
AV topology.

4. Click the Network tab. Disconnect all connections by right-clicking and selecting Disconnect.
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5. Re-assign each connection. 
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Testing device connections
Use the Connections view to test that connected devices work.

After you've added and identified the device, in Connections check the Network
tab to see if an IP address appears in the IP Network Connections pane. If it
doesn't, the device has not been connected properly. Try to connect the device
again.

Testing device controls
After you add an item to the project tree and the device is physically connected,
test that you can control the device.

To ensure the devices are controllable:

1. Click System Design.

2. In the project tree, double-click the icon of each device for its Device Control window to appear. 

Example: Television 

3. Click the available controls in the graphical representation to:

l Ensure that the commands work

l Set the parameters temporarily (for example, configuring the LED lights on
dimmers) 

Notes:
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l If you double-click a device and a Device Control window does not appear, it
indicates that one is not available for that device or item.

l These user interfaces are not specific for each device and model. Understand
the capabilities of a device before testing it.

Device Control examples

Note: The Device Control windows in Composer Pro are provided for testing
purposes only. When you make changes on the Device Control windows for
each device, it only changes the device settings temporarily. Use the
Properties pane or programming to change the device settings permanently.

The following examples show Device Control windows for various devices:

3 Button Keypad

6 Button Keypad

Controller
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Dimmer

DVD Player
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Electronic Gate

Motorized Screen

Receiver

Sprinkler System

System Remote Control, SR-250
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Television

Wireless Thermostat

Wireless Outlet Switch
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Intercom device
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Examples
Use this chapter to see examples of how to:

l Set up a project using the Composer Views method

l Manage apps with the 4Store agent

l Use the Access agent

l Use the Advanced Lighting agent
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Example home project: Composer
views method
The following sample project sections step you through the creation of a Control4 project using the Composer
Pro views.

Example: Design and create the project
Use the Composer Pro views to design and create a project.

Composer views
In this view, you create the foundation of the Control4 system by building the project tree.

To design the Smith Home project:

1. Start Composer and connect to a Director on a local network.

2. Enter the Project Properties for the Smith home.

l Name—Franklin Smith Home.

l ZIP Code—84003 or enter a latitude and longitude manually.

l Date & Time—Use the drop-down menu to change these as desired.

l Time Zone—Use the drop-down menu to select the appropriate zone.

3. Add rooms to the project tree.

1. In the Locations tab, double-click on a room to add it to the project tree.

2. Continue to add rooms until you have included all rooms you want in the house (rooms that will have
automated devices). You can also drag these items to an object in the project tree. 

Example: Add three rooms. 
l Theater

l Bedroom

l Front 

Tips: To build the system design, define the project configuration in the project tree.
You do not have to add all the items in the project tree manually, such as Site > Building
> Floor > Room because Composer Pro automatically adds the required infrastructure.

Also, you can rename the objects as desired; for example, Franklin Smith Home > Home > House > Main
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>Theater. For more information, see Composer Pro Getting Started.

To add the devices:

1. Add the controller to a room in the project tree.

1. When setting up a system, first add the controller driver to the list. In the project tree, select the room where
you want the controller to reside. In the Items pane > My Drivers tab, double-click a controller to move it to
the room. See the example below.

Note: If you installed this version of Composer Pro on a computer with an older version
of Composer Pro, right-click in theMy Driver tab, and select Restore Default List.
This will update the My Driver list.
Example: Add a controller to the Theater Room:

2. From the project tree, select Theater. In the Items pane >My Drivers tab under
Controllers, double-click Controller or drag it to the room where it resides—in this
case, Theater. The controller and Digital Audio appear in the project tree. The Digital
Audio object resides on the controller, but shows up as a separate object in the project
tree. The Digital Audio provides the functionality to play media.
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2. Add the Lighting and Navigators to the applicable rooms. The example below shows some devices you can
add.

Example: Select Theater in the project tree. In theMy Drivers tab, do the following:
1. In Lighting > Light, double-click Wireless Dimmer, and then rename to Dimmer.

2. In Lighting > Light, double-click Wireless Switch, and then rename to Light Switch.

3. In Lighting > Light, double-click Wireless Outlet Switch, and then rename to Television Outlet Switch.

4. In User Interface, double-click System Remote Control.

5. In User Interface, double-click 6-Button Keypad. 

Tip: Use a descriptive name. When adding devices to the home, right-click and select
Rename to rename them with a descriptive name. For example, if you have two
dimmers in a room, give them a descriptive name such as “Wall Dimmer” or “East
Dimmer.” This helps you identify the specific dimmer later when identifying
connections. If there's only one dimmer or switch in a room, however, you can keep the
generic title "Dimmer" or "Switch."

3. Add a Receiver to the applicable room.

Example: Add a Receiver to the Theater. To add, select Theater in the project tree.
From theMy Drivers tab, do the following: 

1. In Audio/Video, double-click Receiver.

2. In the dialog box that appears, select Online Database, select the manufacturer Denon,
and then double-click AVR-3312] to add the receiver to the project tree.

4. Add a Television to the applicable room. This will probably be the same room where the controller is.

Example: Add the television to the Theater. To add, select Theater in the project tree.
From theMy Drivers tab, do the following:

1. In Audio/Video, double-click Television.
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2. In the dialog box that appears, select Online Database, select the manufacturer Samsung, and then double-
click HC-J655W[IR].

The UHF/VHF object may be added to enable you to scan for UHF/VHF broadcast channels.

5. Add additional Audio/Video devices to the room.

Example: Add the DVD player to the Theater. To add, select Theater in the project
tree. From theMy Drivers tab, do the following:

1. In Audio/Video, double-click DVD.

2. In the dialog box that appears, select Online Database, select the manufacturer Samsung, and then double-
click DVD HD841[IR].

Note: If you can access a wireless touch screen, add it now to your project. If you
previously had a wireless touch screen on your system prior to Release 1.3, follow the
special update instructions in “Information about older releases.”

6. Add a motorized device or sensor to the applicable room.

Example: From the My Drivers tab, add a motorized screen and a door contact sensor to
the Theater room from the online database. To add, select Theater in the project tree. In
theMy Drivers tab, do the following:

1. In Motorization, double-click Motorized Screen.

2. In Sensors, double-click Door Contact Sensor.

7. Repeat Steps 2 through 6 as needed to add more devices to the applicable rooms.

Example: To finish creating the project tree for the example project, add devices to the
Bedroom and Front Room as follows.
Bedroom:

1. Select Bedroom in the project tree. In the My Drivers tab, do the following:

l In Lighting > Light, double-clickWireless Dimmer, and then rename it to
Bedroom Dimmer.

l In User Interface, double-click Touch Screen.

Front Room:
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2. Select Front Room in the project tree. In the My Drivers tab, do the following: 

l In User Interface, double-click 3-Button Keypad.

l InMotorization, double-click Electronic Gate.

l InMotorization, double-click Sprinklers.

l In Sensors, double-click Doorbell.

l In Sensors, double-clickMotion Sensor.

l In HVAC, double-clickWireless Thermostat.

Example: Make and verify the connections
This section discusses using Composer Pro views to make and verify the connections.

Note: This process follows  Example: Design and create the project .

In the Connections view, you can:

l Identify Control4 devices to establish a network connection

l Check all network connections

l Define AV connections

l Define control connections

Note: When only one appropriate connection is available in a room for a given
connection type, Composer Pro assumes the connection (example: if a TV is
the only Audio Output device in a room, the system assumes that the Audio
Output connection is routed to the TV). This feature adds value to Composer
Pro, but increases the need to verify every connection.

Note: To remove a connection, right-click on the connection and select
Disconnect.

To make connections:

1. In Composer Pro, click the Connections view.
2. Identify the Control4 devices that connect to the controller through the network. Go to each physical device

and press the button indicated on the Composer Pro screen. 

1. Click the Network tab > IP Network.

 Notice the devices that do not have an address listed under the Address column.
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2. Select the controller, and then click Identify. The screen to identify the controller appears (in this example,
the 8 Channel Dimmer).

3. At the physical controller, press the Identification button. This identifies the controller with a unique address
in the system. When the address appears on the screen, click Next.

4. Select Dimmer, and then click Identify. The screen to identify the dimmer appears.
Press the top dimmer button four times. This identifies this specific dimmer with a
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distinctive address to the system. When the address appears, click Next.

5. When the Light Switch identification screen appears, press the top button four times. When the address
appears, click Next.

6. When the system remote control identification screen appears, holding the physical system remote control
press the red 4 button once. When the address appears in the box, click Next to continue.

7. If you have a touch screen in your project, press the Enter button on the front of the touch screen. When the
address appears in the box, click Next to continue.

8. When the Outlet Switch identification screen appears, press the button on the module four times.

9. When the 6-Button Keypad identification screen appears, press the top left button four times. When the
address appears, click Next.

10. When the Dimmer identification screen appears, press the top button four times. When the address appears,
click Next.

11. When the touch screen identify screen appears, press the indicated button as shown. When the address
appears, click Next.

12. When the 3-Button Keypad identification screen appears, press the top button four times. When the address
appears in the box, click Next.

13. When the Control4 Wireless Thermostat identification screen appears, press the middle button four times.
When the address appears in the box, click Close to exit Identify mode.

14. When you finish identifying the devices, notice that the Address column now has an address for every
network device.
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3. Define the AV and Control connections.

Control and AV connections for a device are visible when you click the Connections view > Control/AV
tab, and then select the device. To make a connection between inputs and outputs, from the top pane
drag a device’s input (or output) to the output (or input) in the bottom pane.

For each device, define the following when applicable:
l Video connections (path of video signals)

l Audio connections (path of audio signals)

l Control connections (how the controller communicates with the device)

1. Define the AV connections for the Receiver.

Example: In the Connections view under Theater, click Receiver. The right top pane
displays all the inputs and output on the back of the Receiver. For Receiver, from the top
pane in Audio Video Inputs, make the following connections:
l Click INPUT DVD (Video-COMPOSITE), and drag it to DVD (Output-Theater) in
the bottom pane.
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l Click INPUT VIDEO 1 (Video-COMPOSITE), and drag it to Home Controller
HC300 (Video Out 1- Family) in the bottom pane. This connects the Receiver
Video 1 input to the Controller Video 1 output.

l Click INPUT DVD (Audio-STEREO), and drag to DVD (Output-Theater) in the
bottom pane.

2. Define the Control connection for the Receiver to the Controller.

Example: In the Connections view under Theater, click Receiver. The right top pane
displays all the inputs and output on the back of the Receiver.
For Receiver, from the top pane under Control Inputs, make the following connections:
l Click IR Sensor (Control-IR_OUT), and drag it to Controller (IR Output 2-Theater)
in the bottom pane.
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3. Define AV and Control connections for the Television.

Example: In the Connections view under Theater, click Television. The right top pane
displays all the inputs and outputs on the back of the Television. For Television, from
the top pane do the following:
In Audio Video Inputs:
l Click AV (Video-COMPOSITE), and drag it to Receiver (Output-Theater) in the
bottom pane.

l Click AV (Audio-STEREO), and drag it to Receiver (Output -Theater) in the
bottom pane.

In Control Inputs, click IR Sensor (Control-IR_OUT), and drag it to Controller
(IR Output 1—Family) in the bottom pane.

4. Define the Control connections for the DVD player to the Controller.

Example: In the Connections view under Theater, click DVD. The right top pane
displays all the inputs and outputs on the back of the DVD. From the top pane, do the
following:
In Control Inputs, click IR Sensor (Control-IR_OUT) and drag it to Controller (IR
Output 3-Family) in the bottom pane.
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Tip: If you prefer to set up a video sense loop instead of using a macro, see “ Changing
power management options.” After you add a video sense loop connection to the DVD
player driver, add a control connection between the controller and the DVD player.

5. Define the Control connections for the Motorized Screen to the Controller.

Example: In the Connections view under Theater, clickMotorized Screen. The top right
pane displays all the inputs and outputs on for the screen.
In the top pane under Control Inputs, click Relay (Control-RELAY), and drag to
Controller (Relay Port 3-Family) in the bottom pane.

6. Define the Control connections for the Door Contact Sensor to the Controller.

Example: In the Connections view under Theater, click Door Contact Sensor. The top
right pane displays all the inputs and outputs for the Door Contact Sensor.
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In the top pane under Control Inputs, click Contact Sensor (Control-CONTACT_
SENSOR), and drag it to Controller (Contact Port 1-Family) in the bottom pane.

7. Define the Control connections for the Electronic Gate to the Controller.

Example: In the Connections view under Front, click Electronic Gate. The top right
pane displays all the inputs and outputs for the Electronic Gate.
In the top pane under Control Inputs, click Relay (Control-RELAY), and drag it to
Controller (Relay Port 4-Theater) in the bottom pane.

8. Define the Control connections for the Sprinklers to the Controller.

Example: In the Connections view under Front, click Sprinklers. The top right pane
displays all the inputs and outputs for the Sprinklers.
In the top pane under Control Inputs, click Relay (Control-RELAY), and drag it to
Controller (Relay Port 2-Theater) in the bottom pane.

9. Define the Control connections for the Contact Sensor to the Controller.

Example: In the Connections view under Front, click Doorbell. The top right pane
displays all the inputs and outputs for the Doorbell.
In the top pane under Control Inputs, click Contact Sensor (Control-CONTACT_
SENSOR), and drag it to Controller (Contact Sensor 2-Theater) in the bottom pane.

10. Define the Control connections for the Motion Sensor to the Controller.

Example: In the Connections view under Front, clickMotion Sensor. The top right pane
displays all the inputs and outputs for the Motion Sensor.
In the top pane under Control Inputs, clickMotion Sensor (Control-CONTACT_
SENSOR), and drag it to Controller (Contact Sensor 1-Theater) in the bottom pane.

4. Go to the next section, “Example: Verify the network connections.”

Example: Verify the network connections
This section discusses using Composer Pro views to verify the network
connections.

Note: This process follows “Example: Verify the network connections.”

There are two places to verify network connections:
l The Network tab (shown below)
l The Tools menu
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Follow the instructions below to check your connections in both locations.

To check your connections from both locations:

1. From the Connections view > Network tab, verify that every device that communicates to the controller using
TCP/IP, Wi-Fi, and/or Zigbee has a network address. If a device doesn’t have a network address, the device
needs to be identified.

2. To identify a device from this location, right-click on the device and select Identify (or click the Identify
button). Follow the on-screen instructions provided for each device, such as those listed in the following
table.

After identifying the network connection, the device’s address appears in the list.
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Device Instructions to Identify a Device to the Control4
System

Controllers Press the Identification button on the controller.

Lights and keypads Press top button 4 times (6-Button Keypad — press top
left button). MiniApp mode: press and hold bottom left
or bottom button for four seconds.

System remote
controls

Press the red 4 button on the remote control.

Speaker point Press button 1 time.

Multi-tuners Press button 1 time.

16-channel amps Press button 1 time.

Thermostats Press center button 4 times.

Wireless outlet
switches

Press button 4 times.

Wireless touch
screens

Press the Enter button on the front of the touch screen
1 time.

Black & Decker
Kwikset locks

Press the Top Left button on the top of the board
(remove the lock's cover first) 4 times. To disconnect,
press the Top Right button on the top circuit board 9
times.

1-button products Press 4 times.

IO extenders Press the Link button on the back of the IO extender.

Touch screens Press the button indicated on the diagram of the device
in Composer Pro.
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Using the Network tab

To ensure all devices have been identified from the Network tab:

1. Click Connections > Network tab > IP Network.

2. In the Address column, make sure there is an address for every line item.

Using Network Tools

To ensure all network connections exist and are active from Network Tools:

1. From the Tools menu, select Network Tools.

2. Check both the IP Network and Zigbee Network tabs for Green, Yellow, and Red connection icons. The
colors indicate the following:

l Green—An address is identified, and the device is online (communicating).

Example: The dimmer is identified and communicating to the system.

l Yellow—An address is identified, and the device is offline (not
communicating).

Example: If the system remote control goes to sleep, the status turns Yellow.
This indicates that the system remote control has been identified, but is offline
(not communicating). Make the device active so it can communicate to the
system.

l Red—A device is not identified. Go to the Connections view > Network tab,
and identify the device to the system or see “ Example: Make and verify the
connections.”

3. If you find yellow or red icons, do the following:
l Yellow Icons—Go to the device, and activate it according to its documentation.

l Red icons—Go to the Connections view > Network tab, and identify the device to
the system.
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Example: At this point in your example project, the system remote control should be
yellow (or the only device not green). The system remote control turns green as soon as
you wake up the system remote control. To wake up the system remote control, press the
red Control4 4 button.

Example: Define the control and audio/video connections
This section discusses using Composer Pro views to define AV connections. 

Note: This process follows “ Verifying the network connections.”

Control/AV connections are visible when you select the Control/AV tab in the Connections view. The
Control/AV tab lets you define the physical connections between the controller or other devices, including AV
signals, IRs, relays, contacts, and/or serial connections.

Tip: If connections do not appear as needed, edit the driver to create the
needed connections. See “ Editing a driver using the Driver Wizard.”

The following steps are described in the next sections:

“Verify that all control and AV connections use room properties”

“Disconnect/Remove control/AV connections”

“Re-assign control/AV connections”

“Update connections in the project if you change locations”

Verify that all control and AV connections use room properties

To verify all Control and AV connections by checking room properties:

1. Click the System Design view.

2. Select a room.

3. On the default tab Audio Video Devices, see if your AV devices are accessible in the room. If an AV device is
not there, see “ Example: Make and verify the connections.”
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Disconnect/Remove control/AV connections

To disconnect or remove a control/A/V connection:

1. Click the Connections view.
2. Select the Control/AV tab.

3. In the Control/AV project tree, select a device for the device’s control and AV connections to appear.

4. In the Control and AV Connections pane, right-click an input (or output) connection and click Disconnect.

Re-assign control/AV connections

To reassign Control/AV connections:

1. Click the Connections view > Control/AV tab.

2. In the project tree, select a device for the device’s control and AV connections to appear.

3. In the Control and AV Connections pane, drag an input from the top pane to a different output on the bottom
pane. The connection is moved to the specified output.

Update connections in the project if you change locations
If you use the same project but you change locations, you have to update all of the connection information.

To update the connection information in an existing project:

1. Click the Connections view.

2. Click the Control/AV tab, and review your connections to ensure that they are updated in the current control
and AV topology.

3. Click the Network tab and disconnect all connections by right-clicking and selecting Disconnect.
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Example: Use the Access agent
Use the Control4 Access agent view to allow or deny access or hide parts of the
user interface on supported touch screens and on-screen TV interfaces. The
Access agent is ideal for commercial applications including hotels, bars, or board
rooms where settings need to be locked or hidden to restrict their use by
unauthorized personnel. By adding this agent to a project, an access code is
required to gain access to selected functions of the Status Bar or the More and
Settings modules. When enabled, the Access agent settings apply to profiles
created in the Identity agent and each profile can be applied to any number of
touch screens and on-screen TV interfaces in the system using the UI
Configuration agent..

The Access agent provides these key features:
l User—Select a profile and define the Access restrictions for that profile. After you apply the settings to a

profile, use the UI Configuration agent to apply the profile to a user interface.

l Current Access Code—The programmer can establish a four-digit access code to restrict access to user
interface elements globally.

l Access Agent—Enable or Disable the Access agent for the selected user profile.

l Hide Digits—Hide or show numbers on the user interface when entering the Access Code on a user
interface.

Navigation
l Experience Menu—Lock the Experience Menu (C4 icon). If locked, you can only see the favorites in the

RoomMenu and must enter the Access Code to see the Experience Menu.

l Return To Room—Lock the Return to Room icon (Room icon in the top left that replaces the Experience
Menu icon after you select a device). When locked, you must enter the Access Code to return to the
RoomMenu.

l Back Button—Lock the Back button in the Status bar after you select a menu. For example, with the
Back button locked, if you navigate to a camera view, you must enter the Access Code to return to the
Cameras Menu.

l Room Selector—Lock or Hide the Room Selector in the Status bar.

l Room/All Filter—Lock or Hide the Filter icon on menus that support filtering like Lighting and Shades. If
you lock or hide the filter, you can only see items in the current room unless you change the filter to All.

Media
l Sessions—Lock or Hide the Sessions interface. With the Sessions interface locked or hidden, you must

enter the Access Code to control Sessions in other rooms.

323



Composer Pro User Guide

l Media Sharing—Lock or Hide the Media Sharing option in the Sessions interface. With Media Sharing
locked, you must enter the Access Code to share media with another room.

Other
l Settings—Lock the Settings icon. With Settings locked, to access Settings like Wallpaper or Screensaver

options, you must enter the Access Code.

l Edit Lighting Scenes—Lock or Hide the Edit icon on Lighting Scenes.

l Favorites—Lock or Hide the option to add an item as a Favorite.

l Intercom—Lock the Intercom icon.

l Lock Screen—Set to Unlocked, Auto, or Manual to configure a lock screen for the interface. For Auto,
configure the Screen Lock Timeout below the Lock Screen option. For Manual, long-press on the C4
icon (or long-press to activate the lock screen.

Prerequisites
l Create a user profile in the Identify agent if you want to apply the Access agent settings to a selected

group of interfaces or use the default profile.

l Figure out which Status Bar or other functionality you want to restrict or hide from unauthorized users.
For example, do you want to lock the Room Selector? Keep others from getting into Settings? Hide the
Favorites button?

l Establish an access code.

To create a profile in the Identity agent:

1. Start Composer Pro and connect to a Director.

2. Click Agents.

3. Select the Identity agent.

4. Click Add User.

5. In the Create New User window, enter a Username, Password, and Confirm Password. The password
must contain 8 digits, 1 capital letter, 1 number, and 1 special character.

To enable the Access agent:

1. Click Agents.

2. (First time only) Click Add to add the Access agent to the project.

3. Double-click on the Access agent to add it into the project.

4. Enter a four-digit access code on the numeric keypad.

5. Click Set Access Code. The new access code appears in ‘Current Access Code’ window.
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6. Select Enabled in the Access Agent option.

To apply a user profile in the UI Configuration agent:

1. Click Agents.

2. Select the UI Configuration agent.

3. Select the User tab.

4. Select the user profile in Assign user to Touch Screen and click Apply To ....

5. Select the user interfaces or rooms to apply the profile to and click OK.
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As a reminder, the Access agent enables the programmer to restrict certain features and settings from all
users on touch screens and on-screen TV interfaces. Any changes to Access Codes or these settings can
only be made using Composer software. If the Access Code is lost or forgotten, it can be recovered only using
Composer.
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Example: Use the Advanced Lighting
agent
Use the Control4 Composer Pro Agents and Programming views to program this
agent. (For OS 2.3.0 or later, this agent supports the Panelized Lighting product
line with full functionality. Older lighting products are also supported, but with
limited functionality.) This agent provides more advanced features than the
Lighting Scenes agent. See also “Example: Program Using the Lighting Scenes
Agent” in this document.

The Advanced Lighting (Scenes) agent provides these features:
l LED tracking for Lighting Scenes
l Toggle Lighting Scenes
l Ramp and fade Lighting Scenes
l Set delays within Lighting Scenes
l Scene sequencing

l Flash lights in Lighting Scenes

To use the Advanced Lighting agent:

1. Start Composer Pro and connect to a Director.

2. Click Agents.

3. (First time only) Click Add to add the Advanced Lighting agent to the project. Note: You must add the
Advanced Lighting agent to the project before your customers can edit Lighting Scenes on a Navigator.

4. Select Advanced Lighting, and then click OK.

5. In the Agents pane, select Advanced Lighting and then click New.

6. Enter a name on the dialog that appears (for example, Party Lights).

7. Click Create. Notice that you have more options than if you were using the Lighting Scenes agent. Note: You
can click the Rename button to rename a scene.

8. Adjust the scene as desired.

l Show flash option—Select this option to add a Flash checkmark in the list of
lighting devices below. When Flash is checked, lights can flash on and off at set
intervals. Use this option with the Delay option. For example, this option works
well in a situation where you want to alert someone so you can set a porch light to
flash in case of an emergency or to get someone’s attention. Note: For older lighting
devices (earlier than OS 2.3.0), flashing is not supported.

l Activate Scene—Click this button to activate the scene immediately. Note: The
Execute On and Execute Off buttons do not appear in the Advanced Lighting agent.
Use the Activate Scene button.

l Sync This Scene—Click this button to synchronize this scene with other scenes.
This option isn’t really needed for Panelized Lighting unless there seems to be a
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problem.

l Sync All Scenes—Click this button to synchronize this scene with all scenes
created. This option isn’t really needed for Panelized Lighting unless there seems to
be a problem.

l Colors—This is the keypad color. Click the Active or Inactive colored boxes to
select another color.

l Tracking—Click All Loads to track a dimmer or switch by name, tracking status,
delay, rate, level %; and all loads must match their tracking condition before the
scene will be considered active. Click Any Load and only a single load needs to
match their tracking condition before the scene will be considered active.

l Hold Rates (sec)—Use the up or down arrows to select the Up hold ramp rate or
Down hold ramp rate. At the keypad, press and hold for a set period of time in
seconds. This action behaves the same as hold rates for dimmers.

l Toggle Scene—This pull-down allows you to select which scene to activate when
the current scene is prompted to deactivate. This applies to all scenes except for the
current one selected. Here, you can toggle scenes on or off.

Example: Create an Advanced Lighting Scene called “Dining.” Notice the number of
switches and dimmers in the Advanced Lighting pane and their values.

1. Create a Dining ‘Toggle’ scene. Notice the difference in switches and dimmers and their values from the
previous screen.
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2. Now click the Connections view to connect the keypad bindings on a 3-Button
Keypad.

When you toggle the 3-Button Keypad in the Dining room, various lights go on or
off at various levels. For more information about connections, see “ Connect and
verify devices.”
Now go back to the Agents view.
l Toggle Scene/Create Default—Click Create Default to create a toggle scene
as a copy of the selected scene. From the copied scene, you can rename the new
scene and adjust the values on some of the dimmers or switches in that scene.
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l Current State—Shows ‘Active’ when the conditions are met to consider the
scene Active or Inactive if the conditions have not been met.

l Add/Remove Load—Click to add or remove specific dimmers or switches to
the scene. Check the lighting loads that you want to add, and then click OK.
This can be a single light, a single room, all lighting loads in an entire house, or
any combination of these options.

9. Assign the settings for each load:

l Dimmer and Switch Options:

l Name—The top line is the room, and the bottom line is the name you assigned to
the dimmer or switch.

l Tracking—This lets you track the lights in the system. Use the down arrow to
select one of these options.

l Don’t Track—Tracking is ignored.

l Is Off—Track when the dimmer or switch is off.

l Is On (Any Level)—The text displays only if the light is a dimmer. Switches just
indicate ‘Is On.’.

l On At Level (%)—Track when the dimmer is on at a specific level.

l At Scene Final Level—Track at the final level of the last sequence. For example, if
someone changes the level on a Navigator, this might be the final level.

l Delay—Use the up or down arrows or type the delay value in seconds.

Tip: If you have several dimmers in a long hall, and you want to set up sequencing,
you can use this option with the green + buttons and increase the delay of each
dimmer in a row by two seconds.

l Rate—Lets you set the ramp rate, which is the speed the load ramps to for the
specified lighting level. Use the up or down arrows to set the milliseconds (ms),
seconds (sec), or minutes (min) of the ramp rate. Then set the amount of time the
device takes to change the level.

Example: Set the time to 1 second for both the Bedroom Dimmer and the Theater
Dimmer.

l Level (%)—Lets you set a target lighting level as appropriate by using the pull-
down menu, for example, 50 percent for the Bedroom Dimmer and 20 percent for
the Theater Dimmer. The green + gives you the ability to add ‘paths’ to a scene.
Each row in the path uses single delay/rate/level settings. Use the green + to add
another step, click the red x to delete a step, or you don’t need to have any steps.
Note: Older lighting devices (prior to OS 2.3.0) only allow 0 or 1 steps.
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l Apply To—Click this option to allow other lights to use the same scene.

l Ignore Scene Ramp/Fade—Check this option to have the light ignore commands
to ramp or fade a scene.

l Graph—Shows in graphical form (red lines) the settings for each dimmer or
switch. Dimmers will show ramp rates, delays, and levels as angled, horizontal, or
vertical lines.

10. Now click Programming. To program a scene, follow the basic steps in “Programming Basics for Control4
Systems.”

Note: In the Programming view, the Advanced Lighting Scene has variables,
conditionals, and loops that do not exist in the Lighting Scenes agent. This agent also
has ‘read-only’ variables for the length of each scene.
Example: Note the screens below. The Events and Actions panes use different options
than the Lighting Scenes agent (Activate, Deactivate, etc.).

Event: (Is Invoked, Becomes Active, Becomes Inactive)

l Is invoked—This event fires when the scene has been explicitly told to activate. If
the scene is already activated, and it is told to activate again, this event will still
fire.

l Becomes Active—This event fires when the scene transitions from the Inactive
state to the Active state.

l Becomes Inactive—This event fires when the scene transitions from the Active
state to the Inactive state.

331



Composer Pro User Guide

l Actions— (Activate, Deactivate)

A programming example for use with the Advanced Lighting agent might be where, if the front door
opens and it’s past 9 PM at night, all the lights turn on in the home at various levels.
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Setting up media
Use this chapter to learn how to:

l Scan your network for media files

l Access media from disc changers

l Play AV from television stations

l Play audio from radio stations

l Add a switch

l Create a playlist

l Test a media connection

l Edit media information
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Media types
To take full advantage of media lookup services by Gracenote, your customers must have an account at
customer.control4.com and their system must be registered to the account. See Composer Pro Getting
Started for details. 

To add and scan songs and albums for playlists, they must be available in MP3, WMA, M4A/AAC, or FLAC
format on an external USB drive, eSATA drive , or network share.

To add Internet radio stations, the Internet radio driver must be bound to the controller. See “ Setting up
Internet radio stations” in this document.

Tip: In OS 2.4 and later, you can use the TuneIn app to stream radio, news,
sports and more from Internet stations worldwide. See the TuneIn Setup
Guide or TuneIn User Guide for details.

You can set up your customer's audio and video media in a Control4 system for:
l Controllers

l Disc changers

l Media players

l Dock for iPod (iPods, iPhones, etc.)

l Television broadcast channels

l Radio broadcast stations

l Internet radio

l Satellite broadcast channels or music stations
l Other external storage devices: USB flash drives and shared network drives 

You can also:
l Add CDs and DVDs

l Add individual songs

l Add cover art, titles, albums, etc.

l Create playlists

l Use the auto-scan feature to scan movies or music

l Add and scan supported files from third-party media managers, for example, iTunes

l Edit media information for DVDs, CDs, etc.

To view and select the media from the Navigators, including wireless touch screens, on-screen, Control4
apps, and System Remote Control devices, you first need to add and scan the media to the Control4
controller. 

For the MP3, WMA, M4A/AAC, or FLAC files stored on an external hard drive or network location that you add
and scan, you can create playlists saved to the Control4 controller’s hard drive in the media database. 

Note: Speaker Point does not support M4P/AAC. Play songs through Speaker
Point using MP3.
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Note: Internet radio supports only MP3, WMA, and MP4 streaming radio
stations.

Tip: The Control4 systemmust be functioning correctly before performing any
of the tasks mentioned in this section. For example, if a disc changer does not
appear in the project tree and is not identified and connected to the system,
media cannot be added to it.
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Overview of media management
Media configuration and media management are controlled in the Composer
(Pro, HE, and ME) software. The primary controller that runs Director always runs
Media Manager and the media database (SQLite 3.1).

l Media Database—Migrating from pre-OS 2.0 to OS 2.0 and later requires a media database conversion
and schema changes; consequently, the media databases in OS 2.0 are smaller.

l Media Manager—All scans are performed by the Media Manager running Director on the primary
controller. Note: Composer Pro configures scanning only, and does not scan the media.

l Media Lookup Service—This service now runs either in Composer Pro or Media Manager.

l Composer New/Edit – Search—For media metadata lookup when media has
not been scanned properly. The information retrieved can be edited and
written to the media database, and/or the metadata can be written to the
tags.

l Media Manager—Uses online media lookup. IMPORTANT! Controller
registration is required on MyControl4 to use this service for versions later
than Release 1.6. 

Other Media Managers: You can use other media managers, for example, iTunes,
Windows Media Player, and Media Monkey to create or manage MP3s and WMAs.
You can still use Composer Pro, Composer ME and Composer HE to configure
media files for a Control4 system.

Media Manager
New scans

l Scans Id3 tags that are embedded in the file.

l The title, album and artist names are extracted from the file system folder and filenames.

l The metadata lookup based on title searches comes from Gracenote.

l In OS 2.0 and later, scans are now much faster.

l Press F5 to refresh after new scans.

l Scans can be tied to events, button presses, etc.

Scans where content is in the media database
l Scans for any updated Id3 tags in the file, or you can synchronize the media database based on the

configuration.

l If no metadata is in the media database, the metadata lookup is based on title searches from Gracenote.

Other Media Manager considerations
l Media Manager scans only one device at a time. If several devices are configured and are in the queue,

they will be scanned sequentially.

l Composer Pro does NOT need to be connected when Media Manager is performing a scan.

l Scans can be performed manually in Composer Pro as an event or in an automated schedule.

l If the path becomes disconnected, the metadata will not be deleted.
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l If devices are modified, the tags will update.

l If you are using a third-party Media Manager, synchronization will occur if set.

Media storage
Audio and video files can be stored on one or more of the following devices:

l Home Controller disk space—Home controllers with disk space can host audio and video content. Note:
Dealers must provide their own backup solution or use a NAS with mirror/recovery capabilities.

l USB-attached storage—Both audio and video can be stored on these devices, although Control4 does
not recommend doing so due to poor performance.

l Network-attached storage (Samba-mounted)—Control4 recommends this solution for audio and video
files due to better performance and backup/recovery capabilities.

As with previous releases, all media storage devices must be added and configured in the Composer Pro
project. Composer Pro does not automatically discover new media storage devices. The storage locations are
not available in the Navigators until the device is scanned.

Media lookup service
l Control4 uses Gracenote for its lookup services.

l Media lookup is optional. See the Media view in Composer Pro Getting Started to disable lookup (set to
Never in scheduling).

l Media lookup requires that the controller be registered at customer.control4.com.

337

http://www.control4.com/docs/product/composer-pro/dealer-getting-started/latest


Composer Pro User Guide

Configure video scanning of network
storage
Use the System Design and Media views to set up scanning of video devices, such as disc changers or media
players, to play video files from network-attached storage. Scanning can occur for devices or extensions.

Prerequisites
l Ensure that the video device is installed as directed in the Control4 Installation and Setup Guide for the

device.

l Ensure that the Network File Storage driver is added to the room in the Composer Pro project.

To configure video scanning:

1. Start Composer Pro and connect to a Director.

2. Click System Design.

3. In the project tree, select Network File Storage.

4. (Optional) To access the files in the storage, if you have password protection enter your user name,
password, and workgroup in the Properties pane. If you do not have password protection, go to Step 6. Click
the browse button to locate the path if you don't know it.

5. Click the Search button to locate the storage.

6. Click Connect.

7. Click the Media view.

8. In the tree, select Media Scanning Options to set up a schedule for scanning. To set up to scan the media
now, click Scan Now, skip Step 9, and then read the Scanning Schedule in Step 10.
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9. Set up the scanning schedule and the files to scan.

10. Set the schedule as follows:

l Scanning Schedule—Select one.

l Never—Select if you never want to schedule an automatic scan.

l Every x Days or Weeks (up to 10) —Select the frequency to scan.

l On the following days—Select Sunday through Saturday.

l At <time>—Use the up and down arrows to select the time. Highlight AM or
PM and type the value: AM or PM.

l Files To Scan—Select a device and extension.

l Network File Storage—Select if you have a NAS you want to scan.

l USB Drive—The manufacturer's USB drive appears here. Select if you have a
USB drive you want to scan.

l Extensions—Use the up and down arrows to select the format to add or
remove from the list. To add a format if it doesn't appear in the list, use the
down arrow to select the extension, select Video, and then click Add. Click
Remove to remove that format from the list. Note: The list only allows format
types that are supported in the Control4 system.

l Use Online Media Lookup to improve scan results—Check if you don't want
the search to access the Internet for every format lookup, for example, a
specific title or cover art. Tip: Properly tagged files will result in must faster
access.
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l Remove media from the database if the files no longer exist—Check to
remove database information when a media file has been deleted. Be careful,
however, because if, for example, you disconnect a USB drive with media on
it, the database files will delete them if checked, and you may not want to
delete them if you use the drive again.

l Update media database if file tags have changed—Check to have the
database updated if the metadata changes.

11. Click Apply.

12. Click Scan Now to start the scan immediately or Stop Scan if you've started the scan and want to stop it.
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Setting up media auto-scan
Use the auto-scan feature in Composer Pro to scan media automatically. This
section applies to disc changers, media players, network-attached storage, and
USB drives. 

Note: Composer Pro does not need to be open to scan media. If you started a
scan in Composer, you can close the program while the scan finishes. Also,
scheduled scans can run automatically or be started through programming.

Prerequisites
l Ensure that the video device is installed as directed in the Control4 Installation and Setup Guide for the

device.

l Ensure that the Network File Storage driver is added to the room in the Composer Pro project.

To schedule a regular scan of media:

1. From the Media view, select Media Scanning Options. To scan your media now (and not set up a scheduled
scan), click Scan Now and skip the Scanning Schedule in Step 2.

2. In the Options pane, set the schedule as follows:

l Scanning Schedule—Select one:
l Never—Select if you never want to schedule an automatic scan.
l Every x Days or Weeks (up to 10)—Select the frequency to scan.
l On the following days—Select Sunday through Saturday.
l At <time>—Use the up and down arrows to select the time. Highlight AM or
PM and type the value: AM or PM.

l Files To Scan—Select a device and extension.
l Network File Storage—Select if you have a NAS (network attached storage)
device you want to scan.

l USB Drive—The manufacturer's USB drive appears here. Select if you have a
USB drive you want to scan.

l Extensions—Use the up and down arrows to choose which file types to add
or remove. To add a file extension (if it doesn't appear in the list), use the
down arrow to select the extension, select Video or Audio, and then click Add.
Click Remove to remove that file type from the list.

l Use Online Media Lookup to improve scan results—Check if you want the
scan to access the Internet to search for missing metadata information (title,
cover art, genre, tracks, or other information).

Tip: To update existing media with high-resolution cover art after updating
your system to OS 2.8+, check this box and scan the media files.
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l Remove media from the database if the files no longer exist—Check to
remove database information when a media file has been deleted.

Important: If you disconnect a USB drive with media on it and run a scan with
this option selected, the media database entries will be deleted, and you may
not want to delete them if you use the drive again.

l Update media database if file tags have changed—Check to have the
database updated if the metadata changes.

l Enable MQA—Check to enable MQA Audio in the project. See ctrl4.co/mqa
for more information.

3. Click Apply.
4. Click Scan Now to start the scan immediately or Stop Scan if you've started the scan

and want to stop it.
Disc changer
This section applies to a Sony CX777ES Disc Changer. The benefits of running a disc changer with
bidirectional communications (RS-232), such as the Sony CX777ES, is that you can scan your DVDs/CDs
stored in the disc changer to identify and index media, and automatically apply cover art and information about
the media.

You can configure your system in Composer Pro to scan media on the associated disc changer either
automatically or manually when the Auto Scan option is selected in the System Design Properties pane for
the disc changer. The default is to scan media manually (Auto Scan: Off).

When the Auto Scan Enabled option is checked on the Disc Changer Properties page, the Auto Scan feature
automatically detects when a disc is added to an empty slot or when a disc is removed. The Navigators are
automatically updated with the change. The Auto-scan feature does not detect when a disc is replaced or
swapped. 

Note: If a DVD/CD is scanned and the media is not recognized, it is titled
'unknown.' You can edit the information about the DVD/CD, and manually
provide this information from either Composer Pro or the Navigators. If this
DVD/CD is then moved to a different slot, the system applies this same
information.

To auto-scan added media to a disc changer:

1. Start Composer Pro and connect to a Director.

2. Click System Design.

3. In the project tree, select the device, for example, Disc Changer with a serial connection (RS-232) to the
controller, for example, the Sony CX 777ES Disc Changer.
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4. In the device's Properties pane, ensure that the Auto Scan Enabled option is checked.

5. Open the disc changer drive, and add or remove the DVD/CD.

6. Close the drive to begin the auto-scan. The information for the added DVD/CD is automatically made
available on the Navigators. See also “ Setting up media stored on a disc changer.”
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Setting up media stored on a disc
changer
Use the Media view to add and scan media according to the options available on your disc changer. Adding
and scanning DVDs and CDs loaded in the disc changer populates the media information in the media
database. This permits users to view the media from their Navigators. 

This section covers how to:
l Add media to a disc changer

l Scan media in a disc changer

Prerequisites
l The system must be registered at customer.control4.com before using the online Media Services. To

register the system, see 'Registering the Control4 system' (Composer Pro Getting Started).

l Ensure that a controller is added to the project tree and identified to the network.

l Ensure that a disc changer is added to the project tree and identified to the network.

To add media to a disc changer:

1. Start Composer Pro and connect to a Director.

2. Click Media.

3. Select Disc Changer in the Media project tree. If any of the following options are available for the selected
disc changer, the buttons will be active (not grayed out):

Scan—Lets you scan all media located on the disc changer to add to the media database (recommended
if available). 

Note: Because media scanning has been moved to the background, the scanning status is
only available through Director status messages. To do this, you can either watch the
Director status line or re-select the media to view the content that has been scanned. 

Search—Lets you search for media titles located on the disc changer to scan and add them to the media
database.

Edit—Lets you edit your entries (artist, album, title, etc.).

New DVD or New CD—Lets you add new DVDs and CDs to the media database. 

4. Always use File > Refresh Navigators to make the new media accessible through the Navigators in the
Control4 system. 
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Note: Control4 has not implemented a UI for browsing CDs stored in a disc changer.
Use a Legacy Navigator (prior to OS 2.0) that supports this functionality if this is an
important consideration.

Scanning media in a disc changer
The following sections describe how to add media to the media database using the options listed above.

To scan media loaded in a disc changer to add it to the media database:

1. Click Connections.

2. Ensure the disc changer is connected to a serial port on the controller. 

Example: From the Control/AV tab, select Sony CX777ES Disc Changer; ensure that
the Serial RS-232 is connected to the correct serial port (1 or 2). 

3. From the Network tab, ensure that the controller has an address.

4. Click Media.

5. Select Disc Changer.

6. In the Disc Changer pane, click Scan > OK to Scan all.

Note: If the following error message displays, "Your system has not been registered on
MyControl4," you can click Yes to continue scanning music without registering, but the
music scans based only on the current metadata stored in the music files. You will need
to enter any missing information manually for each disc. 
Example: If no cover art is found in the file’s metadata, then no cover art is associated
with the music unless the system is registered in 4Sight, and you can go to the online
media lookup (Media view > Edit > Name > Search > Select > Next) to obtain the cover
art for the music. See " Register the controller from a Navigator" in Composer Pro
Getting Started for instructions.

Automatically scan media
The following steps use the Sony CX777ES Disc Changer as an example. 
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To auto-scan added media:

1. From the project tree, click the Sony CX 777ES Disc Changer. The device Properties pane appears for this
device.

2. Ensure that the Auto Scan Enabled box is checked. 

When you select the Auto Scan Enabled option from the device's Properties page in Composer Pro, an
automatic scan of the disc(s) is available if you add a new disc to an empty slot, or if a disc is removed. In
those cases, the disc changer automatically recognizes the change, and the Navigators automatically
update the changes. The disc changer recognizes the changes in its slot when its door closes to perform
the auto-scan. The Auto-scan feature does not detect when a disc is replaced or swapped. 

Note: Control4 recommends that you check the Ignore Unexpected Play, Stop, or
Pause option. This option should be checked if you are configuring a system with
lighting, for example, when the movie starts playing, and the lights in the room dim.
Normally, you can use the Play, Stop and Pause functions on the disc changer during the
course of a movie being played. By checking the option, these functions are ignored by
the system. 

3. Open the disc changer drive's bay, and change the existing DVD or CD.

4. Close the bay.

5. The auto-scan begins automatically when the disc changer door closes, and the information for the new DVD
or CD is available in the Navigators.

Searching media in a disc changer
To search media loaded in the disc changer to add it to the media database:

1. Click Media.

2. Select the Controller in the project tree.

3. In the Disc Changer pane, click Search.

4. Type the DVD name in the blank box. The possible DVD titles from the Web database appear in the Search
Results window. Use the scrollbar to find the appropriate DVD title 

Example: “A Beautiful Mind”
Select the appropriate DVD title, drag it over the empty line item, and then select it again. 
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5. Repeat the previous steps for each of the DVDs/CDs in the disc changer you want to add to the media
database.

6. Click Finished.

Edit CD or DVD information
To edit a scanned DVD or CD:

1. Select the CD or DVD to edit.

2. Click Edit.

3. Change the Title, Director or Artist, Album or Movie, Studio, Genre, etc. You can also change the location,
locate the cover art (Find Art File), and so on.

347



Composer Pro User Guide

4. Click OK. 

Adding a DVD or CD
To add a DVD or CD:

1. Click Media.

2. Select Disc Changer in the Media pane.

3. Select the empty box for the New DVD and New CD buttons to appear. 
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4. Click either New DVD or New CD as appropriate. The New Movie or New Album dialog appears.

5. In the Title box, enter the DVD you want to play.

Example: "A Beautiful Mind" 
6. Click Search. 

7. When the Search dialog appears, use the scrollbar to find the appropriate cover art, and select it.

8. Change the search criteria, and search again if needed. The possible matches from the web database
appear in the Search Results window.

9. Click Next.

10. (Optional) Customize the DVD/CD information before adding it to the media database
by editing the text in the box.

11. Click Finished.

12. Click OK.
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Setting up videos for a media player
Use the Media view to identify the videos that you want the media player to play.

Prerequisites
l Ensure that the media player is installed and added to the Composer Pro project.

l Ensure that the network-attached storage contains the videos that will play on the media player, and that
the NAS is added to your Composer Pro project.
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Setting up media for radio stations
Use the Media view to set up radio stations for a Control4 system.

To set up media for radio broadcast stations:

1. Start Composer Pro and connect to a Director.

2. Click Media.

3. Select the broadcast media type (AM Radio, Dish Network, etc.).

4. Click Search.

5. In the Zip box, type the ZIP Code of where the Control4 system is located.

6. Click Search, and use the pull-down menu to select the listings. The available stations are populated in the
Search Results window.

7. Check the individual boxes of stations that you want to make available in the Navigators; or click Select All,
and then click OK.
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The selected stations populate the media source channel list (such as the FM Radio list shown next). 

8. Repeat the previous steps for each additional media source, e.g., cable, satellite, or AM radio. (Each of these
services must be set up separately.)
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Setting up media for television stations
Use the Media view to set up television channels for the Control4 system.

To set up media for television broadcast channels:

1. Start Composer Pro and connect to a Director.

2. Click Media.

3. Select the broadcast media type (UHF/VHF, satellite, cable, etc.).

4. Click Search. When the dialog appears, type the ZIP Code for the Control4 system’s location in the box.

5. Click Search, and use the pull-down menu to select Local Broadcast Listings. The available channels are
populated in the Search Results window.

6. Check the individual boxes of channels that you want to make available in the Navigators, or click Select All,
and then click OK.

The selected channels populate the media source channel list (such as the UHF/VHF
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channel list shown next).

7. Repeat the previous steps for each additional media source, e.g., cable, satellite, AM radio, or FM radio.
(Each of these services must be set up separately.)
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Setting up Internet radio stations
Use the Media view to add Internet radio stations that you can play from touch
screens, Control4 apps, or on-screen Navigators.

Prerequisites
l Ensure that the controller is installed and identified as directed in the controller's installation guide.

l Ensure that the Internet radio stations you add are in MP3 or WMA format. You'll need to create a new
form for each station you add.

To configure Internet radio:

1. Start Composer Pro and connect to a Director.

2. Click the Media view.

3. From the media list, click Internet Radio.

4. In the Internet Radio pane, click New.

5. Fill out the form:

1. Name—Add the name of the station.

2. Description—Add a description that's meaningful.

3. Channel—Add the URL for the channel. Note: Locate the URL of the MP3/WMA stream that starts with
http://... Note: Ensure that Audio Only is checked.

4. Genre—Add a genre if appropriate.

5. Check Audio Only for listening.

6. Cover Art—If you'd like, you can copy the radio station art to your list. In a browser, go to the link and click
Images. Click Find Art File to locate an image, copy it to your clipboard and then click Paste from Clipboard.
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7. Click OK.

6. Go to the touch screen, Control4 app, or on-screen Navigator and select the Listen > Station. Note: If you
have several sources, Internet Radio appears under Sources.
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Importing a DVD list from a file
Use the Media view to populate DVD metadata stored on a disc changer.

To import a DVD list:

1. Start Composer Pro and connect to a Director.

2. Click Media view.

3. Right-click on the Disc Changer, and select Import DVD List from File. Composer Pro automatically
populates the slots of the disc changer with the DVDs stored in each slot as listed in the file that is imported.

The imported file must be a CSV (comma-separated value) file listing the slots and the titles of the DVDs,
one per line. You can create this file using a simple text editor or spreadsheet program by exporting a
spreadsheet file in a CSV formatted file. This new feature provides a simple and easy way to quickly
configure all of the DVDs in any manufacturer’s disc changer. 

Example formatting for CSV file:

l 1, Toy Story

l 2, The Incredibles

l 3, The Perfect Storm
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Using external storage devices
You can access digital music from an external storage device in your Control4
system. External storage devices include USB flash drives, USB external hard
drives, or a shared network storage area (for example, a computer’s hard drive). 

The following applies when setting up an external storage device:

l USB flash drives or USB external hard drives must be formatted as FAT32 devices.

l Shared drives on a Windows system cannot contain a space in the directory/pathname. 

Set up the external storage device or networked file storage as described in this section. 

Note: When you disconnect the external drive (USB, network, etc.) from the
system, the music is no longer available. Reconnecting the external drive
makes the media available again.

Attach and scan external storage devices

To attach and scan external storage devices using a USB connection:

Note: External storage devices must have media stored in unprotected
MP3/WMA format.

1. Power up the external storage device.

2. As appropriate, use the documentation provided with your Control4 controller to attach the external hard
drive using the USB port.

3. Start Composer Pro and connect to a Director.

4. Click Media.

5. In the project tree, select the external device.

6. Click Scan in the device's pane.

You can add media from the external storage device when it is connected to the controller. However, it is
recommended that you connect your external drive directly to the PC where you want to copy the media.
When scanning, the media appears on the device.

Access and scan network storage devices

To access and scan network storage devices:

Note: The network location must be an open share location (no password
required).

1. As appropriate, use the documentation provided with your operating system to create a shared network drive. 
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Example: Using Windows XP to make a local C:/ Drive directory available on the
network, right-click the folder and select Sharing and Security. Click the Share this
folder button. 

2. Click System Design.

3. From the My Drivers tab, double-click Network File Storage to add it to the project tree.

4. Highlight Network File Storage in the project tree, and configure the username,
password, and workgroup (or domain) for the network file share, and then browse to its
network location.

This information varies between types. Contact your System Administrator or Control4 Technical Support
if you need help with this information. 

5. Click Media.

6. In Network File Storage, notice the options: Audio Media and Video Media.

7. To add or scan audio files, in the media list select Audio Media, and then click New or Scan. 

Notes:
l When adding music to Network File Storage from the desktop, the music folder
must reside in My Network Places so components can access the music files. A
mapped network drive is not applicable in this situation.

l Audio files must be in one of the following formats to be scanned and played by the
Control4 system: MP3, WMA, or FLAC. If you connect an iPod or another audio
device, the Control4 system can play back the files supported on that device; but
only MP3 files can be decoded. 

8. To scan video files, in the media list select Video Media, and then click Scan. 

Notes:
l Video files must be in one of the following formats to be scanned by the Control4
system: .avi, DVD, .iso, .m4a, mpeg, .mpg, or .wmv. These video files can only be
played using a media player.

l Video playback is not supported from files stored on a USB drive, so the Video
Media option is not displayed in the list under a USB drive.
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Creating a playlist
Use Composer Pro to create a playlist from digital media.

You can create playlists from the touch screens, Control4 apps, or on-screen Navigators also. See the
Control4 System User Guide for details.

To create a playlist:

1. Start Composer Pro and connect to a Director.

2. Click Media.

3. In the Media view, go to the Media menu, and select New Playlist.

4. Name the playlist. 

Tip: You can rename it any time by right-clicking the playlist, selecting Rename
Playlist, and then typing a new name. 

5. Select the controller or other media on which the songs are stored, and ensure that you have scanned the
media from the storage to make the media known to the controller.

6. Drag the list of songs to the playlist. 

These playlists are designed exclusively for streaming media in digital audio. If the customer subscribes
to the Rhapsody Music Service, then Rhapsody playlists can be created using a Navigator (see the
Control4 System User Guide for details){XE “Rhapsody playlist” }. In OS 2.0 and later, playlists can
include CDs/DVDs, broadcast channels or stations, but they are a separate playlist from those in
Rhapsody. 

Note: To set up a Rhapsody subscription on behalf of the user or yourself, obtain a
Rhapsody account at http://www.control4.com/rhapsody, and then refer to the
information about Rhapsody in the Control4 System User Guide. 

7. Drag every album or song you want to add to the playlist onto the playlist name.

8. After adding at least one album or song, select the playlist to view the contents.

9. (Optional) Remove songs:
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l To remove a song, right-click and select Delete.

l To remove multiple songs, press and hold the Shift key. Select the songs, right-
click anywhere in the selected list, and select Delete.

l To remove selected songs, press and hold the Ctrl key. Select the songs to delete,
and select Delete.

The playlist can now be played from or edited in the Navigators.
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Testing the media connection
To test control of media through the Control4 Navigators (System Remote Control, on-screen Navigator, or
any of the other Navigators or touch screens), use the steps outlined in the Control4 System User Guide. 

Suggested test items:

l Play an album

l Add an album or track to the Now Playing queue

l Play a playlist created in Composer Pro

l Create a playlist on a touch screen or on-screen Navigator

l Play multiple streams of music (play different music in different rooms)

l Play a movie on the television
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Editing media information
Use the Media view to edit the media information for 'unknown' DVDs or CDs. You
can edit the media information in the Navigators: on-screen, touch screen, or
Control4 app.

Editing CD information
Use the Media view to edit CD album names, artists, genre, or cover art for a
Control4 system.

To edit information about a CD:

1. Start Composer Pro and connect to a Director.

2. Click Media.

3. In the project tree, double-click the CD storage device on which you want to edit CD information; for
example, CD, disc changer, or controller.

4. Select an album and click the Edit button, or double-click the album title.

5. In the Album tab, edit the Album Name, Artist, Label, Genre, or Art. Make text changes as applicable.

6. Click OK, or use the additional features outlined below. 
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7. Search on a Name or Artist to search the database for similar entries. 

8. Select a search result. Double-click to select an album title, and click Next.

9. View or edit the information about the album: Name, Artist/Composer, Label, Genre, Year, Art, and Notes.

10. Change the information as needed, and then click Finished to save your changes.
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11. Select the Track tab, and edit or remove tracks as needed.

12. Select the Notes tab, and edit as needed for future reference.

Editing DVD information
Use the Media view to edit DVD title, director, studio, genre, runtime, release date or rating in a Control4
system.

Tip: New in OS 2.0 and later, you can edit DVD and video titles on the touch
screens and on-screen Navigators.

To edit information about a DVD:

1. Start Composer Pro and connect to a Director.
2. Click Media.

3. In the project tree, double-click the Disc Changer or DVD.

4. Select a movie and click the Edit button, or double-click under Discs.

5. In the Movie dialog under the Movie tab, edit the DVD title, director, studio, genre,
runtime, release date or rating information as needed.
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6. Click OK, or use the additional features outlined below.

7. Click Search to present similar entries.

8. In the results list, double-click a DVD.

9. Edit the DVD information.

10. Replace the cover art using one of the options provided.
11. Click the Cast and Synopsis tab to edit text displays as needed.

12. Click Finished to save your changes.
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Using and Programming with Agents
Use the Agents and Programming views to program agents.

When you program with agents, you typically use these general steps: 

1. In Agents, define an instance of a type of agent.

2. In Programming, use the instance of the agent to program event actions.

Example: In the Agent view, you can create an instance of a Custom Button where
you identify all the buttons you want to program. In Programming, you program the
Custom Buttons. 

Note: Agents vary greatly in functionality and flexibility.

Agent types
l Access—Lets you hide elements of the user interface on a Navigator and use a pin code to change the

settings for the Navigator.

l Advanced Lighting Scenes—Lets you change the lighting state, toggle lights, ramp/fade lights, delay
on/off, use scene sequencing, flash lights, and so on.

l Announcements—Plays a pre-recorded .WAV file, or displays a text message whenever a given event
occurs. You can play an audio announcement on any audio output device with a supporting text
message that displays on selected Navigators.

l Backup—Configure settings for automatic project backups to Control4
online services. Requires a 4Sight subscription.

l Communication—Replaces the Intercom agent for systems running OS 2.7 and above. Provides the
ability to set up Intercom device groups on the T3 series touch screens—audio and video, and Door
Stations (DS2 and DS2 Mini—audio and video) See “ Using the Communication agent”.

l Custom Buttons—Lets you make user interface buttons for specialized devices on the Navigators. See
“ Using the Custom Buttons agent.”

l Email Notification—Lets you send an email message to your email address when specified events occur
as defined in programming. See “ Using the Email Notification agent.”

Notes: (1) 4Sight is required to use the Email Notification and Push Notification
agents. See the Composer Pro Getting Started Guide for details. (2) Avoid
setting up email notifications for events that occur frequently (e.g., when a
Motion Sensor detects motion). If the email notification trigger event occurs
too often, it will cause the system to become sluggish.

l Guest Services—An agent used to interface a local Control4 system to a Guest Services system within a
multi-dwelling or hospitality project.

l History—Enables a history tab in drivers built for the History agent, for example, new security drivers built
for OS 2.8.+. You can configure settings and view history data from the agent.

l Identity—Provides the ability to change the password for the pro-installer login for System Manager Web
and When >> Then automation.
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Light Properties—Manage light properties for Control4 Centralized Lighting
modules and loads.

l Macros—Macros agents associate programming with events.

Example: You can create one macro to use in several different programming
events or to use on a touch screen when creating Favorites. See “ Using the
Macros agent.”

l Media Scenes—Creates a media scene that plays music in selected rooms on your system. See “ Using
the Media Scenes agent.”

l Navigation—Add this agent to the system to enable navigation commands
in the Programming view for T3 and EA On-Screen Navigators.

l Push Notification—Lets you define a push notification to be sent to your
mobile devices as defined in programming.

l Scheduler—Defines conditionals of time to the system, and adds the ability to have scheduled events.
See “ Using the Scheduler agent.”

l Screen Saver—Lets you set up a Screen Saver agent so you can create various Screen Savers. See
“ Using the Screen Saver agent.”

l SNMP Configuration—Lets you set up and configure devices to monitor via SNMP. Requires knowledge
of SNMP and network management. See Example: Program using the SNMP Configuration agent.

l Timer—Starts, stops, or repeats a timer based on a given event and action.

Example: If a Motion Sensor in the system turns on a light when it detects
motion, you can use a timer to turn off the light after 15 minutes. Alternatively,
you can set a timer to repeat an action whenever the timer expires. See
“ Using the Timer agent.”

l UI Configuration—Upload custom wallpaper images and apply wallpapers
from both the default set of images and custom images to multiple touch
screens and on-screen navigators at once. Supported on T3 touch screens
and EA controllers in OS 2.9.0. See “Using the UI Configuration agent”.

l Variables—Create Boolean, string, and number variables. Review “ Examples: programming with
variables” for information about creating Variable agents.

l Wakeup—Initiates a pre-specified wakeup time in the Navigators. This agent lets you play music, turn on
lights, and change temperatures. See “ Using the Wake/Sleep agent.”

l Wakeup/Goodnight—Updated version of the Wakeup agent adding the ability to control shades with a
Wakeup scene.

The agent examples listed in the following sections will guide you through the programming steps for each
agent type.

Using the Announcements agent
Use the Agents and Programming views to program this agent.

You can create announcements that:

l Display a text-message or Web page on any of the Navigators (on-screen Navigator or touch screens)

l Play an audio announcement through any audio end point or T3 touch screen
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l Combine the two mentioned above

Note: The Control4 system allows up to 10 MB of files for the
Announcement agent, and plays a maximum of 15 seconds per
announcement. The Announcements agent supports the same audio
playback file types as the EA and HC controllers support under My Music.

Example: This example demonstrates how to create a 'Dinner is Ready'
announcement that is activated when the family chef (or dad) presses a
custom-programmed button. When the button is pressed, the text
message, 'Come to Dinner!,' displays on all of the Navigators in the home,
and an audio file of a dinner bell ringing plays.

Prerequisites

The following devices are added and identified (with a network address) in the project:

l Controller
l Audio output device (television or connected speakers)

l Navigator with a screen (touch screen or television)

l Any device involved in the triggering event (doorbell contact, keypad, etc.)

To set up an Announcements agent:

1. Start Composer Pro and connect to a Director.
2. Click Agents.

3. (First time only) Click Add to add the Announcements agent to the project.

4. Select Announcements, and then click OK to add Announcements to the agent types list in the project. The
next time you want to create an announcement, just select the Announcements item in the Agents pane and
click New.

5. With Announcements selected in the left pane, click New.

6. Name the new announcement, and click Create. Example: Come to Dinner!

7. Set up the Navigator text message you want to display.
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1. Check the Display Navigator Text/Image Popup box.

2. Click Edit Text/Image.

3. Type a text message, a URL, or browse to an image (JPG, GIF, or PNG) to display.

The text box accepts any HTML code. While certain links and scripts won’t be handled,
when the announcement is triggered, for example, if you put this text in an
announcement, it will show up just as if it were a web page. For example, the following
HTML text will display the latest snapshot of a web page:
<HTML><BODY><IMG
SRC="http://tbn0.google.com/images?q=tbn:1uOhCnlc3zbQgM:http://www.inkycircus.c
om/jargon/images/mountain.jpg" ALT="pumpkin"><a
href="http://www.w3schools.com/">Visit W3Schools!</a></BODY></HTML>
Note: A static image file (JPG, GIF, or PNG) only has to be added to your project once
because it is copied to the controller. When added, it is available in the Text Message
drop-down menu for use in any additional announcements created.

4. Select the time you want the text message to display using the Close after drop-down menu (supported
display times are from five seconds to 10 minutes).

5. Click Add/Remove and check the Navigators that will display the message. Click OK.

8. Audio file—Add an  audio file, and set up the audio file to be played.
1. Check the Play Audio File box.
2. (One time per audio file) Click Add and browse to the audio file to add it to the drop-down menu.

Note: An audio file only has to be added to your project one time because it is copied to
the controller. When added, it is available in the Audio File drop-down menu for use in
any additional announcements created.

3. Select the audio file from the drop-down menu.

4. Click Add/Remove… and check the rooms where the audio file will play. Click OK.
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5. Click Add/Remove… and check the T3 touch screens where the audio file will play. Click OK.

6. Set the volume of the audio play for each room and touch screen.

Note: The volume for an announcement only can be set on devices with discrete volume
control.

9. Click Programming.

10. Verify that the new Announcements agent displays in the Actions list (bottom of list).

1. Select Announcements.

2. Make sure the 'Come to Dinner!' message displays in the Announcement Actions pane and that the
command is there (green arrow).

11. Program the announcement to play or display with a triggering event.

Example: Program a button-press event (left pane) to trigger the Announcements agent
to run 'Come to Dinner!' (right pane).
Using the Communication agent
The Communication agent lets you configure the DS2 Door Stations and T3 Touch Screens (supports audio
and video intercom) so that the Control4 system acknowledges the Intercom system and can communicate
with it.

The Control4 Intercom app requires that the Communication agent is added into the system.

Note: The Control4 Intercom app is currently in a beta testing state.

Important: See Communication Agent Wizard and Migration Process on the
Knowledgebase before using this agent to see if additional steps are required
to add and use the Communication agent.
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Note: This agent also lets you configure the intercom to allow third-party
devices (External Devices) for multi-dwelling units (MDUs). This functionality
requires additional training and hardware not covered in this document.

With the Communication agent, you can send calls to multiple touch screens, monitor a room, and other
controls.

Examples:

l If you have an elderly parent living in their own home, you can create a macro
and assign it to a keypad button. If your family member is in stress, they
simply press the keypad button to notify you that something is wrong.

l Create a “Good Night” setting where all touch screens in the house can be set
to “Do Not Disturb” when it’s time to go to sleep.

l Monitor your kids’ rooms after they’ve gone to bed to ensure that they’re
going to sleep when they should.

l Receive calls from the door station to your Control4 Intercom app.

l Call from the Control4 Intercom app to the touch screen to speak to your kids
at home.

Notes: (1) Broadcasting does not work in a room that’s being monitored if that
room is in Monitor Mode. When in Monitor Mode, you will not want the person
in that room to be disturbed, for example, a sleeping child. (2) Before you use
Intercom with touch screens connected over Wi-Fi, make sure your Wi-Fi
router is set to allow multicasting. Some routers do not allow multicasting.

Prerequisites
l Controller

l T3 Touch Screens

l Communication agent (see below)

Note: Use of the Control4 Intercom app requires an active 4Sight license.

To set up the Communication agent:

1. Click the Agents view.

2. In the Agents pane, select Communication. If the Communication has not been added already, click Add,
highlight Communication in the list, and click OK.
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Add new Intercom group

An Intercom group is a set of Intercom-supported touch screens identified by a
specific group name. This saves time when you want to send a call to a group of
people.

To add an Intercom group:

1. Select Communication in the Agents pane. Then in the Intercom Groups pane, click New.

2. Name the Intercom group, and click Add. Example: “John’s Group.”

3. Add the devices to the new group (see “Local Devices Tab” below).

Local Devices tab

Group properties:

You can add devices to an existing group of 5" or 7" In-Wall Touch Screens, 7” In-Wall Touch Screen with
Camera, 7” Portable Touch Screen with Camera, Door Station, or 7” In-Wall, 10” In-Wall, and 7” Tabletop T3
Touch Screens. This lets the caller from one touch screen send out a call to the group of devices.

To add or remove devices in a group:

l Add: Select the device in the Local Devices tab, and then click Add. Click OK.

- OR -
l Remove: Select the device in the right box of the Local Devices tab, and then
click Remove. Click OK.

Device Properties:

To change device properties for the touch screens in the Intercom Group:

1. Use the Local Devices tab to change the settings for all supported touch screens in the Intercom Group.

l Manual Answer Timeout (seconds)—Use the up or down arrow keys or enter
howmuch time is allowed to answer an incoming call.
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l You can set the intercom device order by selecting the device and clicking
theMove Down orMove Up buttons.

2. Click Apply Changes when you're finished.

External Devices tab

The External Devices tab can be used to add external devices that can communicate with the intercom
system, for example in an MDU solution. Mobile devices using the Control4 Intercom app also show up as an
external device. The Control4 Intercom app is still in a beta state. This functionality requires additional training
and hardware not covered in this document.

Using the Custom Buttons agent
Use the Control4 Composer Pro Custom Buttons agent to create up to four
custommenus to display on the Navigators (including touch screens, Control4
apps, and on-screen). Custom Buttons Menus can be accessed from the Room
Menu in Navigators or added as a favorite to the Room Screen.

Example: If you have a heated driveway or some other specialty device, you can
set up a screen with custom buttons to operate the heated driveway from the
Navigators.

To set up the Custom Buttons agent:

1. Start Composer Pro and connect to a Director.
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2. Click Agents.

3. (First time only) Click Add to add the Timer agent to the project.

Custom button menus can be defined for a single room or for all the rooms in the project.

To set up a Custom Buttons menu for a single room:

1. Select the room in the Rooms pane on the left side of Composer.

2. Click Add... and enter the Menu Name and Button 1-6 names as desired.

3. Click OK.

To set up a Custom Buttons menu for all rooms:

1. Select All Rooms in the Rooms pane on the left side of Composer.

2. Click Add... and enter the Menu Name and Button 1-6 names as desired.

3. Click OK.

Guidelines
l You can access each screen on the Navigators from the Control4 main menu
or for a room from four available tabs. Example: The heated driveway screen
is accessed from a custom tab on the main menu. You can configure the tab
to be viewed system-wide on all screens, or to view in one room only.

l The Navigators allow up to four tabs per room to access custom screens with custom buttons. Each
screen can provide up to six custom buttons for a total of 24 custom buttons. The four tabs in each room
can be allocated as either room or as global tabs.

l On the Navigators, you can set up a room or global tabs. The example shows the creation of custom
tabs that appear in the Front Room and access a custom screen.

Note: If you want to create a Custom tab to appear globally, check the Global box next to the Screen
Name. Because only four screens are available for each room, if a Global button is added and
another room already has four screens, the Global button replaces the first screen in that room.
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Prerequisites

The following devices are added and identified (with a network address) in the project:

l Controller
l Electronic Gate (In the Control & Audio Video Connections tab, ensure that the Electronic Gate is

connected to controller relay Port 4.)

To set up a Custom Buttons agent:

1. Start Composer Pro and connect to a Director.

2. Click Agents.

3. (First time only) Click Add to add the Custom Buttons agent to the project.

4. When the dialog appears, from the list, select Custom Buttons.

5. Click OK.
6. Select the Custom Buttons agent.

7. From the list that appears in the left pane, select the room for the custom button; for
example, select Family.

8. When the Custom Buttons interface appears, in the Screen 1 area, click Add. Note: In the Navigator, Screen
1 appears in the top left corner; Screen 2 appears in the lower left corner, Screen 3 appears in the top right
corner, and Screen 4 appears in the lower right corner.

9. Enter the name of the buttons to appear on the Navigator screen.

10. Enter the relevant information for the device.

The Screen Name is the name that appears on the access tab to enter the custom screen. The buttons
are the names that appear on the custom buttons.

Example: For the Garage Door, enter the following:
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l Screen Name: Garage Door

l Button 1: Toggle

11. Click OK.

12. Click the Programming view to program your Custom Buttons.

13. In the Device Events pane, scroll down to the agents and select the Custom Buttons agent.

14. In the Custom Buttons Events pane, ensure that Family-Garage Door is selected under the Event Screen
next to Toggle, and then select the Press radio button. When custom button ‘Toggle’ on screen ‘Garage
Door’ in Family is pressed, it appears at the top of the Script pane.

15. In the Actions pane, select Garage Door.

16. From the Command tab, select the Toggle the Garage Door radio button. The action command appears in
the Actions pane.

17. Drag the green arrow to the Script pane.

18. Select File > Refresh Navigators.
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Using the Email Notification agent

IMPORTANT! An active 4Sight Internet Service subscription is required for
Email Notification to work. See Composer Pro Getting Started or the Control4
System User Guide.

Use the Control4 Composer Pro Email Notification agent to have an email sent to an email address
automatically when specific events occur as defined in programming.

Example: If you want to know when the basement door opens, you can set up
an Email Notification agent to send an email to your email application’s Inbox
when the Basement door opens.

l The Email Notification is a Control4 service. To use Email Notification agent, remote access is required
to facilitate a secure connection between the controller and the Control4 service.

l The Email Notification agent uses templates to enhance usability. You can use a template to define a
To, Subject, or Body for use when creating instances of the Email Notification agent. See "Connecting to
a Director using Remote Access" in Composer Pro Getting Started.

l Use the Programming view to define the individual instance that triggers an email and completes the
definition.

Example: A security threat to the house notified you of broken windows, doors
opening, and motion detected in Away mode. In the template, you define
Subject: Security Alert and To: fsmith@myemail.com. In the Programming
view, you might define the zone. Examples of other incidents to use E-mail
Notification include: Basement Door Opened, Front Gate Opened, Water
Sensor detection, Carbon Monoxide Sensor detection, Motion Sensor
detection, Sprinklers On/Off, etc.

Tip: When setting up an E-mail Notification agent, note the frequency that an
event can happen; because if it is too frequent, it can slow down the system.
For example, if an email is sent when a Motion Sensor detects motion, the
frequent email messages could cause sluggishness.

Prerequisites

The following example devices are added and identified (with a network address) in the project:

l Controller

l Door Contact Sensor

To set up an Email Notification:

1. Start Composer Pro and connect to a Director.

2. Click Agents.

3. (First time only) In the Agents view, click Add to add the Email Notification agent to the project.
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4. When the dialog appears, select Email Notification.

5. Click OK.

6. Select Email Notification, and click Add in the pane that follows. The New Template Name dialog appears.

Tip: Control4 now includes Control4 system and user-defined variables in the templates
created using this agent. To use this function, you can create or modify email templates
using Composer Pro > Agents > E-Mail Notification, and then use the Add Variable
option.

7. Enter a name on the dialog that appears, for example, 'Security Alert.'

8. Click Create.

9. In Email Notification Template Name, select Security Alert for the Composer Pro email screen to appear.

10. Fill out the information for the email you want sent to you when an event occurs.

Example:
To: fsmith@myemail.com

Subject: Security Alert

Body: The security of the Franklin Smith House may have been compromised.

11. Do the following as needed:

1. Click Send Email to test and see if you receive and email to your email address.

2. Click Add Variable if you've created a variable agent. Scroll down the list to locate the variable, and then click
OK.

3. Click Save to exit and go to the Programming view to set up the programming.

4. Click Reset to clear the To, Subject, and Body of the email to start again.

12. With the Agent template created, you can create one instance of the Security Alert for each security zone (or
object). When you've saved the template, click Programming.

13. In Programming under Theater, select Door Contact Sensor.

14. In Door Contact Sensor Events, select When Door Contact Sensor opens.
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15. In the Actions pane, scroll down and select Email Notification.

16. Make any changes to the email as necessary.

17. Drag the green arrow to the Script pane.

18. In the File menu, click Refresh.

19. Test the Email Notification agent by going to the door and opening it. An email is sent to your Inbox with the
Security Alert as a subject.

Using the Light Properties agent
Use the Agents and System Design views to add and configure dimmable, non-dimmable, and 0-10V lights for
Panelized Lighting devices.

Use this agent to make it easy to set up load and wattage information in the Panelized Lighting Properties
pages for a project.

To use the Light Properties agent:

1. Start Composer Pro and connect to a Director.

2. Click Agents.

3. (First time only) Click Add to add the Light Properties agent to the project.

4. Select Light Properties, and then click OK.

In the Light Properties pane, change the columns for each light in the Panelized Lighting system.

Note: Ensure that the Panelized Lighting module is added and identified to the system.
After you do, the name of the device will display in this agent’s Light Properties pane.
See the Panelized Lighting Quick Start Guide for details.
These options are editable.
l Name—The name of the module you identified in the system.

l Load Number—Assign a load number for each module in the system.

l Watts—Assign the wattage for each module in the system.

Using the Macros agent
Use the Agents and Programming views to program this agent. Macros agents are routines that associate
programming with events.

Examples: You can create and name a macro to use in several different programming events.

The macro can be called from a particular program in the Programming Actions pane or you can create a
custom button on your touch screens or on-screen Navigator to call a Macro .

You can create Macros:

l To use in various programmed events

l To use in Custom pages

l To use from custom buttons in the Navigators

Prerequisites

The following devices are added and identified (with a network address) in the project:
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l Controller
l Light Switch

l Navigator with a screen (touch screen, Control4 app, TV screen, etc.)

l Any device involved in the triggering event (doorbell contact, keypad, etc.)

To set up the Macros agent:

1. Start Composer Pro and connect to a Director.

2. Click Agents.

3. (First time only) Click Add to add the Macros agent to the project.

4. Select Macros, and then click OK.

To create a new Macro:

1. Select Macros in the Agents pane, and click New.

2. Name the new macro, for example, Bob, and then click Create.

To add commands to the macro's programming script:

In this example script, you will select the Family Room Switch which is on, and then turn off everything in the
Living Room.

1. Click the Programming view.

2. In the Device Events pane, scroll down to Macros and select Bob. "When Screen Saver On is executed"
appears in the Script pane.

3. In the Device Actions pane, select Family Room and the Wall Lights.

4. Under Light, select On.

5. Drag the green arrow ‘Turn on the Family >Wall Lights' to the Script pane.

6. Under Light, select Off.

7. Drag the green arrow 'Turn off the Family > Wall Lights' to the Script pane.
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8. You can add the Macros agent to many programs that you create if you want to perform similar tasks, or you
can program the agent for a specific device. For example, you can assign this agent to a button on a keypad
to run the program when executed.

Note: A unique Macro cannot be edited or copied; only created or deleted. If you want
to create a new Macro based on another one, you must create a new one.
Using the Media Scenes agent
Use the Media Scenes agent to allow simpler multi-zone audio control. Media Scenes link source, volume,
and room-off commands. With Media Scenes, you can configure one or more rooms in a system to play the
same music at the same volume. 

Example: A Media Scene for the entire house can include all the rooms in the
Control4 system. Another Media Scene can include only the Master Bedroom
and Bath. You can create any number of Media Scenes containing any
number of rooms.

Guidelines
l To successfully activate a Media Scene (with the rooms being controlled
simultaneously), activate the Media Scenes agent before starting any music
playback.

l Media scenes are persistent; when activated, a Media Scene remains active
until deactivated or until the controller is powered down. If a Media Scene is
deactivated while music is playing, the music continues to play in the
associated rooms, but the rooms are no longer controlled in unison.
Therefore, music can be stopped in one room while it continues to play in
another room.

l You can set up a Media Scene one time, and activate it when desired. Then
play the music.

To create a Media Scenes agent:

1. Start Composer Pro and connect to a Director.

2. (First time only) In the Agents view, click Add to add the Media Scenes agent to the project.

3. On the dialog that appears, click Media Scenes, and then click OK.

4. In the Agents pane, select Media Scenes, and click Add.

5. Enter a name for your new Media Scene. Example: Party Music.
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6. In the Agents pane, select Party Music, and then click Add Room in the Media Scenes pane.

7. In the dialog box is a list of rooms in your system. Check the rooms where you want to play your Party Music,
and then click OK. Example: Theater and Family.

Tips: To remove a room from a scene, click Remove Room. To create another Media
Scene, return to Step 1.

Tip: You can add all rooms on a floor by clicking, for example,Main. This
automatically selects all other rooms in that category. You can also include all rooms in
your entire system in the Media Scene by clicking House.
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The rooms you selected appear in the new Media scene 'Party Music.'

8. To activate the scene, click Activate Scene at the top of the screen.

9. To deactivate, click the Deactivate Scene button. 

10. You can program a button for your Media Scene. Do this by creating a new Custom Button.

1. In the Agents view, click Custom Buttons, and then below, click a room. In the Custom Buttons pane, click
Add.

2. In the Add Screen dialog that appears, enter the name of the Custom Button, and then click OK. 

Example: Click Theater and call the Screen name Media Scene. Name Button 1: On/Off and click OK. 

The custom button name appears in the pane. 

11. Click the Programming View.

12. In the Device Events pane, scroll down and click Custom Buttons. In the pane below, Custom Button Events,
select the screen you want to program, and then select the Press radio button. 

Example: Select the screen Kitchen - Media Scene, and select the Press radio button. 
13. In the Actions pane, select Kitchen.

14. In the Kitchen Actions pane under Conditionals, press the Media Scene Active button which also selects
True.

15. Drag the blue question mark to the Script pane.

16. In the Actions pane, scroll down and select Media Scenes.

17. In the Media Scenes Actions pane under Commands, press the Deactivate button, and then select Party
Music.

18. Drag the green arrow on top of the blue question mark in the Script pane.

19. In the Actions pane, scroll up and select Kitchen. In the Kitchen Actions pane and in Conditionals, press the
Media Scene Active button, and then the False button.

20. Drag the blue question mark to the Script pane.

21. In the Actions pane, scroll down and select Media Scenes. In the Media Scenes Actions pane and in
Commands, press the Activate button, and then select Party Music.

22. Drag the green arrow icon on top of the blue question mark in the Script pane. 

384



Composer Pro User Guide

The Script pane now reads, 'When custom button ‘On/Off’ on screen ‘Media Scene’ in Kitchen is
pressed...Activate scene ‘Party Music.’'

23. To execute the scene, click Execute.

Using the Color agent
The Control4 Color agent enables the creation and editing of color and tunable
white lighting presets. Presets allow for quick selection of a specific color
(chromaticity) or tunable white (CCT) on bulbs and lighting strips that support
color and/or tunable white. Presets only contain information about the color or
CCT value. Brightness is not included with the preset definition. Brightness does
affect the perceived color. Brightness can be set manually using the user
interface and can also be set programatically using Advanced Lighting Scenes,
Brightness Presets, and custom programming.

Minimum required OS version: OS 3.3.0

Quick Configuration
The Control4 Color agent is automatically added to any project installed on or
updated to OS 3.3.0. You should not attempt to delete this agent. If you do, it will
be added back into the project when the controller is restarted.

The Color agent includes a selection of default presets for various color selections
and tunable white selections. Users may also create their own presets using the
customer application. You may add system-wide presets as well. All presets can
be edited and deleted. You can also change the order which will be used to
display these preset selections. Note that individual lights may not be able to
display all chromacity or CCT levels. The Color agent doesn't attempt to enforce
this. But, when the Control4 user interface is used to set the color/temperature for
the device, it will only show the available presets. In other words, the available
presets will be limited based on the device's defined capabilities.
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Presets

There are three categories of presets:

Default ⁠—These are the default presets provided on initial installation of the Color
agent.

Dealer ⁠—These are the presets created by the Control4 Installer using the Color
agent.

Customer ⁠—These are the presets created by the user through the Control4
application.

Add Preset
Name⁠—Name each Preset. Names must be unique.
Category ⁠—The category field is read-only. All presets created by the Installer are
in the Dealer category.

Preset Type ⁠—Color presets are defined by chromaticity and stored either using
xy values or hue & saturation values. Color Temperature presets are defined by a
color correlated temperature (CCT) value in Kelvins.

Definition ⁠—You may use the color wheel or the entry fields to specify the desired
color/temperature.

Hue and Saturation ⁠—Chromaticity is specified using hue (0-359 degrees) and
saturation (1-100%).

xy Chromaticity ⁠—Chromaticity is specified using the xy scale. This gives you the
broadest selection of colors.

RGB ⁠—Color may be specified as an RGB value. The RGB specification combines
both chromaticity and brightness. When you provide RGB values, Control4 will
convert the chromaticity to xy.

Test Light ⁠—You may select one or more lights. The selected light(s) will follow
the color / temperature selections so that you can visually verify the color while
you are creating or editing the preset.

386



Composer Pro User Guide

Edit Preset

Preset Order
You can easily change the order of the presets by dragging a preset higher or
lower on the preset list.

Import/Export Presets
Exporting the preset list allows you to save the preset definition to an xml data
file. This can be very helpful for restoring the presets to a known good
configuration. As with other areas of Composer Pro, the Color agent doesn't have
an 'Undo' function. If you make changes, and aren't happy with them, you will
save a lot of time by restoring a known good configuration. If a preset with the
same name is imported, it will overwrite the preset in the project. Exporting and
Importing presets can also be helpful if you want to provide a standard base set of
presets in all of your customer installations.

Advanced Properties
Log Settings

Log Level⁠—This property allows to filter which message types display in the Lua
Output window. Options 0 ⁠—5 correspond to Fatal through Trace levels,
increasing in level of verbosity.

Log Mode⁠—Activates logging of diagnostic information. The log level is set in the
above property. Options include Off, Print (to the window), Log (to the Director
Log), and Print and Log (both). Default is Off.

General Information

Device ID ⁠—Displays agent device ID.
Agent Version ⁠—Displays current agent/driver version.
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OS Version Status ⁠—Displays whether current OS version fulfills min
requirements for Color agent.

Actions

This section lists and defines the Actions that the agent provides and are available
through ComposerPro. These Actions are primarily for advanced troubleshooting.
You should not need to use them for normal configuration.

List Presets⁠—Prints all defined color presets in table format to the Lua output
window.

Add Preset HS ⁠—Adds color preset in the HS color format. Parameters are:
NAME ⁠—Preset name (mandatory field)
CATEGORY ⁠—Preset category differentiated by who created the preset.
HUE ⁠—Hue component of HSV/HSB/HSL color space (range [0.0, 360.0])
SATURATION ⁠—Saturation component of HSV/HSB/HSL color space (range [0.0,
100.0])

Add Preset XY⁠—Adds color preset in the xy color format. Parameters are:
NAME ⁠—Preset name (mandatory field)
CATEGORY ⁠—Preset category differentiated by who created the preset.
COLOR_X ⁠—x component of xyY color space (range [0.0, 1.0])
COLOR_Y ⁠—y component of xyY color space (range [0.0, 1.0])
Add Preset RGB⁠—Adds color preset in the RGB color format. Parameters are:
NAME ⁠—Preset name (mandatory field)
CATEGORY ⁠—Preset category differentiated by who created the preset.
RGB ⁠—RGB color information.
Add Preset CCT ⁠—Adds color correlated temperature preset. Parameters are:
NAME ⁠—Preset name (mandatory field)
CATEGORY ⁠—Preset category differentiated by who created the preset.
COLOR_TEMPERATURE ⁠—Color temperature in Kelvins (range [1000.0, 20000.0])
Edit Preset Name⁠—Changes name of the preset with the given ID. Parameters
are:

ID ⁠—ID of the preset that is being modified.
NAME ⁠—New preset name.

CATEGORY ⁠—Category from which the preset is being edited.

Edit Preset HS ⁠—Changes HS color information of the preset with the given ID.
Parameters are:

ID ⁠—ID of the preset that is being modified.
HUE ⁠—Hue component of HSV/HSB/HSL color space (range [0.0, 360.0]).
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SATURATION ⁠—Saturation component of HSV/HSB/HSL color space (range [0.0,
100.0]).

CATEGORY ⁠—Category from which the preset is being edited.

Edit Preset XY ⁠—Changes xyY color information of the preset with the given ID.
Parameters are:

ID ⁠—ID of the preset that is being modified.
COLOR_X ⁠—x component of xyY color space (range [0.0, 1.0])
COLOR_Y ⁠—y component of xyY color space (range [0.0, 1.0])
CATEGORY ⁠—Category from which the preset is being edited.

Edit Preset HS ⁠—Changes RGB color information of the preset with the given ID.
Parameters are:

ID ⁠—ID of the preset that is being modified.
RGB ⁠—RGB color information.
CATEGORY ⁠—Category from which the preset is being edited.

Edit Preset CCT ⁠—Changes color correlated temperature of the preset with the
given ID. Parameters are:

ID ⁠—ID of the preset that is being modified.
COLOR_TEMPERATURE ⁠—Color temperature in Kelvins (range [1000.0, 20000.0])
CATEGORY ⁠—Category from which the preset is being edited.

Delete Preset⁠—Deletes preset with the given ID. Parameters are:
ID ⁠—ID of the preset that is being deleted.
CATEGORY ⁠—Category from which the preset is being deleted.

Reorder Presets by IDs⁠—Changes the order in which presets are displayed.
Provided argument is a comma-separated list of IDs which represents their new
order. If the list is partial, only mentioned presets will change their positions, while
the other presets will retain their current positions.

IDS ⁠—Comma-separated list of preset IDs that represent their new order relative
to each other.

Reorder Presets by Names⁠—Changes the order in which presets are displayed.
Provided argument is a comma-separated list of preset names which represents
their new order. If the list is partial, only mentioned presets will change their
positions, while the other presets will retain their current positions.

NAMES ⁠—Comma-separated list of preset names that represent their new order
relative to each other.

Using the Media Sessions agent
Use the Media Sessions agent to view and have limited control over active audio sessions in the project.
Media Sessions agent cannot be used to provide any programming assistance, but can be use to control
volume and mute settings for active zones.
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Example: A media session was creating using the Control4 app. You can use
the Media Session agent to control volume and mute in any of the rooms in
the media session.

Configuring the Master Volume Slider
The Media Sessions agent can help avoid potentially damaging high volume levels when using the Master
Volume Slider in the Sessions page of the user interfaces by configuring an upper threshold for the Master
Volume Slider. Volume won't ramp above the upper threshold until all rooms are at the threshold to avoid a
single room ramping above the level when the Master Volume Slider in a user interface.

In the Properties tab of the Media Sessions agent, use the arrows or enter a volume for the Session Master
Volume Slider upper threshold.

Using the MultiDisplay Manager agent
Use the MultiDisplay Manager agent to control multiple displays in a commercial, retail, hospitality, or
residential project. You can control multiple displays and audio sources from a single interface, a Control4
touchscreen or Control4 app on Android or iPad.
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To set up a video wall to be controlled by the MultiDisplay Manager agent:

1. Add your televisions (displays) to the desired room in the project.

2. On the Connections tab after selecting the room where the TVs reside, make sure your video and audio
bindings are done. You must have one of the TVs assigned as a Video Endpoint. The MultiDisplay Manager
is setup by using the Video Endpoint and Additional Video Endpoint bindings. Connect your first TV to the
Video Endpoint and your other TVs using the Additional Video Endpoints. The Additional Video Endpoint
only shows up one at a time. As soon as the as you bind the first Additional Video Endpoint, the next one will
appear. Due to a new one appearing, you will always have one unbound Additional Video Endpoint. Once the
bindings are made you are ready to create a MultiDisplay Manager. If you do not have all your video and
audio end points setup and configured there is no point moving on to the video wall agent until you do
because these will be required during the setup.

3. Add the MultiDisplay Manager agent to the project within Composer. Go to Agents > Add and select the
MultiDisplay Manager agent.
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4. After theagent has been added, click on Add Wall and select the Audio Zone (room) where the video wall is
to reside.

5. After the Audio Zone (room where the MultiDisplay Manager resides) has been selected, click on the button
to finish the setup. Within the details of the configuration, you will need to provide a Wall Name, select an
Audio Zone, and select a default Audio Source (optional).
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6. Within the second section of the MultiDisplay Manager, you will need to choose the number of columns and
rows for your video wall layout. The max size a video wall can be is 3 rows by 6 columns due to the size limit
on the navigators. Once done press the Get Started button.

Note: When you press get started you will see the TVs in a layout. The up,
down, left, right buttons are currently not functional and will be coming in a
future release of the agent. These are not needed for testing of the
MultiDisplay Manager and just allow for slight visual adjustments of the TVs on
the screen.

7. After saving the layout section, the Sources and End-Points section will be populated with drop down
sections for selecting video endpoints and their default sources. Set your Video Endpoint, Default Source
and if desired, the Default Channel for each television. Press Save to retain the configuration.
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8. After your wall is configured you will need to make sure that it is visible. Go to the room level where this
should be visible. Make sure you are on the System Design tab. On the Properties page go to the Navigator
tab and select MultiDisplay Manager in the Submenu Filters section. If they are hidden, click on the modify
button, select the wall you want to show and press the Show button to make them visible.

You should now have a MultiDisplay Manager icon within the Watch section on your touch screen. You can
favorite that to the main screen if desired by doing a long press on the icon.

Note: The MultiDisplay Manager only works on tablets and touch screens. It
will not work on mobile phones or remotes due to the amount of space
needed to show everything on the screen.

Using the Scheduler agent
Use the Agents and Programming views to program this agent. The Scheduler agent lets you schedule time
on the Control4 system to trigger specific events to occur. You can program a specific one-time event or
multiple events to re-occur daily, weekly, monthly, yearly, etc. 

Example: Schedule an event to play dad’s favorite song at 7:30 AM on his
birthday.

Prerequisites

The following devices are added and identified (with a network address) in the
project:

l Controller
l Keypad

To set up the Scheduler agent:

1. Start Composer Pro and connect to a Director.

2. Click Agents.

3. (First time only) In the Agents pane, click Add to add the Scheduler agent to the project.

4. Select Scheduler in the Agents list, and click OK.
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5. In the Agents pane, select Scheduler. The Scheduler panes appear.

6. In the Scheduler pane, click Add.

7. In the New Event dialog, enter the relevant information for this Scheduler instance:

1. In Name: type Dads Birthday.

2. In Time, add the following:

l Select the Time radio button.

l Highlight the hour: 07, minutes: 30, and AM. Use the drop-down menu to
select each time separately, or

l Select Sunrise/Sunset, and select Sunrise from the drop-down menu.

3. In Randomize time by +/-, keep the default of 15 minutes. This executes the Scheduler either 15 minutes
before or 15 minutes after the actual time you assigned. This is useful when you go on vacation and you want
your lights to go on at different times so outsiders think someone is home.

4. In Start Date, select one of the following:

l Select the Start on radio button. Use the drop-down menu and select today’s
date.

l Select the Start on the radio button to select an exact day, month, and year.
Use the drop-down menus to make your selections.

5. Select Repeats.

l Select Yearly.

Example: You want dad’s favorite song to play at 7:30 AM. This dialog lets you
schedule one-time events and recurring events.
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l Select Stop on, and use the drop-down menu to select a month and year to
stop this agent.

6. Click OK. The event is now added to the list of events.

7. To delete an event, select the event in the list, and click Delete.

8. Click Programming.

9. In the Device Events pane, select the Scheduler object at the bottom of the list.

10. In Scheduler Events, click Dads Birthday event. The Script pane shows Dads Birthday event.

11. Select the device actions to initiate in the Actions panes.

12. Drag the actions to the Script pane. These scripted actions execute when the Dad’s Birthday event executes.

13. You can use the Scheduler agent in programming also to add conditionals or loops to your scripts.

14. In the project tree, select 3 Button Keypad.

1. In the Actions pane, scroll down and select the Scheduler agent.

2. Click the Conditionals tab, select Time, and Within 5 minute(s) Before Sunset.

3. Drag the blue question mark to the Script pane.

4. In the project tree, select the light.

5. In the Commands tab, select turn the room on, and drag the green arrow on top of the blue question mark
in the Script pane.

Results: When the top button on the 3-Button Keypad is pressed, if it is within five minutes before sunrise,
the light comes on. The Scheduler agent lets you define one-time events and recurring events.

Using the Screen Saver agent
Use the Agents view to set up the Screen Saver agent.

Prerequisites

Ensure that the devices you will use to set up a screen saver and store your photos (for example, a network-
attached storage device) are attached to the Control4 system are attached to the primary controller. If you use
a USB device, ensure that it is formatted to FAT 32.

To set up the Screen Saver agent:

1. Start Composer Pro and connect to a Director.

2. Click Agents.

3. (First time only) Click Add to add the Screen Saver agent to the project.

4. Select Screen Saver, and then click OK. The next time you want to create a Screen Saver, click the Screen
Saver item in the Agents pane, and then click New.
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5. From the drop-down menu, select the File Storage Location.

6. Click the Media view.

7. Click Screen Saver in the Media pane.

8. Click Add to scan and add new photos to the Screen Saver pane from the device you selected in the Network
Storage Location box.

9. To set up a custom screen saver on the Navigators, see also:

l “ Setting up the photo screen saver”

l “ Setting up a custom screen saver”

l Control4 System User Guide

Using the Timer agent
Use the Agents and Programming views to program this agent. The Timer agent lets you start, stop, or repeat
a timer based on a given event and action. 

Example: A Motion Sensor turns on a light when it detects motion; use a timer
to turn off the light after 15 minutes. Alternatively, you can set a timer to
repeat an action whenever the timer expires, such as a Bathroom fan that
restarts each time the Bathroom light turns on.

Prerequisites

The following devices are added and identified (with a network address) in the
project:

l Controller
l Any device involved in the triggering event (for example, a Motion Sensor)
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To set up the Timer agent:

1. Start Composer Pro and connect to a Director.

2. Click Agents.

3. (First time only) Click Add to add the Timer agent to the project.

4. Select Timer, and then click New.

5. Type the name of the new timer (for example, Bathroom Fan), and click Create.

6. In Interval, use the drop-down menu to set the timer in seconds, minutes, or hours (hh:mm:ss), and click OK.

7. Click Start to start the timer.

8. Click Programming.

9. Select the Timer Action in the Actions pane, and ensure the new timer options display in the Commands tab
(Start, Stop, Reset, and Change).

10. Start, Stop, Restart, Reset, Resume, or Change the timer as needed.

The following table outlines how the timer behaves depending on the state of the timer when a command
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is executed.

Command
executed is...

Timer is... Then event(s)
triggered

Effect on Timer

Start Running Reset Restarts timer

Stopped Start Starts timer

Paused Start Restarts timer

Stop Running Stop Stops timer

Stopped none none

Paused Stop Stops timer

Restart Running Stop, Reset, Start Restarts timer

Stopped Reset, Start Restarts timer

Paused Stop, Reset, Start Restarts timer

Reset Running Reset Restarts timer

Stopped Reset, Start Restarts timer

Paused Reset Reset timer value

Pause Running Puase Pauses timer

Not running none none

Paused none none

Resume Running none none

Stopped none none

Paused Resume Resumes timer
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11. Program to connect the timer to an event and action, and choose to Start, Restart, or Stop the timer. 

See the example programming screens that follow. Notice how the timer is first used as an action, and then as
an event.

Event screen:

Action screen:
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Using the UI Configuration agent
Use the UI Configuration agent to manage wallpaper settings and upload wallpapers, to manage screen saver
settings for T3 touch screens and EA On-Screen Navigators, to configure the return to home setting for T3
touch screens and EA On-Screen Navigators, and to add favorites for all navigators in the project.

To configure wallpaper with the UI Configuration agent:

1. In the Agents view, select the UI Configuration agent, then click on the Wallpaper tab.

2. To configure the wallpaper in a single room, select the desired room in the Location pane.
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3. Select from the default images listed, or click Add Dealer Image to add a custom image. Wallpaper images
should be JPG files in a 16:9 format with a resolution of 1920 pixels wide by 1080 pixels high for best results.
Images with different resolutions may be scaled or trimmed to fit and may produce undesirable results. Up to
10 dealer images can be added and configured to any rom.

4. Click Apply to set the wallpaper to the room or click Apply To … to select the rooms to be configured with the
wallpaper.

The homeowner can also add a custom image (up to one for each room) using the Control4 app. For
information on how to add images with the Control4 app, see the Control4 System User Guide
(ctrl4.co/userguide). After a custom wallpaper image has been configured, you can use the UI Configuration
agent to configure rooms to use the image.

1. To configure the custom wallpaper in a single room, select the desired room in the Location pane. Select the
image from the images listed and click Apply to set the wallpaper to the room or click Apply To … to select the
rooms to be configured with the wallpaper.

2. To clear the custom wallpaper image, select the custom image and click Clear Customer Image.

You can also choose to include or not include the Control4 logo on any wallpaper images. Click the box next to
Include Control4 Logo to include the Control4 logo, and then continue the process of configuring a wallpaper
image.

To configure screen saver settings with the UI Configuration agent:

1. In the Agents view, select the UI Configuration agent, then click on the Screen Saver tab.

2. Choose the screen saver mode. Available options include:

l None
l Blank
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l Date and Time
l Current Media
l Photos
l Custom

3. Depending on your chosen screen saver mode, configure any additional options that appear.

4. Configure the Begin After option. The value selected is the period of time the touch screen will wait after
detecting inactivity until it turns on the screen saver.

5. Check the box next to Brightness Control to add a brightness control icon to the screen saver.

6. Check the box next to Animate Text to apply a small movement to the text to avoid screen burn-in.

7. Click Apply To … to select the navigators to be configured with the screen saver settings.

To configure return to home settings with the UI Configuration agent:

1. In the Agents view, select the UI Configuration agent, then click on the Screen Saver tab.

2. Configure when the Navigator will return to the home screen by choosing the time in the Return to Home
After: menu.
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To configure favorites with the UI Configuration agent:

1. In the Agents view, select the UI Configuration agent, then click on the Favorites tab.

2. To add favorites to all Room Screen, click the box next to the favorites you want to add in the Add Favorites
pane.

3. Click Add, and then click OK to add the selected favorites to all applicable Room Screens.

To clear all configured favorites and reset to the default favorites, click Clear Favorites.

Using the Variables agent
Use the Agents view to set up the Variables agent. Ensure that the devices you
want to use for variables are added and identified to the system. 

These sections provide information about how to create the type of variable that
you want to use in programming. 

l “ Example: Using room variables”

l “ Example: Using a custom number variable in an agent ”

l “ Example: Using a custom string variable in an agent ”

l “ Example: Using custom Boolean variables in an agent ”

Using the Wake/Sleep agent
Use the Agents view to program this agent. The Wake/Sleep agent lets you set wake times, sleep timers,
lighting, music, and so on.
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Note: Wake times set in Composer Pro synchronize with the user interfaces.
Likewise, wake times changed on the interfaces will synchronize with
Composer. 

Example: At a user-specified time, start playing music in the Master, open the
blinds, and ramp the light on over two minutes.

Prerequisites

The following devices are added and identified (with a network address) in the
project:

l Controller

l Digital Audio (ensure that you can play music in the project)

l Bedroom Dimmer

l Blinds

To configure the Wake/Sleep agent:

1. Start Composer Pro and connect to a Director.

2. Click Connections.

3. Make sure the connections are correct.

4. Click Agents.

5. (First time only) Click Add... to add the agent to the project.

6. Select Wake/Sleep, and then click OK.

7. In the Agents pane, select Wake/Sleep. The Wake/Sleep interface panes appear.

405



Composer Pro User Guide

8. In the Wake/Sleep Rooms pane, click Add....

9. Select the room to enable the Wake/Sleep scene in and click OK.

10. Configure the Wake/Sleep scene for the room:
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l Time—Select the default Wake time by selecting the time in theWake Time
field. Select the default Sleep timer length by selecting it in the Sleep Timer
field. These times can be adjusted by the user in the Wake and Sleep sections
on a T3 touch screen or the Control4 app.

l Lights—Select if Lights are visible in the Wake and Sleep sections on a T3
touch screen or the Control4 app by selecting Visible. Select which lights to
control with the Wake and Sleep scenes by clicking on Light Selection or
click All. Configure how fast lights turn on with the Wake scene by entering
the desired rate into the Ramp Rate field. Enable lights in the current Wake
and Sleep scenes for the room by selecting Enabled.

l Media—Select if Media is visible in the Wake and Sleep sections on a T3 touch
screen or the Control4 app by selecting Visible. Select the default Media
Source by clicking on Source (example: Pandora) and select the Station or
select Use TV as the only media source and click on Channel to select a TV
channel. Enable media in the current Wake and Sleep scenes for the room by
selecting Enabled.

l Curtains—Select if curtains are visible in the Wake and Sleep sections on a T3
touch screen or the Control4 app by selecting Visible. Select which curtains
to control with the Wake and Sleep scenes by clicking on Curtain Selection
or click All. Enable curtains in the current Wake and Sleep scenes for the
room by selecting Enabled.

l Active Days—Select the default days for the Wake scene to be active.

11. Click Save Changes to sync the changes to the Wake and Sleep scenes for the room:

Note: Users can schedule the wake times for the Wake scenes, enable or
disable items from the Wake scenes, and choose from the lights or curtains in
the Wake scene from their T3 touch screens or Control4 app. See the product
documentation or the Control4 System User Guide for more information
about how to schedule the wake time. 

Note: Users can select the behavior of the Sleep scene (for example: decide
whether to turn off media, turn off lights, and close blinds) in the Options
menu in the Sleep scene from their T3 touch screens or Control4 app..
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Programming
Use the Composer Pro Programming view to program the Control4 system. This section assumes that you
have a general understanding about how to use Composer Pro to add and identify devices, and that you are
now familiar with the Composer Pro interface. If not, read “Basics” sections or refer to Composer Pro Getting
Started.

Use this chapter to learn:

l Programming basics

l Programming with commands

l Programming with conditionals

l Programming using rooms

l Programming using variables

l Programming with agents

l And more
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Programming basics
Use the Programming view to program events and other actions that affect
Control4 system devices.

Tip: A useful tool for helping you keep track of your programming scripts is
called Programming Detective which is part of the Detective Suite, in Tools >
Detective Suite. See the Composer Pro Getting Started guide for details.

To get to the Programming view:
1. Start Composer Pro and connect to a Director.

2. Click Programming. In the Programming view, you can perform basic programming tasks.

Event-driven programming
Programming is based on events. When an event is triggered, other actions can
take place. 

Example: If you program to lower the projector screen in the Theater by
pressing a keypad button. You can program the receiver, DVD player, and
projector to power up and start playing a DVD also. Programming the system
is where the true value of Composer Pro becomes a reality.

To program the system using Composer Pro, you drag and drop Events and Actions that you create for
corresponding devices to a programming Script pane. The sections below show these panes.

Events (Programming pane)

Select an event (left side of the window):
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Actions (Actions pane)

Select the action(s) (right side of the window):
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Script (Script pane)
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After you select the Event, Drag the Actions commands to the Script pane
(middle pane):

The next table describes events, actions, and the script.
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Programming Item Description

Events All programming begins with events. An event is a
“when” statement. An event is the trigger report
that something happened that results in an
automation. Events happen instantaneously. On a
keypad, pushing a button is one event. Actions all
occur under Events. Examples of events include:
l When the door opens
l When it is 7:00 AM
l When it is sunrise

Actions After the event identifies to the system that
something occurred, it sends actions. The
following are the methods that are used by the
system to define actions:
l Commands. The Commands tab displays all
available commands for a selected item in the
Action Device Tree. A command is a “do”
statement. Commands are actions the Director
tells the device to do. Examples of commands
include:

Light: on, off
Blu-ray player: play, stop, pause
Security device: arm, disarm
TV device: Power on/off, change channel
l Conditionals. The Conditionals tab displays
all available conditionals for a selected item
in the Action Device tree. A conditional is an
“if” statement. An “if” statement asks a
true/false question to the device. Examples of
conditionals include:

If door is open
If after 5 PM
If light is greater than 50 percent
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l Loops. The Loops tab displays all available
loops for a selected item in the Action Device
tree. A loop is another type of conditional. A
conditional loop is a “while” statement. It is
something that is ongoing. Examples of
conditional loops:

While the sprinklers are on
While the motion detector detects movement
While a doorbell switch is being pressed
Warning: Using loops (WHILE statements) can
potentially overwhelm the controller’s CPU. Use
loops sparingly.
l Delays. A delay stalls a program from
running to ensure actions that occur at the
right time.

Script The linking of events and actions is defined in the
script.

Tip: To configure or program devices, you can use properties, agents and
variables also. These are considered advanced configuration and
programming tasks. See “ Using and Programming with Agents ” or
“ Examples: programming with variables.”

Programming elements
Basic programming consists of two parts:

1. Identify a device’s events to trigger actions.
2. Define a device’s actions to trigger when an event fires.

The following steps introduce the basic programming flow and script creation:

1. Select the device--Bathroom Fan--in the Device Events pane and select the event--When the Bathroom
Fan is turned on. Notice that it appears in the Script pane.
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2. Define the device's actions--Under Timer, select the Bathroom Fan timer and select the
Start Timer action--in the Actions pane.

3. Drag the actions to the script (Script pane).

4. To test the programming command, in the Script pane, click Execute.

Note: Programming can make use of agents also, where you can include pre-
programmed system functionality, such as scheduling, delays, or setting up Lighting
Scenes. Example: To program around sunrise and sunset, use the Scheduler agent.

See “ Using and Programming with Agents ” for more information about using agents in programming.

See the next section or Composer Pro Getting Started for example programs you can create.
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Programming with commands
A Command for a Control4 system is a “do” statement. Commands are actions that tell a device what to do.

Example: The example in this section shows you how to program a keypad
button to turn on the sprinkler system. This example assumes the keypad and
sprinkler system are already set up.

To program a keypad button to toggle sprinklers on and off:

1. Start Composer Pro and connect to a Director.

2. Click Programming.

3. In the Device Events pane project tree, select the keypad.

4. In the keypad Events pane, select the button that you want to program—Zone 1. This
automatically identifies the Press event for programming the button on the keypad. The
event appears at the top of the Script pane.

5. In the Actions pane, select the device--Sprinkler Zone 1.

6. In the device's Actions tab, select Toggle the Sprinkler Zone 1. The command you chose is displayed in the
Sprinkler System Actions pane with a green arrow.

Note: The title of this pane varies depending on the device you select.
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7. Click the green arrow, and drag it to the Script pane (center pane).

8. To test, click Execute in the Script pane to turn on the sprinklers.

9. Click Execute again to turn off the sprinklers.

Results: The top button of the keypad now toggles the sprinklers on and off.
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Programming with conditionals
A conditional is an 'If' statement in Composer Pro that asks a true or false question to the device.

l A 'Break' command used in an 'If' statement should jump to the first statement after the 'If'. See
“Programming with Delay, Stop and Break Commands” for details. Note: A 'Break' command in an 'If'
statement won't behave as a 'Stop' command, but will move to the next level in the script.

l A break not in a 'While' or 'If' statement should behave like a 'Stop' command (jumps to the first
statement after the function).

Example: The example in this section shows how to use conditionals in
programming. If a light is off when the doorbell is pressed, the light is
programmed to turn on. Conditionals also use When statements (events).
When the doorbell is pressed, if the light is off, program the light to turn on.

To program a conditional that turns on the light when the doorbell is pressed and the light is off:

1. Make sure that the doorbell and light switch are configured in the project.

2. Click Programming.

3. In the Device Events pane project tree, select the Doorbell.

4. Select theWhen the Doorbell is pressed event. The event appears at the top of the
Script pane.

5. In the Device Actions pane, select the Front Door Light. Notice that the light switch actions that can be
programmed for this device appear in the Light Switch Actions pane below the Device Actions project tree.

6. Click the Conditionals tab, and select Is Off. Composer Pro displays the conditional you chose in the Front
Door Light Actions pane: ? If <room>->Front Door Light is off.
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7. Drag the blue question mark icon to the Script pane.

8. Click the Commands tab, and select On.

9. Drag the green arrow to the blue question mark in the Script pane to make it a child under the "If" statement
(nest the command under the "If" statement).

Tip: If you drag the action to the text, or you drag the action under the text to the open
space, it places the action as an equal above the conditional. If you drag the action to the
question mark, it becomes a subset of the conditional. Notice the direction of the arrow
to place the action as a peer or a subset under the statement.

10. Click Execute. With the Front Door Light off, press the doorbell; the light should come on.
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Programming with Delay, Stop, Break, Or, And, and Else
commands
When programming in Composer, you have the following Programming Controls available to create advanced
programming:

l Delay—Lets you delay an action from taking place.

l Stop—Lets you stop the programming script.

l Break—Lets you break out of a ‘While’ or loop or 'If' statement when a specified condition is met and returns to
the programming outside of the loop.

l Or—Lets you group conditionals together with an 'or' logical grouping. If any of the conditionals is true, the
programming continues.

l And—Lets you group conditionals together with an 'and' logical grouping. If all of the conditionals are true, the
programming continues.

l Else—Lets you program an alternate set of programming for a conditional. If the conditional succeeds, the
programming continues under the 'if' statement. If the conditional fails, the programming continues under the
'else' statement.

Delay command

To use the Delay command during programming, see this example using a Motorized Screen and a Blu-
ray player:

1. Start Composer Pro and connect to a Director.

2. Click Programming.

3. Select the Motorized Screen in the project tree.

4. Select the event When the Motorized Screen is put down. Notice the string that appears in the Script pane.

5. To use the Delay command, in the Programming Controls section in the top of the Script pane, enter 5 next to
Delay.
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6. Drag the green arrow Delay command to the Script pane.

9. In the Device Actions pane, find and select the blu-ray player.

10. Click the Commands tab, and click Power > On.

11. Drag the green arrow ‘Turn on the <room’s> <blu-ray player>’ to the Script pane.

Stop command
This example uses a Stop command to not close the garage door if the garage light is on. If the light is off, the
garage door closes.
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To use the Stop command during programming, see this example using a keypad, a garage door, and a
dimmer:

1. In the keypad Events pane, select the Garage Door button and select the Pressed event for the Garage
keypad button. ‘When <room> -> <keypad name> Garage button is pushed’ appears at the top of the Script
pane.

2. In the Garage Light Actions pane, click the Conditionals tab, and then click Is On.

3. Click the blue question mark next to ‘If the <room>->Garage Light is on,’ and drag it to the Script pane.

4. In Programming Controls, and click the Stop command and drag it into the Script pane.

5. Drag the green arrow ‘Stop’ over the blue question mark in the Script pane to nest it below "If <room>-
>Garage Light is on".

6. In the Device Actions pane, select the Garage Door.

7. Click the Commands tab, and select Close the <room>->Garage Door.
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8. Drag the green arrow ‘Close the <room>->Garage Door’ below the Stop command. 

Break command
Here are some rules about using the Break command (see example script below). 

l A break in a 'While' loop jumps to the first statement after the While statement.

l A break in an 'If' statement (nested in a 'While' statement) jumps to the first statement after the 'If.'

l A break not in a 'While' or an 'If' statement should behave like a Stop command (jumps to the first
statement after the function).

Note the 'Break' command in the statement below. If the 'While' statement above
the 'Break' command (in an 'If' statement) is met (True), then the program
continues to the next 'While' statement. Otherwise it skips to the next command
(green arrow) statements at the bottom of the script.

See “ Programming with a While statement” or “ Programming with conditionals” for details.
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Else command
You can use an Else command to create alternate programming to an If conditional. This example will
program a button to open the blinds if it's day time and close the blinds if it's night time.

To program the blinds with an Else command:

1. Start Composer Pro and connect to a Director.

2. Click Programming.

3. In the Device Events pane project tree, select the keypad.

4. In the keypad Events pane, select the button that you want to program—Blinds This automatically identifies
the Press event for programming the button on the keypad. The event appears at the top of the Script pane.

5. In Device Actions, select Scheduler and click on Conditionals.

6. Click Time and click Day time.
7. Drag the blue question 'If time is day time' conditional to the Script pane.
8. Select theMaster Blinds in Device Actions, click on Open, and drag the 'Set the blind

target level on <room>->Master Blinds to Open' command to nest it below the
conditional.

424



Composer Pro User Guide

9. In Programming Controls, click on Else and drag the Else icon on top of the conditional
in the Script pane. The mouse icon changes to indicate you can place the Else command
below the If command (and link them logically).

10. Select theMaster Blinds in Device Actions, click on Close, and drag the 'Set the blind
target level on <room>->Master Blinds to Close' command to nest it below the Else
conditional.

See “ Programming with a While statement” or “ Programming with conditionals” for details.

And command
You can use an And command to create additional conditionals to an If conditional. Both the If conditional and
the other conditional(s) must be true or programming won't continue.
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Example: The example in this section shows how to use conditionals and an
And command in programming. If a light is off when the doorbell is pressed
and it's night time, the light is programmed to turn on.

To program a conditional with an And command:

1. Follow the example in " Programming with conditionals". These next steps start after that example.

<continued from the steps in "Programming with conditionals">

11. To add an And command, in Programming Controls, click And and drag it on top of the conditional in the
Script window. The Expression Builder opens to help you build your complex conditional statement.

12. In the Device Actions pane project tree, select the Scheduler.

13. Click Time and Night time.

14. Drag the conditional 'If time is night time' to the Script pane below the AND symbol.

15. Click Finish to close the Expression Builder. The complex condition now reads 'If <room>->Front Door Light
is off AND If time is night time'.
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When the doorbell is pressed, the Front Door Light will turn on if the light is off AND if it is night time.

Or command
You can use an Or command to allow multiple conditionals to activate programming. If any conditional
grouped with an Or command is true, the programming continues.

Example: The example in this section shows how to use conditionals and an
Or command in programming. If a light is off when the doorbell is pressed
and it's night time, the light is programmed to turn on.

To program a conditional with an Or command:

1. Follow the example in " Programming with conditionals". These next steps start after that example.

<continued from the steps in "Programming with conditionals">

11. To add an And command, in Programming Controls, click Or and drag it on top of the conditional in the Script
window. The Expression Builder opens to help you build your complex conditional statement.

12. In the Device Actions pane project tree, select the Scheduler.

13. Click Time and Night time.
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14. Drag the conditional 'If time is night time' to the Script pane below the OR symbol.

15. Click Finish to close the Expression Builder. The complex condition now reads 'If <room>->Front Door Light
is off OR If time is night time'.

When the doorbell is pressed, the Front Door Light will turn on if the light is off OR if it is night time.

Programming with a While statement
A ‘While’ statement runs continuously in a loop until the evaluation is shown to be False (Boolean value).
‘While’ statements can be repeating ‘if’ statements also.

Caution: When programming with WHILE statements, the scriptmust
incorporate delays, or the script will run so fast that it will consume all
available CPU resources and decrease system performance.

This example shows how to program a system to keep the air conditioning off while a window is open.
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To program a While statement, follow this example:

1. Make sure the thermostat and window contact sensor are configured in Composer.

2. Click Programming.

3. In the project tree, select Kitchen Window Contact Sensor to trigger an event.

4. Select the When the Kitchen Window opens event. The event appears at the top of the Script pane.

5. In the Device Actions pane, select Kitchen Window Contact Sensor and click on Loops.

6. Select the the Kitchen Window is open loop.

7. Click the loop icon next to 'While the <room>->Kitchen Window is open' and drag it into the Script pane.

8. In Programming Controls, enter 5 seconds next to Delay and drag the Delay green arrow below the while
loop in the Script pane to nest the delay below the while statement.

9. In Device Actions, select the thermostat and click on Commands.

10. Select Off in the Set HVAC Mode to selection.

11. Click on the green arrow next to 'Set the system mode on <room>->Control4 Thermostat to Off' and drag
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the green arrow below the while statement to nest it below the delay.
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Programming using digital audio and
rooms
You can program a Control4 system using the Digital Audio and Room objects in Composer Pro. You can use
digital audio events when a session starts or stops. A session is when a song or playlist begins and ends. A list
of songs can be compiled into a playlist. You can compile the list by songwriter, album, song type, or any
combination. Room events include turning the room off and on, when media sessions begin and end, etc.

Program a button to play media or a playlist
Use the Control4 Composer Pro Programming view to program a button on a
keypad to play an album or playlist.

Example: The example in this section uses a 6-Button Keypad for the Theater
room. When you press Button 1, music or a movie plays in the Theater room.

Prerequisites
l Ensure that a 2, 3, or 6-Button Keypad is installed as directed in the Control4 2, 3, or 6 Button Keypad

Installation Guide.

l Ensure that your project has an audio end point, such as Speaker Point, added and identified on the
network.

To program a button on a 6-Button Keypad to play music:

1. Start Composer Pro and connect to a Director.

2. Click Programming.

3. In Programming in the Device Events pane, select the 6-Button Keypad.

4. In the 6-Button Keypad Events pane, press Button 1, and select the Press radio button.

5. In the Device Actions pane, select the Theater room.

6. Click the Commands tab, and press the Select Media radio button.

7. In the new window, select the media type to play, such as Playlist.

8. Select the movie, playlist, etc.

9. Click OK.

10. In the Actions pane, drag the green arrow to the Script pane.
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11. Click Execute in the Script pane.

Program a button to turn up the volume
Use the Programming view to let you use a keypad button to turn up the volume in a room.

Example: The example in this section uses a 6-Button Keypad for the Theater
room. When you press Button 2 the volume increases in the Theater room.

Prerequisites
l Ensure that a 2, 3, or 6-Button Keypad is installed as directed in the Control4 2, 3, or 6 Button Keypad

Installation Guide.

l Ensure that your project has an audio end point, such as a Speaker Point, added and identified on the
network.

To program a button to turn up the volume:

1. Start Composer Pro and connect to a Director.

2. Click Programming.

3. In Programming on the Device Events pane, select the 6-Button Keypad.

4. In the 6-Button Keypad Events pane, press Button 2, and then select the Press radio button.

5. In the Device Actions pane, select the Receiver.

6. Click the Commands tab. In Sound, select Volume > Start > Up.

7. Drag the green arrow in the Receiver Actions pane to the Script pane.

8. Click Execute.
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Program a button to add a room to another room’s music
session
Use the Programming view to use a keypad button to play music in additional
rooms.

Example: The example in this section uses a 6-Button Keypad for the Theater
room. When you press Button 3, music starts playing in the Bedroom as well
as the Theater room.

Prerequisites
l Ensure that a 2, 3, or 6-Button Keypad is installed as directed in the Control4 2, 3, or 6 Button Keypad

Installation Guide.

l Ensure that your project has an audio end point, such as Speaker Point, added and identified on the
network.

To program a button to add another room's music session:

1. Start Composer Pro and connect to a Director.

2. Click Programming.

3. In Programming on the Device Events pane, select the 6-Button Keypad.

4. In the 6-Button Keypad Events pane, press Button 3, and then select the Press radio button.

5. In the Device Actions pane, select Digital Media.

6. Click the Commands tab.

7. Use the pull-down menu to select the Theater room as the Selected Room. Select the Add Rooms radio
button.

8. Check the box next to Bedroom to indicate that this is the room that is going to join the music session.

9. Drag the green arrow in the Digital Audio Actions pane to the Script pane.

10. Click Execute.

Set the default for a room’s music volume
Use the System Design view to set the default music or media volume for a room.

Example: The example in this section uses the Theater room. When you set
the default, the volume stays at a certain level for the Theater room until you
change it. You can change the volume for every room that uses music or
media.

Prerequisites
l Ensure that the controller is added and identified on the network..

l Ensure that your project has an audio end point, such as Speaker Point, added and identified on the
network.

To set the default volume for a room:
1. Start Composer Pro and connect to a Director.
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2. Click System Design.

3. In the project tree, click a room.

4. In the Properties pane, click the Miscellaneous tab.

5. In the Miscellaneous tab, check the Enable Default Volume box. Adjust the Audio Volume and Video
Volume as desired for the room. The default volumes are enabled immediately. Repeat these steps for each
room in the Control4 system.
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Examples: programming with
variables
Use the Programming view to program the Control4 system using configuration, properties, variables, delays
and agents.

Variables provide other programming options not available using commands, conditionals or loops. 

There are three types of variables you can use:
l Room Variables—Provide you with additional programming options not available in the Room object

programming. Use Room object programming as a preference to room variables whenever possible.
See “ Example: Using room variables.”

l Custom Variables—Let you define additional programming options using:

l Boolean—Provides a True/False option. For example, the light is on or off. If
the light is on, it is True; if the light is off, it is False.

l Device—Provides a list of device options.

l Number—Provides a value option. For example, the light level is 70 percent.

l String—Provides the option to enter a string.

To program using a custom variable, in the Agent view select Variable and click New to set up a new
variable. 

Example: Use one keypad button to toggle between turning on the Theater
Dimmer and the Theater Switch. 

l Container Variables—Provides the ability to connect two or more devices together by using the device
variables. A variable is a representation of information about the controlled devices, for example, a
power state or current level of the device. It works much like a Media Scenes agent (see “ Using and
Programming with Agents ” for details). Container variables are available in the Agent view by selecting
Variables. 

Note: Container variables are provided only for backward capability in Release 1.3
and later. Issues with various implementations have been found. The use of
Container variables for future implementations is not recommended. Where
possible, replace existing implementations with alternate programming.

The sections below provide examples you can follow when you use variables.

Example: Using room variables
Control4 room variables provide greater flexibility in programming, letting you
program using events and actions at the room level. 

Note: Most of the functions in Room Variables are available by selecting the
Room object which is the recommended method for programming the room.
Whenever possible, use the Room object rather than Room Variables.
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To use room variables:

1. Start Composer Pro and connect to a Director.

2. Click Programming. In this view listed under every room in the project tree is a Room Variables object.

3. Click to expand the Room Variables options. Room variables are available as events
and actions.

The room variables are described in the following table:
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Events/Actions Description

CURRENT_SELECTED_
DEVICE

Lets you do programming when any device
changes in the room.

CURRENT_MEDIA Lets you do programming when any media
changes in the room.

POWER_STATE Lets you do programming when any
device’s power state changes from True to
False in the room (read only). A device in
the room is required to detect the power
state.

CURRENT_VOLUME Lets you do programming when the volume
of the currently selected audio path changes
in the room (requires discrete volume). Use
conditional programming.

HAS DISCRETE_VOLUME Lets you do programming when any devices
changes in the room (requires discrete
volume). Use command programming.

HAS_DISCRETE_MUTE Lets you do programming when Mute state
is known (MUTE_ON or MUTE_OFF).

IS_MUTED Lets you do programming when in Mute
state (MUTE_ON).

IN_NAVIGATION Lets you do programming when On-screen
is available.

USE_DEFAULT_
VOLUMES

Lets you do programming any time a
selection changes to reset the default
volume. For example, when changing from
viewing a DVD to listening to music, the
volume is reset to the default discrete set
volume.

DEFAULT_AUDIO_
VOLUME

Lets you program the default Audio volume.
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Events/Actions Description

DEFAULT_VIDEO_
VOLUME

Lets you program the default Video Audio
volume.

VOLUME_IS_LINKED Lets you set programming not to affect
already linked volume.

MUTE_IS_LINKED Lets you set programming not to affect
already linked mute state.

ROOMOFF_IS_LINKED Lets you set programming not to affect
already linked room off state.

SELECTIONS_LINKED Lets you set programming not to affect
already linked selections.

ROOM_HIDDEN Lets you set programming to hide rooms
from appearing on the navigation device.

MEDIA_SCENE_ACTIVE Lets you set programming to set a media
scene as active.

Variable handling
In programming, variables are easier to define than conditional loops.

Variable handling enhancements:
l Preserve user-defined variables—Preserves the user-defined variable values (for example, the current

dimmer light level) across a normal system restart. It may not preserve them if the system shuts down
abnormally.

l Program a system startup event —Initializes variables or performs other programming at system startup
with a system startup event (in Programming, select the root of the project, and then select the event
When the project is loaded).

l Define one variable to equal another—Defines one variable to equal another variable. This can be used
to save and restore variable values.

Example: The level of a light or the volume of music in a room.

After this value is saved to the variable, you can restore the system variable to the value stored in the
user variable. The system can then compare the two variables and determine if it needs to reset one of
them.

l Create the event “When a System reboots”—Sends an email notification to the Control4 dealer that a
customer’s system rebooted, helping the dealer monitor the system’s performance.
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Example: Using custom Boolean variables in an agent
Use the Programming view to create custom variables in an agent using a
Boolean value.

In this example, when someone is at the door:
l Program to activate the Media Scene 'Someone is at the door,' and turn on the porch light.

l Program to play a song in the Bedroom and the Theater.

l When the Motion Sensor stops sensing motion at the door, program to turn the music and porch light off.

Prerequisites

The following devices are added and identified in the project:
l Controller
l Porch Light Switch
l Bedroom music

l Theater music

l Motion Sensor

To program using a custom Boolean variable in an agent:

1. Start Composer Pro and connect to a Director.

2. Click System Design.

3. Click Connections. Make sure the connections are correct. 

Note: Ensure that the Front Light is connected to the correct Contact Sensor on the
controller. 

4. Click the Network tab, and ensure that the controller and Porch Light have a network address.

Create a new variable
5. Click Agents.

6. Select Variable. The Variables view appears.

7. Click New.

8. On the dialog that appears, do the following:

1. Click New Variable.

2. In the drop-down menu, select Boolean.
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3. Name the Variable Power State and click OK. The default value is false.

Create a media scene ‘Someone is at the door’
9. Select Media Scenes, and click New.

10. Name the Media Scene Someone is at the door. Click OK.

Add the bedroom and theater room

11. Click Add Room, and add the Theater and the Bedroom (see above).
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12. Set the volume in the Bedroom to 50, and the volume in the Theater to 75.

13. Click Programming.

14. In the project tree and the Device Events pane, click to expand Variables, and select Power State.

15. In the project tree and in the Device Actions pane, click to expand Variables, and select Power State.

Add the conditionals and commands
16. Follow the previous programming steps to create a script with Conditionals.

17. Click the Conditionals tab.

18. In the Conditionals tab, click Is False, and drag the blue question mark to the Script
pane.
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19. Click the Commands tab.

20. In the Commands tab, click Set to True, and drag the green arrow on top of the blue question mark in the
Script pane to make it the first subset item of the first conditional.

21. In the Device Actions pane, select Light Switch.

22. Click the Commands tab.

23. In the Commands tab, click On, and drag the green arrow on top of the blue question mark in the Script
pane to make it the second subset item of the first conditional.

24. In the project tree and in the Device Actions pane, select Media Scenes.

25. Click the Commands tab.
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26. Click Activate in the Commands tab, and drag the green arrow on top of the blue question mark in the Script
pane to make it third subset item of the first conditional.

27. In the project tree and in the Device Actions pane under Variables, select Power State.

28. Click the Conditionals tab.

29. In the Conditionals tab, click Is True, and drag the blue question mark to the Script pane.

30. Click the Commands tab.

31. In the Commands tab, click Set to False, and drag the green arrow on top of the blue question mark in the
Script pane to make it the first subset item of the second conditional.

32. In the project tree and in the Device Actions pane, select Light Switch.

33. Click the Commands tab.

34. In the Commands tab, click Off, and drag the green arrow on top of the blue question mark in the Script
pane to make it the second subset item of the second conditional.

35. In the project tree and in the Device Actions pane, select Media Scenes.

36. In the Commands tab, click Deactivate, and drag the green arrow on top of the blue
question mark in the Script pane to make it the third subset item of the second
conditional.

37. In the project tree and in the Device Events pane, select Media Scenes and select the event Someone is at
the Door.

38. In the project tree and in the Device Actions pane, select the Bedroom object. (Repeat the next four steps for
the Theater.)

39. Click the Commands tab.

40. In the Commands tab, click Select Media.
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41. In the dialogue that appears, select the album and song that you want to play when Someone is at the Door
executes. In this example, Rhapsody’s ‘50s Hits’ is used. Click OK.

42. Drag the green arrow to the Script pane.

43. Repeat steps 37-41 for the Theater.

44. In the project tree and in the Device Events pane, select Motion Sensor under Front, and select the event
When the Motion Sensor senses motion.

Add the Boolean Values
45. In the project tree and in the Device Actions pane, click to expand Variables, and select Power State.

46. In the Conditionals tab, click Is False, and drag the blue question mark to the Script pane (this is the third
conditional).

47. In the Commands tab, click Set to True, and drag the green arrow on top of the blue question mark to make
it the first subset of the third conditional.

48. In the project tree and in the Device Events pane, select the event When the Motion Sensor stops sensing
motion.

49. In the project tree and in the Device Actions pane, click to expand Variables, and select Power State.

50. In the Conditionals tab, click Is True, and drag the blue question mark to the Script pane.

51. In the Commands tab, click Set to False, and drag the green arrow on top of the blue question mark to
make it the second subset of the third conditional.

52. Click Execute.

Results: The porch light turns on and plays a song in the bedroom and theater whenever the motion sensor
senses motion at the front door.

Example: Using a custom number variable in an agent
Use the Programming view to create custom variables in an agent using a
numeric value.
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In this example, program one keypad button to toggle between turning on the Theater Dimmer and the
Theater Switch.

Prerequisites

The following devices are added and identified in the project:

l Controller
l Dimmer (Theater)

l Light Switch (Theater)

l 6-Button Keypad

To program using a custom variable agent number:

1. Start Composer Pro and connect to a Director.

2. Click System Design. Make sure the project has the correct devices and rooms.

3. Click Connections. Make sure the connections are correct.

Note: In the Network tab, ensure that the controller, dimmer (Theater), switch (Theater),
and 6-Button Keypad have a network address.
Add a new variable

4. Click Agents.

5. Select Variables. The Variable Agents view appears.

6. Click New.

7. On the dialog that appears, do the following:
1. Select New Variable.
2. Name the variable Keypad releases.

3. Use the Variable Type pull-down and select Number.
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4. Click OK.

8. In the Variables pane, select the variable Keypad_releases. The available variables for your devices appear
in the right pane.

9. Enter the value as 0 (zero).

Create an event
10. Click Programming.

11. In the project tree and in the Device Events pane, select 6 Button Keypad.

12. Click Button 1 on the 6 Button Keypad.

13. Select Press for the event. The event appears at the top of the Script pane.

Create the actions
14. In the Actions pane, scroll down to view the agents.

15. Click to expand Variables.

16. Select Keypad_releases.

17. In the Commands tab, select the following to add 1 to the present value:

1. Select the radio button by the plus (+) sign.

2. Ensure the plus sign is selected.

3. Select 1 (one).

The action appears in the Actions pane.

18. Drag the green arrow icon to the Script pane.

Create the conditionals
19. Click the Conditionals tab.

1. Select the Is radio button option.

2. Select the equals (=) sign.
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3. Select 1 (one).

20. Drag the blue question mark below the previous command in the Script pane. This places the conditional
Action parallel to the previous Action command.

21. In the Actions pane, select Theater Dimmer.

22. In the Command tab, select On. The action command appears in the Actions pane.

23. Drag the green arrow to the blue question mark in the Script pane to make it a subset of this conditional
item.

24. In the Actions pane, scroll down to Variables and select Keypad_presses.

25. Click the Conditional tab.

1. Select the Is radio button option.

2. Select equals (=) sign.

3. Select 2 (two).

26. Drag the blue question mark to the blank space under the previous Action command. This places the
conditional Action parallel to the previous Action conditional.

27. In the Actions pane, select Light Switch.

28. In the Command tab, select On. The action command appears in the Actions pane.

29. Drag the green arrow to the blue question mark in the Script pane to make it a subset
of the conditional item.

30. In the Actions pane, scroll down to the agents.

31. In the Variable agent, select the Keypad_presses variable.

32. In the Commands tab, select the following:

1. Select the Set to Value radio button.

2. Set the value to 0 (zero). The Action command appears in the Actions pane.
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33. Drag the green arrow icon to the blue question mark icon in the Script pane to make it a second subset of
the conditional.

34. Click Execute.

Results: Press Button 1 on the 6-Button Keypad to toggle between turning on the Theater dimmer and the
light switch.

Example: Using a custom string variable in an agent
Use the Programming view to create custom variables in an agent using a numeric value. The steps in this
section are for more advanced users of Composer Pro.

In this example, program Button 4 on a Keypad to toggle through four playlists.

Note: This procedure is relatively complicated to create. Review the steps first
to understand how the conditionals work.

Prerequisites

The following items are added and identified in the project:
l Controller
l 6-Button Keypad
l 4 Playlists: Mom’s Favorites, Dad's Favorites, Choral Music, and Kid’s Music

To program using a custom variable agent string:

1. Start Composer Pro and connect to a Director.
2. Click System Design. Make sure the project has the correct devices and rooms.

3. Click Connections. Make sure the connections are correct.

Note: In the Network tab, ensure that the controller and the 6-Button Keypad have an
address.
Add a new variable

1. Click Agents.

2. Select Variables. The Variables agent list appears.

3. Click New.

4. On the dialog that appears, do the following:

3. Select New Variable, and name the variable My Playlists.
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4. In Variable Type, use the pull-down menu to select String, and click OK.

Set up a ‘Mom's Favorites’ playlist in the theater
1. Click Programming.

2. In Programming select the 6 Button Keypad in the Theater from the Device Events pane.

3. In 6-Button Keypad Events, click Button 4 on the Keypad.

4. In the Device Actions pane, scroll down and click to expand Variables.

5. Select My Playlists.

6. In the My Playlists Actions pane, click the Conditionals tab, and enter the name of a playlist; for example,
Mom’s Favorites.
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7. Drag the first blue question mark to the Script pane.

8. In Device Actions, select the Theater room object.

9. In Theater Actions, select Select Media.

10. In the window that pops up, select Playlists, Mom’s Favorites, and then click OK.

11. Drag the green arrow icon on top of the first blue question mark in the Script pane to
make it the first subset of the first conditional.

12. In Device Actions, select Variables > My Playlists.

13. In the Commands tab under My Playlists, enter the name of the next playlist that you’d like to play; for
example, Dad’s Favorites.
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14. Drag the green arrow on top of the first blue question mark to the Script pane to make it a second subset of
the first conditional.

The next time the button on the keypad is pressed, the value of the variable will be Dad’s Favorites, and
will then cue that playlist in the Theater.

15. In Device Actions, scroll up and select the 6 Button Keypad in the Theater.

16. In 6 Button Keypad Actions, click Button 4.

17. Under Color Settings select LED On.

18. Click the square of color to select the color you want Button 4’s LED to be when Mom’s Favorites plays.
Select the color in the menu that pops up (in this example: green), and click OK.
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19. Drag the green arrow on top of the first blue question mark in the Script pane to make it
a third subset of the first conditional.

20. In Device Actions, scroll down and select Programming Control.

21. In the Programming Control Actions, select the Stop radio button.

22. Drag the green arrow on top of the first blue question mark in the Script pane to make it a fourth subset of the
first conditional.

Note: It is important to add a Stop command here so that when the conditional is
fulfilled, the programming will not continue. Because of the way this programming is set
up when it’s finished, without the stop, the button on the Keypad will always select the
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last playlist in the script.

Set up a ‘Dad's Favorites’ playlist
1. In Device Actions, select My Playlists again.

2. In the Conditionals tab, next to ‘Is’ enter Dad’s Favorites in the text box.

3. Drag the second blue question mark to the Script pane.

4. In Device Actions, select the Theater.

5. In Theater Actions, select Select Media.

6. In the window that pops up, select Playlists, Dad’s Favorites, and then click OK.

7. Drag the green arrow on top of the second blue question mark in the Script pane to make it the first subset of
the second conditional.

Set up a ‘Kid's Room’ playlist
1. In Device Actions, select My Playlists.

2. In the Commands tab under My Playlist Actions, enter the name of the next playlist that you’d like to play; for
example, Kid’s Music.

3. Drag the green arrow on top of the second blue question mark in the Script pane to make it a second subset
of the second conditional.

4. In Device Actions, select the 6 Button Keypad in the Theater.

5. In 6 Button Keypad Actions, click on Button 4. Click the square of color to select the color you want Button 4’s
LED to be when Kid’s Music plays. Select the color in the menu that pops up (in this example: purple), and
click OK.

6. Drag the green arrow on top of the second blue question mark in the Script pane to make it a third subset of
the second conditional.

7. In Device Actions, select Programming Control.

8. In the Programming Control Actions pane, select Stop.
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9. Drag the green arrow on top of the second blue question mark to make it a fourth subset of the second
conditional.

10. In Device Actions, select My Playlists again.

11. In the Conditionals tab, enter Kid’s Music.

12. Drag the blue question mark to the Script pane to make it the third conditional.

13. In Device Actions, select the Theater room object.

14. In Theater Actions, select Select Media.

15. In the window that pops up, select Playlists, Kid’s Music, and then click OK.

16. Drag the green arrow on top of the third blue question mark in the Script pane to make it the first subset of the
third conditional.

Set up a ‘Choral Music’ playlist
1. In Device Actions, select My Playlists.

2. In the Commands tab under My Playlists, enter the name of the next playlist that you’d like to play; for
example, Choral Music.

3. Drag the green arrow on top of the third blue question mark to make it a second subset item of the third
conditional.

4. In Device Actions, select the 6 Button Keypad in the Theater.

5. In 6 Button Keypad Actions, click on Button 4. Click the square of color to select the color you want button 4’s
LED to be when Kid's Music plays. Select the color in the menu that pops up (in this example: red), and click
OK.

6. Drag the green arrow on top of the third blue question mark in the Script pane to make it the third subset of
the third conditional.

7. In Device Actions, select Programming Control.

8. In the Programming Control Actions, select the Stop radio button.

9. Drag the green arrow on top of the third blue question mark in the Script pane to make it a fourth subset of the
third conditional.

10. In Device Actions, select My Playlists again.

11. In the Conditionals tab, enter Choral Music.

12. Drag the fourth blue question mark to the Script pane.

13. In Device Actions, select the Theater room object.

14. In Theater Actions, select the Select Media radio button.

15. In the window that pops up, select Playlists, Choral Music, and then click OK.

16. Drag the green arrow on top of the fourth blue question mark in the Script pane to make it the first subset of
the fourth conditional.

17. In Device Actions, select My Playlists.

18. In the Commands tab under My Playlists, enter the name of the next playlist that you’d like to play; for
example, Mom’s Favorites.

19. Drag the green arrow on top of the fourth blue question mark in the Script pane to make it a second subset of
the fourth conditional.

20. In Device Actions, select the 6 Button Keypad in the Theater.

21. In 6 Button Keypad Actions, click on Button 4.
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22. Click the square of color to select the color you want Button 4’s LED to be when Choral Music plays. Select
the color in the menu that pops up (in this example: yellow), and click OK.

23. Drag the green arrow on top of the fourth blue question mark to make it a third subset of the fourth
conditional.

24. In Device Actions, select Programming Control.

25. In the Programming Control Actions, select the Stop radio button.

26. Drag the green arrow on top of the fourth blue question mark to make it a fourth subset of the fourth
conditional.

27. In Device Actions, select the Theater room.

28. In Theater Actions, select Media.

29. In the window that pops up, select Playlists, Mom’s Favorites, and then click OK.

Note: You do this is because the first time the button on the Keypad is pushed, the string
variable does not have a value, and nothing happens. This last command is created when
none of the conditionals are fulfilled, something will play; each time the button is
pushed thereafter, a conditional is fulfilled.

30. Drag the green arrow below the previous Stop command in the Script pane. It is not a subset of the previous
conditionals, but a command on its own.

31. In Device Actions, select My Playlists.

32. In the Commands tab under My Playlists, enter the name of the next playlist that you’d like to play; for
example, Dad’s Favorites.

33. Drag the green arrow below the previous command in the Script pane.

34. In Device Actions, select the 6 Button Keypad in the Theater.

35. In 6 Button Keypad Actions, click on Button 4. Click the square of color to select the color you want Button
4’s LED to be when Mom’s Favorites plays. Select the color in the menu that pops up (in this example:
green), and click OK.

36. Drag the green arrow below the previous command in the Script pane. You do not need a stop at this point,
because the programming automatically stops at the end of the script.

Results: Press Button 4 on a 6-Button Keypad repeatedly to toggle through four playlists.
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Other programming tasks
Other special programming functions can be accessed by right-clicking on an item in the Script pane.

l Move Up/Down—Lets you move a script item up or down in the script, changing the order that the commands
execute..

l Disable/Enable Event—Lets you disable the event and the entire programming script without having to delete
the script. If the event is disabled, the text is grayed out and the only menu item is Enable Event.

l Disable/Enable Item—Lets you disable a single item in the script. Other items execute normally. If the item is
disabled, the line of text is grayed out and the line's icon has a red x on it.

l Insert Comment—Lets you insert a comment into the script. See also Using Programming Comments.

l Copy All—Lets you copy an entire script.

l Copy Selected—Lets you copy selected items in a script.

l Paste—Lets you paste copied items into the current script.

l Find and Replace—Lets you find and replace elements within the script item with similar items. See Using
Find and Replace.

l Delete—Lets you delete the selected script items. You can also delete items by pressing the Delete key.

l Delete All—Lets you delete the entire script.

l Change to Customer—Lets you change programming items to be accessible or locked out fromWhen
>> Then programming by the customer. By default, programming entered with Composer cannot be modified
by the customer in When >> Then. Select Change to Customer to allow the customer to modify the
programming in When >> Then.

l Change to Dealer—If the customer has entered programming in When >> Then and you want to lock out that
programming from being modified in When >> Then, select Change to Dealer to lock the programming to
Composer only.

Note: Selecting Change to Dealer does not lock out programming from Composer HE
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Using Programming Comments
The Comments programming feature lets you add comments inline with your
programming to document your programming. This is useful when using
advanced programming, using variables, and when multiple technicians may
need to work on the project.

Example: You have a variable that is changed by a button press. You can add a
comment in the code to know where the variable is being changed from..

To add a comment in programming:

1. Click Programming and select the event in the Device Events pane.

2. In Programming Controls in the Script pane, enter the comment in the field next to
Comment.

3. Click on Comment and drag the comment below into the Script pane. Place it anywhere in the programming
script. A comment does not affect the programming.

Using Find and Replace
The Find and Replace programming feature lets you find one device already
programmed and replace it with another. 

Example: You want a button on your Configurable Keypad to turn on all the
outside dimmers in your Control4 system. Currently, the button is programmed
to turn on all the lights in your garage. Use the Find and Replace programming
option to replace the lights with outdoor lights in your programming.
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To program using the Find and Replace feature:

1. Start Composer Pro and connect to a Director.

2. Click Programming.

3. In the Script pane, right-click and select Find and Replace. A Find and Replace dialog
appears.

4. Replace the programming device object with the one you want.

Find: Family > Left Dimmer

Replace with: Theater > Theater Dimmer
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5. Click Replace. The statement in the Script pane changes to the replacement script.

6. Repeat for each line in the Script pane.

Find: Family >Middle Dimmer
Replace with: Bedroom > Bedroom Dimmer
Find: Family > Right Dimmer

Replace with: Front > Front Dimmer

When you complete this process, the script reflects that you have changed all the lights in your Control4
system to dimmers.

Using Copy and Paste
The copy and paste programming feature lets you copy the programming you
configure from one device and paste it to another device. By creating the same
command, loop, or conditional for a device, you can copy it for use in another
programming script. 

Example: You want all of the lights in the Control4 system to turn on by pressing
Button 1 on the 6-button keypad. When you press Button 4, you want to turn all
the lights on in the system except in the Bedroom. In this example, you can copy
the first set of actions into the second set and not include the Master Bedroom. 
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To program the 6-button keypad:

1. Start Composer Pro and connect to a Director.

2. Click System Design.

3. Ensure that you have the following devices added and connected to the Control4 system:

l Controller

l Bedroom Dimmer

l 6-Button Keypad

4. Click Programming.

5. Select 6-Button Keypad in the project tree of the Device Events pane.

6. In 6-Button Keypad Events, push Button 1, and select the Press radio button.

7. In the Device Actions pane, scroll down and select Dimmer.

8. In the Dimmer Actions pane, click the Commands tab, and click the On radio button.

9. Drag the Dimmer Action green arrow to the Script pane.

10. Repeat Steps 1 through 9 for all the lights in your system. This includes the Light Switch and Dimmer in the
Theater and the Dimmer in the Bedroom.

11. Move to the Script pane, right-click, then select Copy from the options. This
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automatically copies all arrow statements in the pane.

12. Click Button 4 in the 6-Button Keypad Events pane, and then select the Press radio button.

13. Right-click in the Script pane, and select Paste. The programming of the lights shows up in the Script pane
for Button 4.

You have completed Copy and Paste Programming. Now you can edit the Button 4 Script as needed.

Example: You can remove the Bedroom Dimmer from the Button 4 Script, so when you
push Button 1 all the lights in the system come on; and when you push Button 4, all the
lights come on except for the dimmer in the bedroom. 
Tip: This feature is very useful when programming complex loops and conditionals.
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Customizing Navigators
Use this chapter to learn how to:

l Set up screen savers

l Hide and view device availability
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Overview
Use the Control4® system Navigator interface on your Navigator to make adjustments to the Navigator you're
using.

Tip: You or your customer can customize pages in the touch screens, Control4
apps, or on-screen Navigators also. See the Control4 System User Guide for
information.

Setting up screen savers
Setting up the photo screen saver
Use the Agent and Media views to set up a photo Screen Saver agent to view
photos from the touch screens, Control4 apps, or on-screen Navigators. In OS 2.1
and later, you can use a single photo to display on all of your Navigators. If you
change the interval on one Navigator, it will change all of them.

Prerequisites

Have one of the following storage types available before you copy the photos. You will need to set up one or
more of them later when you add your photos. 

Note: In some cases, the Control4 systemmay take a few minutes to
recognize the device.

l Controller—If the controller has no storage, add and connect a device that contains storage for your
photos; for example a USB drive or Network File Share (see Step 6 in the next section).

l USB Drive—Ensure that the USB drive is attached to the controller. When you insert the USB drive, it will
appear in the project tree in the same room as the controller.

l Network File Share—Ensure that the Network File Share object is added to the project tree and
connected (see the steps to do this later in this procedure). Ensure that you have access to the Network
File Share, that you have a valid Username, Password, and Workgroup, and that you can identify the
network location (you will need to add the path).

To display photos as screen savers on the Navigators:

1. Start Composer Pro and connect to a Director.

2. Click Agents.

3. (First time only.) From the Agents view > Agents pane, click Add to add the agent to the project.

4. From the Available Agents dialog, select the Screen Saver agent, and click OK.

Note: If Screen Saver already appears in the Agents pane, it has already been added. Go
to the next step. If not, see “Example: Program Using the Screen Saver Agent.” 

5. In the Agents pane, select Screen Saver.

6. From the storage location list, use the drop-down menu to select the location where you will save your photos
for use on the Navigators (controller, CBM Flash Disk: USB drive, or Network File Storage, etc.).

Notes:
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l If the storage option that you want does not appear in the list, disconnect from
Director and reconnect.

l At any given time, only one storage location can be set as the photo Screen Saver
source.

l CBM Flash Disk (USB drive)—If you inserted the USB drive in the controller
earlier, the CBM Flash Disk option appears in the list.

l Network File Storage—If you select Network File Storage, specify where the
Control4 system needs to go to copy the files. Click System Design and select the
Network File Storage icon in the project tree (you will have to add it from the
Items pane). In the Properties pane, type the Username, Password, and
Workgroup, and then browse to the network location. Click Connect.

7. Click the Media view, and select Screen Saver.

8. Click Configure in the Screen Saver pane, set the location to copy the files to (for display in the Navigators),
and click OK. 

Note: If you didn’t select a storage location in Step 6, an error message appears. Click
OK, and then click Configure to set the location. 

9. In the Screen Saver pane, click Add. In the My Pictures dialog, browse to the photos
you want to copy to the storage location, select them, and click Open. The files will be
copied to the storage location you specified in Step 8, and a folder may be created for
you using the Control4 name (Example: Control4 pictures).

Note: When media is added (copied) to the storage device, it is pre-scaled to the
resolution for all of the Navigators. Control4 preserves the aspect ratio of the original
image, and boxes the extra space with bars for any given screen size.
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10. In Composer Pro, click Tools > Refresh the Navigators to display the copied photos.

11. To activate the Screen Saver in each Navigator (on-screen, touch screen, or Control4 app), do the following:

1. Go to Info > Config > Screen Saver (on the system remote control) or More > Settings > Screen Saver.

2. Enable the Custom option, and then select the Photo Screen Saver option along with any other screen
saver option you want to include. For photos only, check the Photo option. See “ Setting up a custom screen
saver” to display the photos on the Navigator or see the Control4 System User Guide.

Setting up a custom screen saver
Use the Control4 Navigator to create a custom screen saver to view on touch screens, Control4 apps, or on-
screen Navigators.

Note: This task must be completed on a Navigator. Either the Installer or
homeowner can set this up. The Custom Screen Saver option lets users mix
and match available screen saver options, including the option to use stored
photos.

Prerequisites

Before setting up a custom screen saver, photos must be available for viewing from the Navigator. See
“ Setting up the photo screen saver.”

To set up a custom screen saver:

1. From the main menu on an on-screen Navigator, Control4 app, or touch screen press
More > Settings > Screen Saver or Info > Config > Screen Saver on a system remote
control.

2. In Screen Saver, press the drop-down arrow, and press Custom.

3. In Turn on, press the drop-down arrow, and press an option to enable the screen saver.

4. Press Settings.

5. Press to select one or more of the following options:

l Media

l Time

l Date

l Temp

l Photo

l Shuffle

6. Press Done.

7. (Optional) Press Preview to test the settings. 

To set up a custom screen saver in the touch screens, Control4 apps, or on-screen Navigators for OS 2.0 and
later, see the Control4 System User Guide for details.
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Programming the screen saver sleep mode
Use the Programming view to schedule a Screen Saver mode change, for example, a ‘Go To Bed’ mode
during sleep hours. 

1. In Programming, select Navigator actions.

2. Create a Scheduled Event (such as ‘Go To Bed’). See “ Using and Programming with Agents ” for details.

3. Add the following script:

“Set the screen saver mode on the [graphical navigator device] to Blank.”

“Turn the screen saver on after [time interval] on the [graphical navigator device].”

Changing the time on a Navigator screen saver
Use the Control4 Composer Pro System Design view to change screen saver date, time or time zone.

To change the time on a Navigator screen saver:

1. Start Composer Pro and connect to a Director.

2. Click System Design.

3. In System Design, click the Properties tab.

4. Use the Date & Time drop-down boxes to modify the time and date. 

Date—To change the Date (month, date, or year), click the drop-down arrow for a calendar to appear.
Click the left or right arrows to select the month, and then select the day.

Time—To change Time (hour, minute, second), click the up or down arrows to the
appropriate time in hours, minutes, or seconds.

Tip: An easy way to change the hour, minute, or second is to highlight the hour, minute,
or second number, and then type the new number over the old one. 

Time zone—To change the Time Zone, at the Timezone box, click Edit. Select the time zone from the
drop-down menu, and click OK.

Hiding device availability
Use the System Design view to hide a device from view in a Navigator. In OS 2.3.0 or later, you may find the
Access agent useful for device availability. See “ Using and Programming with Agents ” for details. 

Example: Set availability so that the touch screen in the Bedroom cannot
control music in the Theater.

Prerequisites

Ensure that the following devices are added and identified to the network:

l Controller

l Digital audio

l Navigator
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To hide a device so others cannot see it:

1. Start Composer Pro and connect to a Director.

2. Click System Design.

3. In System Design and in the project tree, select Bedroom.

4. Go to the Navigator tab in the Properties tab.

5. Select Music in the Menu box, and then click Modify.

6. Select Digital Audio in the Theater, click Hide, and then click OK.

Viewing device availability in navigators
Use the System Design view to change the order of devices to view. This task is useful if you have a lot of
media devices, and some are used more frequently than others. 

Example: Change the order of a Tuner to appear in a Navigator before the
Receiver.

Tips: (1) In OS 2.2 and later, you can use Shift+Click or Ctrl+Click to add or
remove devices. (2) In OS 2.3.0 or later, you may find the Access agent useful
for device availability. See “ Using and Programming with Agents ” for details.

Prerequisites

Ensure that the following devices are added and identified to the network:

l Controller

l Digital audio

l Navigator

To enable a device to be viewed in a specific order in a Navigator:

1. Start Composer Pro and connect to a Director.

2. Click System Design.

3. In System Design, select Theater.

4. Go to the Navigator tab in the Properties tab.

5. Select Radio under Menu, and then click Modify.

6. Click Tuner, and then click Move Up.

7. Click OK.
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Creating drivers
Use this chapter to learn how to:

l Use the DriverEditor

l Use the Driver Wizard

l Create IR controller drivers

l Create serial-controlled drivers

l Configure Composer Pro properties

l Create two-way drivers

l Export a driver
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Creating and managing drivers
Use this chapter to learn how to:

l Use Driver Manager to update and manage drivers

l Use the DriverEditor

l Use the Driver Wizard

l Create IR controller drivers

l Create serial-controlled drivers

l Configure Composer Pro properties

l Create two-way drivers

l Export a driver
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Using the Manage Drivers window
Use the Manage Drivers window in Composer Pro to view driver versions, manage
drivers, update drivers and schedule updates.

To manage drivers using the Manage Drivers window:

1. Select Drivers > Manage Drivers.

2. Click on a driver in the window and click Update...
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3. The Update Driver window shows the driver name, file name, version info and update options.

4. Select an option in Update Options to update, sync, or replace the driver. You can choose between:

a. Update Driver—Update the local (computer) version and controller version of the
driver with the latest online version.

b. Sync Newest—Synchronize the newest driver from either the local computer or the
project.

c. Sync Local—Synchronize the driver on the local computer to the controller.
d. Sync Controller—Synchronize the driver on the controller to the local computer.
e. Replace Obselete—Replaces an obsolete driver with a recommended replacement

driver.
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To configure automatic driver updates:

1. Select Drivers > Manage Drivers and click on the Auto Update tab.

2. Check the box next to Enable Driver Update Agent to enable automatic driver updates.

3. Check the box next to each driver to enable or disable automatic updates for that driver.

4. Click on Execute to run the automatic driver updates now.

Tip: To configure the schedule when the automatic driver update runs, use the
Scheduler agent to configure the update event, by default the Auto Update
Driver Agent Event.
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Creating device drivers
To complete device support using Composer Pro® for a Control4 system, every device requires a
corresponding driver.

To add a device to the Control4 system that does not have a supporting driver, use the built-in Driver Creation
Wizard in Composer Pro or Driver Editor to create the driver prior to adding the device.
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Overview
Why create a device driver?
A hardware driver is a small piece of software that allows a computer program to communicate with a specific
device, for example a controller, in the Control4 system. Every device in the Control4 system requires a driver,
and that driver must be added to the project tree in Composer Pro. Some devices do not have existing drivers
in the Composer Pro driver database, or the drivers there cannot control a device. In that case, a new device
driver needs to be created. Control4 provides the means if anyone wants to develop drivers for their products.

Example: A computer may use a printer driver to send a print order to a
printer. Every controllable device uses codes that represent commands on
that device. To control the device, you must capture or enter these codes in
the driver.

Example: An IR-controlled CD player’s commands are Play, Stop, Pause, etc.
Using the Driver Wizard and controller hardware along with the
manufacturer’s remote control supplied with the equipment, you can capture
these codes and build a working driver using the codes. Serial-based devices
are also supported; you can enter the serial codes to the Driver Wizard
manually.

Tip: Each driver consists of a collection of files. One of those files is a
configuration file, which is an XML file referred to as a config data file or.c4i file.
This file provides specific IR, serial, or connection codes that are pertinent to
supporting a device model on the Control4 system. In the default Composer
Pro installation, these files are located on your PC at: c:\program
files\control4\Composerxxx\drivers\virtual.

Guidelines for creating device drivers
The most important information you need to know before you begin to create
your own Control4 device driver is to understand how your devices work. After
that, you can use the Driver Wizard and/or the DriverWorks SDK or DriverEditor to
create your own drivers. Contact Control4 Technical Support for details.

IMPORTANT! Before you begin, check the manufacturer's documentation to
learn about the codes or customized macros required to support your device,
and understand the inputs and outputs that your device supports and other
details about the device as needed.

For best results, understand the following concepts and guidelines:

l Supported commands and inputs/outputs of the device—Prior to starting the Driver Wizard, have a
basic understanding of the device.
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l Discrete versus toggle—In the Driver Wizard, the term 'discrete' indicates a direct setting rather than a
toggle option between settings. For example, a receiver might have 'discrete input select,' which lets you
select the input directly (DVD) rather than using a toggle button that cycles through all the inputs (DVD,
VCR, TV), such as Input Toggle.

l IR codes versus macros—In the Driver Wizard, some IR codes complete the needed command;
however, to complete the commands, you may need a macro (a sequence of codes).

l Adding all options for AV connections—When adding AV connections, select all possible options for the
device so all options are available for selection.

l Power management options—A variety of supported Power-Management options are available to
choose from, but the optimal method depends on the device. When no other option works, use the
Assume the Device is Always On option, and leave it up to the user to ensure manually that the device
is on. See “Guidelines for defining power management.”

l Adding commands and custom commands—The Driver Wizard supports a set of default commands for
each device type, such as Television, VCR, DVD, etc. If a command you need does not appear on the
Default Command list, click Add and use the pull-down menu to look for the command. You can also add
custom commands if necessary.

l Driver Wizard screens vary for device types—Because different devices, such as televisions, VCRs,
and DVDs have different functionality, the Driver Wizard steps you through different questions as
appropriate for that device type, and there are pre-defined generic Device Types that have a common
set of commands with varying capabilities that you can use as a base. The Driver Wizard prompts you to
select the appropriate commands from these basic commands, as well as identify any additional
capabilities that the particular device is able to perform.

Example: All televisions have Up/Down channel and Up/Down volume
commands, so these basic commands are already included in the generic TV
device type. However, not all televisions have direct channel selection, where
you can select a channel by pressing a sequence of numbered keys.

l Creating or editing multi-featured device drivers—You can create only combination types that are listed
in the Create New Driver wizard. Control4 recommends that you start with an existing driver in the
Online Database, add it to your Local Database, and then edit it as needed to meet the new device-
driver need. Be patient. You may need to change IR codes if a code doesn't work with your device.

l DriverWorks can be used to create 2-way drivers for AV and non-AV devices. It requires some
programming skills, however, but leverages the Lua-embeddable scripting language, a powerful, fast,
and light-weight (when compared to other scripting languages). See “Creating a 2-way serial or TCP/IP-
controlled driver.”

Tip: When a device driver is created, you may want to distribute it to multiple
projects on different computers. To do this, copy the driver file from the
default install directory: C:\Program
Files\Control4\Composerxxx\Drivers\Virtual to the same directory on the
other computers.

This action makes this driver file available to all the projects stored on that computer. Driver files are
named by device type, protocol, manufacturer, and model with a.c4i extension.

Example: tv_ir_samsung_tx-p1430.c4i.

l DriverEditor—This tool is designed to assist the dealer or driver developer in creating and maintaining
their drivers for use with the Control4 system.
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Using DriverEditor
The DriverEditor is an advanced tool that allows DriverWorks drivers to be developed. This tool is free and is
available at: http://update.control4.com/DriverEditor/DriverEditor_Installer.exe. You can find information
about DriverEditor in the Forums under ‘DriverWorks.’

Features:

l Edit AV_GEN or DriverWorks drivers from the same tool.

l Switching from AV_GEN to DriverWorks requires only a menu choice.

l No more wondering if the XML portion of the driver is correct. All choices are validated.

l Capture IR codes from Control4 controllers or enters them manually in pronto hex format or by IR code
(s).

l Create/maintain all aspects of IR macros.

l Commands/notifications are filtered by proxies in the driver.

l Capabilities are filtered by proxies in the driver.

l DriverWorks editor with API auto-complete for Control4 APIs and Lua script APIs.

l DriverWorks editor with Call tips and syntax highlighting.

l DriverWorks debugging from within DriverEditor. No longer writing in one application and debugging in
another.

l Monitor output from up to four different debug windows.

l All DriverWorks documentation is accessible from within DriverEditor with context searching.

l Updating from within DriverEditor.
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Using the Driver Wizard
Use the Driver Wizard in Composer Pro to create device drivers for your devices.

The Driver Wizard is a basic level driver developer tool for IR and one-way serial
control. Instructions for using this wizard are detailed in this section.

To start the Driver Wizard from the Driver menu:

1. Select Create New Driver. See “Composer Pro menu options” in Composer Pro Getting Started for details.
The Driver Creation Wizard (or Driver Wizard) lets you add device support to the system, including support
for:

l Infrared (IR)-Controlled—Devices that are controlled using wireless
remotes. Commands are sent via pulses of infrared light to the device.

Examples of IR-controlled devices: receivers, televisions, plasma screens,
projectors, DVD/CD players, DVD/CD changers, VCRs, satellites, cable boxes,
DVRs, tuners, audio/video switches, amplifiers, blinds, and other specialized
equipment.

l Serial-Controlled—Devices are controlled via a serial connection (RS-232, RS-
422, or RS-485) to the controller hardware.

Examples of serial-controlled devices: projectors, multi-disc DVD changers,
and other serial-controlled devices.

Limitations of the Driver Wizard
The Driver Wizard is not designed or intended to create drivers in the following situations:

l Bi-directional drivers—Bi-directional drivers provide enhanced support for two-way communication
between the device and the controller. Custom bi-directional drivers are available for some devices
(check the Online Database). The Driver Wizard does not create bi-directional drivers. If you need to
create a custom bi-directional driver, ask your Control4 Sales Representative about the Control4
software development kit (SDK) program.

l Logical Calculations—Some devices require logical calculations. The Driver Wizard can provide only
limited support for devices that require logical calculations.

l Relays and Contacts—The Driver Wizard is not designed to create drivers for relays and contacts. If you
cannot find a specific driver for your contact or relay device, use the generic drivers provided in the
Online Database.

l Serial Codes—To create serial drivers, get the serial codes from the manufacturer’s documentation.
Control4 collects the serial codes in a database from the manufacturers/dealers that obtain these codes.
If you need serial codes, contact Control4 Technical Support or contact the manufacturer directly.

Editing a driver using the Driver Wizard
To make changes to a driver located in your local driver database that is NOT fully-configured and connected
in a project, you can use the Composer Pro Driver menu > Edit Existing Driver option. This option lets you
modify and update the driver options in the Driver Wizard.

To edit a driver using Driver Wizard:

1. Start Composer Pro and connect to a Director.
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2. From the Driver menu, select Edit Existing Driver.

3. In the next screen, select the driver type, such as VCR.

4. Select the Model type.

5. Select a section, and click next to advance to the screen that you want to edit.

6. Edit the screens or recapture the codes as needed. See “Creating IR-Controlled Drivers” for details.

7. When you’ve edited the driver, click finish, and click next.

IMPORTANT! If you edit any inputs or outputs of the driver after editing a driver, you
must remove the driver from the project, add it to the project again from the Search tab,
and then make the connections.

Verifying the IR codes using the Driver Wizard
Use the Edit Existing Driver menu option to verify your IR codes for the Control4 system.

Note: Make sure the controller is connected to the device via IR, and that all
necessary connections are made.

To verify driver IR codes using the Driver Wizard:

1. Start Composer Pro and connect to a Director.

2. From the Driver menu, select Edit Existing Driver.

3. Select the driver type, such as VCR.

4. Select the Codes section.

5. Click next to advance to the screen for the first IR code listed.

6. On the left side, use the scrollbar to select the code you want to test, and click Emit to verify the function of
the specific IR code.

7. Edit or recapture the codes as necessary.

8. After you’ve edited the driver, click finish.

9. Click next to save your changes. 

IMPORTANT! If you edit any inputs or outputs of the driver after editing a driver,
you must remove the driver from the project, add it to the project again from the
Search tab, and make any necessary connections.

Tip: To exit the Driver Wizard without saving your changes, click x at the top right
of the screen.
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Power management
Guidelines for defining power management
Power Management options are modifiable using the Driver Wizard in Composer
Pro which is accessible through the Driver menu during creation or driver edits.

Editing power management options
If resetting the connections is not required, you can sometimes edit the Power Management options from the
Composer Pro project tree.

To edit the Power Management options:

1. Right-click the device.

2. Click Edit Driver.

1. If the Edit Driver option does not appear, edit this driver from the Driver menu.

2. Remove and then add the device to the project tree again.

Options on this screen include:

l Assume the device is always on—Select this option if the device is always on, or if the device is turned
on and off by pressing the same button. For example, the system has no way to acknowledge if a
television is on when the television uses a toggle button (such as buttons labeled 'Power' or 'On/Off')
instead of discrete (separate) On and Off buttons.

Note: Use this option for Power Management of a multi-zoned receiver.

l Send Toggle Codes—This option is selected automatically when you check the Has Power feedback
box. You can select the other available options, such as Macro. Click next to return to this page and
reset the page to this option.
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l Use discrete on/off codes—Select this option if the device features a separate button for On and Off
versus one button used to cycle between On and Off.

l Use On/Off macros—Use this option to control power on the device by using a sequence of button
presses to determine the power state of the device.

Example: You know the state of most DVD players by sending a Play
command, because Play typically changes the power state to On.

You can set up a macro that

l Sends a Play command.

l Sends a power toggle command to turn the device off.

l Sends a power toggle command to turn the device on.

The system can determine with certainty that the power state is On.

l Has Power Feedback.

l Video sense loop—Check this option if you want the system to determine
(using a Composite video connection) whether a device is On or Off based on
whether a video signal is present.

l Contact sensor (power sensing)—Check this option if the device is plugged
into a Wireless Outlet Switch and is configured as a Contact Sensor.

l Control power directly (power control)—Check this option if the device is
plugged into a Wireless Outlet Switch and is configured as a relay. With this
option, you can set two delays to accommodate special devices. 

For more information, see “ Configure a Wireless Outlet Switch V2.”

Configuring assignable inputs and outputs
In a driver, you want to create all possible inputs and outputs on a device. However, a driver can only support
the physical inputs and outputs that exist on that device, so don’t attempt to create inputs or outputs that do
not exist on the device.

Changing power management options
Use the Power Management options in the Composer Pro Driver menu to change power for a Control4
system.

To change the Power Management option of a driver, you can edit the driver to provide a different Power
Management option. After editing a driver, you may need to add the driver to the project and set up the
necessary connections.

To change Power Management options in a driver:

1. Start Composer Pro and connect to a Director.

2. From the Driver menu, select Edit Existing Driver.

3. Select the driver type, such as VCR.

4. Select the Manufacturer type, such as Mitsubishi.

5. Select the Model type.
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6. On the Power Management screen, change the Power Management option. 

Example: To change the Power Management option, check Has power feedback, and
then select the Video sense loop option. 

7. After you edit the driver, click finish, and click next. 

Example: The Video Sense loop requires a Control connection. A control Video Sense
connection has been added to the DVD driver. 

8. Make any necessary connections to configure the new Power Management option. 

Example: With the Video Sense Loop Power Management option, connect the Control
connection. 

1. From Connections, select Control/AV > DVD.

2. From the top pane in Control Connections, drag the Video Sensor connection to a Video Sense Loop
connection on the controller.
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IR-controlled drivers
Creating IR-controlled drivers
This section provides instructions for creating and testing a driver using the Control4 Driver Wizard in
Composer Pro. Depending on the device type, the Driver Wizard asks you questions for the driver you are
creating. The Driver Wizard varies between device types because different device types have different
functions. Follow the Driver Wizard screens until your driver is created.

Prerequisites

For the IR Learning capability to work, you must be connected to a Director and have a controller added to
your project.

To use the Driver Wizard:

1. Start Composer Pro and connect to a Director.

2. From the Driver menu, select Create New Driver.

3. From the list, select the type of driver you want to create, and click ok.

4. Enter the Device Information.

1. Fill out the requested information, such as device’s Manufacturer, Model number, and the name of the Driver
Creator (whoever is creating the driver), and click next.

2. Check whether the device is IR or Serial controlled, select the appropriate options, and click next.

3. Define the type of power management, audio parameters, and device properties there are, and click next.

4. Identify the relevant commands, add custom commands as necessary, and click next.

5. Capture, paste, or enter the device codes using one of the following:

l IR—Use the manufacturer’s remote and the controller’s IR Learning capability
for capturing IR commands.

l Serial—Enter the codes.

6. Create and identify the input and output connection options for the device, and click next.

7. Create macros if necessary.

8. Find your driver, add it to the project, and test it. See Composer Pro Getting Started for details about how to
do this.

Guidelines for capturing IR codes
For best results when capturing IR codes for a Control4 system, follow the on-
screen prompts in the Driver Wizard.

Follow these guidelines:

l Point your manufacturer’s remote control directly at the IR window located just below the dial on the
front panel of your controller hardware (e.g., EA-3). Avoid aiming the beam at an angle, and keep the
beam in the same axis as the IR window.

l While capturing the first few codes, the controller begins to recognize the frequency. Note that a
message about 'an alternate frequency' might display. This is normal, and it means that the controller is
adjusting to the remote frequency.
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To help ensure a successful capture:

1. Hold the manufacturer’s remote at a distance of approximately 6" away from the controller hardware, and
then press the button requested.

2. When prompted, press the button again to confirm the code captured. You are prompted a third, fourth, and
possibly a fifth time to press each of the first few buttons.

3. If another device in the room emits IR, such as a bi-directional IR device, block the IR so it does not
interfere with IR capture.

4. The process of capturing IR codes is very sensitive to light, such as sunlight and fluorescent lights. If it is
not working properly, turn off the lights, close the drapes or blinds, or cover the physical hardware so that the
light cannot interrupt the capturing of codes.

5. When capturing IR codes, press and release the remote button in one second.

Note: Do not press and hold for long periods (longer than three seconds). Doing so
increases repeat counts. Typical repeat counts are between three and five seconds.

6. When capturing IR codes, look for a green light to turn on and off on the controller hardware. Also, watch
the Driver Wizard screen; it changes the steps to indicate that codes are captured.

7. Avoid IR interference from your laptop by disabling or powering off the IR devices.

After successfully capturing a few codes:

1. Hold the manufacturer’s remote at a distance approximately 8" - 12" (about 20 – 30 cm), and then press the
next button requested.

2. When prompted, press the button again to confirm the code captured. Most buttons are confirmed with the
second button press. You may be prompted repeatedly to confirm the code captured, including:

If the remote uses alternative codes—Some manufacturers provide alternate codes or a second code to
differentiate between two distinct button presses, such as '1' and then '1' again for Channel '11.' Some
remotes have a different code for each '1.'

If an incorrect button was pressed, or if there was interference during the IR capture—If you press the
wrong button for a code or there was some interference during IR capture, the system may sense this and
ask for a different code or request the same code again. If you test the code, and it doesn't work, try to
capture it again.

If you pressed a button longer than three seconds. 

To disable the devices from the laptop’s Control Panel:

1. Select Wireless Link.

2. Click the Hardware tab, and click Properties.

3. Ensure that any IR devices are disabled.

4. After capturing the codes, enable the IR devices again.

When the system has finished capturing codes for a device, the Driver Wizard moves to the Input/Output
category.

Creating an IR television driver
This section provides an example for creating an IR television driver using the Control4 Driver Wizard in
Composer Pro. The example uses the Samsung TX-P1430 television; let’s create a driver for it. 
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The major steps are:

1. Create an IR-Controlled Television.

2. Select the Volume and Other Properties for IR.

3. Indicate How Power Is Handled for IR.

4. Identify the Commands that the Device Supports.

5. Capture the Device Codes for IR.

6. Identify the Input/Output Connections.

7. Define the RF/Antenna and Connection Type.

8. Define the Set Channel Macro.
l See “Add the IR driver to the project tree.”

l See “Connect the devices for IR control.”

Conditions
l The Samsung TV is using IR for device control as an example.

l There is not a discrete power on/off option, so you cannot control the power; the control system needs to
assume this device is always on.

l As with most TVs, there is Discrete Channel Selection; and the TV can provide audio output.

l The TV does not have discrete volume control, but it does have mute toggle capability.

To create an IR-controlled television using the Samsung TXP1430:

1. Start Composer Pro and connect to a Director.

2. Ensure that you add a controller to your project (e.g., EA-5). This should be the first device added.

3. To add a controller:

1. Select the room (such as Theater) where the controller is installed.

2. Click the My Drivers tab.

3. Under Controllers, double-click a Controller (e.g., EA-5). This adds the controller and the Digital Audio object
that resides on the controller to the project tree.
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4. In the Connections view, identify the controller you just added.
4. Start the Driver Wizard. From the Driver menu, select Create New Driver.
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5. Select the device driver you want to create, and click ok.

6. Enter the information for the driver you are creating, such as device’s Manufacturer, Model number, and
name of Driver Creator, and then click next.

The Created, Modified, and Copyright information is automatically generated.
l Manufacturer: Samsung.

l Model: TX-P1430.

l Device Creator: ACME Integrators.

7. Under How is this device controlled? select the IR radio button to indicate that this television is controlled
with an IR device, check Direct Connect if applicable (if IR codes are running through a direct cable, such as
S-link), and then click next.

Select the Volume and other properties

8. Under Volume Properties, select the volume properties for this device, and click next.

l Select Audio.

l SelectMute.

l Leave the other options as they are.

9. Select the properties that apply to this device, and then click next.

Options for this screen include:

l Select Discrete Input Selection—This television has this capability and
indicates that a television has the ability to select inputs directly. On the
television’s remote you can select Video 1, Video 2, or Video 3 using three
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different buttons rather than one toggle button that toggles to each
selection.

l Do not select Discrete Channel Selection—This television does not have this
capability and indicates that the television has the ability to select channels
directly. On the remote you can select a “discrete” channel by clicking 05
rather than toggling through channels by clicking the Channel Up and
Channel Down buttons.

Indicate how power is handled for IR
10. Determine how power is handled for the device:

l For the Samsung TX-P1430 television driver, select Assume device is always
on.

l For a description of each option, see “Guidelines for defining power
management” to help with a selection.

11. Click next.

Identify the commands that the device supports

12. De-select the default commands not relevant to the device, add any custom commands (additional buttons)
required, and then click next.

l Deselect Cancel.

l Deselect Info.

l Deselect TV/Video.

Capture the device codes for IR

13. Capture the device codes using the manufacturer’s remote and the controller’s IR Learning capability. Follow
the guidelines listed in “ Guidelines for capturing IR codes” and the on-screen instructions.

Use the Samsung TX-P1430 television remote control to capture the codes by pointing
the remote directly at the IR window on the controller.
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When a code has been captured, Composer Pro puts a check next to the captured code in the Codes list,
and selects the next code to be captured. When you capture all the codes, Driver Wizard automatically
moves you to the next section: ‘Input/Output.’

(Optional) After you capture a code, if you want to view the code, click back. You can
also edit and emit the code from this screen.
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14. When you are finished, click next.

Note: Sometimes a device can have alternative patterns. In this case, multiple codes
show up on the screen.

15. Read the television manufacturer’s documentation to find out the necessary inputs/outputs.

Identify the input/output connections

16. Click Add to identify the Input/Output connections on the television, and then click ok.

17. For the Samsung TX-P1430 television driver, add the following inputs:

l Line Input—Select Input and Line Level type.

l RF Antenna—Select Input and RF/Antenna type.

l Monitor Out—Select Output and Line Level type.

The inputs appear in the Input/Output Connections window.

489



Composer Pro User Guide

18. When the Input/Output Connections list is completed, click next.

19. Define the connection types for Inputs/Outputs, and then click next.

For the Samsung TX-P1430 television driver, define the Line Input:

l Under Audio Connections, select Stereo (RCA).

l Under Video Connections, select Composite and S-Video.

Define the RF antenna and connection type
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20. Define the RF/Antenna type on the input RF Antenna, and then click next.

For the Samsung TX-P1430 television driver, select the UHF/VHF radio button.

21. Define the connection type for output Monitor Out, and then click next.

l Under Audio Connections, select Speaker.

l Under Video Connections, select Composite and S-Video.

Define the Set Channel macro
22. Define a Set Channel macro to set the number of digits required by the TV to change channel so that the

system can imitate the behavior of the TV’s remote. Some TVs require two numbers and others require three.

The Samsung uses a 2-digit channel entry. Select CHANNEL 3 and use the Minimum Length drop-down
menu to change to 2.

23. Increase the inter-digit delay (delay button code) if necessary for the TV you are adding.

24. Click the blue number sign (#) to move the settings into the center pane.

25. Click next.

26. You have completed the setup of this driver. You can view the driver you created in the Search tab. Click
next, and then click ok to continue.
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27. Next, add the new driver to the project tree and connect the device. See “Add the IR driver to the project tree”
and “Connect the devices for IR control” below.

Add the IR driver to the project tree
After you create an IR driver using the Driver Wizard, you must add it to the Composer Pro project tree. This
section uses the Samsung TXP1430 as an example.

To add the IR driver to the project tree:

1. Start Composer Pro and connect to a Director.

2. Click System Design.

3. In the project tree, remove the existing television driver that you previously added to the example project (if it
was added).

4. From the Search tab, use the drop-down menu to select the Device Type and Manufacturer of the driver you
just created.

Example:
1. At Device Type, select Television.

2. At Manufacturer, select Samsung.

5. Double-click the new driver to add it to the project tree. Example: Samsung TXP1430.

6. Make the connections. See “Connect the devices for IR control.”

Connect the devices for IR control
After you create an IR driver using the Driver Wizard, you must add it to the Composer Pro project tree and
connect the device. This section uses the Samsung TXP1430 as an example.

To connect the IR device:

1. Start Composer Pro and connect to a Director.

2. Click the Connections view to make the appropriate video, audio, and control connections or network
connections (if appropriate) for the device.

3. For the Samsung TX-P1430 television driver, select Television.

4. Make all the necessary Control and AV connections.

Example (Television): In Connections under Theater, click Television. The right pane
displays all of the inputs and outputs on the back of the television. For television, from
the top pane: 

Under Audio Video Inputs, drag the object from the top pane to the bottom pane:

1. Click AV In (Video—COMPOSITE), and drag it to Receiver (Output—Theater).

2. Click AV In (Audio—STEREO), and drag it to Receiver (Output —Theater).

3. Under Control Inputs, click IR Sensor (Control—IR_OUT), and drag it to Home Controller HC-500 (IR Output
1—Theater).

5. Click System Design, and double-click the device on the project tree.

6. Use the Device Control window to test the control of the device. For the Samsung TX-P1430 television driver,
double-click Television.
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Editing an IR-controlled receiver driver
This section takes you through an example of creating a custom IR-controlled receiver driver for a Control4
system by starting with an existing driver with multiple outputs, and then editing it. 

Example: In this example, pick the driver for the Harman Kardon AVR-230
Receiver. The Harman Kardon AVR-230 receiver is using IR for device control.

Conditions
l There is a discrete power on/off option.

l Like most receivers, the device uses Discrete Input Selection and Discrete Surround Selection.

l It does not have Volume Discrete Control, but it does have Mute toggle capability.

l The Harman Kardon AVR-230 Receiver has the capability of Discrete Power on/off.

To edit an existing device driver:

1. Start Composer Pro and connect to a Director.

2. Pick an existing driver in the Online Database to edit.

1. From the Driver menu, select Manage Drivers.

2. In the Local Driver Database screen, click Add to access the online database.

3. In the Search dialog box, use the drop-down menus to select the Device Type and Manufacturer, and then
click Search.

Example: For the Harman Kardon AVR-230 use the following information:
l Device Type: Receiver.

l Manufacturer: Harman Kardon.

4. In the Search Results list, select the Model Number.

Example: Select Harman Kardon AVR-230.
5. Click OK to add this driver to your local database.

6. Click Exit.

3. From the Driver menu, select Edit Existing Driver to begin editing the driver in your local database.

Note: If you right-click on the driver in the project tree, you will edit ONLY the driver
in the project and not the driver in your local database.

4. Select the Device Type (for example, Receiver) to view list of manufacturers.

5. Select the Manufacturer (for example, Harmon Kardon) to view list of model numbers.

6. Select the Model Number (for example, AVR-230).
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7. Click OK to open the existing driver (with all of its current settings) in the Driver Wizard.

Edit the device information
8. Edit the Device Info form as needed, including Manufacturer, Model number, and Driver Creator. This should

reflect how you want this driver to display in your Local Database.

9. For the Harman Kardon AVR-230 use the following information:

l Manufacturer: Harman Kardon.

l Model: AVR-230 [IR] - Edited.

l Driver Creator: ACME Integrators.

10. Click next.

Indicate how the device will be controlled

11. Indicate how this device is controlled using IR or Serial. Example: Select IR and Direct Connect.

l IR—Select this radio button if the device you want to create a driver for is IR
(infrared) controlled.

l Direct Connect—Check this box if your IR codes are running through a direct
cable, such as S-link.

l Serial—See “Creating a serial-controlled device driver” for information and
example implementation.

12. Click next.

Edit the volume properties

13. Edit the volume properties for the Harman Kardon AVR-230:
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l Check Audio.

l CheckMute, but do NOT check Discrete Control. The Harmon Kardon AVR-
230 has mute toggle only.

14. Leave the other options unchecked. The Harman Kardon AVR-230 does not have these features.

15. Click next.

Edit the existing properties for the driver

16. Edit the existing properties for the driver as needed.

17. For the Harman Kardon AVR-230 driver:

1. Accept the defaults of Discrete Input Selection and Discrete Surround Sound Selection.

2. Click Add to add surround sound modes and in the dialog that appears type the Name, and click ok.

3. Do this for each of the surround sound modes, including Dolby Pro Logic, DTS Neo 6, and THX.

18. Click next.

Indicate how power is handled for the device

19. For the Harman Kardon Receiver driver, select Use discrete on/off codes, and click next. See “Guidelines
for defining power management” for help making a selection on this screen.

20. Click next.

21. De-select the commands not relevant to the device as needed, For the Harman Kardon Receiver driver, click
to de-select.

l Cancel

l Info

l Mute Off

l Mute On

l Power Toggle

l Pulse Surround Mode

l Recall

l Toggle Input

l TV/Video

22. See the diagrams that follow.

Add the commands

23. From the extended command list, add several commands: DVD and Video 1.
24. To add the commands from the extended command list for each individual command, click Add.

25. On the dialog that appears, use the drop-down menu to select the commands, and click ok. The new
command appears in the Default Commands pane.

26. Add custom commands for surround modes, including DTS Neo 6, Dolby Pro Logic, and THX. To add custom
commands for each individual command, click Add.
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27. Enter the name of the command, and then click ok. The new commands appear in the Custom IR Commands
pane.

28. Click next.

Capture the codes
29. Capture (or recapture) the device codes as needed using the manufacturer’s remote and the controller’s IR

Learning capability. Follow the guidelines for capturing IR codes in “ Guidelines for capturing IR codes.”

When a code has been captured, Composer Pro puts a check next to the captured code in the Codes list,
and selects the next code to be captured. When you have captured all the codes, it automatically moves
you to the next section Input/Output.

30. Use the Harman Kardon AVR-230 Receiver remote control to capture the codes by pointing it directly at the
IR window on the controller.

31. Use the Harman Kardon Receiver remote control to capture the codes.

Add the input and output connections
32. Add the input and output connections. For the Harman Kardon Receiver driver:

1. Add 2 inputs: DVD and Video 1.

2. Add 1 output: Monitor Out.

The inputs and outputs appear as shown:
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33. Click next.

34. Define the connection types for input DVD.

1. In Audio Connections, check Stereo.

2. In Video Connections, check Composite, S-Video, and Component.

35. Click next.

36. Define how you select DVD. Select Code. Use the drop-down menu, and select DVD.

37. Click next.

38. Define the connection types for input Video 1.

1. In Audio Connections, check Stereo.

2. In Video Connections, check Composite, S-Video, and Component.

39. Click next.

40. Define how you select Video 1. Select Code; use the drop-down menu, and select Video 1.

41. Click next.

42. Define connection types for input Video 1.
1. In Audio Connections, check Stereo.
2. In Video Connections, check Composite, S-Video, and Component.

43. Click next.

44. Define connection types for input Monitor Out.

1. In Audio Connections, check Stereo.

2. In Video Connections, check Composite, S-Video, and Component.

45. Click next.

46. Define three macros for Dolby Pro Logic, DTS Neo 6, and THX.

1. Use the scrollbar to skip all the macros until you get to “Set output Mon...”

2. Select this macro.

3. Go to the window in the bottom right corner and find Dolby Pro Logic.

4. Ensure Pulse is selected, and click the green arrow. This adds the macro to the center pane. The screen
heading should read “Define the macro to: Set Monitor Out surround mode to Dolby Pro Logic?”

5. Do the same for DTS Neo 6 and THX.
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47. Click finish.

48. See the diagram series that follows.

49. You have now completed your driver setup. View the driver you edited in the Search tab.

50. Drag the new driver to the project tree.

51. Connect the video, audio and control or network connections (as appropriate) for the device.

52. Click System Design, and double-click the device in the project tree.

53. Use the Device Control window to test the control of the device.

54. For the Harman Kardon Receiver driver, double-click Receiver.
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Serial-controlled device drivers
Creating a serial-controlled device driver
Create serial drivers using the Driver Wizard in Composer Pro. Instead of capturing the code as you do with
IR, you enter the specific serial data that you must send for each command.

To create a serial-controlled driver:

1. Follow the same steps used in “ Creating IR-controlled drivers” and select a serial-controlled driver rather
than an IR-controlled driver.

2. Follow the wizard pages to create the driver.

Guidelines for entering serial codes
This section describes the different formats you can enter for the serial data of each command in Control4
serial drivers.

These formats include:

l Basic Method to Enter Bytes—Shows you how to enter a basic code.

l Method to Enter Delays—Shows you how to enter a delay code that you need to control some devices.

l Method to Enter Parameters—Shows you how to enter the needed parameters.

l Method to Enter Checksums—Shows you how to enter the checksums.
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Method Description

Basic Method to
Enter Bytes

All serial data in the end becomes bytes. There are
three basic formats to represent bytes, but in the end
the resulting data is just bytes, and any format would
suffice for the entry. For ease-of-use, multiple formats
are supported.

Examples for all methods: Data is equivalent to the
ASCII string “DVD” with a carriage return at the end.

Decimal Data—With decimal data and between any
of the different formats there must be a space to act as
a delimiter between different pieces of data. To enter
decimal data, enter the value to be stored in the byte in
decimal. Valid data is from 0-255.

Example: Data (“DVD” with carriage return):

68 86 68 13

Hexadecimal Data—With hexadecimal data and
between any of the different formats, there must be a
space to act as a delimiter between different pieces of
data. To enter hexadecimal data, enter the ‘$’ symbol
immediately followed by the value to be stored in the
byte in hexadecimal. Valid data is from $00-$FF.

Example: Data (“DVD” with carriage return):

$44 $56 $44 $0D

ASCII Data—All ASCII data must be inside double
quotes. Each byte inside the quotes represents one byte
of data. Look at any ASCII table to see the real values
each character represents. The same ASCII characters
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Method Description

supported in the C programming language are
supported. Escape characters are also supported in the
same way. Supported characters include \n (new line),
\r (return), \t (tab, and \” (double quotes).

Example: Data (“DVD” with carriage return):

“DVD\r”

Mixing formats — All of the above formats can be
used together, and the person can use whichever seems
most efficient.

Example Data (All examples represent the exact same
data):

“DVD” $0D
68 “VD” 13
“DV” $44 13
$44 $56 68 13
68 $56 68 “\r”

Method to Enter
Delays

Many times it is necessary to create delays when
sending data to a serial device. The ‘#’ character is
used to represent that the following number is a delay
in milliseconds. A space is required between each
element in the data.

Example: This example assumes that the protocol calls
for a “PWON\r” command followed by a 1500
millisecond delay followed by a “PLAY\r”.

ASCII Example:
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Method Description

“PWON\r” #1500 “PLAY\r”

Decimal Example:
80 87 79 78 13 #1500 80 76 65 89 13

Method to
Enter Parameters

Many commands have parameters. Examples of these
commands are the GO_TO_CHANNEL command for
TVs and Satellite receivers or GO_TO_DISC
commands for DVD and CD changers.

During driver creation, you are allowed to create
macros to embed the parameter in the data that is
being entered. This creates different problems
depending on whether the protocol is a binary or
ASCII protocol. When entering ASCII parameters, use
a modified version of the format that C uses in its
printf function.

Example: This example is a GO_TO_CHANNEL
command where the protocol specifies that the devices
need the ASCII command “Channel XXX\r” where the
XXX is the three digit (decimal) channel number that
is being requested with zeroes padded (on the left) if
the number is less than 100. The parameter name is
CHANNEL_NUMBER.

ASCII Example:

“ChannelHarman Kardon03dCHANNEL_NUMBER
\r”

Later, at run time when this command is called with
the Channel 56, the output appears as follows:
“Channel 056\r”

502



Composer Pro User Guide

Method Description

During driver creation, you can also enter parameters
in a binary protocol format. Borrowing from the last
format with the modification that following the%, first
is the byte count (valid counts are 1, 2 and 4),
followed by the byte order (E = big endian, e = little
endian), followed by the data format (D = decimal,
others to follow). This is obviously followed by the
actual parameter name as in the example above.

Example: This example assumes the protocol needs a
start byte that is the number 2, followed by the GO_
TO_CHANNEL command code which is 57, followed
by a 2-byte big endian channel number, followed by
the end byte which is 0.

2 57%2EDCHANNEL_NUMBER 0

Later on at run time when this command is called with
the Channel 357 the output looks like the following
using our format.

2 57 1 101 0
(Hint 0x0165 is hexadecimal for 357, and 1 = 1 in
decimal and 65 = 101)

If the protocol used little endian for the parameter, the
data entry is:

2 57%2eDCHANNEL_NUMBER 0

The output for the previous example is:

2 57 101 1 0
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Method to Enter
Checksums

Many protocols require a calculated checksum. A way
must be provided for the user to calculate a checksum.
There are several formats for checksums, so different
types of checksums must be allowed. The ‘&’ signifies
that the software needs to enter a checksum followed
by a byte count (valid counts are 1, 2, and 4), followed
by the byte index in the command where the checksum
calculation starts (valid numbers are 0-9), followed by
the byte size of the checksum chunks (valid sizes are 1
and 2), followed by byte order (E = big endian e =
little endian), followed by the checksum calculation
format (STD = standard (chunk size wide) addition
inverted, CRC = CRC).

Example: The example uses the same devices as
previously mentioned and assumes the big endian GO_
TO_CHANNEL command, where that command
needs a checksum (before the 0 end byte) starting at
the beginning of the command, and the command is a
simple 1-byte checksum.

The data entry displays the following:

2 57%2EDCHANNEL_NUMBER &101ESTD 0

And the output for the previous examples is (channel =
357):

2 57 1 101 94 0

Example: Creating a serial driver InFocus LP850 projector
When creating a serial driver using the Driver Wizard in Composer Pro, the driver
supports one-way communications.
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Example: In this example, you create a driver to support the serial-controlled
InFocus LP850 Projector.

To create a new serial driver:

1. Start Composer Pro and connect to a Director.

2. Ensure that you have added a controller to your project (this should be the first device added).

3. To launch the Driver Wizard, from the Driver menu select Create a New Driver.

4. In the Driver Wizard, select the device driver you want to create, and click ok.

5. Fill out the driver information, such as Manufacturer, Model, and Driver Creator name. The date created, date
modified, and the copyright information is generated automatically.

For the InFocus LP850 Projector, use the following information:

l Manufacturer: InFocus

l Model: LP850

l Driver Creator: ACME Integrators

6. Indicate how this device is controlled using IR or Serial. Example: Serial.

7. Set up the serial settings.

l Serial—Select this radio button if the device you want to create a driver is for
serial controlled. The following serial options are specific settings on serial
devices.

l Baud Rate—The number of symbols or characters per second sent over a
serial link. Options: 110, 300, 1200, 2400, 4800, 9600 – default, 19200, 38400,
57600, 115200, 230400, 460900, 921600.

l Data Bits—Use the drop-down menu to select (5, 6, 7, 8 – default).

l Flow Control—The control of the transfer of data to avoid congestion.
Options: None - default, Xon/Xoff, Hardware.

l Stop Bits—Options: 1-default, 1.5, 2.

l Parity—The process for detecting whether bits of data have been altered
during transmission of data. A parity bit is appended to an array of bits to
make the sum of all the bits always odd or always even for error detection.
Options: None – default, Even, Odd, Mark, Space.

8. For the InFocus LP850 Projector, use the following settings:

l Baud Rate: 19200

l Data Bits: 8

l Flow Control: None

l Stop Bits: 1

l Parity: None
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9. Click next.

Define the audio parameters

Example: Projectors do not have audio, so do not check anything.
10. Click next.

11. Fill out the device properties for the driver you are creating. Properties are features that vary between the
different models of the same device type. For example, some Televisions have discrete power control and
some only offer toggle power on/off. You must define in the driver you’re creating the features supported in
the model.

12. For the InFocus LP850 Projector driver, check Discrete Input Selection.

13. Click next.

Indicate how the power is handled
14. For the InFocus LP850 Projector driver, select Use discrete on/off codes. For more information about power

management options, see “Guidelines for defining power management.”

15. Click next.

Select the appropriate codes
16. For the InFocus LP850 Projector driver, de-select the following commands:

l Cancel

l Channel Down

l Channel Up

l Enter

l Info

l Number 0 through 9

17. Click Add to enter any custom commands.

18. Add the following options:

l Aspect Ratio: 16:9

l Aspect Ratio: 4:3

l Aspect Ratio: Native

l Ceiling mount off

l Ceiling mount on

19. Enter the serial code for each serial command.

20. Click next to continue through the codes. For information about how to enter serial codes, see “Creating a
serial-controlled device driver.”

21. Click Add to identify the Input connections on the device.

22. For the InFocus LP850 Projector, add the following input connections:

l Video 1 (Input, Line Level)
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l Video 2 (Input, Line Level)

l Video 3 (Input, Line Level)

l Computer 1 (Input, Line Level)

l Computer 2 (Input, Line Level)

l Computer 3 (Input, Line Level)

23. Click next.

Define the connection types for the inputs and outputs
24. Define the connection types for Inputs/Outputs for all the inputs/outputs. For the InFocus LP850 Projector

driver, define all the previous inputs identified previously.

25. Click next until you have defined all of the inputs and outputs.

Define the macros
26. Enter any additional serial codes needed to perform the desired action. For Serial Drivers, based on the

selections you made in the Device Info section (where you defined Driver capabilities), both Codes and
Macros have to have the serial strings entered.

27. Click next.

28. Click next again.

29. Click OK to return to Composer Pro. The driver you created is located in the Search tab in Composer Pro.

30. You have now completed the setup of you driver. Select the Search tab and the driver type you just created.

31. To check whether your driver is in the Online Database, select the driver. For the InFocus LP850 Projector
driver, select Projector > InFocus LP850.

32. Drag and drop the new driver to the project tree.

33. Make the appropriate video, audio, and control connections or network connections (if appropriate) for the
device.

34. Click System Design and double-click the device in the project tree. Use the Device Control window to test
the control of the device.

Example: Double-click Projector.
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DriverWorks Two-way serial or TCP/IP
driver
Creating a 2-way serial or TCP/IP-controlled driver
You can create most serial drivers using the Driver Wizard in Composer Pro. Instead of capturing the code as
you do with IR, you enter the specific serial data that you must send for each command.

Use DriverWorks instead of the Control4 Driver SDK to create 2-way drivers for AV and non-AV devices that
are controlled using a serial or TCP/IP connection.

DriverWorks exposes each of the driver APIs previously published through the Control4 Driver SDK (now
discontinued). It is an SDK framework that allows 2-way drivers to be written for the Control4 system.

DriverWorks drivers can be written and installed without requiring platform- and version-specific compiling.
Using DriverWorks does require some programming skills, but this tool leverages the Lua-embeddable
scripting language, which is powerful, fast, and light-weight language (when compared to other scripting
languages). DriverWorks comes installed with Release 1.6 and later software releases.

For information on using DriverWorks, refer to the SDK DriverWorks documentation (“Getting Started with
DriverWorks”), which is downloadable from the documentation area on the Control4 Dealer Web site: Go to
http://dealer.control4.com/dealer/support/software-updates.
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Related tasks
Two other tasks related to using Control4 device drivers in Composer Pro are:

l “ Exporting a driver in the project”
l “ Verifying the IR codes using the Driver Wizard”

Using a new device driver in an existing project
A new device driver can be added to an ongoing project in the Control4 system.

To add a new driver to an existing project:

1. Start Composer Pro and connect to a Director.

2. Delete (right-click > Delete) the driver from the existing project.

3. Add the device to the project again.

4. Re-configure any connections (see the Network or Control/AV tabs in the Connections view) and any
associated programming.

Exporting a driver in the project
For all audio/video equipment, you can export a Control4 driver to save or add to
other projects. This essentially saves a driver for other uses outside of the current
project. 

Example: Export the driver you have edited on one Control4 system to another
Control4 system, and save it with your company name.

To export a connected driver:

1. Start Composer Pro and connect to a Director.

2. In an existing project and from the project tree, right-click the driver you want to export and select Export
Driver. This option is available from System Design, Connections, or Programming.

3. On the dialog that appears, type your company name in the Creator Name box.

4. Click the Search tab to find the saved driver.
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Maintaining your system
Use this chapter to learn how to:

l Update Composer and Director

l Create Panelized Lighting reports
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Maintaining your system
Use this chapter to learn how to:

l Update Composer and Director

l Create Reports
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Updating Composer Pro
You can use Composer Pro to download and update to a new version of software or you can download a
software update directly from the Online Portal.

Update Composer Pro using Composer Pro
Use the Control4® Composer Pro software to download and update Composer Pro.

IMPORTANT! Before you begin any update, check the Release Notes for any
important notes or upgrade documents associated with the update, especially
if it's a major update such as Smart Home OS 3. Read those documents first.

To update Composer Pro software from Composer:

1. In the Help menu, click on Check for Updates.

2. If an update is available, select it in the Available Updates drop-down menu and click Update.

3. Select a different download location in the Available Locations drop-down menu if instructed by Control4
Technical Support.
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4. Check the box next to Check for version of Composer at startup to have Composer Pro check for an update
every time the software starts.

Update Composer Pro from the website
You can download an update to Composer Pro from the Online Portal.

IMPORTANT! Before you begin any update, check the Release Notes for any
important notes or upgrade documents associated with the update, especially
if it's a major update such as Smart Home OS 3. Read those documents first.

To update Composer Pro from the Online Portal:

1. Log into the portal at dealer.control4.com.

2. In Support > Software Downloads, find the needed version of Composer Pro and click on the correct OS
version number, for example OS 3.

3. Click on Download Composer Pro.

4. After the file has finished downloading, open the downloaded file to start the install process. Follow the on-
screen instructions to finish installing Composer Pro.
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Updating the Control4 System
Use the Control4® Composer Pro software to update Composer Pro and Director.

IMPORTANT! Before you begin any update, check the Control4 website for any
Release Notes or upgrade documents associated with the update, especially if
it's a major update such as up to Release 1.8.2, OS 2.0, or OS 3.0. Read those
documents first.

Depending on the type of upgrade you need to perform, the following tools and website may need to be used.

l Control4 website

l Update Manager

l Network Status

l System Manager

Control4 website
Composer Pro updates (software releases) are available on the Dealer Portal at
http://dealer.control4.com/dealer/products/software-updates/. You will need a
Dealer login and password to access this site.

Prerequisites
Ensure that Release 1.8.2 and Composer Pro 2.0 are installed before you begin a subsequent update. See
Composer Pro Getting Started for details. If you have an earlier release, see the update instructions for that
release. You must update first to Release 1.7.4 and then 1.8.2 before updating to OS 2.0 and later.

Activate your licenses. See "Purchasing and Setting Up Dealer Licenses" in Composer Pro Getting Started or
Managing Dealer Accounts on MyControl4 on the Control4 Knowledgebase for details.

To access the software updates:

1. Log in and go to: http://dealer.control4.com/dealer/products/software-updates/.

2. Under Software Updates select the software version to download and install. The following software releases
are available on the Control4 website:

Composer 1.7.4 Composer 1.8.2 Composer 2.0.6 Composer 2.2.4*

Composer 2.5.3 Composer 2.6.0 Composer 2.7.0 Composer 2.8.1

Composer 2.9.1 Composer 2.10

Other software utilities are available for download also at the Dealer software download site.

IMPORTANT! For new installations, it is always a best practice to use the latest
version of the released software.
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Update Manager
Update Manager in Composer Pro updates Director and all the IP-connected
devices that are available in your project (identified and online), allowing you to
update all the devices in the project configuration also. You can use Update
Manager to update from previous releases.

To support multiple releases, the release (for example, 1.7.x) installs in a Composer Pro directory (for
example, Composer17x), which differs from previous releases that were installed in the Composer Pro
directory. You do not need to uninstall previous releases to install a new release, but you must install
Composer 2.0 or later before you begin the update to the latest release.

To access Update Manager:

1. Start Composer Pro and connect to a Director.

2. From the Tools menu, click Update Manager.

Zigbee Health
Zigbee Health provides a dashboard to give insight into the Zigbee health, summary, and project
improvements and a detailed list of Zigbee devices in the project with troubleshooting information.

Zigbee Health Dashboard

The Zigbee Health Dashboard has three main sections: Health, Summary, and
Project Improvements.

l The Health grade is based on devices that are online and devices that have a
strong and consistent signal.

l The Summary gives more details on how the grade is calculated by breaking
down total devices in the project, how many are identified, and howmany
are in a Healthy,Warning, or Critical status. Devices that are offline or have
extremely poor signal show as Critical. Devices that have communication
errors, but are online, show as Warning. Devices that are online and with
good connectivity strength show as Healthy.
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l Project Improvements gives suggestions to improve the Zigbee health of
the project. The number of devices that are not identified and that are offline
are listed.

Zigbee Health Devices

The Zigbee Health Devices tab gives details on the Zigbee devices in the project.

Tip: You can sort by each column by clicking on the column name.

l Search—The Search bar lets you enter the device name, room in the project,
device type, or MAC address of a Zigbee device and filter the Devices list.

l Show Data Columns—Click on the Show Data Columns dropdown menu to
choose which data columns to display in the device list: Device Type, Node
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Health, Address, From Failures, To Failures, Signal, and RSSI.

l Include—De-select a device in the Include column to not include that device
in the Zigbee Health Dashboard grade. For example, if you have an outlet
switch that you use for Christmas tree lights that gets put away most of the
year, deselect the outlet switch so it doesn't lower your Zigbee Health grade.

l Status—Shows a green dot for online status, red dot for offline status, or gray
dot for offline status if the device is not identified.

l Device Name—The device name given to the driver in System Design.
l Room—In System Design, the room the device is located in.
l Node Health—A combination of factors is used to give each device a node
health grade.

l Address—The MAC address of the Zigbee device if it has been identified into
the system.

l From Failures—Average message failures, per hour, from device to mesh
controller since the last time Zserver was started or counts were cleared with
a data reset. Normal ranges are 50 or fewer per hour. Signal interference or
distance can negatively impact this value. From the menu, click on Reset
Counts:<name of mesh controller> to reset the data.

l To Failures—Average message failures, per hour, frommesh controller to
device since the last time Zserver was started or counts were cleared with a
Data Reset. Normal ranges are 50 or fewer per hour. Signal interference or
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distance can negatively impact this value. From the menu, click on Reset
Counts:<name of mesh controller> to reset the data.

l Signal—An icon to rate the signal strength: from green full bars for very good
signal to red empty bars for poor signal. Interference or distance can
negatively impact signal strength.

l RSSI—Received Signal Strength Indicator (RSSI) is a negative numerical value
in dBm that measures signal strength. Negative numbers closer to zero are
better (-40 dBm is better than -65 dBm). What is considered normal varies
from device to device, so only compare RSSI values from like devices
(manufacturer and model). Values range from -100 (soft) to 0 (loud). Signal
interference or distance can negatively impact this value.

Network Tools
The Network Tools menu option shows the Connections > Network view which offers network information on
IP and Zigbee devices.

To access Network Tools:

1. Start Composer Pro and connect to a Director.

2. From the Tools menu, click Network Tools.

3. The Connections > Network view has three tabs. Use these tabs as required by the software:

l IP Network

l Zigbee Network
l Z-Wave Network

System Manager
System Manager provides some of the functionality as in previous releases, but it does not perform the
update. Use System Manager to add, refresh, connect, or disconnect devices.

Updating firmware
Sometimes you’ll receive new devices that aren’t on the same firmware version. For all devices to be able to
communicate with each other, they do need to be on the same firmware version. Refer to the current Release
Notes to get the latest updates on firmware.

Zigbee devices
Zigbee devices update automatically to the current firmware version when they are installed and identified to
the system.

IP devices
To update IP devices, run Update Manager. You can check the firmware version either in System Design >
Properties pane (for the device), or in Tools > Network Tools > Zigbee tab for Zigbee devices.

Black & Decker locks
Note: Ensure you're running a current version of Composer Pro and Director on
the system. Without the current version, the latest firmware will not be available.
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To force a firmware update on the lock:

1. Remove the batteries from the lock (press a key or two to eliminate any charge in the lock).

2. Put the batteries back in.

3. Press the top left button four times.

4. Press the top right button four times.

The firmware should start updating. If it does not, ensure that your batteries are fresh. If you cannot manually
start the firmware update, the lock should automatically check in for an update after the first check-in of the
lock, at 3 AM.

Guidelines for updating a Control4 system
Use these guidelines to update a Control4 system.

IMPORTANT! Before you begin any update, check the Dealer Portal for any
Release Notes, Read This First, or upgrade documents associated with the
update and the release. Read those documents first.

Note: The update behavior and steps for various releases differs. Make sure
you review any documentation associated with the release before you begin
your updates.

Follow these important guidelines for updating Composer Pro:

l Back Up Your Project. If you have a project in an earlier version of Composer, back it up before you
update.

l Verify the Network Connections. Update Manager requires an active network connection to function
properly. Ensure that the network connection is up and working prior to performing the upgrade.

l Update Errors. If you notice any errors during the update process in the Update Manager’s output pane,
take note of the error message, and follow instructions provided at “Troubleshooting the Upgrade
Process.”

IMPORTANT! You cannot have both connection methods identified on the
system. Remove the network connection to ZigBee and identify it again using
the Ethernet connection.

l Power On. Ensure that the power state of all devices is On. You can verify
that all devices are online from the Network Tools page.

l Know When the Update is Completed. When upgrading the Control4
controller running Director, you are disconnected from Composer Pro and
streaming audio stops.

1. After this occurs, restart Composer Pro and reconnect to the system.

2. Go to Tools > Update Manager and watch the update process.

3. Also, go to Tools > Network to ensure that everything is connected. If it is not connected, it cannot update
that firmware.
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4. After Update Manager indicates that it is completed (you may see a message like “Finished site update
attempt,” all the IP devices on the system are now updated. This does not include Zigbee devices or hybrid
devices (containing both IP and Zigbee).

5. Go to Tools > Network Tools to view the firmware versions to ensure they are updated to this release.

Tip: Be patient. In cases where the Zigbee mesh is moved, it can take up to five minutes
for all connections to be re-established.

Guidelines for updating specific devices
l Primary Controller. The primary controller holds a new firmware image file,
which is transferred and reflashed when an Ethernet network connection is
present. After the update, disconnect the IP identification and identify again
using Zigbee.

l Zigbee Devices. When upgrading a controller associated with Zigbee devices, such as dimmers,
switches, and keypads, these are also upgraded. As these devices upgrade, the device’s LEDs and the
associated lighting loads may flicker. This is normal behavior.

Estimating Control4 system update times
Estimating update times per device type
The update time is dependent on the size of the Control4 system, the available network bandwidth, and the
types of devices you are updating. 

There are three types of devices: IP devices that communicate solely by TCP/IP, Zigbee, Zigbee Pro devices
that communicate via Zigbee or Zigbee Pro, and hybrid devices that use both TCP/IP and Zigbee for
communication. 

Depending on the device type, some devices, such as the IP devices update in parallel; other Zigbee devices
are updated sequentially, one after another. Generally, the IP devices are updated in parallel immediately
after the primary controller updates. After that, the Zigbee devices update in sequence starting with the
system remote controls. The system remote control is the first Zigbee device to update if it is in Wake mode.
During or after the update, if the system remote control was in Sleep mode, it updates immediately after it
wakes up.

The following list identifies some typical Control4 devices and update time
estimates.

l IP devices (updated in parallel immediately after the primary controller):

l Controllers—20 to 40 minutes

l 7” touch screens—15 to 20 minutes

l Speaker Point—10 to 15 minutes

l Zigbee devices (updated sequentially):

l System Remote Control—3 to 5 minutes (updated as the first Zigbee
device if awake)

l Dimmer/Keypad/Switches—3 to 5 minutes

l Thermostat—10 minutes

Example: a total of
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l 20 devices may take 110 minutes or longer

l 30 devices may take 150 minutes or longer

l 60 devices may take 300 minutes or longer

to complete the process. Dimmers and switches do not need to be updated.

You may want to practice on your own Control4 system first before upgrading a customer's home.

Best practices for updating a Control4 system
These sections will help you understand the best practices to follow when performing a Control4 update in
Composer Pro. If you follow these sections in order until your system updates successfully, you may avoid
some unnecessary pitfalls.

General procedure

To update your system and software:

1. Back up the current project and media.

2. Check that you have a good network connection.

3. Check the currently-installed Composer Pro and Director versions.

4. Update Composer Pro software and drivers.

5. Update Control4 products using Update Manager.

6. If you have problems, see “Troubleshoot the Upgrade Process” or contact Control4 Technical Support.

Tip: The update process is highly dependent on valid network configurations and
Internet connection availability and bandwidth. Please confirm that the devices on
your network have a valid connection to the Internet. If you are using DHCP,
confirm that your DHCP is active and can issue valid IP addresses to clients on the
network.

IMPORTANT! Do not use a previous release of Composer Pro to modify a system.
Likewise, do not use a current version of Composer Pro to modify a previous
release of the Control4 system.

Back up the current project and media

To back up your current project and media:

1. Back up your current project file from a previous release by using File > Backup As. Give it a filename that
clearly identifies it as the backup.

2. Continue to the next section.

Check the currently installed Composer version
It is helpful to check the currently-installed Composer Pro version before installing the update to make any
necessary project adjustments.
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To check currently installed Composer Pro version:

1. In Composer Pro, click Help > About Composer.

2. From the dialog that appears, write down the Composer Pro and Director versions.

Example: Composer version 2.3.0.190646 and Director version 2.3.0.190646.
To ensure that the Control4 system is working properly, the Composer Pro and Director versions should
always be consistent and have the same version number.

Note: You do not need to be on a certain version, however, to update. Update Manager
updates the Control4 system from all previous releases. The only reason you need to
know this information is to determine when your project was set up. Control4 always
recommends that you write down these versions in case this information is needed later.

3. Continue to the next section.

Update Composer software and drivers
The Composer Pro software download consists of Composer Pro software and new or updated device drivers
to support Control4 hardware and other third-party products. The following steps outline how to launch the
software executable and ensure that you have the latest drivers.

Note: The Inspector utility can be used to verify each package after installation.
Inspector reads all of the md5sums in the /var/lib/dpkg/info directory, and runs
a newmd5sum against them. Any missing files or files where the md5sums
have changed are reported in /tmp/Inspection.$timestamp.

To install a released Composer Pro software version:

The following steps are an example of a software installation. Refer to the Release
Notes associated with the software release for specific instructions.

1. Download the software package from the Internet at dealer.control4.com.

2. Install the current Composer Pro software, for example, Composer Pro 3.0.0.

3. Follow the on-screen instructions to complete the installation.

4. During the installation process, click the Continue Anyway button for the installation to proceed.

5. Continue to the section, "Update Control4 Products Using Update Manager."

(Optional) To ensure the driver database is updated:

1. From the Driver menu, select Manage Drivers. In the utility, you can see the creation and modification dates
for all drivers in the local database residing on your computer.

2. Click Add to search the online database, and compare the modified dates to determine if a new driver is
available.

3. If a newer driver is available and you want to download it, check the box next to the device model number,
and click OK to download the newer associated driver.

Tip: When Composer Pro is first installed, the My Drivers tab is pre-populated with a
list of drivers. The My Drivers tab provides shortcuts to commonly-used drivers. You
can add, remove, and re-order items to the My Drivers tab as needed. Removing drivers
from My Drivers tab only removes the driver from the list. It still exists in the Local
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Database. To get back to the default My Drivers tab list and to include newly-added
Control4 devices, right-click any device and click Restore Default List. This action
does not affect the Local Database in any way. Also, right-click theMy Drivers tab,
select Add Driver, and then select all the Control4 devices not currently in the list.
Note: Devices that use SDDP for Auto Discovery (OS 2.2.4 and later) do not require
you to identify the device; just add the device to the room. See the Composer Pro
Getting Started guide for details.

Updating with a USB device (USB Stick Creator)
Create an Install on a USB device
These steps show you how to create an install to a USB device attached to your
computer’s hard drive and use the same USB device to install your customer’s
system without an Internet connection.

Prerequisites
l Have a USB drive handy, formatted for FAT32 with at least 2GB (OS 2.2.2 or earlier) or 4GB (OS 2.2.2

or later) total available disk space.

l Only installs for OS 1.7.4, 1.8.2, 2.1 or later can be created using this procedure. Note: This creation
procedure does not work on OS 2.0.x releases. If you are creating an install using an older software
version, refer to USB Stick Creator White Paper at control4.com on the Knowledgebase to create the
install.

l A valid license on the controller to be updated.

To copy an install to a USB device:

1. Open a browser and go to dealer.control4.com.

2. Log in as the dealer.

3. Go to Support > Software Updates > USB Installer.

4. Click on the USB Install Creator program.

5. Follow the instructions in the USB Stick Creator White Paper (located next to USB Installer) to complete the
process.

6. Connect the USB drive to your customer’s system using Composer Pro, and then follow the instructions in
the USB Install White Paper.
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Reports
Upgrade Report
Composer Pro 3.0 includes an Upgrade Advisor that creates an Upgrade Report the first time Composer Pro
3.0 is connected to system running a lower version.

Upgrade Advisor
After you connect to a system that needs to be updated to Control4 Smart Home OS 3, the Upgrade Advisor
runs automatically.

After the scan, the Upgrade Advisor creates an upgrade report listing any compatibility issues. Click View
Report to see the results.
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Viewing the Upgrade Report
Use the Composer Pro Tools menu to view or review an OS 3 upgrade report for your Control4 system.

To view an Upgrade Report:

1. In Composer Pro Reports menu, select the report by clicking on the project name in
the Upgrade Reports list.

2. Download or print the upgrade report by hovering the mouse over the report and clicking on the Download or
Print icons on top of the window.

Tip: Connect remotely to a project before meeting with the customer, run the report, and print it off so the
customer can see any incompatible drivers or devices in the project.

System Report
Use the Composer Pro Tools menu to create a system report for your Control4 system.
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To create a System Report:

1. In Composer Pro Reports menu, select System Report.

2. Select the items to include in the system report, and click Display Report.

3. View, save, or print out the report. The report shows a summary view of the system and each category
selected in the last step.

Tip: Use this report to print out a useful list of device properties, connections, or
programming
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Centralized Lighting reports
Use the Composer Pro Tools menu to create reports for Centralized Lighting
installations (Tools > Reports).

Creating reports in Composer Pro is essential for the electrician to use as a
reference before they install and wire the Centralized Lighting devices in the
panels. Use the Tools > Reports option to select and generate the reports.

IMPORTANT! Before you begin to design and plan a Centralized Lighting system,
make sure you attend the Centralized Lighting training sessions and videos, and
then review the Centralized Lighting documentation in the Products section on
the Control4 website.

Report types
l Panel Report. This report lists all Control4 panels in the project. Each panel shows the modules and

associated terminal blocks that should be installed in each slot.

l Module Report. This report can be generated for one or all panels in the project. This lists each module,
where it goes in the panel, the circuit breaker information for the module, and all loads connected to the
module.

l Load Schedule Report. This report lists all of the Panelized Lighting lights in the project.

Create a Panel Report
Create and generate this report for Control4 2-Slot or 5-Slot panels.
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To create a Panel Report:

1. In the Reports list, select Panel Report.
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2. Click Display Report.

3. View, save, or print out the report. The report shows a graphical view of the panels and where the devices
should be installed.

Create a Module Report
Create and generate this report for Panelized Lighting modules.
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To create a Module Report:

1. In the Reports list, select Module Report.

2. Select to create a report for All Panels or a specific panel.

3. Click Display Report. This report shows the channels, loads, load name and location, wattage, and power
booster.

4. View, save, or print out the report.

530



Composer Pro User Guide

Create a Load Schedule Report
Create and generate this report for the load schedule.

To create a Load Schedule Report:

1. In the Reports list, select Load Schedule.

2. Click Display Report.

3. View, save, or print out the report. This report shows the load number, name, and location, the connections
and the wattage.

Engraving reports
Use the Composer Pro Tools menu to create reports for Centralized Lighting installations (Tools > Reports).

Report types
l Keypad Engraving—This report lists all Control4 keypad engraving in the project. Each keypad shows

the keypad name, location, finish, and a graphical preview of the finished engraving.

l Export Engraving Order—This report creates your keypad engraving order. The engraving order can be
uploaded on the Dealer Portal.

Creating a Keypad Engraving Report

To create a Keypad Engraving Report:

1. In the Reports list, select Keypad Engraving.

2. Click Display Report.
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3. View, save, or print out the report. This report shows each keypad, name, location, finish, and a graphical
preview of the finished engraving.

Exporting your Engraving Order

To Export your Keypad Engraving Order:

1. In the Reports list, select Export Engraving Order.

2. Select the devices you would like to include in the engraving order in the project tree list.

3. Click Export Order.
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Troubleshooting
Use this chapter to learn how to:

l Follow general guidelines for troubleshooting

l Troubleshoot controllers

l Troubleshoot a Director connection

l Troubleshoot media

l Troubleshoot devices

l Troubleshoot the upgrade process
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Guidelines for troubleshooting
This section outlines general troubleshooting guidelines to check first if you are having problems with a
Control4® system.

The following table lists the main areas typically found to resolve some issues on the Control4 system.
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Guideline Where to go

Check room
connections

Composer Pro automatically sets room connections when
you set up a system. These settings are default settings,
and may not necessarily match your physical connection.
Ensure that the room connections are set to match your
specific system. If you move a device to another room,
move it in the project tree also, and then identify it again
to make sure it's connected properly. For more
information, see: “ Connecting rooms” “ Testing device
controls”

Check Control/AV
connections

The Control and AV connections identify the physical
connections to the system. When these are defined, the
system is completely automated and programmable.
However, if one of the connections is not correctly
identified, it can cause the system not to run properly.
Ensure that the control and AV connections match the
physical configuration.

For more information, see: “Testing control and AV
connections”.

Check network
connections

If a device is not using a control connection to
communicate to the Control4 controller, it uses a network
connection: a type of connection that uses a network
address such as TCP/IP (Ethernet), Zigbee, Zigbee Pro
and Wi-Fi.

1. Ensure that the network connections viewable in the
Connections view > Network tab all have a network
address associated with the device. If not, identify the
device again.
2. Ensure that the Control4 controller, such EA-3, has a
network address. If the address is not appearing, identify
the device again.

From the Tools menu, select Network Tools. This lets
you see all of the Zigbee and IP network addresses on the

535



Composer Pro User Guide

Guideline Where to go

network. It shows whether the device has an address, if it
has an active connection to the network (status is online),
and the Zigbee signal strength of each device.

For more information, see:

“ Using the Network tab”
"Tools menu"
Connecting a Device to the Network
(see “Connecting devices”)
“ Cannot identify the device to the network”
“ Verifying the network connections”

Ensure Navigators
are connected to
Director

From any of the Navigators, press Info > Director (for
releases prior to 2.0) orMore > Settings > Network (OS
2.0 or later) to ensure that you are connected to the
Control4 controller’s network address. You can find out
the Control4 controller’s network address from the
Connections view > Network tab.

For more information, see ”Customizing Navigators.”

Ensure music is
added and scanned

In Composer Pro, ensure that your music is available
(added to the controller) and is scanned into the system.

1. Make sure the stored or broadcast media is added or
scanned.
2. Check the Room Properties page to see if the media
was added.
3. Ensure that Navigators were refreshed after scanning
media.
4. If the controller reboots, re-scan the media.

For more information, see:

536



Composer Pro User Guide

Guideline Where to go

“ Adding items to the project tree”
“Setting up media stored on a controller”
“ Setting up media stored on a disc changer”
“ Setting up media for television stations”
“ Setting up media for radio stations”
“ Using external storage devices”
“ Configure an audio or AV switch”
“ Creating a playlist”
“ Editing media information”

Refresh Navigators Whenever you update the system, scan music, or update
devices or device information, from the File menu, select
Refresh Navigators.
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Troubleshooting controllers
The following table lists troubleshooting problems on Control4 system controllers.

Symptom Possible problems and solutions

The controller has
N/A for IP address

1. The controller has no network connection. Plug in
your Ethernet cable. After a few moments, the addresses
should appear.
2. The power cable is not plugged in. Plug in your power
cable.
3. No DHCP on the network. Ensure that DHCP is
operational.

The controller has a
blank front display

1. Either your cables are unplugged, or they are not
connected. If both are connected, unplug them and
connect the Ethernet cable before connecting the power
cord.
2. The controller is not connected to a
cable/modem/switch/ using DHCP.
3. Ensure that the Reset button is not jammed behind the
plastic cover (older controllers only).

The controller
doesn't come back
up after a power
outage

To receive a notification of the controller going down
and coming back up, set up an Email Notification agent
to alert you when the project is loaded and the controller
comes back up. When you create the alert, place the alert
on the project (Device Events top level). See " Using the
Email Notification agent.”

Rebooting the Control4 system
At one time or another you may have configured the Control4 system incorrectly, or the connection to the
network is not behaving the way it should. In this case, you can reboot or reset the system. You don't have to
do anything in Composer Pro other than check that the device you reboot is on the network.

To reboot a controller:

1. Disconnect the power cord from the controller.

2. Plug the power cord back into the controller.

3. Verify that the controller comes back on the network in Composer Pro. See “Connecting devices to the
network” or your controller’s installation guide for details.
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Resetting the Control4 system
Refer to your controller’s installation guide for reset and factory restore
instructions.
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Troubleshooting a Director connection
The following table lists troubleshooting problems connecting to a Director.

Symptom Possible problems and solutions

Cannot see the
Network Address
of Director in the
Director’s dialog

1. In Tools > System Manager, click Refresh several times
to see if the network address appears.
2. If not, select Add and enter the name and network
address.
3. Make sure Director is enabled on the controlling device.
a. At a command line, enter telnet [controller IP address].
b. Enter the root username and password.
c. Enter sysman status.
d. If Director is not enabled, enter sysman enable director.
e. Enter sysman status and verify the Director is now
enabled.
f. Enter exit.
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Troubleshooting media
The following table lists troubleshooting problems with Control4 system media.

Symptom Possible problems and solutions

DVDs not showing
up in the disc
changer

Ensure that you have a serial disc changer. Only bi-
directionally-controlled serial disc changers can scan
media.

If you have a serial disc changer, see the following:

1. Ensure that music is added and scanned
2. Check these sections:
“ Setting up media stored on a disc changer”
“ Connecting rooms”
“Testing control and AV connections”
“ Connecting a device to the network”

Cannot play music
or music channels
not appearing in the
Navigators

If music is not running, see the following:

1. Ensure that the Navigator is connected to Director. See
Composer Pro Getting Started.
2. Ensure that a room is appearing on the Navigator. If not,
click the room and change the room to one that can play
music.
3. Ensure that music is added and scanned. See:
“ Connecting rooms”
“Testing control and AV connections”
“ Connecting a device to the network”
4. Refresh the Navigators. See the Composer Pro Getting
Started.
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Troubleshooting device control
The following table lists some control problems on Control4 system devices.

Symptom Possible problems and solutions

The Device is not
Controllable from a
Navigator

If the device, such as a dimmer, is not controllable from
the Device Control window (double-click the device from
the project tree); no connection exists.

Refer to the following sections:
“ Connecting rooms”
“Testing control and AV connections”
“ Connecting a device to the network”
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Troubleshooting Navigators
The following table lists troubleshooting problems with Control4 Navigators.

Symptom Possible problems and solutions

Not seeing Room
Location on the
Navigators

From a Navigator (on screen or touch screen), ensure that
the device is connected to Director. See “ Connecting
rooms”.
Check the connections:
1. For an on-screen Navigator, see “Testing control and
AV connections”.
2. For touch screens, see “ Connecting a device to the
network” .
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Troubleshooting driver creation
The following table lists troubleshooting problems when creating Control4 drivers.

Symptom Possible problems and solutions

IR Learning is not
working

1. A controller must exist in the project to run IR
Learning. Add a controller.
2. The process of capturing IR codes is very sensitive to
lights, such as sunlight, fluorescent lights. If it is not
working properly, turn off the lights or cover the physical
hardware so that the light cannot interrupt the code
capture.
For a complete list of IR capturing guidelines, see
“ Guidelines for capturing IR codes.”
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Troubleshooting dimmers, switches,
and keypads
The following table lists troubleshooting problems with Control4 system
dimmers, switches, and keypads.

Symptom Possible problems and solutions

Dimmers, switches,
or keypads are
not behaving
correctly

1. Reboot. Try rebooting the device by tapping the top
button 15 times. On the 6-Button Keypad, this is the top
left button. This action reboots the device, but does not
clear programming associated with the device.
2. Reset.
a. Tap the top button 5 times.
b. Tap the bottom button 5 times.c. Tap the top button
again 5 times. If you are using the 6-Button Keypad, this is
the top left and bottom left button. This clears all your
network connections.
d. Go back into the Connections view > Network tab, and
identify the device again after resetting.

545



Composer Pro User Guide

Cannot identify the device to the
network
This section provides troubleshooting instructions to identify a Control4 system device on the network.

If you cannot identify a device on the network, follow these steps until the problem is resolved:

1. Make sure the Control4 controller is identified in Composer Pro. In the Connections > Network tab, see the
line item for the Control4 controller. Is there a network address for the controller?

2. (Controller only) In System Design, select the controller object to check the Zserver status. Is the Zserver
running? If not, click Enable.

3. If the controller is identified and Zserver is running, check whether any other devices identify. Do they?

l If yes, a problem exists with the individual device. On switches, dimmers, and
keypads, if you tap the top of the button 9 times, the bottom 9 times, and the
top 9 times again (pause for a breath in between each 9 count), this will reset
the device. Doing the same thing with 7, 4, and 7 will make the device’s LED
flash the channel it’s on (if it’s on Channel 14, it will flash 14 times). If the
channel doesn’t match the one for your system remote control and
controller, the channel will need to be changed. Call Control4 Technical
Support.

Note: For Release 1.8 and later, Zigbee Pro devices select one channel.
Control4 recommends that you not change the channel; Zserver determines
which channel to use automatically based on the available frequency space.
Refer to the Composer Pro Software Release Update Instructions - 1.7.4 to 1.8.2
on the Control4 Knowledgebase or on the Dealer Portal for details.

l If no, some other devices in the house may be causing interference. Power
down any 2.4 GHz devices, such as microwaves and cordless phones.
Continue to the next step.

4. Will the devices identify now?
l If yes, something in the house is causing interference. Replace it, or reset the
channel on all of your devices. You cannot reset the channel on wireless
dimmers, switches, etc., at this time. Call Control4 Technical Support.

l If no, a problem exists with the controller’s radio transmitter. Call Control4
Technical Support.
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Troubleshooting the upgrade process
Follow these guidelines if you are experiencing Control4 upgrade or update problems.

Basic troubleshooting guidelines
1. Reset the device’s network settings. See “Resetting the Control4 system .”

2. Attempt to have the update successfully downloaded while connected to a different network or by using a
USB drive update (see “Information about older releases”).

3. Allow the device to retry downloading the update as it automatically restarts and retries it.

4. Is the defect install/update related to an ongoing system operation?

5. Media not available? If it is a USB drive or network file share, make sure it is mounted (use the System
Design view). If the media is on USB drive connected to a secondary controller, re-scan the media for that
device.

6. Navigator not connected to Director? Reconnect Navigator to Director.

7. Are strange things happening to the devices?

l Make sure all Zigbee devices are updated to the latest firmware.

l Make sure Director and Composer Pro are using the same version.

l Disconnect and identify any problematic devices again.

l Power cycle all IP devices.

l Be patient. In cases where the Zigbee mesh is moved, it can take up to five
minutes for all connections to get re-established.

8. Turn on Diagnostic Logging (in Composer Pro, Tools > System Diagnostics > Logging > Start). Use the
Logging tool to determine what was happening on the system. Can you duplicate it, and is there a
workaround? For details, see “ Logging diagnostics information.”

Tip: Report any problems during the update process to:

Control4 Technical Support: http://dealer.control4.com/support Email:
support@control4.comTelephone: 1-888-400-4072

547

http://dealer.control4.com/support
mailto:support@control4.com


Composer Pro User Guide

Status message Description Resolution

1. Device IP address
detected with a different
version — update needed.

The Director discovered
a device that is a
different version than
the Director box.

Perform update.

2. Device IP address
indicated it needs to be
updated.

The device sent a status
message to the Director
that says it needs to be
updated.

Perform update.

3. Finished update
attempt.

Current update is
completed. A separate
message notifies you of
how many devices
succeeded or failed.

(Status message only)
No action is required.

4. Update information was
missing or invalid.
Reinstall the files for the
USB drive, and attempt
the update again. If the
problem persists, contact
Technical Support.

A Director could not
find the matching
update information for a
device retrieved from
the USB drive. This
would be the case if
files were deleted from
the USB drive.

Re-install the files for
the USB drive, and
attempt the update
again. If the problem
persists, contact
Technical Support.

5. Update information was
missing or invalid.
Contact Technical
Support.

The Director could not
find the matching
update information for a
device retrieved from
the Web. The database
contains invalid data.

Contact Technical
Support.

6. Director device is not
yet identified. Please
identify the Director
device and attempt the
update again.

The system has not yet
discovered the Director
device.

Identify the Director
device, and perform the
update again.

7. Starting update to An update has started. (Status message only)
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Status message Description Resolution

version <targetVersion>.
Director version is
<version of Director>.

No action is required.

8. Detected USB device
containing update
information. The USB
device will be used for the
update.

The system has detected
a USB drive.

(Status message only)

9. Device <ipaddress>:
<Status data received from
the device>

The system received
data from the device.

(Status message only)
No action is required.

10. Updated: <number of
updated devices> Failed:
<number of failed
devices>

Follows the message
“Finished update
attempt” (number 3) to
provide specific details.

Reconnect, re-identify,
and restart the update.

11. Device <ipaddress>
failed to update.

Provides the specific IP
address of any device
that failed to update.
Follows the message
number 10 when
applicable.

Try to identify the
device again, and try the
update again. If not
successful, contact
Technical Support.

12. Failed email results to
<entered email address>”.
Error was: <error
number>. Verify that the
VPN is correctly setup and
functioning on your
Director box and that a
valid mail address was
entered. Contact Technical
Support if this problem
persists.

This is called if an error
is returned when trying
to send the summary
via email.

Verify that the VPN is
correctly set up and
functioning on your
Director box, and that a
valid mail address was
entered. Contact
Technical Support if
this problem persists.

13. Unable to obtain System has not received 1. Ensure that you can
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Status message Description Resolution

update version information
from the Web interface at
URL <url used for getting
the version, i.e.,
http://webdev-
1.control4.com/...>. Verify
that Internet access is
available from Director.

the version information
back from the database.

communicate to the
Internet to the Website
from your computer.
Use a prompt box to
ping the address.
2. Ensure that you can
connect to the Control4
controller through the
Local Area Network.
3. Ensure that a firewall
is not blocking the
update.
4. If you still cannot
update, use a USB drive
for the installation.

14. Detected devices that
still need to be updated.
Restarting the update
process.

To allow an update to
propagate throughout
the system, the system
waits 5 minutes after
the start of the update
before checking the
status of connected
devices. If outdated
devices are still
detected, this message
is sent, and the system
restarts the update
process.

(Status message only).
No action is required.

15. The information on the
USB drive is invalid.
Reinstall the update on the
USB drive and attempt the
update again.

The system cannot
parse the update-
info.html file on the
USB drive. The file is
not valid xml.

Re-install the update on
the USB drive, and
attempt the update
again.

16. Not enough free space
on file system to store

There is not enough
free space on the box

Remove the stored
media, log files, etc.,
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Status message Description Resolution

update information. Disk
free = <amount of free
space> needed = <space
needed>.
Remove stored media, log
files, etc., and attempt the
update again.

running Director to
store the largest set of
packages for a device
type.

and attempt the update
again.

17. Unable to access the
directory for update
information. Please
contact Technical Support.

System cannot access
the /packages directory.
Either the disk has a
serious problem, or the
mounts didn’t work
right.

1. Ensure that you can
communicate to the
Internet to the Website
from your computer.
Use a prompt box to
ping the address.
2. Ensure that you can
connect to the Control4
controller through the
Local Area Network.
3. Ensure that a firewall
is not blocking the
update.
4. If you still cannot
update, use a USB drive
for the installation.

18. Out of file space for
packages.

Ran out of disk space
while downloading the
software packages. The
update fails, then
restarts after 5 minutes,
and the “Not enough
free space” message
(number 16) displays.

Remove the stored
media, log files, etc.,
and attempt the update
again.

19. Device <ipaddress>
failed because it reported a
status of <reported device
status>.

The device reported that
it failed to update.

Try to identify the
device again, and restart
the update. If it fails
again, contact Technical
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Status message Description Resolution

Support.

20. Touch screen device at
<IP address> must be
docked before upgrading.
Please dock the touch
screen and restart the
update.

A Wireless Touch
Screen was not properly
seated in its dock when
the update started.

Please dock the touch
screen, and restart the
update.

Diagnosing trouble spots
Use the System Diagnostics tool in Composer Pro to view, monitor, and troubleshoot a Control4 system.

System Diagnostics tool
The Control4 system includes many devices running embedded operating systems communicating over a
wired or wireless network. During installation, configuration, and troubleshooting, the ability to look at the
overall status of the components becomes very useful. 

The System Diagnostics tool lets you gather system information to help you determine if any issues
encountered are configuration problems, performance issues, or potential defects.

System Diagnostics uses

Possible uses of the System Diagnostic tool include:
l Viewing controller performance information:

l CPU usage

l CPU usage history

l Memory usage

l Memory usage history

l Processes running

l Viewing controller networking information:

l Network type

l Connection status

l MAC address

l IP address

l Subnet mask

l Gateway

l DHCP status
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l DNS server information

l View system information

l Viewing system information:

l Detailed lower-level information about the devices listed

l Viewing logging information:

l When troubleshooting a problem that is reproducible, use the System
Diagnostics tool to capture logged information while reproducing the
problem to email to Control4 Technical Support.

l When troubleshooting a problem that is not reproducible, connect the
controller, enable logging, and allow the logging to continue running for a
specified period of time to capture the problem. The logs are then captured
and emailed to Control4 Technical Support.

Use the Control4 Composer Pro System Diagnostics tool to view, monitor, and troubleshoot a Control4
system. The diagnostics information is organized into four tabs:

l Controller Performance

l Controller Networking

l System Info

l Logging

To access the System Diagnostics tool:

1. Start Composer Pro and connect to a Director.

2. On the menu bar, click Tools menu, then click System Diagnostics. The tool is available over a LAN
connection using remote access.

3. Use the tool to diagnose problems on your own, or capture and send information to Control4 Technical
Support.

System Diagnostics interface

Viewing controller performance information
Use the System Diagnostics tool (Tools menu > System Diagnostics) to view controller performance.

The Controller Performance tab contains information regarding CPU and memory utilization for the Primary
Controller of the project. Asynchronous messages from the Director regarding its current state are also
displayed.

To view controller performance information, including CPU and memory usage:

1. Start Composer Pro and connect to a Director.

2. From the Tools menu, select System Diagnostics. The Controller Performance tab is viewable by default.

3. View information displayed on the Controller Performance tab:
l CPU Usage—Shows a graphical form of current CPU usage and CPU usage
history for the primary controller, which is the Control4 controller used to
control the system if multiple controllers exist on a system.
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l Memory Usage—Shows in graphical form the current memory usage and
memory history for the primary controller.

l CPU and Memory Usage by Component—Shows percentages of CPU and
memory use per component.

4. Refresh the screen or update the speed. To do this, from the View menu you can:

l Refresh Now—Restart the real-time display of CPU and Memory usage.

l Update Speed—Change the speed to High, Normal, Low, or Paused.

5. View the Directory messages by clicking the History button.

Using the controller networking information
Use the System Diagnostics tool (Tools menu > System Diagnostics) to use
controller networking information.

View the information, including:
l Network type
l Connection status

l MAC address

l IP address

l Subnet mask

l Gateway
l DHCP status

l DNS server information

To use controller networking information:

1. Start Composer Pro and connect to a Director.

2. From the Tools menu, select System Diagnostics, and then click the Controller Networking tab.
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3. Ensure that the network information shown is reflective of your network.

4. To test your Internet connection, click the Test Internet Connection button. The screen
displays the current status of networking services, including the CD & DVD Lookup
Service, Media Web Service, and Updates Web Service.

This screens shows that the example services failed.

5. Click Close to exit the dialog box.

Using system information
Use the System Diagnostics tool (Tools menu > System Diagnostics) to use system
information.

View System Info current configuration settings, state of the primary controller and any other Control4 device
in the Control4 system’s current project. The information displayed is a summary of several commands.

To use system information:

1. Start Composer Pro and connect to a Director.

2. From the Tools menu, select System Diagnostics, and then click the System Info tab.
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3. Select a device or sub-category (expanding the list as needed) in the left pane to display the system
configuration information in the right pane.

4. To save the displayed information to a file, click Save to File and specify the location and name for the file.

Logging diagnostics information
Use the System Diagnostics tool (Tools menu > System Diagnostics) to use the logging feature and log files.

View Logging to configure, start, stop, and schedule diagnostic logging of the Control4 system.

l Capturing Information While Reproducing a Problem—When troubleshooting a problem that is
reproducible, use the System Diagnostics tool to capture logged information while reproducing the
problem to email to Control4 Technical Support.

l Enabling Logging for Debugging—When troubleshooting a problem that is not reproducible, connect to
the controller, enable logging, and allow the logging to continue running for a specified period of time to
capture the problem. The logs are then captured and emailed to Control4 Technical Support.

l Zigbee and I/O Communications—These items are available for logging in System Diagnostics.

l DirectorState.corrupt—If for any reason Director is unable to load a project file, it is saved to
DirectorState.corrupt prior to loading a clean project file (Tools > System Diagnostics > Logging).

To use system logging:

1. Start Composer Pro and connect to a Director.
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2. From the Tools menu, select System Diagnostics, and then click the Logging tab.

3. To enable logging, select the logging categories and click Start Tail

4. The results are displayed.

5. (Optional) To save the log, but continue logging the results, click Clear Output. The logging feature remains
enabled, but a Save As dialog box lets you specify the location and name of the text version of the log.

6. (Optional) To save the log and disable the logging process, click Stop Logging. The logging feature is
disabled, but a Save As dialog box lets you specify the location and name of the text version of the log.

7. To view the controller Log, click Open Controller Log.
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Glossary
4

4Sight: An Internet service that provides a connection to the home automation system any time and from any
place worldwide.

A

AAC: Advanced Audio Coding. A successor to the MP3 format. A standard, lossy compression and encoding
scheme for digital audio. Touts better sound quality.

action: An activity that occurs when an event prompts it to do so.

agent: In Control4 programming, agents provide the ability to perform complex programming by using
functional modules. There are various types of agents; for example, Announcements, Email Notifications,
Scheduler, Lighting Scenes, Wakeup, etc.

Anywhere Access: Lets users access and control their Control4 systems remotely using a mobile device or
tablet anywhere in the world.

AV: Audio Video

B

Boolean: The computer logic used to determine if a statement is ‘True’ or ‘False.’

button-link binding: The LED colors used based on the device; the Installer can set these colors
independently from the device to which the colors are bound.

C

CD: (Compact Disc) - An optical disc that stores digital data. This format is compatible with Control4 products.

client: A software or hardware device that communicates to a server for feedback from the server via an
application for the user.

Command: A ‘do’ statement; actions the Director communicates to a device.

Composer: The Control4 software used to design and define a Control4 home automation system.

Composer Pro: Composer is used to set up and configure Control4 devices to communicate with each other
in a home automation system.

conditional: An ‘if’ statement that asks a true/false questions which are acted upon in Composer
programming.

configuration worksheet: Used in Composer software training to design and configure a project in Composer.

connection: Binding or linking devices together in Composer so they can communicate with each other.

contact: Contacts are generally used to monitor the status of something (door, window, water sensor, etc.)
and can be hooked up through a security panel or directly using a Control4 controller or Contact/Relay
Extender. Contacts connected to a Control4 controller or contact/relay extender can be configured either as
NC (normally closed) or NO (normally open).

Control4 App: A Control4 graphical Navigator that runs on mobile devices or a PC or tablet.

Control4 system: A home automation system designed and developed by Control4.

controller: The main device that makes home automation possible. There may be multiple controllers within a
Control4 system. The controller that runs Director is referred to as the primary controller.

cover art: An illustration of the cover of a DVD or CD album that displays in the Graphical or on-screen
Navigators when playing music or watching videos.
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CSV: comma-separated value. Can be used when adding media to a Control4 system.

D

Detective Suite: A set of tools that perform diagnostics tests on the Control4

device: A component that requires a device driver; code that is used to allow the Control4 system to work with
that device.

device driver: Every device in the Control4 system needs a corresponding device driver to control the device.

DHCP: DHCP (Dynamic Host Configuration Protocol) - A protocol used between a network client and a DHCP
server (usually a router or access point) that dynamically assigns IP addresses from a pre-defined list to
clients on a network.

Director: Each Control4 controller (such as a Home Controller HC-500) ships with pre-installed Director
software (Linux based) embedded in the device. The Director communicates with Control4 products and third-
party products to enable home automation and interaction of individual devices. Director runs the Control4
devices. Composer Pro is the software used to connect to and program a system Director that resides on a
controller.

DriverWorks: The DriverWorks SDK is used to create two-way drivers for audio video (AV) and non-AV
devices.

DVD: (Digital Versatile Disc) – A media format for video and data storage.

E

end point: The end point is the final point (device) on the defined path over which audio and/or video content
is routed to a room. An example of this would be a TV or Receiver.

Ethernet: Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a star network
topology that allows multiple points to communicate to a single point. The Speaker Point® and Mini Touch
Screens use Ethernet to communicate to the Control4 controller.

event: An action; used to trigger Composer programming when programming Control4 devices.

F

forward-phase dimming (also known as leading edge dimming): A type of phase-cut dimming in which the
load is dimmed by cutting off the leading edge of each electrical cycle. This type of dimming must be used with
magnetic transformers (magnetic low-voltage loads) and works well for many other load types including
incandescent and cold cathode. It should not be used with electronic transformers (electronic low-voltage
loads) unless the transformer specifications specifically state that Forward Phase dimming is allowed.

file format: A format used by applications to store/read files.

FLAC: Supported by Control4 for software release 1.8, this is a free, open source, lossless audio codec format
that supports tagging, cover art and fast seeking. Audio is compressed with no loss in quality.

full duplex: The simultaneous transfer of data in both directions. For example, on a 5” or 7” In-Wall Touch
Screen the caller can send out a call and the receiver on the other end of the call can answer via his or her 5”
or 7” In-Wall Touch Screen and then respond.

G

gateway: (router)- Provides a means of communicating between two separate networks.

H
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home network: A network installed in the customer’s home that provides an Ethernet or wireless connection
so that Control4 devices can communicate with each other.

home automation system: The Control4 system: a line of home automation products that communicate with
each other over Ethernet, Wi-Fi, or Zigbee for a total home automation experience.

I

intercom: A two-way audio and/or video communication among supported Control4 touch screens.

IR: A device controlled using a wireless remote control device. Commands are sent via pulses of infrared light
to the device.

K

keypad managed: On a keypad, the LED state is controlled by the buttons on the keypad.

keypad unmanaged: On a keypad, the LED state of the buttons is controlled through programming rather
than from the keypad buttons.

L

LCD: (Liquid Crystal Display) - A display used with some Control4 interfaces.

LCD Navigator: An LCD device used to control lighting, music, videos, etc., on an LCD screen.

List Navigator: A system remote control device uses a Navigator that lists the options.

Live Connection: A term used in Composer Pro to indicate an actual connection to the network.

loop: A type of conditional in programming; a ‘while’ statement; for example, “while the sprinklers are on…”

M

Media Manager: Media information is stored in the Media Manager database, which will permit users to view
the media information from the Navigators.

MP3: A music format that makes streaming audio available.

MP4: An audio and video format. Can also store images and subtitles.

N

Navigator: A Control4 Navigator used with the Control4 system to control lights, music, videos, etc. Navigator
is software that the customer interacts with using a universal remote control, on-screen Navigator, touch
screen, or LCD Screen.

O

on-screen device: Allows you to select the controller (Media Controller or Home Theater Controller) in the
room that controls the source for the on-screen display.

P

playlist: A list of songs compiled in a list. The list can be compiled by songwriter, album, song type, or any
combination.

Power Over Ethernet (POE): Network cabling that provides Ethernet connectivity and device power over a
single cable for Control4 devices.

programming: A machine-readable artificial language used to express computations that can be performed
by a device.
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project tree: A tree view in Composer where the project is layered by the larger branches (Home, Office, etc.)
and then the lower branches (floor, rooms, etc.), and finally to the leaf level (drivers).

R

ramp rate: The rate that a dimmer ramps up its voltage.

relay: An electrical switch that opens and closes. A relay is controlled by another electrical circuit.

remote access: The ability to access a device from a remote location.

Remote Director: Connects you to the home network while working in Composer from a remote location.

retrofit: The ability to set up a home automation system in an existing structure or home. Compare this with
new building construction.

reverse-phase dimming (also known as trailing edge dimming): A type of phase-cut dimming in which the
load is dimmed by cutting off the trailing edge of each electrical cycle. This type of dimming must be used with
electronic transformers (electronic low-voltage loads), and works well for many other load types including
incandescent; some types of dimmable fluorescent and compact fluorescent; and some LED power supplies.
It should never be used with magnetic transformers (magnetic low-voltage loads).

RJ-45 jack: An eight-pin jack used to connect CAT5e network cables to devices through Ethernet signals.

router: See gateway. Functions similar to an AP but with additional functionality for controlling the network; for
example, coordinating traffic between different networks.

S

SDDP (Simple Device Discovery Protocol): A protocol developed by Control4 to allow devices to be easily
added to a control system. It has the ability to leverage other protocols and work on almost any physical layer.
SDDP offers four primary functions:

l Enable devices to use Dynamic Host Configuration Protocol (DHCP) while still
being able to identify them uniquely.

l Enable Director to discover devices residing within the Control4 system.
l Enable Director to identify devices residing within the Control4 system.
l Enable automatic installation of drivers for discovered devices.

serial-controlled device: Serial-controlled devices with an RS-232 interface and control protocol often have a
higher level of controllability than IR-controlled devices. Examples of serial-controlled devices are projectors,
multi-disc DVD changers, etc.

switch: An extension of a router that adds more Ethernet ports to support additional devices or clients on the
local network.

system event: An action that causes another action; for example, if a projector turns on, it enables the other
devices in the system that work with the projector.

system remote: System remote control

system remote control: A Control4 system remote control is a universal solution that replaces system remote
control devices from other manufacturers, and includes programmable buttons. This system remote control
can access on-screen (graphical) Navigators.

T

touch screen: A touch screen is a home automation system Navigator that controls the home’s lighting,
music, videos, and other devices on the home automation system.

U
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UI (user interface): The preferred term is Navigator. The Control4 interface used with Control4 devices to
control home automation, such as touch screens, Control4 apps, or on-screen Navigators.

universal remote: Universal remote control. A third-party remote control that can be programmed to replace
other remotes in the home so that only one remote is needed, replacing all others. Control4 system remote
control devices are a type of universal remote control.

USB (Universal Serial Bus): A format used with USB sticks that plug in to a USB port on Control4 devices.

V

Virtual Connection: A term used in Composer Pro to indicate a connection outside the network.

Virtual Director: A connection to a virtual controller only (a PC is the Director host rather than the controller).
Projects created or edited here are benign until the saved project is loaded onto a controller.

W

WAP: Wireless Access Protocol. The protocol used to enable wireless access of Control4 devices.

Wi-Fi: Uses bi-directional wireless technology to transfer data. Wi-Fi (wireless fidelity) devices “connect” to
each other by transmitting and receiving signals on a specific frequency of the radio band using a wireless
access point. This technology uses the star network topology. Wi-Fi uses high bandwidth 802.11.

wired network: Uses Ethernet Category 5 (CAT5) wiring to send and receive data between devices connected
to a network.

wireless access point: A router extension with an antenna that communicates with Wi-Fi devices and clients
in the home. A wireless hub that connects to the wired network, and distributes the wireless signal.

wireless switch: Uses the Zigbee. UL listed dimmer. Single or multi-gang. Has an air gap to cut power.

WLAN: Wireless local area network.

WMA (Windows Media Audio): – Audio data compression technology developed at Microsoft; an audio file
format that competes with MP3.

Z

Zigbee: A wireless network that uses bi-directional wireless mesh network technology to transfer messages
from one device to another. Unlike a star network topology where devices can only send messages to each
other by sending them first to a single central device (which then delivers the message to the recipient device),
a mesh network topology allows the devices to forward messages from one device to another, thereby
extending the effective range of the network. Uses low bandwidth 802.15.4. 250 devices are allowed per
controller but Control4 recommends 125.

Zigbee Pro: The 1.1 version of Zigbee that provides improvements in standardization by: allowing more
interoperability with other Control4 devices, support for home automation profiles, and improves the scalability
of multiple Zigbee access points.

Zserver: A Zigbee server that contains software which runs on a Control4 HC-class controller.
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Index

0

0-10V dimmer 163

1

10-digit registration code 121

3

3-way lights

configure 221

configure 2-Button Keypad for 221

configure 3-Button Keypad for 222

4

4-zone amp

configure 239

Properties 240

4Sight

setup 121

7

7\ 212, 214-215

8

8-Channel 0-10V Dimmer

Properties 195, 197

8-Channel Dimmer

Properties 192

8-Channel Relay

Properties 194

A

AAC 57

563



Composer Pro User Guide

Account Services, Tools menu 78

Action, programming, example 62

Actions pane

programming 410

Actual playlist options 59

Adaptive phase dimmer 163

Add Driver option 67

Add locations, to project tree 29

Advanced Device Configuration, thermostat 257

Advanced Lighting agent 367

Agent

Access 323

Advanced Lighting 327

Announcements 368

Custom Buttons 374

E-Mail Notification 378

Light Properties 380

Macro 380

Media Scenes 382, 389-390

Rhapsody 246

Scheduler 394

Screen Saver 396

Timer 397

Variables 404

Wakeup 404

Agents

options 61

pane 61

program 367

view 27, 59

view, from Go menu 70

AM/FM/XM 58

And command 425

Announcement agent 367

audio end point 276
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Audio end point 39

devices 39

Audio Matrix Switch

configure 227, 230, 236

Audio switch

configure 238

audio volume 277

Audio volume 39

Audio/Video inputs 52

Connections view 54

Audio/Video outputs 54

Auxiliary stages, thermostat 260

AV devices

configure 227

AV switch

configure 238

Available Devices pane 56

Available inputs and outputs pane 54

B

Back up Composer 25

Back up system 521

Back up, media information 87

Backup 65, 86

project 84

Backup As 65, 87

Backup to Cloud 65

Basic tasks 83

Bindings

Detective Suite 73

Black & Decker lock

configure 262

update firmware 519

Boolean variable 435

Break command 420, 423
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Broadcast media types 57

Broadcast message, intercom 215

Build project, system design 105

Buildings, Locations tab 50

C

CA-1

configure 143

CA-10

configure 144

Cable TV 58

camera

configure 261

CBM Flash Disk

and Photo Screen Saver 464

CD 57-58

add 348

edit 363

CD information

edit 347

Celsius 255

Certified Only 48, 139

CFL Load

Wireless Dimmer 164

Change location 322

Change Logging 81

Chat with Support 81

Clear Media List 59, 66

Clear Project 64, 84

Cloud Management 65

Command tab 63

Commands

programming 416

using Delay, Stop, Break 420
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Communication agent

External Devices 374

program with 371

Communication options, installation 20

Composer

back up 25

exit program 25

older versions 109

same version as Director 102

startup screen 24

views 26

Composer Auto Update 81

Composer HE 56

Composer ME 56

Composer Pro

activation 19

basic tasks 131

check version 521

defined 15-16

interface 23

purpose 15

update 512, 514

views, from Go menu 70

Composer Views Method

example 306

Conditional

program 418

Conditionals tab 63

Configuration information 82

load 85

Configure 5;Touch screen

5\ 215

Configure properties

system design 106

Connect physical devices 105
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Connect to Director 65, 95

Connected items pane 54

Connection

audio and video 265

control 265

IP Network 266

network 265

room 265

verify 266, 274

verify network 282

WiFi 281

Connections

Identify 55

test 299

update when location changes 297

Connections view 26, 52

from Go menu 70

Connections, Properties pane 82

Contact connection 16

Contact Control4 123

Container variables 435

Control & Audio Video Connections pane 52

Control A/V tab, Connections view 52

Control and AV connections 295

define 268

disconnect 296

example 269

re-assign 296

verify 295

Control inputs 52, 54

Control outputs 54

Control/AV connections

disconnect 322

example 321

re-assign 322
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Control/AV tab 53, 175, 182, 295

Control4 apps 558

Control4 System 16

Control4 website 514

controller 16

digital audio 57

playlists 58

registration 17

Controller

configure 143

troubleshoot 538

controller networking 554

Controller performance

view 553

Controller properties 146, 152, 154

Controllers

configure multiple 157

Cooling Cutoff Point, thermostat 259

Cooling system

configure 253

Copy Existing Driver option 67

CPU Usage 553

Create New Driver option 67

Create script

programming 414

Create variables and agents

system design 106

Custom Buttons agent 367

Custom variables 435

Customize Navigators

system design 106

D

Dealer information 51

Delay command 420
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Delete playlist 66

Design project

connect devices 105

example 306

programming 105

Design system 104

Detective Suite 73

Device

cannot identify 546

connect to the network 281

Device Actions pane 62

Device connection status, Tools menu 70

Device control

test 299

Device Control window 31

device examples 300

Device driver 16

create 473

create 2-way serial 508

create TCP/IP controlled 508

edit 477

export for projects 509

use new driver in project 509

Device driver creation

overview 474

Device driver wizard 473

Device driver, Driver Wizard 69

Device driver, locate 138

Device drivers

and system design 105

My Drivers tab 44

organize 68

purpose of 106

Search tab 44

Device Events pane 62
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Device properties 82, 132

Device Properties 40

example 133

device type 48, 139

Device type 48, 139

Device, configure

guidelines 135

Devices

add 515, 518

change order in Navigator 467

connect 515, 518

disconnect 515, 518

hide 466

install 131, 333, 468-469

refresh 515, 518

troubleshoot 542

view 467

Devices, Properties pane 82

DHCP 18

DHCP status 75

Digital audio 57

Dimmer

change LED colors 172

troubleshoot 545

Director 16

connect to 95

Director on local network 98

live connection 17

load configuration 85

on local network 24

remote connection 17

same version as Composer 102

troubleshoot 540

update 514

virtual connection 17
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Virtual mode connection 97

Directors dialog 25

DIRECTV 58

disc changer

add media 345

add media to 344

auto-scan media 345

media storage 344

search media 346

Disc changer 57-58

Disconnect from Director option 65

Discover tab 43

Dish Network 58

DNS server information 75

Document scope 15

Door Station

configure 225

Driver

assign inputs and outputs 480

Delete button 68

My Drivers button 68

Sort button 68

Driver creation

guidelines 474

Driver Creation Wizard 105

Driver database

updates 522

Driver menu 63

Driver wizard 55

Driver Wizard

IR-controlled drivers 482

limitations 477

using 470, 477

Driver, search 68
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Drivers

Exit button 68

Notes 68

troubleshoot 544

DriverWorks SDK 474

DVD 57

add 348

edit 365

DVD changer 57

DVD information

edit 347

DVD player 58

E

E-mail Notification agent 367

EA-1

configure 143

EA-3

configure 143

EA-5

configure 143

Edit Existing Driver 55, 67

Else command 424

Emergency Stage, thermostat 259

Endpoints 38

Engraving

keycaps 219

Ethernet cables 79

Ethernet connection 20

Event, programming, example 62

Events pane

programming 409

Example

add devices to theater room 109

add DVD to theater room 112
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add motorized screen to theater room 113

add receiver to theater room 110

add thermostat 114

add TV to theater room 111

system design 108

Exit Composer 84

Export media list 59, 66

Export playlist 59, 66

Expression Builder 426-427

External storage device

using 358

F

Fahrenheit 255

Feedback menu 63

File management options 64

File menu 63, 86

filter 30

FLAC 57

Floors, Locations tab 50

FM 58

Forward phase dimmer 163

Full duplex, intercom 215

G

Gateway 21, 75

Go menu 63, 69

Green icon, Network Tools dialog 72

H

Hard disk space 18

Hardware, install 20

HC-800

configure 143

HDMI Video Matrix Switch 238
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Heat Stage, thermostat 259

Heating Cutoff Point, thermostat 258

heating system

configure 253

Help menu 63

Help options 81

High-Resolution Audio 146

Home network requirements 18

HVAC

configure 253

I

Identify device 318

Import DVD list from file 66

Import media list 59, 66

Import playlist 59, 66

Info pane 51

Install hardware 20

Installation

Composer Pro 22

guidelines 20

notes 52

software 21

Intercom 215

Intercom license 215

Intercom, user experience 215

Internet connection 18

Internet radio

set up 355

IO Extender

configure 158

IP address 18, 75

IP addresses, Directors dialog box 88

IP device

update 518
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IP Network Connections pane 55

IP Network tab 72

IP Network, Network Tools tab 72

IR 16

IR codes

guidelines for capturing 482

verify in Driver Wizard 478

IR driver 69

create 477, 482

edit 493

Items pane 28, 42

iTunes 56

K

Keycap

engraving 219

Keypad

troubleshoot 545

Keypad dimmer 163

Knowledgebase 19, 81

L

LED colors

changing on dimmer or switch 172

LEDs, controllers 21

License 19

Intercom 215

Lighting

configure 160

List View

pane 41

tab 83

List View properties 132

Load Project option 64, 86

Load Project, Virtual Director mode 97
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local database, device drivers 48, 139

Local driver database 68

Locale 35

Localization 35

Location

system design 108

Locations tab 42, 49

system design 108

Locks

configure 262

Logging 556

Longitude/Latitude 34

Properties tab 108

Loop 423

Loops tab 63

M

MAC address 75

Macro agent 368

Make connections

example 310

Manage Drivers dialog 68

Manage Drivers option 67

Manufacturer, device drivers 139

Maximum Run Time, thermostat 260

Media

Auto-scan 341

Disc Changer 342

edit 363

radio station 351

scan schedule 339

set up 334

storage 337

television station 353

test connection 362
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troubleshoot 541

media database 336

Media database 56, 66

Media Lookup Service 336

media management 336

Media Manager 56

Media menu 63, 65

Media Monkey 56

Media pane 57

media player

configure 243

scan videos 243

set up videos 350

Media Scenes agent 368

Media types 57

Media view 26, 56

Media view, from Go menu 70

Media, select from Navigators 56

Memory usage 553

Menu options 63

Minimum Run Time, thermostat 259

Mobile devices

use with Control4 system 225

Model, device drivers 49, 139

Movies, can't play 38

MP3 57-58

MP4 57-58

MQA 342

Multi-channel amp

configure 241

properties 242

My Drivers list 143-144

My Drivers tab 43, 137

my.control4.com 19
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Navigator

configure 199

set up Photo Screen Saver 463

Navigator tab 39

Navigators

troubleshoot 543

Network address 21

Network addresses, address types 56

Network connection 17

TCP/IP 55

WiFi 55

Zigbee 55

Network requirements 18

Network storage

scan videos 338

Network tab 54, 282

example 320

Network tab, Connections view 52

Network Tools 282, 518

example 320

Network Tools dialog 70-71

Network Tools window 70

Network, devices discovered 56

New playlist 66

New Playlist 59

New Project icon 28

NTP 34

Number variable 435

O

on-screen device 277

Online database 68

device drivers 48, 139

Or command 427
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Ordering

Keycap engraving 219

Outlet Light object

switch 174, 180

Overview of 16

P

Phased dimmer 163

Photo Screen Saver

setup 463

Physical connection 17

Physical connections 52

Playlist

create 360

Playlist, types 58

Power Control

switch 174

Power Learning 176

switch 174

power management 479

editing options 479

Power Management

change options 480

Power sensing 176

example 177

wireless outlet switch 174

Power sources, and installation 20

Program events and actions

system design 106

Programming

add a room to play music 433

agents 367

basics 409

button to play music 431

button to turn up volume 432
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commands 416

Conditionals 418

Copy and Paste 459

Detective Suite 74

digital audio 431

elements of 414

Find and Replace 457

rooms 431

set default music volume 433

Programming and Communication agent 371

Programming view 27, 61

Programming view, from Go menu 70

Programming, actions and events 61

Project configuration information 64

Project configuration, back up 88

Project information, Properties pane 82

Project properties 33, 81, 132

Project settings 34

project tree

filter 30

search 30

sync 30

Project tree 17

add devices 138

add items to 107

Project, back up 86

Project, clear 84

Properties pane 27, 32, 82, 132

Properties tab, Properties pane 82

Properties, Composer 81

proxy 48, 139

Push Settings from Project 34

R

Reboot Control4 system 538
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Reboot controller 538

Red icon, Network Tools dialog 72

Refresh Navigators 65

Refresh option 65

Register Composer 22

Register system 17

create project 105

Related documents 16

Relay connection 16

Relay, single contact

configure 248-249

Properties 249

Remote Access 18

add account 101

requirements 100

setup 99

Remote connection to Director 100

Remote Director 24

connect to 100

Remove items from project tree 84

Rename playlist 66

Replace Legacy Control4 Device 167

Replace Light setting 167

Reset Composer Layout 81

Restore default list 109

RJ-45 jack 21

Room connection

types 276

Room connections 54, 275

Room control 52, 54

Room properties 82, 132

Room Properties pane 38

Room Summary pane 39

Room tree 73

Room variables 435
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Rooms, Locations tab 50

Router 18, 21

S

Same version, Composer and Director 102

Scan media

from network 358

new 336

Scan songs 334

Scheduler agent 368

Scheduler agent, example 61

Screen saver 57

Screen Saver

change time 466

program 466

set up custom 465

Screen Saver agent 368

Script pane 62

programming 411

search 30

Search tab 138

Search tab, device drivers 45

security system 277

Serial 16

Serial codes

for device drivers 499

Serial device driver 499

create 505

Serial driver 69

create 477

Set up media

project design 106

Site, Locations tab 50

SNMP Configuration agent 368

Songs 59
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Songs, options 58

Speaker Point

configure for WiFi 233

Stage Cutoff Delay, Auxiliary 260

Stage Delay, Auxiliary 260

Stage Minimum Off Time, thermostat 259

Start Composer Pro 23

Status information, Properties pane 82

Stop command 420-421

Storage devices, external 58

String variable 435

Switch 21

change LED colors 172

troubleshoot 545

sync 30

System Compatibility Check 102

System configurations

examples 277

System design 17

methods 114

System Design

Go menu 70

pane 27, 57

Properties tab 107

view 26

view, create project 17

system diagnostics 552

System Diagnostics

Controller Networking tab 75

Controller Performance History button 75

Controller Performance tab 74

Logging tab 77

System Info tab 76

Test Internet Connection button 76

System information 555
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System Manager 24, 518

System Owner information 51

System registration 17

system remote control SR-150

properties 201

System Remote Control SR-150B

configure 201

program buttons 202

system remote control SR-250

change Zigbee channel 205

program buttons 205

System Remote Control SR-250

change Watch/Listen sources 199-200

configure 203

paging 206

properties 204

system remote control SR-260

program buttons 208

System Remote Control SR-260

configure 207

paging 209

properties 207

System security 34

System setup 16

T

Tag media files 66

TCP/IP 16, 18

Technical Support, contact 123

Television driver

creating IR 483

Temperature and temperature Control 277

Temperature calibration, thermostat 258

Thermostat

heat/cool engage delta 257
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lock, unlock 256

remote temperature sensor 256

set backlight 256

set date and time 257

setting advanced properties 257

Thermostat schedule, change 255

Thermostat, set Vacation mode 256

Third-party devices

configure 142

Third-party devices, install 20

Timer agent 368

Timezone 34

Tools menu 22, 63, 70

touch screen

configure 215

Troubleshooting

guidelines 534

U

UHF/VHF 58, 112

Update Composer Pro 512, 514

Update Director 514

Update Manager 78, 515

Update system 79

best practices 521

general steps 521

guidelines 519

software and drivers 522

update times 520

Update time

per device 520

Upgrade

troubleshooting 547

USB drive 57

and Photo Screen Saver 464
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USB stick

create 523

User interface 16

V

Variable

handling 438

room example 435

room, variable options 436

using Boolean 439

using custom variable agent number 444

using custom variable agent string 448

Variables

use in programming 435

Variables agent 368

Version

updating to same firmware version 518

video audio end point 276

Video end point 39

Video End Point 276

Video mode

set correctly 157

Video resolution 18

Video scanning

from network 338

Video volume 276

Virtual Director 24

W

Wakeup agent 368

WAP 19

Web image

configure 261

What's New 81

While statement 423, 428
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WiFi connection

controllers 143

Windows 7 16

Windows Media Player 56

Windows Vista 16

Windows XP 16

Wireless Access Protocol 19

Wireless Music Bridge 244

Wireless outlet dimmer

configure 179

Properties 180

Wireless outlet switch

configure 173

define connection 175, 182

Wireless Thermostat

program the schedule 253

Properties 255

setup 253

Wizard

Controller Migration 147

WMA 57

Y

Yellow icon, Network Tools dialog 72

Z

Zigbee

signal strength 72, 284

Zigbee device

update 518

Zigbee Health 515

Zigbee Network

Network Tools tab 72

tab 72
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Zigbee Server 143

ensure it is running 152

ZigBee Server

ensure it is running 146, 154

Zip code, Properties tab 108

589



11734 S Election Road
Draper, UT 84020

www.control4.com

Copyright © 2022, Copyright ©2021, Snap One, LLC. All rights reserved. Snap One and its respective logos 
are registered trademarks or trademarks of Snap One, LLC (formerly known as Wirepath Home Systems, 
LLC), in the United States and/or other countries. 4Store, 4Sight, Control4, Control4 My Home, SnapAV, 
Araknis Networks, BakPak, Binary, Dragonfly, Episode, Luma, Mockupancy, Nearus, NEEO, Optiview, OvrC, 
Pakedge, Sense, Strong, Strong Evolve, Strong VersaBox, SunBriteDS, SunBriteTV, Triad, Truvision,

200-00005-AA


	Contents
	Introduction
	Scope
	Related documents and resources
	Composer Pro overview
	Setting up the Control4 system—overview

	Composer Pro system requirements
	Computer software and hardware
	Home computer network
	Control4 home automation network


	Installing the hardware and software
	Installing and connecting the hardware
	Installing Composer HE software

	Exploring Composer Pro features
	First page
	Composer Pro startup options
	Start Composer Pro
	Exit Composer Pro

	Composer Pro views
	Available views
	System Design view
	System Design pane
	Project tree search, sync, and filter

	Device Control window
	Properties pane
	Room Properties
	Room Summary
	Device Properties
	List View pane
	Items pane
	My Drivers tab
	My Drivers options
	Search tab
	Locations tab
	Info pane

	Connections view
	Control/AV tab
	Network tab

	Media view
	Possible buttons
	Right-click options

	Agents view
	Programming view
	Composer Pro menu options
	File menu
	Media menu
	Driver menu
	Manage Drivers dialog
	Create, copy, and edit drivers with Driver Wizard

	Go menu
	Tools menu
	Network Tools
	IP Network tab
	Zigbee Network tab

	Detective Suite
	System Diagnostics
	Account Services
	Update Manager
	Feedback menu
	Help menu

	Composer Pro Properties
	Accessing properties from the project tree
	Properties pane
	Basic Composer Pro tasks
	Accessing the List view from the project tree
	Removing items from the project tree
	Clearing a project
	Exiting Composer Pro
	Getting project configuration information from a controller
	Loading a project’s configuration from a computer to a controller
	Backing up a Composer Pro project
	Automatic Project Backups
	Backing up and loading from a virtual to a local or remote Director
	Backing up a project's configuration and media
	Validating the project



	Composer Pro Version Independence
	Connecting Composer Pro to a Virtual, Local, or Remote System
	Virtual System
	Local System
	Remote System

	Composer Pro makes new decisions when connecting
	Connecting to a Virtual System with versioned APIs
	Connecting to a Local or Remote System with versioned APIs

	Connecting to a Director
	Connecting Composer Pro to a Virtual, Local, or Remote System
	Virtual System
	Local System
	Remote System
	Connecting to a virtual system
	Saving changes when working virtually
	Using Virtual mode

	Connecting to a Director on a local network
	Setting up Remote Access
	Connecting to a Director using Remote Access
	Requirements
	Connecting using Remote Access

	Ensuring that Director and Composer are compatible
	System Compatibility Check

	Designing the Control4 system
	Introduction
	Purpose of device drivers
	Adding items to the project tree
	Building a project in System Design
	Composer Pro design methods
	Planning a Composer Pro project: Create a plan
	Home automation design methods
	Prerequisites to creating a design
	Guidelines of system design

	Using Composer views to build a project


	Making and testing the connections
	Connecting the hardware
	Testing the device connections
	Testing network connections
	Testing control and AV connections
	Testing room connections


	Registering the Control4 system
	Register the system at customer.control4.com
	Register the controller from Composer Pro

	Setting up a 4Sight subscription
	Managing and assigning Composer Pro licenses

	Where to go from here
	Contacting Control4 technical support
	Other resources

	Project build example using system design
	Adding a controller
	Adding keypad and electrical interfaces
	Adding AV components
	Adding a touch screen
	Finishing the project

	Basics
	Installing devices
	Configuring device properties
	Help for device properties


	Configuring devices
	How to add devices to a project
	Auto Discovery (SDDP)
	Composer views
	Using the My Drivers tab
	Using the Search tab
	Adding drivers manually

	Adding Z-Wave devices
	Z-Wave device drivers
	Motorization, sensor, and light drivers
	Configuring third-party devices

	Configuring controllers
	Configuring a home controller
	Configuring a CA-10 Automation Controller

	Configuring a Zigbee mesh controller
	Configuring high-resolution audio with an EA Controller
	Replacing an existing controller using the Controller Migration Wizard
	Ensure that Zigbee Server is running

	Configuring a Z-Wave controller
	Advanced configuration

	Advanced Z-wave concepts
	Troubleshooting Z-Wave
	Ensure that Video Mode is set correctly
	Configure multiple controllers
	Configure an IO Extender

	Configuring lighting
	Wireless Lighting
	Device settings for Configurable Keypads
	Device settings for dimmers
	Configuring the Keypad Dimmer’s buttons

	Device settings for switches
	Changing LED colors on a switch or dimmer

	Outlet Lighting
	Configure a Wireless Outlet Switch V2
	Perform power learning
	Configure a Wireless Outlet Switch for power-sensing AV devices
	Configure a Wireless Outlet Dimmer V2

	Centralized Lighting
	Adding Centralized Lighting to your project
	Configure light properties for Centralized Lighting

	Set Dimmable Light properties
	Non-Dimmable properties
	0-10V properties
	Configure an 8-Channel Dimmer
	Configure an 8-Channel Relay
	Configure an 8-Port Ethernet Switch
	Configure an 8-Channel 0-10V Dimmer
	Configure a Bus Ethernet Gateway


	Configuring user interfaces
	Change the order and visibility of devices
	Enable Equalizer Settings
	Configuring remote controls
	Configure System Remote Control SR-150B
	Program the System Remote Control SR-150B programmable buttons

	Configure System Remote Control SR-250
	Program the SR-250 programmable buttons
	Program the SR-250 Paging feature

	Configure System Remote Control SR-260
	Program the SR-260 programmable buttons
	Program the SR-260 Paging feature


	Configuring touch screens
	Configure the Intercom Proxy Properties for touch screen drivers compatible w...
	Configure a 7” or 10” T3 Series In-Wall Touch Screen
	Configure a 7” T3 Series Tabletop Touch Screen
	Configure a 7 In-Wall Touch Screen with Camera (C4‑TW7CO)
	Scenarios

	Configure a 7 Portable Touch Screen with Camera (C4‑TSMC7‑EN)
	Wireless Network Limitations

	Configure a 5 or 7 In-Wall Touch Screen (C4-TSWMC5 or C4-TSWMC7)
	Scenarios


	Keypads
	Configure a Configurable Keypad
	Device settings for Configurable Keypads

	Ordering keycap engraving
	Configuring lights for 3-way
	Configuring a 2-Button Keypad as a 3-way light
	Configuring a 3-Button Keypad to control a 3-way light

	Configure a Dry Contact Input Module
	Device settings for Dry Contact Input Module


	Configure mobile devices or PCs/tablets as Navigators
	Configure a Door Station

	Configuring AV devices
	Configure a Triad Audio Matrix Switch
	Configure a Triad Power Amplifier
	Configure a Triad One Streaming Amplifier
	Input Mode
	Direct
	Stream
	Direct + Stream
	Configure Triad One for Wi-Fi


	Configure an Audio Matrix Switch
	Configure a Control4 4k Ultra HD 10x10 HDMI Matrix Switch
	Configure an audio or AV switch
	Configure a 4-Zone Amplifier
	Configure a Multi-Channel Amplifier
	Configure a media player
	Configure a Wireless Music Bridge
	Configure TuneIn

	Adding a media service
	Configuring Motorization
	Configuring a Zigbee IO and Zigbee Contact
	Configure a contact
	Configure a Fan Speed Controller
	Keypad properties


	Configuring HVAC systems
	Setting up a Wireless Thermostat
	Programming the Control4 Thermostat schedule
	Using the Wireless Thermostat advanced properties
	Advanced Device Configuration


	Configuring a camera
	Prerequisites

	Configuring Black & Decker locks
	Connecting devices
	Why you need connections
	Connection design tips for CentralizedLighting

	Connect and verify devices
	Connection Filters
	Connecting rooms
	Get room connections
	Room connection types
	Examples of system configurations
	Verify default room connections

	Connecting devices to the network
	Connecting a device to the network
	Configuring a Wi-Fi connection
	Verifying the network connections

	Connecting Zigbee devices
	Connecting Zigbee device drivers to the Zigbee network
	Zigbee Mesh Routing Tree

	Connecting Z-Wave devices
	Connecting Z-Wave device drivers to the Z-Wave network
	Connecting Z-Wave device drivers to motorization, sensor or light drivers
	Available Devices

	Removing Z-Wave devices
	Removing Z-Wave devices from the network
	Removing failed Z-Wave devices
	Replacing failed Z-Wave devices
	Connecting and managing control and AV devices
	Verifying control and AV connections
	Disconnecting or removing control/AV connections
	Re-assigning control/AV connections
	Updating connections when a location changes


	Testing device connections
	Testing device controls
	Device Control examples


	Examples
	Example home project: Composer views method
	Example: Design and create the project
	Composer views

	Example: Make and verify the connections
	Example: Verify the network connections
	Using the Network tab
	Using Network Tools

	Example: Define the control and audio/video connections
	Verify that all control and AV connections use room properties
	Disconnect/Remove control/AV connections
	Re-assign control/AV connections
	Update connections in the project if you change locations


	Example: Use the Access agent
	Example: Use the Advanced Lighting agent
	Setting up media
	Media types
	Overview of media management
	Media Manager
	New scans
	Scans where content is in the media database
	Other Media Manager considerations
	Media storage
	Media lookup service


	Configure video scanning of network storage
	Setting up media auto-scan
	Disc changer

	Setting up media stored on a disc changer
	Scanning media in a disc changer
	Automatically scan media
	Searching media in a disc changer
	Edit CD or DVD information
	Adding a DVD or CD

	Setting up videos for a media player
	Setting up media for radio stations
	Setting up media for television stations
	Setting up Internet radio stations
	Importing a DVD list from a file
	Using external storage devices
	Attach and scan external storage devices
	Access and scan network storage devices

	Creating a playlist
	Testing the media connection
	Editing media information
	Editing CD information
	Editing DVD information

	Using and Programming with Agents
	Agent types
	Using the Announcements agent
	Using the Communication agent
	Add new Intercom group
	Local Devices tab
	External Devices tab

	Using the Custom Buttons agent
	Guidelines

	Using the Email Notification agent
	Using the Light Properties agent
	Using the Macros agent
	Using the Media Scenes agent
	Guidelines

	Using the Color agent
	Quick Configuration
	Presets
	Add Preset
	Edit Preset
	Preset Order
	Import/Export Presets
	Advanced Properties
	Using the Media Sessions agent
	Configuring the Master Volume Slider
	Using the MultiDisplay Manager agent
	Using the Scheduler agent
	Using the Screen Saver agent
	Using the Timer agent
	Using the UI Configuration agent
	Using the Variables agent
	Using the Wake/Sleep agent


	Programming
	Programming basics
	Event-driven programming
	Programming elements

	Programming with commands
	Programming with conditionals
	Programming with Delay, Stop, Break, Or, And, and Else commands
	Delay command
	Stop command
	Break command
	Else command
	And command
	Or command

	Programming with a While statement

	Programming using digital audio and rooms
	Program a button to play media or a playlist
	Program a button to turn up the volume
	Program a button to add a room to another room’s music session
	Set the default for a room’s music volume

	Examples: programming with variables
	Example: Using room variables
	Variable handling

	Example: Using custom Boolean variables in an agent
	Example: Using a custom number variable in an agent
	Example: Using a custom string variable in an agent

	Other programming tasks
	Using Programming Comments
	Using Find and Replace
	Using Copy and Paste

	Customizing Navigators
	Overview
	Setting up screen savers
	Setting up the photo screen saver
	Setting up a custom screen saver
	Programming the screen saver sleep mode

	Changing the time on a Navigator screen saver
	Hiding device availability
	Viewing device availability in navigators

	Creating drivers
	Creating and managing drivers
	Using the Manage Drivers window
	Creating device drivers
	Overview
	Why create a device driver?
	Guidelines for creating device drivers

	Using DriverEditor
	Using the Driver Wizard
	Limitations of the Driver Wizard
	Editing a driver using the Driver Wizard
	Verifying the IR codes using the Driver Wizard

	Power management
	Guidelines for defining power management
	Editing power management options
	Configuring assignable inputs and outputs

	Changing power management options

	IR-controlled drivers
	Creating IR-controlled drivers
	Guidelines for capturing IR codes
	Creating an IR television driver
	Conditions
	Add the IR driver to the project tree
	Connect the devices for IR control

	Editing an IR-controlled receiver driver
	Conditions


	Serial-controlled device drivers
	Creating a serial-controlled device driver
	Guidelines for entering serial codes
	Example: Creating a serial driver InFocus LP850 projector

	DriverWorks Two-way serial or TCP/IP driver
	Creating a 2-way serial or TCP/IP-controlled driver

	Related tasks
	Using a new device driver in an existing project
	Exporting a driver in the project

	Maintaining your system
	Maintaining your system
	Updating Composer Pro
	Update Composer Pro using Composer Pro
	Update Composer Pro from the website

	Updating the Control4 System
	Control4 website
	Prerequisites
	Update Manager
	Zigbee Health
	Zigbee Health Dashboard
	Zigbee Health Devices

	Network Tools
	System Manager
	Updating firmware
	Zigbee devices
	IP devices
	Black & Decker locks

	Guidelines for updating a Control4 system
	Guidelines for updating specific devices
	Estimating Control4 system update times
	Estimating update times per device type

	Best practices for updating a Control4 system
	General procedure
	Back up the current project and media
	Check the currently installed Composer version
	Update Composer software and drivers

	Updating with a USB device (USB Stick Creator)
	Create an Install on a USB device


	Reports
	Upgrade Report
	Upgrade Advisor
	Viewing the Upgrade Report

	System Report
	Centralized Lighting reports
	Report types
	Create a Panel Report
	Create a Module Report
	Create a Load Schedule Report

	Engraving reports
	Report types
	Creating a Keypad Engraving Report
	Exporting your Engraving Order


	Troubleshooting
	Guidelines for troubleshooting
	Troubleshooting controllers
	Rebooting the Control4 system
	Resetting the Control4 system

	Troubleshooting a Director connection
	Troubleshooting media
	Troubleshooting device control
	Troubleshooting Navigators
	Troubleshooting driver creation
	Troubleshooting dimmers, switches, and keypads
	Cannot identify the device to the network
	Troubleshooting the upgrade process
	Basic troubleshooting guidelines
	Diagnosing trouble spots
	System Diagnostics tool
	System Diagnostics uses
	System Diagnostics interface

	Viewing controller performance information
	Using the controller networking information
	Using system information
	Logging diagnostics information


	Glossary
	Index



